Desktop Publishing with Microsoft Word on the Macintosh

Second Edition

Tim Erickson  William Finzer

Through Version 4.0

With Time-Saving Design Examples

Plus a Mystery Woven In

“A-rated, complete tutorial to desktop publishing”
—Computer Book Review
### CHAPTERS

#### ABOUT PARAGRAPHS

<table>
<thead>
<tr>
<th></th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paragraph Marks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paragraph Numbering</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### PARAGRAPHS: ABOUT STYLES

<table>
<thead>
<tr>
<th></th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applying Styles</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□</td>
<td></td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Automatic Styles</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Default Styles</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Defining Styles</td>
<td></td>
<td></td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Finding Styles</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Importing Styles</td>
<td></td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Next Style</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Normal Style</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Printing the Style Sheet</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Redefining a Style</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Style Hierarchies</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Style Name Aliases</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
</tbody>
</table>

#### PARAGRAPHS: ABOUT THE RULER

<table>
<thead>
<tr>
<th></th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Tab Settings</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Indents</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Justification</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Ruler</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Tab Settings</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Vertical Bars</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
</tbody>
</table>
### Chapters

#### Paragraphs: Paragraph Formats

<table>
<thead>
<tr>
<th>Feature</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep Lines Together</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keep With Next</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Spacing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paragraph Borders</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Positioned Paragraphs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Space After</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Space Before</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tab Leaders</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td></td>
</tr>
</tbody>
</table>

#### About Entire Documents

<table>
<thead>
<tr>
<th>Feature</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Hyphenation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Facing Pages and Gutters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Footnotes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indexing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual Hyphenation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multiple Columns</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multiple Files</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outlining</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page and Column Breaks</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Numbering</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Orientation</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Size</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table of Contents</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Templates</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vertical Justification</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Viewing Documents</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Widow Control</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*continued inside back cover*
DESKTOP PUBLISHING
WITH MICROSOFT WORD
ON THE MACINTOSH
To Anne and Lauren in the first year of their lives;
and to Brigid and Meg in one of the longest years of theirs.
ACKNOWLEDGMENTS

Many people contributed to this book as it traveled down the long road from inception to this second edition. Dr. Rudolph Langer, editor in chief at Sybex, supported our initial proposal and talked to us about Shakespeare criticism, planting seeds that sprouted into the mystery. We are grateful to Barbara Gordon, David Kolodney, and Bret Rohmer, not only for their indulgence with respect to the aforementioned mystery but also for their willingness to depart from long-established production patterns and to take on desktop publishing as a production vehicle.

Vince Leone, developmental editor for the first edition, served as a sounding board for our ideas, clarified our thinking, tried to keep us on schedule, tracked the thousands of tasks that together make a book, and offered moral support at critical junctures. Michael Wolk, in his role as copy editor, found and obliterated the fuzziness in our writing and tried to impose consistency from beginning to end. He managed to moderate our humor, which can give an editor a lot of trouble, and conversational style, while supporting the spirit of the book. Scott Campbell bravely wrestled a floppy-based Mac to implement the word processing changes; for this second edition he used a 40 MB hard disk.

Ingrid Owen, the book designer, created and refined the design of the book you hold in your hands. She had the unenviable task, as a newly expert desktop publisher, of laying out the final pages of the first edition. The sharp and patient eyes of Sylvia Townsend proofed the first edition; Lisa Jaffe found all the mistakes in the second.

The second edition technical reviewer, Celia Stevenson, deserves special mention. She relentlessly tried everything we suggested and documented hundreds of discrepancies thoroughly. We’ve done our best to fix them all; it’s a good bet that any that are left are our fault, not hers.
We took advantage of our Mac-using friends and colleagues whenever they expressed an interest in our book. Among those who read and critiqued were Lynne Alper, Dan Fendel, Helen Garvy, Bethanie Gilbert, Nancy Kreinberg, Purusha Obluda, Diane Resek, Jean Stenmark, Mark Sytsma, Julian Weissglass, and Linda Witnov.

For the first edition, we printed drafts on LaserWriter Plus printers at the Lawrence Hall of Science (University of California at Berkeley) by special arrangement with the EQUALS program and with Mac's Headroom, a teaching lab there. All of the people associated with Lawrence Hall were extremely patient with us as long as we provided toner cartridges and free consulting. Mac’s Headroom was made possible by a grant from Apple Computer, Inc. We printed second-edition drafts and page proofs on an NEC SilentWriter from Frog’s Rentacomputer of Berkeley, California.

Our harshest and most valued criticism came from those closest to us—Meg Holmberg and Brigid McCaw. Not only did they mark up manuscripts; they also relieved us of baby-care duties before deadlines, brought sanity into our insane worlds, laughed at some of our jokes, dragged us away from our flickering screens for much-needed walks, and loved us even as we babbled about slivovitz and macaroons.
## CONTENTS AT A GLANCE

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>xxvi</td>
</tr>
<tr>
<td>1 How to Use This Book</td>
<td>3</td>
</tr>
<tr>
<td>2 Desktop Publishing in Perspective</td>
<td>13</td>
</tr>
<tr>
<td>3 Elements of Design</td>
<td>23</td>
</tr>
<tr>
<td>4 Bulleted Lists and Simple Scripts</td>
<td>45</td>
</tr>
<tr>
<td>5 Letters</td>
<td>67</td>
</tr>
<tr>
<td>6 Event Programs</td>
<td>95</td>
</tr>
<tr>
<td>7 Résumés</td>
<td>127</td>
</tr>
<tr>
<td>8 Fliers</td>
<td>161</td>
</tr>
<tr>
<td>9 Brochures</td>
<td>191</td>
</tr>
<tr>
<td>10 Forms</td>
<td>221</td>
</tr>
<tr>
<td>11 Proposals</td>
<td>251</td>
</tr>
<tr>
<td>12 Simple Books</td>
<td>283</td>
</tr>
<tr>
<td>13 Scholarly Articles</td>
<td>309</td>
</tr>
<tr>
<td>14 Manuals</td>
<td>337</td>
</tr>
<tr>
<td>15 Letterheads</td>
<td>375</td>
</tr>
<tr>
<td>16 Annual Reports</td>
<td>401</td>
</tr>
<tr>
<td>17 Newsletters</td>
<td>429</td>
</tr>
<tr>
<td>18 Large Projects</td>
<td>449</td>
</tr>
<tr>
<td>A What You Need to Use This Book</td>
<td>477</td>
</tr>
<tr>
<td>B Basic Word Skills</td>
<td>481</td>
</tr>
<tr>
<td>C What Word Can and Cannot Do</td>
<td>491</td>
</tr>
<tr>
<td>D A Sampling of the Adobe Type Library</td>
<td>495</td>
</tr>
<tr>
<td>E About Font Sizes</td>
<td>507</td>
</tr>
<tr>
<td>F What’s New in Version 4</td>
<td>513</td>
</tr>
<tr>
<td>G Bibliography</td>
<td>519</td>
</tr>
<tr>
<td>Index</td>
<td>523</td>
</tr>
</tbody>
</table>
# Table of Contents

## Introduction

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>xxvi</td>
</tr>
</tbody>
</table>

## 1 How to Use This Book

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learning to Do Desktop Publishing on the Macintosh</td>
<td>4</td>
</tr>
<tr>
<td>Where This Book Fits In</td>
<td>4</td>
</tr>
<tr>
<td>What We Assume You Know</td>
<td>4</td>
</tr>
<tr>
<td>If You Have Never Used a Word Processor Before</td>
<td>5</td>
</tr>
<tr>
<td>If You Have Never Used Word Before</td>
<td>5</td>
</tr>
<tr>
<td>What If You Know a Lot More?</td>
<td>5</td>
</tr>
<tr>
<td>How This Book Is Organized</td>
<td>5</td>
</tr>
<tr>
<td>Ways to Read</td>
<td>6</td>
</tr>
<tr>
<td>Reading Cover to Cover</td>
<td>6</td>
</tr>
<tr>
<td>Using Specific Recipes</td>
<td>6</td>
</tr>
<tr>
<td>Learning Specific Desktop Publishing Techniques</td>
<td>7</td>
</tr>
<tr>
<td>What You Will Find in Every Chapter</td>
<td>7</td>
</tr>
<tr>
<td>Example Documents</td>
<td>7</td>
</tr>
<tr>
<td>Typography</td>
<td>8</td>
</tr>
<tr>
<td>Summaries of Important Points</td>
<td>9</td>
</tr>
<tr>
<td>Keyboard Commands</td>
<td>9</td>
</tr>
<tr>
<td>Customization</td>
<td>9</td>
</tr>
<tr>
<td>From the Mac Screen</td>
<td>10</td>
</tr>
<tr>
<td>Step-by-Step Procedures</td>
<td>10</td>
</tr>
<tr>
<td>Gotchas</td>
<td>10</td>
</tr>
</tbody>
</table>

## 2 Desktop Publishing in Perspective

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converging Technologies</td>
<td>14</td>
</tr>
<tr>
<td>Controlling the Look of the Page</td>
<td>14</td>
</tr>
<tr>
<td>WYSIWYG and the Macintosh Interface</td>
<td>15</td>
</tr>
<tr>
<td>Printers</td>
<td>16</td>
</tr>
</tbody>
</table>
Example: Bulleted Lists 52
Changing the Bulleted List 53
The Space Before Icon 54
Nested Bulleted Lists 57
How Paragraph Marks Can Cause Trouble 57
The Remedy for Many Gotchas—Undo 60
Using Dingbats as Bullets 60
Bulleted Lists as a Design Element 63
A Simple Script 63
For More on Various Topics 64

5 Letters 67

Reasons to “Publish” Letters 68
Designing the Letter 68
The Look of a Letter 68
How to Define the Return Address Style 69
Spacing Above and Below Paragraphs 71
How to Define the Date Style 72
Changing Back to Normal 74
The Normal Style and the Inheritance Chain 75
Defining the Inside Address Style 76
A Standard for Describing Styles 77
The Remaining Styles 77
Instant Thumbnail—Print Preview 78
The Chosen Printer Affects Print Preview 80
The Print Preview Tools 81
Changing Your Mind and Playing with Styles 81
Design Aspects of Different Fonts 82
One Way to Change the Normal Font 84
Justification and First Line Indentation: Changing the Body Style 86
An Exercise 86
The Letter as a Template 87
Installing the Template on the Work Menu 89
What If the Letter Is Already Written? 90
Another Way to Apply a Style 91
For More on Various Topics 92
Event Programs

The Overall Plan 96
Creating the Thumbnail 96
New Techniques 97
   Paper Orientation 98
   Margins 98
   Formatting Columns in the Section Dialog 99
   Tab Settings 101
   Tab Leaders 103
Defining the Styles 104
   The Music Style: When It’s Already Formatted 105
   The Title Style: Formatting in the Dialog Box 105
   The Other Styles 107
Typing In Text and Setting the Styles 109
Fixing the Page Layout 111
   Horizontal Positioning of Paragraphs 111
   Vertical Positioning of Paragraphs 114
   The Return of WYSIWYG: Page View and Column Breaks 115
Design Issues 118
   The Relative Importance of Different Elements 118
   Balance 118
   The Problem of Unbalanced Vertical Space 119
   Balanced but Boring 122
Customization Corner 122
For More on Various Topics 123

Résumés

The Importance of Design in a Résumé 128
   Form and Function 128
Outlining and Page Layout 128
   Using Outline View 129
   Setting the Outline Levels 129
   Controlling the Hierarchy 131
Back to the Résumé 132
Heading 3: Responsibilities and Contributions 132
Typing Body Text in Outline Mode 133
Back in Galley View 134
About Levels and Automatic Styles 135
Defining the Body-Text Style 136
Using Next Style for Convenience 136
The Address and Title 138
A Typewriter Page Layout 138
The Résumé in a Table 141
Side Headings with a Table 142
Table Practice 144
Adding New Rows to a Table 145
Table Cells and Paragraph Formatting 146
Tabular Résumé 147
Independence of Column Width 148
Styles Inside Cells 149
Moving Paragraphs in a Table 150
Filling in the Rest of the Table 151
Finishing with Styles 153
Style Redefinitions 153
Two Kinds of Paras 154
Three Columns, Anyone? 155
Adding a Column to a Table 155
For More on Various Topics 158

8 Fliers 161

Basic Graphic Techniques 162
Pasting Graphics 162
A Graphic Is Like a Character 163
Character Formats Applied to Graphics 165
Subscripting Graphics: Controlling Vertical Position 166
Changing the Frame 166
Reserving Space for Artwork 167
Stretching and Shrinking 168
Sources of Graphics

Picture Fonts 170
Paint Art—Working with Bit Maps 171
Higher Resolution through Reduction 173
Draw Art—More Flexibility, Better Resolution 173
Other Sources 175
Word as an Inexpensive Scrapbook 176

Placing Paragraphs on the Page 176
Preparing the Flier 177
Positioning a Graphic—an Example 178
Repositioning a Positioned Paragraph 181
Adding More Graphics 182
Notes on Completing the Flier 184
Customization Corner 186
For More on Various Topics 187

9 Brochures 191

An Overview of the Project 192
Planning the Two Sides 192
Choosing a Font 193
Special Problems with the Inside 193
Special Problems with the Outside 194
Doing the Inside 194
Setting Up 195
Changing the Number of Columns 196
Making the Headline 200
Paragraph Borders: Fancy Lines and Boxes 204
Typing In the Text 207
Styles and the *-A Shortcut for Formatting 208
Preparing for the President's Picture 210
Getting the Bottom to Line Up 212
Aligning Space after the Headline 214
Full Justification and Manual Hyphenation 215
Customization Corner 217
For More on Various Topics 218
10 Forms

Thinking about Forms 222
Thumbnail Planning 222
Four Ways to Make Columns 223
  Tab Settings 224
  Hanging Indents 224
  Using Columns in Section Format 225
  Table Formatting 225
The Table Section of the Invoice 226
  The Main Grid 227
  Column Widths and Tab Settings 229
  Overview of Table Commands 231
  The Table Header 232
The Bottom Section 234
  The Thank You and Send Address 236
  A Table under the Total Column 236
  The Amount Due 239
  Adding a New, Blank Row 239
The Top of the Invoice—Tricks with Tables 240
  Logo and Title 240
  Customer and Order Information 242
Filling In the Table 244
  Practicing with Word’s Calculator 245
  Calculations in the Invoice’s Table 246
Customization Corner 246
For More on Various Topics 248

11 Proposals

General Design Considerations 252
  Thinking about the Reader 252
Writing as a Cooperative Endeavor 252
  Writing within a Preliminary Design 253
Commenting with Hidden Text 253
Laying Out the Sections 255
Paper and Fonts 256
The Cover—the First Section 256
The Abstract 258
The Background Section 262
The Plan Section 268
The Budget Section—Pasting, Editing, and Updating Links 269
Detailed Formatting 271
Changing Underlining to Italics 271
About Page-Break Problems 272
Making a Table of Contents 276
Placing Page Numbers 276
Creating the Table Itself 277
Editing the Table of Contents 278
For More on Various Topics 279

12 Simple Books 283

An Overview of the Project 284
Facing Pages: Theory and Tradition 284
Preparing the Manuscript 286
Setting Up the Pages 287
Headers and No Footers 290
Header Formatting Considerations 292
Creating Styles for the Headers 293
Viewing and Editing the Finished Headers 294
Making the Chapter Title Page Special 294
The Chapter Title 294
A Drop Cap 297
Automatic Hyphenation 299
Dealing with Long Documents 301
Making Styles Consistent among Many Files 301
Numbering Pages in Many Files 302
File Sequences 303
Making a Table of Contents 303
For More on Various Topics 306
13 Scholarly Articles

The Problem 310
The Style Sheet 310
Comments on the Article’s Design 311
The Plan 311
Setting Pages and Styles 313
Sections and Columns 314
Title Section Styles 315
Body Section Styles 316
Typesetting Mathematical Formulas 319
A Fraction Example 319
A Brackets Example 320
Miscellaneous Examples of Formulas 321
Footnotes 321
Entering a Footnote 323
Adding and Deleting Footnotes 325
The Footnote Text and Footnote Reference Styles 325
Footers 326
Preparing for Printing 327
Checking Spelling and Final Proofreading 327
Checking the Design 331
Page- and Column-Break Problems 331
Vertical Justification and the Last Page 332
The Article as a Template 333
For More on Various Topics 334

14 Manuals 337

Introduction 338
The Design 338
Special Techniques for Writing Mac Manuals 338
Macintosh Screen Shots 339
The Clover Character 340
Advanced Outlining 341
Controlling What You See in the Outline 343
Printing the Outline 347
Returning to the Editing Window 347
Moving Sections Around 348
Formatting Headings 350
Thinking about the Two Columns 350
Negative Indents and the Main Headings 351
Lesser Headings as Positioned Objects 352
Numbering Paragraphs 353
Creating a Table of Contents 359
Creating an Index 362
Using the Insert Index Entry Command 362
Formatting Subentries 363
Different Index Formats 363
Indexing Conventions 364
More Indexing Features and More Examples 365
Tips—and What to Watch Out For 368
The Styles in MacCello™ 369
For More on Various Topics 371

15 Letterheads 375

The Plan 376
Setting Up 376
Simple Techniques 376
Words across the Top 376
White-on-Black with Positioning 377
White on Black with Formulas 381
Text Down the Left Margin 381
The Company Name 382
The Officers’ Names 384
Another Way to Make Long Headers 386
PostScript Effects
  What Is PostScript? 386
  Word's PostScript Conventions 387
  Gray Text 388
  Confidential 394
  Framing the Page with PostScript 395
For More on Various Topics 398

16 Annual Reports 401

The Project 402
  Design Considerations 402
  Beginning the Project 402
  Page Setup for the Report 403
  Styles for the Report 404
Placing the Text 406
The Major Headings 409
  What Do I Do with the Existing Headings? 410
  Splitting the Document into Sections 411
A PostScript Header 413
  Making a Gray Bar 414
  Adding a White Page Number 415
  Adding the Name of the Section 417
  The Odd Header 417
Finishing Touches 418
  Smart Quotes 418
  Ligatures 419
  Em and En Dashes 420
  Fractional Widths 420
  The Table of Contents 422
  A Trip to the Print Shop 422
For More on Various Topics 425
Newsletters

The Page Design
- Easy and Difficult Newsletter Layouts in Word
- Using Sections in This Newsletter
The Masthead in PostScript
- Defaults: Redefining the PostScript Style Again
- Clipping and PostScript
- The Right-Hand Side
The Questionnaire
Special Techniques
- Pull Quotes and Oxford Rules
- A Style Chain
- Illustration Screens
- The PostScript Glossary
For More on Various Topics

Large Projects

Designing for a Large Project
- Designing Early
- The Gutter Bug
- Squashing the Gutter Bug
- Mirrored Margins
- The Beauty of Styles
- An Example—Bulleted Lists and How-To Lists
Keeping Flexible
- The Master Template
- Organizing Large Style Sheets
- Document Setup with Macros
- The Master Glossary
- Section Marks in the Master Glossary
- Why Changing Margins Can Be a Big Deal
- Character Styles
Two Formatting Issues 464
  A Family of Styles for How-To Lists 464
  Planning for Page Breaks 465
Production Notes 466
  Small Pages on Large Paper—Registration Marks 466
  Making Registration Marks in PostScript 467
  Bleeding to the Edge 467
  Producing Camera-Ready Copy 469
The Table of Contents and the Index 469
  A Linked Chain of Files 469
  The Table of Contents and the Figure List 469
  The Index 470
    An Indexing Checklist 471
Changing Character Formatting with RTF Files 471
Customization Corner 473
For More on Various Topics 473

A What You Need to Use This Book 477

  The Macintosh 478
  Keyboards 478
  Printers 478
  System Software 479
  Word 479
  Graphics Software 480
  Paperware 480

B Basic Word Skills 481

  Basic Macintosh Skills 482
    Click, Double-Click, and Drag 482
    Documents and Applications 482
    Launching Word 483
Selecting from Menus  484
Using the Open and Save Dialog Boxes  484
Scrolling  486
Basic Editing  486
Selection  487
Cut, Copy, and Paste  489
Imposing Character Formats  490
On the Fly  490
After the Fact  490
Getting Help  490

<table>
<thead>
<tr>
<th>C</th>
<th>What Word Can and Cannot Do  491</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Can</td>
<td>492</td>
</tr>
<tr>
<td>Word Cannot</td>
<td>493</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th>A Sampling of the Adobe Type Library  495</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>About Font Sizes  507</td>
</tr>
<tr>
<td>The Truth about Points and Picas</td>
<td>508</td>
</tr>
<tr>
<td>The Size of Letters</td>
<td>508</td>
</tr>
<tr>
<td>Leading</td>
<td>509</td>
</tr>
<tr>
<td>Typewriter Terms—Pica, Elite, and Pitch</td>
<td>509</td>
</tr>
<tr>
<td>What Happens with Font Substitution</td>
<td>509</td>
</tr>
<tr>
<td>Why Font Substitution Looks Strange</td>
<td>510</td>
</tr>
<tr>
<td>Real Italics and Real Bold</td>
<td>511</td>
</tr>
</tbody>
</table>
### What's New in Version 4

- Customization 514
- Styles on the Ruler 515
- Tables 516
- Positioned Objects 517

### Bibliography

- Design and Desktop Publishing 520
- PostScript 521
- Writing 522

### Index 523
INTRODUCTION

Until recently, when we wanted to write something, we pounded out double-spaced drafts on typewriters or scribbled on yellow pads. Manuscripts were messy, and editing might mean a lot of work with blue pencil, scissors, and tape. Publishing was a distant pinnacle, involving typesetting, galleys, paste-up, and finally a print run. For most things we wrote, it wasn’t worth the trouble.

All that has changed.

This is a book about desktop publishing. Desktop publishing makes it possible to use a personal computer to create documents that look professionally designed and typeset, so that the words are beautiful on the page and genuinely easier to read—and therefore more likely to be read at all.

This is also a book about using Microsoft Word on the Macintosh. Though billed as a word processor, Word can accomplish most desktop publishing tasks, in some cases more easily than with “page-layout” software. This book will show you how to take full advantage of many of Word’s capabilities, taking you from the basics of word processing to the design and layout of complex documents such as reports, newsletters, and books.

Strangely, this book is about itself. We created the book you hold in your hand using Microsoft Word on the Macintosh; only when we sent the book to the printer did it leave the new world of desktop publishing and rejoin traditional book production.

Stranger still, this book contains a story about Delilah Stone. Delilah works as a desktop publisher for a firm in Emeryville, California. You’ll read a part of her story at the beginning of every chapter. We’ll use her story to remind us of our typewritten heritage and to connect the various documents we’ll help you create.

Enjoy!
I was laying out the program for the stock-offering gala Saturday night. The Macintosh on my desk commanded my complete attention until I sensed something behind me. When I turned, I saw the Black Currant Calistoga hidden under his coat. “All this can be yours, sweetheart,” he said, “if you’ll help me find that newsletter article about the amoeba races at Genetically Altered Protists.”


“Mr. Hines is in a meeting, Delilah. Can I take a message?”

“Tell Chuck that if he doesn’t get me a description of his string quartet by five, I’ll make something up.”

I hung up and took a long pull on the soda. I like my job: Publications Manager for Immaculate Assessment, Inc., rising star of the unobtrusive measures industry. A big step up from driving a mouse for the Emeryville Police—and from that empty year of all-too-private investigation.

It was a frenzied Friday afternoon at IA. The gala tomorrow night, more projects than ever. A converted warehouse, a maze of partitions, network cabling like capillaries, a Macintosh on every desk, and people—dedicated, devoted, engaged, and successful. An atmosphere of respect and informality. I was wearing jeans and a shirt; my down vest took care of the morning fog. The business types wore suits, of course. Morton Delgado was one of the more pleasant.

“May I take one?” He was standing at my file with the folder of reprints.

“How many are there?”

“Four. Now three.”

“Go. You ever take one of the last two, I break your legs. And thanks for the Calistoga.”
HOW TO USE THIS BOOK

Give us a moment to explain the underlying philosophy of this book, why we wrote it, and why you may want to read it. After that we’ll outline the basic organization of chapters and what assumptions we make about what you already know. We also have a bit to say about the various graphic and typographic conventions used in this book.
Learning to Do Desktop Publishing on the Macintosh

While the Macintosh is the easiest-to-use computer ever invented, you still have to learn how to use it. Some of what you need to learn has to do with the Mac's metaphor—its windows, icons, pointers, menus, and so on. To do desktop publishing on the Mac you also have to become proficient with software such as graphics programs, word processors, and page-layout programs. Finally, desktop publishing has its own set of concepts and terminology about such things as typography, symmetry and asymmetry on the page, and templates.

Though the best way to learn such things varies from person to person, it certainly involves a combination of consultation with a knowledgeable person and working through written tutorials at the computer with reference manuals close at hand.

Where This Book Fits In

We have tried to put an expert, private tutor into this book. Sometimes we'll take you step-by-step through desktop publishing projects. Other times we'll step back and talk to you about some underlying principles of computer use or page layout. We'll use our experiences in helping people learn to use Word to focus on traps you are likely to fall into.

What We Assume You Know

Just as desktop publishing builds on developments in microcomputing over the last decade, this book builds on the word processing skills and knowledge about using computers that we assume you have.

We assume you are reasonably familiar with the Mac's interface—using the mouse, the menus and their key equivalents, scrolling, and starting applications. We assume you know how to put files into folders and how to find them and get them out.

Second, we assume that you have some familiarity with word processing on the Macintosh—that you can type in text, select text, and use the Cut, Paste, Find, and Change commands. You should already know how to print your work and how to open and save files. We
assume you understand that it is important to back up your work frequently.

You will find a complete list of the skills we expect you to have in Appendix B.

*If You Have Never Used a Word Processor Before*

You’ve got some exciting times ahead. Along with this book, you’ll need some additional help. A knowledgeable friend or officemate will do. In lieu of such a person, work through the first few chapters of *Learning Microsoft Word*, the thin volume (not the reference manual) that came with your copy of Word. Then read this book from the beginning.

*If You Have Never Used Word Before*

You are familiar with word processing but not Word? If you’ve come from any other word processing program on the Macintosh, such as MacWrite, just dive into this book. You already know the basics, and we’ll take you from there.

If your previous word processing experience was on another computer, you probably have to learn about using the Mac. Go through the introductory materials that come with the Mac; then dive into this book.

*What If You Know a Lot More?*

It depends on what you already know. If it’s Word that you know a lot about and you want to learn about design techniques, read Chapter 3 and select later chapters that particularly interest you. If you’re interested in differences between Version 3 and Version 4, Appendix F is especially for you. If you’re a designer and you’re interested in using Word for page layout, look in the table of contents to find a chapter that introduces Word techniques that are new to you and start there.

*How This Book Is Organized*

Chapters 2 and 3 are not specific to Word but provide you with an overview of desktop publishing and introduce the basic concepts of page design. Starting with Chapter 4, we leave generality behind and enter the “recipes” section. There, we concentrate on 15 documents that
represent common desktop publishing projects that are arranged from simple to complex. Each chapter fulfills two purposes:

- It gives you a workable template for a document that you can easily modify to suit your own needs and taste.
- It introduces a number of new page-layout concepts and techniques for specific kinds of formatting in Word.

You will find some useful appendices in the last section. If you are not sure whether you have enough word processing skills to use this book, check out Appendix B.

**Ways to Read**

You don't **have** to be sitting in front of a Macintosh to read this book—the figures, especially the screen shots, do a good job of showing what you would see on the screen. On the other hand, we think you'll have more fun and learn more (and more quickly) if a Mac running Word is within arm's reach.

We have anticipated three significantly different ways to read this book. Choose your poison.

**Reading Cover to Cover**

We don't expect everyone to want to read everything in this book, but we hope at least a few of you will. The chapters build on each other with a minimum of redundancy, and useful tips and techniques are embedded throughout. By the time you finish, you'll be an expert. Go to it. (Maybe you'll figure out who murdered Victor Markovsky.)

**Using Specific Recipes**

Perhaps there is a certain document that you need to create, a proposal or a newsletter, for example. Great. Go directly to that chapter.

Just be aware that a recipe will often depend on techniques learned in previous chapters. We don't tell you how to do everything from scratch each time but instead refer you to the place where we introduced the technique. So if you're new to this business, maybe you should start with the earlier chapters.
Remember that a design that looks good to us may not look good to you. We want you to get good enough to modify anything we suggest here to fit your own needs and taste.

**Learning Specific Desktop Publishing Techniques**

Let's say you want to learn how to put an illustration next to some text as we've put the illustration at left next to this text. There is no chapter devoted to doing this. What are some strategies for finding what you need to know?

- If you know what to call the thing you want to do, use the index.
- If you don't know what to look for in the index, the table of contents may help. There you'll find each type of document and a list of techniques that are used to create it. By browsing you may encounter words that suggest just what you want to do.
- On the page facing each chapter title you will find a reduced version of the document to be produced. By examining this document, you can probably tell whether the technique you want to learn is covered there.
- Sometimes the thing you want to do will require combining techniques that we cover in more than one place in this book. At the end of each chapter there is a section entitled "For More on Various Topics," in which we tell you where to find related information.

**What You Will Find in Every Chapter**

There are certain typographical and graphic devices you'll see throughout the book.

**Example Documents**

You'll find the reduced versions of the example documents helpful in orienting you to what is going on in that chapter (see Figure 1.1). They show you what you will produce in the chapter if you work through the step-by-step instructions.
Résumé of Victor Markovsky

Employment Objective
Tax Manager, Supervisor, or Director for financial, service, or industrial corporation

Education
Graduate work in accounting at San Francisco State University
B.S., Rutgers University

Personal Data
Age 31, divorced, excellent health

Experience
Responsibilities
Maintain accounts, supervise clerks and bookkeepers, upgrade to Macintosh-compatible software. Write budget portions of proposals and balance sheets for final reports.
Contributions
Worked with auditors in preparation for public offering of stock. By changing accounting software, saved $30,000 per year.

1983-1987: Assistant Accountant, Jenco Photographic Supply
Responsibilities
At this $50,000-per-day mail-order company, handled daily transaction sheets, supervised three clerks, helped introduce computerized bookkeeping practices, trained entire staff in new system.
Contributions
Streamlined accounting process, eliminating need for one clerk position. Devised method to partially automate tax preparation.

1981-1983: Bookkeeper, Brightway Camera Shop
Responsibilities
While at graduate school managed the books for this large store.
Contributions
Advised management on techniques for automating the sales receipts and inventory recording processes. Kept store from attempting to computerize its books with inadequate hardware and software.

Other Interests
Desktop publishing on the Macintosh computer
Photography, including color darkroom work
Bicycle racing

References
On request

Figure 1.1: The example document from Chapter 7

Typography
We use a different font, Bold Helvetica Narrow, to differentiate Word’s various features from normal text. This, for example, is how we would tell you to select the Copy command in the Edit menu. Titles of Word’s dialog boxes, such as the Character dialog box, appear in this font.
Starting in Chapter 5, we’ll also use this font to refer to styles, such as *Normal* and *inside address*, as well as numerous other things that appear in the fields of dialog boxes.

**Summaries of Important Points**

---

**Important Ideas**

When we encounter an important idea about design or about how to use Word effectively, we often restate the idea in text like this in a way that is independent of the example being discussed.

If part of the idea has to do with some habit you should develop, we indicate that with the ✍ icon.

---

**Keyboard Commands**

When you start learning new commands, you’ll probably want to select them by name from menus. But once you master new commands, you’ll probably want to use keyboard shortcuts for the ones you use often. Word gives you a dizzyingly complete set of keyboard shortcuts, and we will mention Word’s default shortcuts for most commands as they come up in this book; for example, we will inform you that the default keyboard shortcut for the *Show Ruler* command in Word’s *Format* menu is ⌘-R.

**Customization**

If you don’t like the shortcuts that Word provides, you can hammer together new ones. Perhaps you have been using a word processor that has different keyboard commands and would like to continue with those, or perhaps Word does not provide a keyboard shortcut for a particular command that you use a lot. Word makes it easy to add, delete, or change commands. You can even have one set of commands that you use for one kind of task, such as page layout, and another set of commands that you use for ordinary word processing.
In addition to keyboard shortcuts, you can customize Word’s menus, deleting items that you rarely use and adding those that you use frequently. Commands that you add to menus, with or without associated keyboard shortcuts, can save you tedious steps through dialog boxes.

In this book, we show you how you can customize Word in ways that we have found helpful for desktop publishing tasks. At the end of some chapters, we have included a "Customization Corner" with relevant suggestions for customizing your copy of Word.

From the Mac Screen

Frequent screen shots show you what you should be seeing on your Mac. Usually we show only the portion of interest, not the entire screen. Word uses many dialog boxes such as the one at left; some can be quite intimidating the first time you see them. We don’t try to explain what you can do with a particular dialog box all at once. Instead we focus on one specific capability of the box.

Step-by-Step Procedures

Often we take you through a sequence of steps. We distinguish these steps from other text, so that you will know when we expect you to be doing something with the computer. For example, here are the steps for opening up Word.

1. Start up Word by double-clicking on its icon in the Finder.
2. When the Untitled1 window appears, type a sentence, noting how the words wrap when they reach the end of the line.

Sometimes, in the midst of some step-by-step instructions, we use text like this to explain something about what is going on. For example, we might want to explain how optional hyphens can change the way words wrap.

Gotchas

Now Why Did This Happen? In all work with computers, mysterious things happen, things that are the results of misunderstandings of how programs work. We call these mysterious events gotchas, and we signify the fact that we’re going to explain one with the gotcha graphic.
At 2:25 by my menu bar, Clara McConnell walked in looking like Death warming up. From her red hair to her Reeboks she was a seething pantomime of fury and aggravation. Eyebrows raised, I pointed my thumb over my shoulder. She nodded. Victor’s cubicle was just on the other side of the partition in Accounting.

The Surly Serb had never been my idea of a good match for her. She finally spoke, a spitting whisper. “I know something’s wrong, and he won’t tell me what.” This woman has a Ph.D. in psychology? He had been cranky all week. Everyone was steering clear.

I whispered back. “Maybe with all this talk of going public he’s getting ideas about you two.”

Clara blushed. And at her age. “Delilah! Not yet.”

“Bigshot VP of Projects sleeps with lowly accountant. Just in time for the July issue of the Unobtrusive News.” She cringed. I grabbed my mouse. “Let me open up a new file.”

“Oh, be nice. If you weren’t my friend...”

“And confidante,” I added. A phone rang. We froze. It was for Victor. Through the wall in his office--

“Markovsky,” he barked. We held our breaths. “Al, you have no idea what I’m going through right now. Why are you tormenting me? No, I can’t meet today. What about Monday? You can’t be serious!” He checked his rising voice. We strained to hear. “All right. Okay. I’ll be there by four, is that soon enough? Three then.” He hung up.

We heard him punch another line. “Adam. Victor. Get me a cab, I have to go out. No, my car is not here today, just get me a cab.” Punch. Punch. “Mrs. Ford, this is Victor Markovsky. I’m going out now, but I want to assure Dr. Brockmyer that I will be at his house at eight tonight. Thank you.” Clara and I raised eyebrows at one another. Victor seeing Emil Himself, Founder and President.

A moment later, Victor stood in my doorway with his briefcase, looking at the two of us. Six eyes held a conversation. Finally, he spoke aloud to Clara. “I have to go out. I’ll see you after dinner.” Then he was gone.
DESKTOP PUBLISHING IN PERSPECTIVE

Palo Alto, California, 1978. At a secretary’s workstation in the Palo Alto Research Center of Xerox Corporation, an IBM Selectric lay covered and gathering dust. Resting on the cover was a laser-printed sign, “This machine is now obsolete.” Back then it seemed incredible that the typewriter, with all its peculiar and lovable idiosyncrasies, could become outmoded. Today the same forces that vanquished the typewriter have gone on to threaten an equally venerable institution—typesetting. Ordinary mortals have machines on their desks that make it possible for them to design and produce documents such as brochures, fliers, articles, books, and newsletters, and these printed products are rapidly becoming indistinguishable from the output of vastly more costly equipment. This is desktop publishing.
Converging Technologies

There was a time when the best print you could afford to produce at home came out of your typewriter. It looked like the document opposite the title page of this chapter. In order to get the attractiveness and readability of a book or magazine, you had to use a typesetter and layout artist. The desktop publishing revolution has changed all that. Suddenly you can produce something that looks "like a book" immediately, from the comfort of your own chair.

Desktop publishing results from the confluence of several different technologies. Inexpensive and powerful computers such as the Macintosh, elegant software, storage devices such as hard disks, high-resolution graphic displays, and printers have all contributed. The distinction between typesetting and word processing has blurred as word processors have become able to accomplish typesetting tasks. Microcomputer users are doing more and more of what was formerly done manually by pasteup artists.

The first word processors let us experiment freely with words, and as word processing software has evolved, it has provided increasing control over the look of printed words as well.

Printers also govern the appearance of your page, of course. Letter-quality printers do an excellent job of reproducing the typewriter look, but they can't go any further. Dot-matrix printers provided a proving ground for building an image from hundreds of thousands of tiny dots. Laser printers have increased the number of dots on a page as much as a thousandfold, so that the dots flow together to produce letters and drawings indistinguishable from those of the phototypesetters.

Controlling the Look of the Page

Many subtle visual elements, aside from the words, determine the impact of a printed page on the reader's mind. Consider the look of the individual letters.

The way individual letters look is determined by their *typeface* and their size. When we read, we perceive the shapes of words, phrases, and even whole sentences rather than individual letters. Letters in typeset text fit together more tightly and flow more harmoniously from one to another than they do with typewriter text. This makes typeset text much easier to read than typewriter text.
Big computers have been driving typesetters since before the inven­tion of the microcomputer. They use typesetting languages in which formatting commands are embedded in the text to tell the computer what to do. Figure 2.1 shows text embedded with some sample formatting commands, and Figure 2.2 shows the effects of the commands in Figure 2.1.

The commands enable the typesetter to produce the desired effect on paper without requiring that the computer display that effect on the screen. The first word processing programs for microcomputers used similar commands to control formatting.

```
.CP\S14
How to print great looking text\S10
.P
Each paragraph has to be preceded by a '.P' command. If you want
.I italics
or
.B boldface
you have to set off the affected words with special formatting commands.
```

Figure 2.1: Text with embedded formatting commands

```
How to print great looking text
Each paragraph has to be preceded by a '.P' command. If you want italics or boldface you have to set off the affected words with special formatting commands.
```

Figure 2.2: Output of Figure 2.1

**WYSIWYG and the Macintosh Interface**

In computer science research labs like those of Xerox, researchers began treating text on the screen as though it were a picture. They developed high-resolution screens to better display this picture/text, and they wrote software to allow easy alteration of the text's characteristics with graphic input devices, such as a mouse. The goal
was WYSIWYG (pronounced “wizzy-wig”), that is, what you see is what you get.

Xerox largely ignored the commercial implications of what these researchers were doing. Steve Jobs did not. After a visit to the Palo Alto labs, he took the ideas he saw on the screens and many of the Xerox researchers back to Apple to develop a new computer.

Thus the Macintosh was born, and along with it came the word processor MacWrite. MacWrite has no formatting commands that you type in. You select the text to be affected and either click on icons or select items from menus. Italics! Boldface! Large type! Centered paragraphs! All are produced with a click, and all appear on the screen almost exactly as they will be printed.

**Printers**

Printing posed a problem at first. Dot-matrix output from the ImageWriter looked good, but not typeset. The budding desktop publishing revolution required a reasonably priced, high-resolution printer that could handle both text and graphics. Laser printers, controlled by a sophisticated page-description language, PostScript, began to fill this need. Apple’s LaserWriter was the first such printer.

In a laser printer, a fine beam of laser light paints the page image on a rotating drum using tiny dots. The LaserWriter has a resolution of 300 dpi (dots per inch), which means the dots are so close together that the eye sees the jagged edges of the dots as smooth curves. The fine contours of the letters in set type are convincingly simulated on that 300 dpi grid. For nearly all desktop publishing tasks, this resolution is perfectly adequate.

Magazines and books are typeset at even higher resolutions, however, and the trained eye can tell the difference. When one of us first got access to a LaserWriter, he took a sample of its output to the woman who managed our glossy-publication department. She looked at it, frowned, and peered at it through a 10-power loupe eyepiece. “Not good enough,” she said.

When 300 dpi is not good enough for you, take your floppy disk to a typesetter (or even some local copy shops) who can print your document at higher resolutions (600 to 2500 dpi) on more expensive laser printers or on “imagesetters” such as the Linotronic 300.
Page-Layout Software

With MacWrite and the first version of Microsoft Word you can produce typeset quality pages, but you cannot adequately control the placement of text and graphics on the page. You cannot, for example, put text beside a graphic, print in multiple columns, or even adequately control where the next page begins. These programs obviously did not eliminate the need for manual pasteup.

Aldus Corporation, with its PageMaker program, changed that. With PageMaker, you can place text and graphics created in other programs wherever you want on the page in practically any format. With the advent of powerful, easy-to-use page-layout software, desktop publishing was born.

Why Use Word for Page Layout?

Starting with Version 3.0, Microsoft added significant desktop publishing capabilities to Word, and the boundary between word processing and page-layout software began to grow fuzzy. PageMaker and other layout programs let you edit your text as you do with a word processor, although not as efficiently as with Word. Conversely, Word lets you control the placement of text and graphics on the page. Though some layout tasks are more natural with PageMaker or its cousins, others, such as creating side headings or tables, are actually easier to master in Word.

Nearly all of what you can do with "true" page-layout software you can also do with Word. Word provides an excellent, less expensive starting place for learning and doing desktop publishing, especially if you are already using the program for word processing.

The Two-Edged Sword

On the other hand, enthusiasm for desktop publishing needs to be tempered with an understanding of its problems. Not every project is appropriate for it, not all tasks we undertake to do with it will prove worthwhile, and numerous traps await the unwary.
Cost Considerations

The first reason to go for desktop publishing is that it's cheaper, right? Not always. If you are publishing a book of fiction yourself, for example, it might be cheaper to send your regular word processed disks to a printing house than to take your time formatting and printing camera-ready copy.

If you have a project with lots of artwork or photos that won't be computerized, those graphics will have to be pasted in anyway. Depending on your time and talents, it might pay to have a pasteup artist lay out the whole project manually.

Any complex layout task will take a lot of time, and your time is valuable. That's another reason to hire someone to do it.

A computer won't make aesthetic decisions for you. If you're not artistic and the appearance of your pages will be important to the project, consider hiring an artist for the task.

The other side of all this is control. While the document is in your computer, you have complete control over what it looks like. If you want to change a sentence ten minutes before final printing, go ahead. While desktop publishing usually proves cheaper and faster than conventional typesetting, the added control may well be worth extra time and money.

The Diddling Factor

Once you have mastered the basics, desktop publishing becomes so much fun that many people find themselves spending unnecessary time playing with formatting at the expense of getting the job done. Will 12-point type look better than 10-point type? Let's try Palatino, and, while we're at it, let's see if things will look better in three columns instead of two. And on and on, in search of the perfect page.

If you are susceptible to this kind of diddling but can't afford it, you'll have to train yourself to keep the end in sight, know when the pages look good enough for their purpose—and stop.

Learning Time

One of the Mac's selling points is that it is easy to learn to use. This might lead you to expect that learning to do desktop publishing on a Mac won't take much effort. Wrong. The Macintosh is billed as easy to use because it is so much easier to use than other computers. For example, even a simple task like composing and printing a memo requires a
great deal more expertise on other machines than on a Mac. But desk­top publishing involves much more than simple tasks. The Macintosh interface makes learning to lay out a newsletter on the screen easier than it has ever been but not easy. Learning to do desktop publishing will take time and effort. Our aim in this book is to make the effort enjoyable and the time productive.

The Typewriter Mentality

Those who grew up with typewriters acquired some habits that make it harder for them to learn to do desktop publishing. Some examples are

- Pressing RETURN at the end of every line
- Using the SPACE bar to position text horizontally
- Using the TAB key to indent a paragraph
- Using the underscore ( ) character to make lines
- Emphasizing with underlines instead of italics

A typewriter mentality is behind these habits; we will show you ways to recognize and escape that mindset and learn the rich variety of alternatives Word offers.

Balance and the Two-Edged Sword

Desktop publishing may cause projects that would never have existed before to spring up. You will need to strike your own balance between exciting new tasks and constraints on your time, between desktop publishing’s power and judicious restraint, between diddling with the formatting and just getting the job done, and between the cost of projects and the advantages of total control.

Don’t Forget Content

Throughout this book we are concerned with appearances. Despite the way it may seem, no amount of formatting and glitz will make words better than they are. Organization, style, and good ideas are still what make writing work. The formatting you’ll be learning here can
help you get your words to your readers, but it will never help the words themselves. That's your responsibility.

Desktop publishing in particular and computers in general can actually get in the way of good writing. That the words look good does not mean that they are good. A rough draft that you create with Word is just as rough as the ones you used to scratch out on a yellow pad of paper even though it looks almost good enough to go out the door. Don't let it—your readers will not be deceived. In fact, as people become accustomed to laser-printed documents they won't be snowed by the looks and will spot errors and stylistic problems even more easily than before.

On the other hand, desktop publishing makes it easier for you to see how the meanings of your words will be affected by their appearance. If you are careful, you can use this effect to help you write better.

For More on Various Topics

Fonts—See Chapter 3.

Comparison of Word and page-layout software—See Appendix C.

High-resolution printers—For details on how to get things printed at 1200 and 2400 dpi, see Chapter 15.
Five after six on the last day of June and Immaculate Assessment was hopping. Public offering of stock within the week, end of the fiscal year at midnight, tomorrow’s gala bash. We had plenty of work and were all seeing dollar signs. Everyone had at least a few thousand shares we had been given for bonuses in lieu of cash, and now the pundits were predicting the stock would triple.

It was hard to keep my mind off what I would do with all my money, but I had work to do. The bash at the Magnifique needed a program, and I was laying it out on my Mac as best I could, scrounging for copy.

I had last Sunday’s Chronicle; I looked for a blurb on Turgid Sturgeon, the bahia nova group Himself’s son played in and the last event of the evening’s entertainment. Chuck Hines sent over some material on the string quartet.

The menu was still missing. It made me think how hungry I was. ESP must work: Clara puffed in under a load of pizza. About time.

“How long does it take to get pizza?” I asked—and then I smelled it. I was in heaven. “That is not Luigi’s.”

“No, Lilah, I went into Berkeley to the Big Z.”

“You’re a genius. They should give you a Ph.D. They should make you a vice president. They should make you rich.”

“Two out of three. I shouldn’t complain.”

“You’ve got stock. I say three weeks and you’re living in the hills.” Clara smiled, but I knew her too well. “What’s wrong?” I asked. Only then did I notice the briefcase—black Samsonite with a combination lock.

“Strangest thing,” she said, “it’s Victor’s. It was in my car.”

“He has a key? You drove in together today?” She nodded to both. “Not so strange,” I said. “When he left in such a rush, he didn’t need his briefcase. So he stashed it in your car when he went out to meet that cab.”

“Why wouldn’t he leave it here in his office?”

“Good question. I don’t know. But I guess he was expecting to get it from you tonight.”

“You’re right. Remind me to take it with me when I go, okay?”

I said I would, but I forgot. When she left for home at nine that night, it was still in my office under the pizza box. And I never got the menu.
ELEMENTS
OF DESIGN

You may not think of yourself as a designer when you sit down at your Macintosh to write a company newsletter, draft a sales invoice, or make a flier. But as you choose a font, decide whether to center or left justify the title, or place an illustration, you are doing design. Desktop publishing liberates the page designer in all of us, creating countless new opportunities to flood the world with ugly, garish, and awkward documents. With a few guidelines, however, we can avoid the most obvious errors and produce pages that are good to look at and easy to read. In this chapter we will give you only a taste of the issues in a field that you could immerse yourself in for a lifetime. Our goal is to open your eyes to the shapes of letters, the weight and placement of text, the patterns of dark and light on the page, and the symmetries, broken and unbroken, of a two-page spread.
Choosing Fonts: Size and Texture

Let's start with the shapes of the letters.
You're reading text set in a font called Palatino. You can make the same shape letter in different sizes; the sizes are measured in points, which are about 1/72 inch. This type is 10-point Palatino. Different fonts look different on the page. They create a different impression, and they are different in the way they take up space.

There are two broad categories of fonts: serif and sans serif. Serifs are the little feet that appear at the ends of strokes in some fonts. Fonts that have these feet, such as Palatino, are serif fonts. Those that don't have these feet, such as Helvetica, are called sans serif.

There are also two broad functions for type: body text, such as what you're reading, and display text, such as the heading at the top of this page. Let's look at body text and display text in different fonts.

Helvetica is the most common and enduring of all sans serif fonts:

Helvetica Bold

Helvetica is a noble font. It inspired the Macintosh screen font Geneva. Practically everyone who gets their hands on a LaserWriter writes in Helvetica exclusively for at least three weeks.

Times, named for the newspaper, is extremely efficient, packing lots of words into a small space:

Times Bold

Times is related to the Macintosh screen font New York. It's a real workhorse, extremely readable and compact. After you get over your infatuation with Helvetica, you will probably find yourself using Times more frequently.

In contrast, Avant Garde (on the next page) is a sans serif font with striking looks and a subtle problem. If you defocus your eyes a little and look at the three samples, you'll see that the Avant Garde sample has a mottled texture in comparison to the other two. Avant Garde is great as a display font—in a heading—but it is unnerving in a paragraph. Texture is an important consideration when you choose a font for body text.
Avant Garde

At first glance, you might confuse Avant Garde with Helvetica; not for long, though. The texture of this font is uneven. Narrow letters fall very close together, making dense spots, while wide letters are comparatively light. Consider "balloons."

Some books on design say that body text must be between 9 and 12 points. If your readers require large type, 14 point looks very good. Text smaller than 9 points is for warranties and disclaimers—it appears as fine print. This sample is 7-point Times:

The authors of this book will not be held liable for any inconsistencies that arise as a result of improvements made by Microsoft or by Apple Computer.

14 point is for easy reading. This font is New Century Schoolbook:

"Oh, good," cried Jane, "Here comes Spot!"
"Yes," Dick said, "Spot will play ball."

The best fonts for body text that come with the LaserWriter Plus are Times, Helvetica, Palatino, New Century Schoolbook, and Bookman. All but Helvetica are serif fonts.

You can use any font for a heading, as long as the font is compatible with the body text and the impression you want to get across. The same font as the body text always works.

Sans serif display fonts frequently look nice with serif body fonts. The converse is true less often. If you use two different serif fonts, be sure that you contrast them—through size or weight—so that the readers can tell you didn’t just mess up. See Figure 3.1.

Headings: Size, Weight, and Space

In general, we make the most important text larger and heavier and the explanations and fine print smaller and lighter. Heavy text needs more space, and hierarchical documents need headings of different importance. There are many different ways to help your readers understand your hierarchy and find their way.
This is a headline
whereas this is body text. The headline font
(New Century Schoolbook) is similar to the
body font (Times). Compare this:

This is also a headline
and this is its body text. Here, the headline in
Helvetica is different enough from the body text
in Times that no one would wonder, however
unconsciously, whether we made a mistake.

Figure 3.1: Use contrasting head and body fonts.

In Figure 3.2 we have used headings that are slightly larger than the
body text and numbered them to indicate the hierarchy. The heads look
like they're important, but the hierarchy gets lost in the numbers.
Suppose we use size and weight to indicate position in the
hierarchy, as shown in Figure 3.3. Now the hierarchy comes through,
but the big type is crowded by the body text.
In Figure 3.4 we've added 12 points of space before each heading.
We could also have added a (smaller) space after. See how much easier
it is to find the section you want? Nevertheless, there is still something

1. Pizza in America 1950-1999
We can't begin to understand America in the last half of the twentieth century without
understanding pizza; and we can't understand pizza without understanding the deepening
chasms that separate both pizza styles and pizzaphiles.

1.1. Emerging Stylistic Differences
Some linguists believe that these conflicts did not arise until there were widely-recognized
names for the styles. Witness the analogous problem over clam chowder, which comes in
two forms: virtuous (Boston) and heretical (Manhattan).

1.1.1. Traditional (Thin Crust) Pizza
For many years, many Americans believed this was the only kind of pizza. Even today, it
forms an acceptable substrate for melted cheese and cooked vegetables, and an excellent
companion for beer.

1.1.2. Chicago Style
The deep dish pizzas that escaped their urban origins in the seventies were led by the
Chicago style. Thick crust and extra green peppers helped us all escape ordering pizza
simply by specifying no anchovies.

Figure 3.2: The typography of these heads doesn't help to make the hierarchy clear.
blocky about this document. All of the sections look the same in spite of
the different-sized heads.

Indentation is a powerful visual organizer. In Figure 3.5 there’s no
question how the document is put together. We have gone beyond
changing the weight of text and adding space. Now we’re changing the
horizontal position of text as well.

Pizza in America 1950-1999
We can't begin to understand America in the last half of the twentieth century without
understanding pizza; and we can't understand pizza without understanding the deepening
chasms that separate both pizza styles and pizzaphiles.

Emerging Stylistic Differences
Some linguists believe that these conflicts did not arise until there were widely-recognized
names for the styles. Witness the analogous problem over clam chowder, which comes in
two forms: virtuous (Boston) and heretical (Manhattan).

Traditional (Thin Crust) Pizza
For many years, many Americans believed this was the only kind of pizza. Even today, it
forms an acceptable substrate for melted cheese and cooked vegetables, and an excellent
companion for beer.

Chicago Style
The deep dish pizzas that escaped their urban origins in the seventies were led by the
Chicago style. Thick crust and extra green peppers helped us all escape ordering pizza
simply by specifying no anchovies.

Figure 3.3: Here the size of the heads clarifies the hierarchy.

Pizza in America 1950-1999
We can't begin to understand America in the last half of the twentieth century without
understanding pizza; and we can't understand pizza without understanding the deepening
chasms that separate both pizza styles and pizzaphiles.

Emerging Stylistic Differences
Some linguists believe that these conflicts did not arise until there were widely-recognized
names for the styles. Witness the analogous problem over clam chowder, which comes in
two forms: virtuous (Boston) and heretical (Manhattan).

Traditional (Thin Crust) Pizza
For many years, many Americans believed this was the only kind of pizza. Even today, it
forms an acceptable substrate for melted cheese and cooked vegetables, and an excellent
companion for beer.

Chicago Style
The deep dish pizzas that escaped their urban origins in the seventies were led by the
Chicago style. Thick crust and extra green peppers helped us all escape ordering pizza
simply by specifying no anchovies.

Figure 3.4: Adding space makes it easier to read.
Pizza in America 1950-1999
We can't begin to understand America in the last half of the twentieth century without understanding pizza, and we can't understand pizza without understanding the deepening chasms that separate both pizza styles and pizzaphiles.

Emerging Stylistic Differences
Some linguists believe that these conflicts did not arise until there were widely-recognized names for the styles. Witness the analogous problem over clam chowder, which comes in two forms: virtuous (Boston) and heretical (Manhattan).

Traditional (Thin Crust) Pizza
For many years, many Americans believed this was the only kind of pizza. Even today, it forms an acceptable substrate for melted cheese and cooked vegetables, and an excellent companion for beer.

Chicago Style
The deep dish pizzas that escaped their urban origins in the seventies were led by the Chicago style. Thick crust and extra green peppers helped us all escape ordering pizza simply by specifying no anchovies.

Figure 3.5: Horizontal positioning further clarifies the hierarchy.

Font Proliferation
Word processing on the Macintosh invites us to play with fonts, but it's too easy to get carried away. How many of us have written a letter to a friend with a different font in every paragraph? We tire quickly of such hyperfontia, but it is easy enough to make other, less obvious, mistakes of font proliferation. Here are some examples.

In Figure 3.6 only one font family, Palatino, appears, so we cannot judge it as having too many fonts. Yet the internal goings on detract from our ability to concentrate on what it is saying; it looks busy.

Even though the letters are all Palatino, there are four different forms of the font—two in the headings and two in the body—too many in such a short space.

The use of italics seems gratuitous. While the writer may have been attempting to represent the rise and fall of speech, we do not all speak with the same patterns, and so the italics distract us further.

Figure 3.7 contains two completely different fonts (with the headlines in Helvetica). Yet, because there is only one form of each family, the sense of busyness has been replaced by a straightforward clarity.
English Versus American Mysteries

Such variation within a single genre makes you wish the book sellers would mark one section for the English mystery and another for the American.

An Island Mentality

The English love the small and ordinary. An English murder takes place in a garden or a country house; the murderer blends in with the common folk that make up the cast of characters; and the detectives (for there are often two) solve the mystery by use of their considerable intelligence.

Might Makes Right

Americans, in contrast, seem to thrive on a mixture of the bizarre and violent. The murder, described in gruesome detail, is perpetrated with axe or machine gun. The lone detective, a cowboy at heart, stands alone against the criminals, the police, and society as a whole to set things right with his hard-driving fists, his quickly-drawn pistol, and his sleek, fast car.

Figure 3.6: Too much variety, even within one font family, is distracting.

Whereas previously a different text style was used to distinguish the title from the subsidiary headings, moving the headings to align with the left margin and enlarging the title serves the same purpose here, without adding to the visual complexity.

With the italics gone, we can impose our own speech patterns on the text as we read. Italics should be reserved for emphasis that resolves ambiguity of meaning.

There are many ways to change the texture of the printed word, changing font families being just one. Always have a considered reason for changing that texture. When in doubt, err on the side of too few changes, trusting that the meaning of the words will come through better when not covered with visual glitter.
English Versus American Mysteries

Such variation within a single genre makes you wish the book sellers would mark one section for the English mystery and another for the American.

An Island Mentality

The English love the small and ordinary. An English murder takes place in a garden or a country house; the murderer blends in with the common folk that make up the cast of characters; and the detectives (for there are often two) solve the mystery by use of their considerable intelligence.

Might Makes Right

Americans, in contrast, seem to thrive on a mixture of the bizarre and violent. The murder, described in gruesome detail, is perpetrated with axe or machine gun. The lone detective, a cowboy at heart, stands alone against the criminals, the police, and society as a whole to set things right with his hard-driving fists, his quickly-drawn pistol, and his sleek, fast car.

Columns and Grids

If you stand fifteen feet away from a double-spaced, typewritten page, you see horizontal lines. Now split each line in half and slip it into the empty space. You’ve done two things to the eye: you’ve made a column and you’ve turned the lines into a gray texture.

Another way to look at this transformation is that we’ve taken all of the white space from between the lines and put it on the right.
What if we put twice as much text on the page? We have two choices: to single space the original copy or to put up another column.

The second alternative is a lot easier to read because of the length of its lines. In the left-hand example, the lines are too long in comparison to the space between them.

Long lines need space around them. Without that space, readers will skip lines or read the same line over. Researchers say that seven to ten words is a good length for a line—between 35 and 50 characters. Too few characters and lines get too ragged or sparse because of differing word lengths. There are exceptions: many book lines are a little longer; The New Yorker has very short lines.

These rules of thumb imply relationships among font size, column width, and how much text must fit into the space you assign to it.
In this way, your project helps drive your design. Do you need lots of text in a few pages? Better use several narrow columns and small type. Unless you’re writing a telephone book, however, you’re going to need more advice than that.

Many designers use grids when they design pages. A grid is a set of imaginary lines on the page that helps align text and graphics. The most important parts of the grid are the vertical column lines; they define the limits of text that appears in columns.

It makes sense to think about horizontal lines, too—lines that will help regulate the locations of headings, graphics, and blocks of text. If you think about and use your grid consistently, Word can give a well-designed, coherent appearance to your pages.

**White Space**

White space helps bring out the material it surrounds. It is easy on the eye and tells the reader that your work is for reading, not for reference. You don’t need to cram as much text as possible onto a page; you have chosen your words well and want to give them space to breathe.
There are three fundamental questions about white space: how much should you have, how do you get it, and where should it go?

Surprisingly, there's an easy rule of thumb for the first question. If you leave half of your page white, you’re doing fine. In the example at left, the page size is 8 1/2 by 11 inches. The active area—the area within the margins—is 6 by 7 1/2 inches. This means that 52 percent of the page is white. Novels use a larger fraction of the page: hardcovers typically leave about 40 percent white space, paperbacks 33 percent.

The usual situation is that you have too much material for your pages. Where do you get white space to help it breathe? Many of the following techniques involve recovering little bits of white space and consolidating them into useful blocks:

- You can edit the text to make it shorter.
- You can spread the document over more pages.
- You can hyphenate.
- You can reduce the point size of your text, taking care not to make it unreadable or to leave too many words in a line.
- You can shrink your graphics.
- You can choose a font that doesn’t take up as much space.
- You can reduce the spacing between your columns.
- You can eliminate unnecessary vertical space between paragraphs, indenting the paragraphs if they are block left.
- You can take space from between the lines as we did on the double-spaced page. Even if your text is not double spaced, you can reduce the leading.

Once you get white space, where should you put it?

The most obvious place is in the margins. Generous margins look good. The page at left illustrates another rule of thumb that some designers like: leave a wider bottom margin (2 inches in this case) than top (1 1/2 inches). If the margins are identical, the bottom one looks smaller.

But suppose you can’t afford big margins like that. Maybe that look isn’t what you want. Where do you put white space? There are no unalterable rules, but all other things being equal, consider these two guidelines:

- Put white space around important objects, such as headings and pictures. Many pictures look better if you reduce them and leave a white space around them.
• Put white space towards the top of the page. A white area near the top (but below the margin) will call attention to headings and pictures in the area and be more noticeable as white space.

Better
(White space is at the top and surrounds the heading.)

Not as good

Is there any place that white space is bad? Yes. Try to avoid a large white space at the bottom of a page. (The last page of a long section or document doesn't count.) It makes it look as if there were not enough copy to fill the space. It is better to put the space somewhere earlier and push the active material to the end. Similarly, if you must leave a column blank, make it an inside column (if you have facing pages) or a left column (if you do not).

Symmetry and Asymmetry

Symmetry gives a formal, reliable, and organized impression, while asymmetry is less formal and generally more interesting. Both require balance. While you can consider symmetry and asymmetry on single pages, it's easier to study the principles if we look at spreads, that is, two pages that face one another.

In the example at the top of the next page, the left spread is symmetrical, but too heavy in the middle. Each page also mixes two- and three-column grids, which is more complex than we need here. The layout on the right, while square and conservative, is pleasing—partly because the individual pages as well as the spread are symmetrical, but more because the white space has been consolidated at the top, where it looks best.
If there were a reason to keep the pictures in a line, as they are shown below—if they show a sequence of events, for example—you could keep them there. But the text should be balanced.

How can you balance asymmetry? To find out, let's look at two examples:

In the layout on the left, the left page is too heavy. The biggest picture and most of the text are there. In the layout on the right, some
text has been moved to the right page, but more important, the text has been moved down. Notice, for example, how the text on the left page of the left layout surrounds the picture. On the left page of the right layout, the picture is more important. How did that happen? Important elements need space around them; on the right, as the text moved down, white space moved from the bottom to the top of the page.

It's also true on the right that the middle picture and much of the text "hang" from an invisible grid line running across the page. This lends order and an appearance of planning to the spread. The result is an asymmetrical spread that still looks balanced.

What about single pages? Here are two examples. The first has columns of different widths: a narrow one for headings and a wide one for body text. The second is a business letter. Here, too, we have balanced asymmetry.

---

**Ruled Lines**

A ruled line can

- Separate one element on the page from the rest. The line at the top of the page in Figure 3.8 separates the book title in the running head from the page proper.

- Call attention to something, as the lines around the heading in Figure 3.8 emphasize the heading

- Divide the page or a portion of the page into two parts, one above and the other below, or one to the left and the other to the right (see Figure 3.8)
Crime in the Stock Market

Friends and Fraud: The Case of Oleander Electronics

Ever since the SEC came into being as a watchdog agency, shenanigans such as the one Vanderbilt pulled off in the "Nickelplate Railway" case are harder to get away with. It's not that fraud is any less legal now than it was in the nineteenth century, but the existence of the SEC has made the more straightforward bilking of major and minor stockholders easier to prosecute.

But the SEC's leash extends most comprehensively only over the public securities markets. In this chapter you'll meet Elizabeth Oleander, a slippery practitioner of the gentle art of fraud who made her millions in a series of private stock transactions.

The Corporate Shell

Her scam was a new twist on a classic play the Barons used to get rich off the rails — the one we met in Chapter Two: sell out your large interest in a company that only you know is junk. The corporate shell provides both immunity from creditors and the confidence that brings investors in. It is always easier to make a company look good than to make it a genuinely profitable venture, and Elizabeth Oleander was a master of corporate disguise. She was also in the right place at the right time. That was Silicon Valley in the early seventies, just before the invention of the microprocessor. Oleander Electronics was assembling.

The Legal Definition of Insider Trading

When a person has special knowledge about a company because the person is associated with that company as an employee, consultant, board member, or in any other capacity, or obtains knowledge from some other person in that situation, and uses that knowledge to personal advantage in any trading of stocks, bonds, or commodities, then that person is guilty of insider trading. The person may trade as would anyone else when the knowledge becomes public knowledge; that is to say, the law does not attempt to forbid individuals from trading in their company's stock.

As shown in Figure 3.9, lines can vary

- In width, from a hairline (the thinnest line the printer can make) to a bold, thick stroke
- In blackness, from the lightest of grays to the blackest of blacks
- In orientation, from horizontal to vertical, including any angle in between
- From single to multiple
- From solid to dashed

Figure 3.8: Uses of rules
Boxes

As shown in Figure 3.10, you can use boxes and gray screens to

A box may not be completely successful at confining its contents. Even the page may have trouble.

Text that is printed on top of a screen will have to be bigger and darker to be as legible as text printed on white. The dots of the screen blur the letters.

The Space

you leave around the contents of a box, and the space between a box and its surrounding text, gives the boxed material more breathing room and more importance.

Figure 3.9: Varieties of ruled lines

Figure 3.10: Boxes give you the idea that their contents are related.
• Isolate something that is not part of the main flow
• Separate different parts of the document
• Confine an irregularly bounded figure
• Unify elements when the fact that they belong together might not be clear without a surrounding box
• Emphasize that something is worth reading or looking at

Note the following in Figure 3.11:
• Thin borders don't draw excessive attention to themselves.
• Thick borders make a bold statement.
• Sharp corners are crisp.
• Rounded corners are soft.
• A shadowed box suggests a note stuck onto the paper.

Small text within a big, thick rectangle with rounded corners looks like it will be worth reading. The author must have some reason for circling this text.

White on black for a headline!

A box with a shadow seems to stand off the paper, calling attention to itself.

A double border is more elegant than a single line.

Figure 3.11: Some uses for boxes
Unity through Consistency

A document has a design as much as does each page. One goal of this design is to create the feeling that the document is a unified whole. We want a consistent use of all design elements—typeface, grid, amount of white space, headings, and so on—to give a sense of unity across sections even when the content of the sections varies greatly.

The two pages below come from two sections of a project report. The left page is from the narrative describing what the project did, and the right page is from the account of how the monies were spent.

Take note of the following differences in these page designs:

- While headlines and footers are flush left on the left, they are centered on the right.
- There are two columns on the left and only one on the right.
- There are fairly wide margins and lots of white space on the left, while there are narrow margins and little white space on the right.
- The left page is asymmetrical, while the right has near perfect symmetry.

You can unify the two pages by bringing one into the design of the other or by creating a new design that can encompass both pages. Suppose we prefer the spaciousness of the left page and want to impose its design on the right page. The table in the accounting section presents a
problem only if we think it forces us into a one-column grid. The pages below have a unified design:

Note how the design has been unified:

- Headlines and footers have the same alignment.
- Though the table spans the full width of the page, the basic grid is still two columns.
- White space has been added by reducing the size of the table and the amount of text.
- The symmetry is more nearly the same.

Other design elements also need to be used in a consistent way throughout the document. Font changes should have the same significance in all places, and ruled lines and boxes should always border or enclose the same kind of text. The cover, if any, is part of the document and should use a design consistent with the body of the document.

When confronted with a new section in a document containing a different type of information than other sections, it will often seem easier to start over with a new design for that section. But the challenge is to integrate the new material into the already existing design.
For More on Various Topics

Typefaces—For more samples of different fonts, see Appendix D. For some general information about fonts, see Appendix E.

Headings—Chapter 8 shows a way to format headings in Word in which the headings are pulled out to the side of the text.

Columns—We first introduce a two-column format in the context of a concert program in Chapter 8. Three-column text appears in a brochure in Chapter 9, and two-column formatting is used for an article in Chapter 13.

White space—The problem of how to get sufficient white space comes up in many contexts in this book, but see Chapter 9 for a case in which the problem is how to fill the space.

Symmetry—The cover of a proposal in Chapter 11 presents another opportunity to compare symmetrical and asymmetrical layouts.

Ruled lines—These first appear on a brochure in Chapter 9 and then again in the running head of a book in Chapter 12.

Boxes—Chapter 10 deals with boxes to construct a form.

Unity and consistency—Chapter 11 has more discussion about consistency in the context of the sections of a proposal.
I was still mostly asleep Saturday morning at one when I let Clara in. “Happy July,” I mumbled, “what are you doing here?”

She was still wearing teal sweats and Reeboks, but her skin was three shades paler than the usual pale. She was far away. Seeing her eyes reminded me of looking through binoculars the wrong way. I steered her to the only comfortable chair and fixed her a Calistoga float while I woke up.

“Sip it,” I said. “Tell me when you’re ready.”

She shook and sipped. Finally she spoke.

“Victor’s dead. I think he’s been poisoned.”

“Oh, Clara!”

“It was about midnight--he knocked on my door and left a note. He wanted to end it--to end us. I went to his place, and he was dead, lying on the floor of his apartment, his damned slivovitz on the table and a cookie in his hand. It was so strange, so grotesque. And so wrong.”

“What do you mean ‘wrong’?”

“The note, for one thing. It looked funny. He’s always sending me notes--LaserWritten, just like this one--but it just looked wrong, somehow.”

“He knocked, but you didn’t see him?” She nodded. “How long before you left for his place?”

“I had a little cry, I guess. Fifteen minutes.”

“Time enough. Suicide? But why would he knock? Let me see the note.”

“My God, I must have left it there. Lilah, he wouldn’t kill himself!”

I thought hard. “Clara. We have to call the police. But first you have to go to Victor’s and get that note. Then come back here--fast--and we’ll call. And don’t touch anything.”

“Lilah, won’t you go?”

I looked at her, hard. She went. I made a list.
• How and when did Victor die?

• Who wrote the note and who delivered it to Clara's apartment? Possibilities:
  1) Victor – he wasn't being up front with Clara. Then he did commit suicide.
  2) The murderer – to implicate Clara.
  3) Clara – or no note exists. But why would Clara lie?

• Where did Victor go this afternoon? And who is AI?
  ⇒ Ask Adams if he transferred the call?
  ⇒ Check with cab company.

DELIHAH: Delilah, he was there. I was there. I was there.
CLARA: Clara, where are you?
DELIHAH: He was just lying there, so still. And now I'll never know. (weeps)
CLARA: Clara, listen to me. They're looking for you, you can bet on it. I want you to go to the police. If you can, get me a copy of the letter first. One more thing — the briefcase you gave me is locked. Do you know the combination? (waits) Can you hear me?

CLARA: (silent a moment) Tell me: what's Victor's birthday? And what about the letter?
DELIHAH: He's dead, don't you understand that? I love him! He meant everything to me! And I didn't get the letter, okay? And what does his birthday have to do with anything? (Bystander points out Clara in booth to police; Clara sees them) They're here. Thanks for nothing.

CLARA: Clara! What's his birthday?
DELIHAH: July 29, and to hell with you. (hangs up)
BULLETED LISTS AND SIMPLE SCRIPTS

In this chapter, we begin to explore paragraph formatting, an issue that is central to using Microsoft Word on the Macintosh for desktop publishing. Paragraph formatting is the foundation for all the beautiful documents you will create—and the insidious cause of many bizarre mistakes. We will first present some of what you might call the "theory" of paragraph formatting—the basic principles underlying how this particular word processor treats paragraphs. Because we all need experience to go with theory, we'll launch into some examples. In the most important example in this chapter, we will create a bulleted list, like the one shown on the page facing this one. Next, we will use the list to explore some common problems that can occur during editing. We will see how to use Word's glossary to store frequently used text or graphics, such as fancy characters. Finally, we'll show you how to apply what you've learned to a desktop publishing task: how to write a script such as the one on the facing page.
Don't Skip This Chapter

This chapter reviews word processing fundamentals that center on Word's concept of a paragraph. Some of you may already be hotshot Word users who can create a bulleted list at the drag of a mouse and who understand the intricacies of paragraph formatting and the real truth about rulers and how useful they are. If you're one of those lucky people, you're probably anxious to get on with creating newsletters and annual reports. Go ahead. Skip this chapter if you want.

Do so, however, at your peril. We have discovered in our own learning that we were much more effective as Word users when we thoroughly understood paragraphs. Creating bulleted lists and formatting scripts are useful exercises for developing that understanding.

Paragraphs and Rulers

A document in Microsoft Word is organized into chunks of different sizes. The smallest are characters or single letters. Paragraphs are collections of characters. Sections are collections of paragraphs, and a document is made up of one or more sections.

What Is a Paragraph?

Understanding the nature of a paragraph is fundamental to everything you do with Word.

A Paragraph

A paragraph is all the text between two RETURNs, including the second RETURN.

You can watch the creation of paragraphs if you have the Show ¶ feature turned on in the Edit menu. (The ¶-Y keyboard shortcut is worth memorizing.) Every time you press RETURN, a ¶ symbol appears. It's invisible when you print, of course. Each ¶ is attached to the paragraph that precedes it.
It’s straightforward, yet misunderstanding paragraphs causes countless mistakes! Later in this chapter, we will demonstrate and explain one of the most common mistakes. But before that, we have to talk about rulers.

**The Ruler**

When you select *Show Ruler* from Word’s *Format* menu (⌘-R is the shortcut), a ruler appears at the top of the document window. People who grew up with MacWrite (like us) are used to rulers that govern many paragraphs, each ruler staying in effect until the next ruler appears. Word’s rulers are not like that.

---

**Ruler Rules**

Every paragraph has its own ruler.

The ruler at the top of the window controls and displays the format of the paragraph containing the cursor—wherever that paragraph might be.

You will frequently need to use and refer to the ruler since it controls, among other things, the horizontal position of text. Therefore,

> Leave *Show Ruler* turned on whenever you are doing page layout.

In this chapter we’re going to concentrate on using rulers to control the paragraph’s indents and *Space Before*, leaving tab settings, line spacing, and justification for another time.

**Indents**

The black triangles pointing inward at opposite ends of the ruler are called indents. They mark the limits of the text of a paragraph when you type. As labeled in Figure 4.1, there are three indents: left, right, and first.
The left and right indents mark the horizontal boundaries of text in a column. As you type, the words extend towards the right indent. When your words reach the right indent, without your pressing RETURN, the cursor jumps to the next line—at the left indent. This is the familiar phenomenon of word wrap.

The left triangle has two parts: the real left indent (marked by the bottom triangle) and the first indent (marked by the top triangle). First indent is short for first line indent. It marks the indentation of the first line of the paragraph—where the cursor goes when you press RETURN.

**Indents Are Not Margins**

It is easy to confuse indents with margins. Margins determine the size of the active area of the page. Figure 4.2 shows the difference between margins and indents. It is possible to set text outside the margins by moving the indents beyond them, but you can usually get the effect you need without resorting to this. Word provides three different ways to change the page margins, including a margin tool in the Print Preview view of the document. We’ll work with margins later, in Chapters 5 and 6; for now, we’re concerned only with indents.
Using the Indents

You move the indents by dragging them with the mouse. The implications of this simple capability are tremendous. For example, to set up an indented paragraph, drag the first indent as far right as you want and forget about it. If you want the first line of the paragraph aligned with the others, just put the cursor in that paragraph and drag the ruler’s first indent back on top of the left indent.

Try It Out

There’s nothing like experimentation to solidify your understanding. So boot up your copy of Word, type in a paragraph, and try moving the first, left, and right indents around. Notice that as you drag the left-indent marker, the first indent comes along with it. If you want to move the left indent independently, hold down the SHIFT key before you begin dragging.
First see if you can duplicate a paragraph like this one, with wide margins and no first-line indent. This type of paragraph, in which the left edge lines up, is called block left. Unless you have changed Word's defaults, this is the kind of paragraph you'll get if you just start up Word and begin typing.

Next, see if you can change it to look like this. Don't use spaces or tabs—use only the indents on the ruler! (We've dragged the first indent one-quarter inch to the right to make this paragraph, so it looks like a normal indented paragraph.)

Here's a block-left paragraph whose right indent has been moved to the left; now there are only two inches between the left and right indents. Where is the first indent?

On the other hand, this paragraph has its left indent set at the three-inch mark and the first indent at three and one half inches.

**Outdented Paragraphs**

The three indents move independently of one another. We can move the first indent to the left of the left indent to get a paragraph such as the following.

This is an example of a paragraph with the first indent hanging out one and one half inches to the left of its left indent. This is a strange example of a hanging indent, but you will find many uses for this type of paragraph—besides as a silhouette of Oklahoma.

Paragraphs such as the one up above, also called outdented or exdented paragraphs, work well in lists, each one beginning with some kind of special mark like a number or a filled-in circle (called a bullet). But we would need to make the left edge of the text after the bullet line up with the following line, as in Figure 4.3.
Fortunately, whenever the cursor is to the left of the left indent, pressing TAB will take you to the left indent. That way the paragraph will line up properly with wrapping lines of text.

This is an example of an outdented paragraph. The first character in this paragraph is a bullet, made with OPTION-8. Notice that the text all lines up nicely on the left. How did we do that? A bunch of spaces? No way. We used a TAB after the bullet.

Figure 4.3: An example of an outdented paragraph with a bullet and the text lined up correctly

Question for the curious: what happens to a paragraph whose right indent is to the left of its left indent?

The Heartbreak of Spaces

A common bad habit learned from typewriting is using the SPACE bar to position things horizontally.

On the Macintosh, because spaces are very narrow, it takes lots of them to position anything. And because most letters are different widths, it’s almost impossible to get things to line up correctly. Finally, spaces in different fonts have different widths, so if you ever decide to change the font, things that used to line up won’t any more.

Word provides tools for lining things up. Indents are one such tool, and the TAB key is another.

Therefore, avoid using spaces for anything other than separating words. Instead, use appropriate paragraph formatting and tabs to position text.
A bullet, OPTION-8 in most fonts

Some sample Zapf Dingbat characters

Example: Bulleted Lists

The most common use of outdented paragraphs is to construct bulleted lists. A bulleted list consists of several outdented paragraphs in succession, each beginning with a "bullet," often a round, black dot. The purpose of the bullet is to emphasize the beginning of each paragraph and to draw attention to the list as a whole.

In place of official bullets, you can mark lists with numbers, letters, or graphic characters called dingbats, such as those in the Zapf Dingbats font. Some of these are shown at left. The bullet can be surrounded by parentheses or square brackets.

Let's create a bulleted list. A little later we'll use the list we create to demonstrate some interesting and common ways things can get fouled up. Follow these steps:

- To get a clean slate, select New from the File menu.
- Be sure the ruler is showing. If it isn't, select Show Ruler from the Format menu or use the %R shortcut.
- Hold down the SHIFT key and drag the left indent (that's the bottom triangle on the left) with the mouse to the one-half inch mark. Notice that the top triangle does not come along with it.

  Word also provides a shortcut for creating a hanging indent—
  %E-SHIFT-T.

- Move the right indent to the 3 1/4 inch mark. You will be making a narrow column of text so you can see the effects of word wrap.
- Press OPTION-8. (Or use any number, letter, or dingbat you wish.) This is the bullet.
- Press TAB. This brings the cursor to the left indent at 1/2 inch.
Type a sentence such as “How and when did Victor die?”

Press RETURN. This starts a new paragraph and shoots the cursor back to position zero, where the first indent is sitting.

Repeat this process—starting with typing the bullet—two more times, with different text for each bulleted item. You should wind up with three items in your bulleted list, and it should look like Figure 4.4.

Figure 4.4: A bulleted list with three items, as seen in the document window

You may have noticed an important behavior of Word while you were doing that exercise:

What Happens When You Press RETURN?

The format of the new paragraph you get when you press RETURN is identical to that of the previous paragraph. This behavior is almost always a great convenience. The new format stays with you until you tell Word to change it.

Changing the Bulleted List

Now we’ll change the bulleted list we just created. First, let’s change the formatting. The items would be easier to read if there were some extra space between them. How should we do that? The typewriter solution would be to use a blank line, generated with an extra
RETURN between each paragraph. We won’t do that. Instead we’ll show you a scheme that makes it easier to change things later on. Our scheme will leave the formatting of the paragraph to formatting commands, not to text characters like spaces and RETURNs. In fact, what we’re getting at here is something that will return again and again in this book:

**A Fundamental Principle**

Use formatting commands to adjust your paragraphs instead of invisible characters such as SPACE or RETURN. Do this not to save keystrokes (though that usually happens too) but to make your document easier to change later on.

It’s time to learn about the ruler icons that control space between paragraphs.

**The Space Before Icon**

There are several sets of little icons just below the numbered part of the ruler. The right-hand pair of icons (shown in Figure 4.5) controls paragraph spacing. Remember, each icon affects only the paragraph the cursor is in.

The paragraph spacing icons are an ingenious feature. When the right-hand one (the Space Before icon) is selected, there will be 12 points (\(1/6\) of an inch) of vertical space automatically attached to the beginning of the paragraph. That’s the height of a typical typed line of text. The icon is supposed to look like two paragraphs on a page with some space between them. Its partner, the No Space icon, causes the paragraph to have no extra space before it. This is Word’s default setting. Figure 4.5 shows the two icons in a close-up with the No Space icon selected.

Try them out:

- Click somewhere in the second paragraph.
- Click on the Space Before icon.
Your screen should look like Figure 4.6. Notice that the ruler you see applies to the second paragraph (the one with the cursor in it).

The Space Before icon generates 12 points of space before each paragraph.

The No Space icon formats paragraphs so there is no extra space between paragraphs.

**Figure 4.5: The two paragraph spacing icons on the ruler**

The Space Before icon is highlighted. There is space between the first and second paragraphs. The space was inserted before the second paragraph, and "belongs" to it.

**Figure 4.6: The space before the second paragraph has been changed.**
You could do that same operation for every paragraph in the list, but that's hardly the most efficient method. Now you need the ruler rule for selected text:

**Ruler Rule for Selected Text**

Suppose a text selection spans more than one paragraph.
- Changing the ruler will change the formats of all those paragraphs.
- If all the paragraphs have the same format, the ruler will show that format. If there is *any* difference in the format of the paragraphs in the selection, the ruler will be grayed out, the indents will refer to the first paragraph in the section, and the icons will be blank, but the controls are still active.

You can demonstrate these rules in the next example.

- Select the text from the middle of the first paragraph to the middle of the third. Your screen should look like Figure 4.7.
- Now click on the Space Before icon in the ruler. Your screen should now look like Figure 4.8.

*Figure 4.7: The screen with the multiple-paragraph selection*
Bulleted Lists and Simple Scripts

The ruler is white and the ruler icons highlight because the formatting is now the same for all paragraphs.

Figure 4.8: After the change. Notice the white ruler and the space before each paragraph—even the first.

Nested Bulleted Lists

Sometimes each main item on a list will have its own sublist, often called a nested list. In our example list, we might want to add more suggestions and information under each main bullet. Let's add a sublist to the second bulleted item:

1. Put the cursor down at the end of the second paragraph.
2. Press RETURN. This starts a new paragraph, of course, but we want to change its format...
3. ...so we drag the left indent (the bottom one; the top will follow it) one-half inch to the right, to the one-inch mark.

Dragging the left indent one-half inch is such a frequent operation that Word has a keyboard shortcut. \$-\text{SHIFT-N} (N as in Nest) drags both the left and first indents one-half inch to the right. (You can change how far the indents move by changing the default tab stop.)

Now type in the numbered list until it looks like Figure 4.9. Don't forget that it's a TAB after the number and the closing parenthesis.

How Paragraph Marks Can Cause Trouble

At this point, we're going to screw up on purpose, to give us our first opportunity to step through a gotcha in detail. (A gotcha is a mysterious and frustrating problem caused by our misunderstanding of how things work.)
Who wrote the note and who delivered it to Clara's apartment? Possibilities:

1) Victor — he wasn't being up front with Clara. Then he did commit suicide.

2) The murderer — to implicate Clara.

3) Clara — or no note exists. 
   But why would Clara lie? — Here's the cursor.

Figure 4.9: The first part of a nested bulleted list

Suppose we want to remove the sentence "But why would Clara lie?" One seemingly reasonable way to do this leads, unfortunately, to the gotcha. Here's the plan: we're going to select the last sentence by dragging across it with the mouse from left to right. Then we'll delete the sentence by pressing BACKSPACE.

⇒ Move the mouse pointer to the left of the word "But" in the last line of item 3.

⇒ Drag to the right with the mouse until you're to the right of the question mark after "lie." Now the sentence and the question mark are selected. The screen should look like Figure 4.10.

⇒ Press BACKSPACE. The screen should now look like Figure 4.11.

Figure 4.10: Before the mistake. You can see the mouse pointer—the I-beam—to the right of the selection.
Victor — he wasn't being up front with Clara. Then he did commit suicide.

The murderer — to implicate Clara.

Clara — or no note exists.

Where did Victor go this afternoon? And who is Al?

Figure 4.11: After the mistake. Note how paragraph 3 has moved to the left!

What went wrong? You'll figure it out if you do the whole thing again using Show ¶. What happened was that by dragging well past the question mark, you selected the paragraph mark at the end of the third list item. Since the RETURN was deleted, the third list item and the following bulleted item became one paragraph with the format of the latter.

Figure 4.12 is like Figure 4.10 except that Show ¶ has been turned on so that you can see the ¶ marks as well as the tabs, which are essential for getting everything to line up in this bulleted list.

What can you do to prevent this mistake? Fortunately, almost any other way of changing the paragraph would have worked fine. Here are some:

• Drag from right to left instead of left to right. This does not select the paragraph mark.
• Carefully select only up to the question mark.
• Use ×-click to select a sentence. That selects the punctuation at the end, but not the paragraph mark.
• After dragging left to right, don’t press BACKSPACE. Just type something new. Microsoft Word does not delete the paragraph mark in this case.

Figure 4.12: Before the mistake, but with Show ¶ turned on. Note that the ¶ mark is selected.
This gotcha teaches us something about paragraphs:

The Soul of the Paragraph

When two paragraphs merge, they take on the format of the second paragraph. The formatting of the first paragraph is lost because its paragraph mark has been deleted. This critical experiment demonstrates that the formatting of the paragraph—its soul, if you will—resides in its end, in the ¶ mark that concludes it.

Sometimes Formatting Doesn't Seem to Work. Suppose you have left the cursor somewhere and scrolled to a different part of the document to read. Then you see a paragraph that needs indenting, so you go to the ruler and drag the indent. Nothing happens. Or so it seems. In fact, you have indented a paragraph elsewhere in the document—the one containing the cursor. If you press one of these ruler controls and nothing happens, consider that possibility—and prepare to undo.

The Remedy for Many Gotchas—Undo

The more you learn about Word, the more dramatic the gotchas you will stumble upon. Word usually gives you a chance to recover from a mistake by selecting Undo from the Edit menu (or typing its ~-Z shortcut). But be careful: Word can only Undo the last change you made to the document. So when something odd happens, don't make any more changes! Instead, try to figure out what happened and Undo it if you need to. (Since scrolling and repositioning the cursor don't count as changes, you can use these to help figure it out.)

⇒ For many gotchas—like the unexpected merging of two paragraphs—Undo works great. Try it.

Using Dingbats as Bullets

We'll make a second sublist and use a more graphic dingbat for the bullet. Once we get the dingbat set up properly, we'll store it in Word's glossary, where it will be easily accessible for use in other documents.
11 • Position the cursor at the end of the third bulleted item in the list and press RETURN.

11 • We’re constructing a new sublist, so nest (⌘-SHIFT-N) this paragraph. While you’re at it, click on the ruler’s No Space icon so that the sublist will nestle up to the main list item.

11 • Type in a dingbat from some font other than the one you are using. We’ll use a ☰ dingbat from the Zapf Dingbats font.

When we want a new dingbat, we find we have to refer to a list or open the Key Caps desk accessory so we can see what is available. Even when we have in mind a specific dingbat, we still must find out how to type it. That’s why, once found, it makes sense to store a favorite dingbat in the glossary.

11 • Before pressing TAB, set the font back to the one you were previously using (New York for us). Then press TAB.

11 • Select the dingbat and the tab, but not the ¶ mark.

11 • Select Glossary... from the Edit menu or use the ⌘-K shortcut. You should have something like Figure 4.13.

11 • Type a name that you can easily remember into the Name: box. We’ll name ours “quill pen.”

11 • Press the Define button. The dingbat is stored in the glossary. Now close the Glossary dialog box by pressing Cancel.

Figure 4.13: The dingbat and the tab are selected, and the Glossary dialog box is showing.
Finish this entry in the sublist and press RETURN. Now you are ready for a second dingbat.

Bring up the Glossary dialog box again and then double-click on the desired dingbat’s name. The dialog box will close and the dingbat will appear—including the tab—all ready to type some more in the usual font.

Word’s glossary helps you store many things beside those hard-to-recreate dingbats:

- Frequently used phrases, especially those that are hard to spell
- Frequently used paragraphs of text, such as your return address
- Graphics, for example a company logo
- Paragraphs with special formatting, for instance a paragraph in a nested sublist, complete with special bullet and ready for modification

If you invest a lot of time typing or formatting something, and you plan to use it again in other documents, you should consider storing it in the glossary.

There are two other ways, in addition to the Glossary... command, to insert glossary items into the text you are typing. Here is the first:

Press ⌘-BACKSPACE (⌘-DELETE on some keyboards). Doing this highlights the Status Info box in the lower-left corner of the document window, as shown at left.

Type in the name of the glossary item, “quill pen,” (no quotes) and press RETURN.

You do not need to remember the entire name of the glossary item. You can type just the first few letters, and, if they are enough to distinguish the desired item from others in the glossary, Word will choose it. If more than one item begins with these letters, Word will beep, indicating it needs more. Word will also beep if no items begin with these letters. If you get stuck, press ⌘-PERIOD to get out of the stuck place.

Another method to enter glossary items into text is to install them on Word’s Work menu and then choose them directly from that menu.

Use ⌘-OPTION-PLUS (that’s the ⌘ key and the OPTION key along with the plus key) to get a ✱ for a mouse pointer.
Using the +, select **Glossary**... from the **Edit** menu. When you click on the desired glossary item, the menu bar at the top of the screen will flash and the mouse pointer will return to normal.

The **Work** menu at the far right of the menu bar will now contain the name of your glossary item. Selecting its name will automatically insert the item into your text. (See "Installing the Template on the Work Menu" in Chapter 5 for instructions on how to remove a **Work** menu item.)

**Bulleted Lists as a Design Element**

In addition to their use as lists of questions and things to do, bulleted lists can help you emphasize or clarify detailed instructions by setting the steps apart. Be careful though—the emphasis the bullets and outdenting provide fades with overuse. Bulleted lists usually stand out best against a background of normal text.

Think about some of the elements of a bulleted list that you have control over.

- The larger or more unusual the bullets, the more emphasis you place on the list as a whole and on the separateness of the items.
- The more blank space at the top and bottom of the list, the more the list stands as a distinct entity.
- The more space between items, the more you are saying that they are separate from each other.

You could use bulleted lists to create an outline. But Word has a better way to do this: a built-in outlining utility that we will discuss in Chapter 7.

**A Simple Script**

A not-so-obvious use of bulleted lists brings up a genuine desktop publishing task. Suppose we want to publish a script, such as one for a play. There are many different formats it could take; we'll use one where the names of the speakers appear in a column of their own to the left of the words they speak. The result will look like the example on the page facing the beginning of this chapter.
One way to format this script is as a special case of a bulleted list. The name of the speaker takes the place of the bullet. Figure 4.14 shows the ruler setting used for the example opposite this chapter's title page. Incidentally, we use the Small Caps character format for the names of the characters. The shortcut is ≈-SHIFT-H.

For More on Various Topics

Margins—In Chapters 5 and 6 we demonstrate various ways to set page margins.

Outlining—You might think you would use bulleted list techniques to create outlines, but actually you would do better to use Word's own outliner, as explained in Chapter 7.

Space Before—Word's ruler allows only two amounts of space before. See Chapter 5 for setting it to any amount.

Tabs—In Chapter 6 we introduce various ways to set tabs.

Two-column formats—The script example used a kind of two-column format. See Chapters 6 and 7 to see two more elegant methods.

Work Menu—In this chapter you learned how to add a glossary item to the Work menu. See Chapter 5 for deleting items from menus.
The fog smothered the streetlamps as my Valiant slid through Emeryville. The DJ on my car radio was too cheerful for 5:30 in the morning. I parked in the lot, shook myself awake, let myself into the IA offices, and felt my way to my cubicle. My goose-neck desk lamp, the incandescent minority, was the only warmth, the only light.

Victor's briefcase was still under the pizza box, screaming to be opened.

I had to try. I dumped the box and set the briefcase on my desk. I dialed 729 into the combination lock. I didn't even know what to hope for when I pressed the latch, but it didn't matter, because 729 wasn't the combination. The Samsonite was silent once more, inanimate jetsam.

I never did like Victor Markovsky. He and I were opposite poles. I am intuitive and messy; he was the epitome of order, organization, and control. Clara said he had a sense of humor, but I guess it was one of their many secrets.

Once she told me something about him that made me feel he and I were even more removed from each other. I had been complaining that he was too much of a neatnik. "He doesn't cherish order, Delilah," she said, "he fears chaos." She told me that he set his watch five minutes slow so he would be on time to things.

"You mean five minutes fast, don't you?"

She meant slow. While some people develop systems so they won't have to think about being on time, Victor arranged his life so he was continuously compensating. It made me shiver. I chided myself. What did I know? I never spoke with him for more than five minutes; all I knew about him was that he was a Yugoslavian emigre who loved my friend Clara and drank slivovitz—maybe one slivovitz too many.

The Surly Serb is gone. I tried to imagine him where he would fit in, bending an elbow in Sarajevo, toasting Gabrilo Princip and the heroic overthrow of the Hapsburgs. Then, in a flash, I knew the combination. 297, of course. The latch opened with a flapping sound; I raised the lid.

There was a letter on top.
Dear Victor,

Do you know what you're doing? Everyone I know at the Pacific Exchange is coveting every block of promised stock they can get from your investment bankers; the pundits predict the stock will go to eighteen minimum, max thirty-five. Reminds me of Aldus.

And then you show me a discrepancy between a draft of your annual report and your own figures on the company's bizarre debt situation? First, now we both go to jail if either of us trades in the stock and we get caught. Second, if you're wrong, I wish you wouldn't burden me with your suspicions. Third, if you're right, somebody at IA is going to make a major killing on this deal. Many tens of millions, all illegal. So watch your step, buddy. This reminds me of a case I heard about in the seventies. If I find a reference, I'll send you a copy.

In the meantime, my recommendation is not to play the hero. You must have some inside track on your company's stock. Best bet: get as much as you can and sell a week after it hits the street. If there's a major bust they won't bust you. Second best is forget all this and act surprised. Me, I'm shredding everything you sent me.

I hear nothing, I see nothing,

cc: Nobody.

Brian Thompson
Financial Consultant

Victor Markovsky
5269 Portola Way #201
Oakland, CA 94618

Brian Thompson
Phelan and Company
553 Pine Street
San Francisco
23 June 1989
LETTERS

In this chapter, we use the familiar layout of a business letter to introduce another central idea—that we can store a paragraph format in a named style. You will learn how to define a style for the return address, salutation, and all the other parts of a business letter, and you will begin to see how styles give you control over the layout of a document. It becomes easier to get things right in the first place and easier to change your mind and try out new designs once the document is formatted. In addition to defining styles, we'll cover how to apply styles, redefine styles, and how to transfer styles from one document to another. A valuable time-saving technique involves setting up template documents so that you rarely have to start with a blank page. The example letter in this chapter becomes such a template, and you will learn how to install a menu command for accessing it.
Reasons to "Publish" Letters

What does desktop publishing have to do with writing a letter? The publish in desktop publishing is really a misnomer. When we think of publishing, we think of printing thousands of copies, while most letters are written to a single person. But the desktop publishing revolution is about the appearance of any printed document. It would be better named desktop page layout.

Even before you used a computer to write your letters, you probably cared about how they looked. Your first glance at a letter sets your frame of mind. If the page has lots of white space and the type is large, you may feel like reading it because it won’t take a lot of time or effort. On the other hand, a dense page full of small type may fill you with a sense of dread. Straight right margins and fancy typefaces may make you suspicious—is this a form letter or a personal letter? An interesting letterhead may draw you in, leading you to believe the letter itself contains something worth reading. You want the letter’s appearance to be consonant with its contents and to motivate the recipient to keep reading.

Designing the Letter

How do we go about designing a letter? The first step is to figure out where we’re headed. Once we decide on the general design of our letter, we’ll start learning how to define the styles in Word that will make those design decisions easy to maintain and easy to change.

The Look of a Letter

A letter looks like a letter because its parts all fit in well-defined places on the page. Figure 5.1 shows a typical business letter and identifies its parts. Designers call this kind of picture of a page a thumbnail and use it frequently to design and communicate page layouts.

The thumbnail shows various elements and gives each a name. For the most part, only two formatting characteristics distinguish each element from the others:

- Indentation from the left margin
- White space between elements
You already know from Chapter 4 most of what there is to know about how to control these two elements of paragraph formatting.

We will now proceed from the top to the bottom of the letter, defining a style for each of the design elements.

**What’s in a Style?**

A style is nothing more than a paragraph format with a name. Styles are what make desktop publishing with Word a worthwhile endeavor. Without styles, whenever we change the layout of a document, we are forced to find all the places that need the change. With styles, we can make the change once and have it applied automatically throughout the document.

**How to Define the Return Address Style**

Now we’re going to go through, in detail, one way to define the return address style. Word provides quite a number of methods for defining a new style; the method we’ll use here, defining a style by example, is perhaps the most straightforward.
Start with a new, blank document (though one of the aims of the chapter is that you never have to start a letter from a blank again).

You need to use Full Menus. Word provides Short Menus so beginners won't be overwhelmed by an abundance of possibilities. You can tell if you are using Full Menus by looking at the Edit menu. If Short Menus appears near the bottom of the menu, you are already using Full Menus. If Full Menus appears on the bottom line, select it.

Word will remember your choice; you won't have to do it again the next time you start up.

Make sure that the Ruler is showing (use Show Ruler from the Format menu or the Shift-R shortcut).

Drag the left indent over to the 4-inch mark on the ruler. That's all the formatting this paragraph needs. Type the first line of the return address.

With the mouse, highlight the box that says Normal at the far left of the ruler by clicking on it. When this box, called the style selection box, is highlighted, you can type a new style name into it. You should have something like Figure 5.2 on your screen.

Type return address into the box and press RETURN.

You will notice that return address does not quite fit in the box and the second word may not appear as you type it.

After you press RETURN, the dialog box shown at the top of the next page appears, asking you to confirm that you really do want to define the new style. Click on the Define button. (The Define button has a heavy outline around it, which means that pressing RETURN or ENTER is equivalent to clicking on the button.)
Go ahead and type a return address. As you press RETURN at the end of each line, each new paragraph gets the return address style.

Word has two ways of showing you the style for the paragraph containing the cursor. First, the style selection box now contains return addr... with the three dots indicating that the name of the style is longer than will fit in the box. Second, as shown below, return address appears next to the page number in the lower-left corner of the window. Use these indicators to keep track of the current paragraph's style. If more than one paragraph is selected, the name you see is the name of the style for the first selected paragraph.

In these instructions we had you define the style as you typed in the text. Later in this chapter, you will learn to impose styles on a letter which comes to you without any formatting at all. In Chapter 6, you'll learn how to define many styles before typing any text.

Spacing Above and Below Paragraphs

Now we'll deal with the date, which comes after the return address. Although it has the same indent as the return address in our thumbnail, we'll give it a different style in order to deal properly with the white space that follows the date. In Chapter 3, we talked about the importance of white space as a design element in a page layout. Now we begin to explore the many ways to generate white space.
White Space Belongs to the Paragraph

Because white space is so important to the design of a page, we need to give ourselves as much control over it as possible. You can generate vertical white space by pressing RETURN, but that won't give you very fine control. Word gives us a much better tool: each paragraph comes with a certain amount of space before it and after it. You get precise control over this white space using the **Paragraph...** command on the **Format** menu.

Whenever possible, use space before and space after to control the amount of white space between paragraphs. Don't use RETURNs to generate white space.

How to Define the Date Style

If white space belongs to the paragraph, which paragraph gets it—the paragraph with the date, or the paragraph with the first line of the inside address? The white space could be space after the date or space before the first line of the inside address. Later we'll find it a bit easier to edit the template if we give the white space to the date paragraph, so let's do that here. We'll assume that we want one inch of white space below the date.

- Put the cursor on a new line under the return address by pressing RETURN. This new paragraph initially has the **return address** style.
- We would like to have one inch of white space between the date and the inside address; that is, one inch of space after the date. White space belongs to the paragraph, so we set the amount of space after a paragraph using the **Paragraph...** command in the **Format** menu. (The keyboard shortcut is %M.)
- The **Paragraph** dialog box has many features packed into a small space. For now we are interested only in the box labeled **After**: Click in that box and type 1 in. Figure 5.3 shows what you should see on the screen. Then click **OK**.
- Highlight the ruler's style selection box just as you did to define the **return address** style, type **date**, and press RETURN. When the
Figure 5.3: The Paragraph dialog box set for one inch of space after dialog box appears, click on Define, thus completing the second style definition for the letter.

Type in a date and press RETURN. Notice that the cursor moves down one inch because the space after belongs to the date paragraph.

To make it easier to enter today's date, Word provides the glossary items shown below. If your computer's clock is set, just bring up the Glossary dialog box and double-click on the date entry with the format you want.
Changing Back to Normal

Pressing RETURN after the date produced a new paragraph with the date style. But this paragraph is to be the first line of the inside address. How tedious it would be if we had to undo the formatting we added to the date paragraph in order to format the inside address. Fortunately, there are several quick ways to change the style of any paragraph to Normal. We'll demonstrate three of these ways here.

Using the Ruler's Style Selection Box

- The style selection box on the ruler has a down arrow next to it. Hold down the mouse on the arrow to reveal an alphabetized list of the currently defined styles. Drag the pointer to Normal and release. This changes the style of the currently selected paragraphs—or the one the cursor is in.

Using the Styles Dialog Box

- Select Styles... from the Format menu. The resulting dialog box, shown in Figure 5.4, shows a list of styles with date selected. In the box below the list of styles you can see that the definition of date is return address + Space After 72 pt.

- Click on Normal and then the OK button. This changes the style of the paragraph containing the cursor to Normal; we see the results of the change as the left indent and first line indent move to zero.

Figure 5.4: The Styles dialog box allows you to apply styles and to see their definitions.
Using the Keyboard Shortcut: ⌘-SHIFT-P

⌘-SHIFT-P
Shortcut for applying Normal style

If you press ⌘-SHIFT-P, the paragraph the cursor is in will revert to the Normal style. If you're used to MacWrite or Word Version 1, you might expect that since ⌘-SHIFT-I is italic and ⌘-SHIFT-B is boldface, ⌘-SHIFT-P would be plain text.

The Normal Style and the Inheritance Chain

There is a powerful idea behind what we are doing, an idea that greatly facilitates managing the styles in a complex document. First consider what it means to be normal.

Normalcy

Normal is the style that Word automatically assigns to the empty paragraph in a new document. Most new styles that you define inherit some of their formatting from Normal.

Recall that in Figure 5.4 we saw that the definition of the date style was return address + Space After 72 pt. This means that the date style inherits from the return address style. If we bring up the Styles dialog box to see the definition of the return address style, we find that it inherits from Normal; its definition is Normal + Indent: Left 4in. Using the Styles dialog box again, we see that Normal is defined as Font: New York 12 Point, Flush left; it doesn't inherit from anything.

The Importance of Inheritance

When you define a new style, the new style is based on the style of the paragraph the cursor is in. The new style inherits all the attributes of the old style except those you explicitly change.
When you change the definition of a style, the definitions of all the styles that inherit from it change as well. This property allows us to make sweeping changes in a document by changing only one style. For example, we can change the size of the font in the Normal style with immediate effect throughout.

**Defining the Inside Address Style**

Getting back to formatting the letter, we’re ready to create the inside address, each line of which is a separate paragraph. Why not leave the style for the inside address Normal? While that’s workable, especially in the context of a document as short as a letter, it is better design practice to define a new style, inside address, even though its definition is the same as Normal. Here’s why.

### Never Stay Normal

Use the Normal style as a foundation for all the other styles in a document, but don’t let any paragraphs keep it as their style. This allows you to change Normal to make global changes to the document, for example, to change the font (since all of the styles are ultimately based on Normal), but still retain individual control over the styles of all parts of the document.

No paragraph should end up with the Normal style.

If we decide to change the formatting of inside address—we might want it in italics, or indented—we can quickly change the style of these lines without affecting the rest of the letter. Of course, for a short document, such as this letter, nothing terrible will happen if we let the inside address have Normal as its style. But part of learning to use a computer effectively is acquiring habits that serve you well, and the habit of never staying Normal will save you lots of grief when you work on long, complex documents. Besides, it takes almost no time to do:

- With the cursor in the paragraph that will contain the first line of the inside address, click on the ruler’s style selection box, type
"inside address," press RETURN, and click Define in the resulting dialog box.

Now type the address, pressing RETURN after each line.

A Standard for Describing Styles

Throughout the rest of this book, we’re going to be using styles to facilitate page layout. We need a way to write down what a style is for and how it is defined. Here are the three styles we’ve created so far.

return address  Contains the sender’s address.
Normal + Indent: Left 4 in

date  Contains the date and the space between the date and the inside address.
return address + Space After 72 pt

inside address  Contains the address of the person to whom the letter is addressed.
Normal +

On the first line you see the name of the style. Next to the name is a short description of the purpose of the style. The last line contains the definition of the style following the same conventions you have already seen in the Styles dialog box.

The Remaining Styles

Practice defining styles by creating the rest of the letter. Figure 5.5 shows the thumbnail again with style definitions. Be careful to apply the Normal style to paragraphs before formatting and defining styles if those styles are based on Normal.

No new techniques are used in these style definitions. But notice that the salutation and copies styles are defined separately even though they have the same format, so that they can be changed independently later on. For example, we might realize later that we should have outdented the first line of the copies paragraph 0.25 inch, so that with SHIFT-RETURNs between the names of people who are to receive copies, the names will line up correctly. If both of these elements had the same style, we would have to separate them into two styles, a more difficult operation than starting with two styles in the first place.
One Style, One Function

Each element of a document should have a separate style, even if two elements happen to have the same formatting. In following this dictum, we are preparing for a time when we might want to change the formatting of one element but not the others. This kind of planning ahead makes desktop publishing powerful, flexible, and efficient.

If two paragraphs in a document have different functions in the design, you should define different styles for them, even if they have the same formatting.

Figure 5.5: The remaining styles belonging to the business letter

Instant Thumbnail—Print Preview

Our work thus far has been done in what Word calls galley view, named for the typesetter’s galleys. Printed galleys contain all the text in a document in one continuous stream without any of the page layout
and are used for proofreading before the text is placed in its final form on the page.

Though galley view has presented us with an accurate representation of what the letter will look like on paper, we have not been able to see the entire page at once. For page layout, we would like to step back and see the whole page, including the margins. The Print Preview... command in the File menu (with the keyboard shortcut %I) is what we use to get this view of the document. Looking at the on-screen thumbnail of the letter, as shown in Figure 5.6, we can assess our design and decide what changes we want.

You should be aware that print preview is a mode in which you can’t edit the text or access the menus. To get out of print preview, click the Cancel button. (Typing $W or $-PERIOD will also close the preview window.)

The Ruler Shifted and I Have These Funny Lines! If you double-clicked on the print preview page or clicked the Page View button, you wound up in a third “view”—page view. For this document, page view is OK, but your screen will match the figures better if you press $B and return to galley view. We’ll learn about page view in Chapter 6.

---

**Three Stages of Proofing a Page Design**

The first stage of proofing a design happens as you create it. You define a new style and see immediately how it looks in Word’s galley view. When you want a better look, use the print preview mode to see more exactly how things will look on paper. Finally, you print the document and check the print out. Print preview is much faster than printing, so...

Do as much proofing of your design as you can using print preview, saving printing until you cannot find anything else to change or correct on the screen.
The Chosen Printer Affects Print Preview

The printer you have chosen will affect the details of how things look in the print preview window (and during normal editing, for that matter). In particular, when you have used the Chooser desk accessory to choose the LaserWriter as your printer, a line holds only nine-tenths as many characters as when you have chosen the ImageWriter. What fits on a page to be printed on an ImageWriter may not fit when printed by a LaserWriter. So you should use the Chooser to select the printer on which you will print your final copy before working out the details of a page design.

As long as you have the LaserWriter file in your System folder, you can choose the LaserWriter as your printer even if your computer is not connected to one. This allows you to work on layout on a computer that has no LaserWriter and print later from another computer that is connected to a LaserWriter.
The Print Preview Tools

Print preview offers a number of tools for viewing and modifying a document; we’ll be using them throughout the rest of this book. Let’s take a brief look at how they work.

First, the scroll bar behaves just a bit differently in print preview than it usually does. As shown in the margin, clicking on an arrow or in the gray area above or below the thumb scrolls forward or backward one page per click. You can also drag the thumb to an approximate place in the document.

Clicking on the Page Number icon changes the mouse pointer to look like this: $\rightarrow 1 \leftarrow$. You can then position this pointer at the place on the page you would like a page number to appear and click again. If you click and drag the mouse, you can see, in the upper-right corner of the window, the current distance from the right and top edges of the paper. Double-clicking the icon will place the page number in the upper-right corner of the page. Although these methods of getting page numbers in documents are convenient, for desktop publishing purposes, you will almost always need the greater control over page-number placement and formatting offered by Word’s headers and footers.

When you click on the Margins icon, the print preview window displays the page margins as shown in Figure 5.7. You can change these margins by dragging the small black handles. As you drag, the new position of the margin shows in the upper-right corner of the window. Click outside the page to reformat it.

Occasionally you will find it helpful to view one page at a time instead of two. The Page View icon toggles back and forth between one or two pages each time you click it.

Clicking on the Printer icon brings up the same dialog box you would get if you chose Print... from the File menu.

Changing Your Mind and Playing with Styles

A novelist who spends her time playing with fonts instead of working with the words has gotten sidetracked from her task. But as a designer, you give your aesthetic sense a tremendous opportunity for expression when you can experiment quickly and easily with fonts, margins, columns, positioning, and other aspects of page layout.
Design Aspects of Different Fonts

The chances are good that the letter you have written uses the New York font because Word comes with this font as the default. New York was designed for the Imagewriter printer, not a laser printer. (In the early Macintosh days, Imagewriter fonts were named for cities such as New York, Boston, Chicago, and Geneva.) Imagewriter fonts look terrible on a laser printer, at least compared to fonts specifically designed for laser printers. The reason is that Imagewriter fonts contain at most 144 dots per inch, while laser printer fonts are defined by algorithms that enable the printer to generate 300 dots or more per inch. So let’s assume that you are going to be printing on a laser printer and would like to change to a laser font.

But When I Printed It in New York, It Looked Fine! You have discovered one of the subtleties of printing on a LaserWriter with a Macintosh. The Mac assumes you don’t really want to cripple your printer, so it substitutes a different font, Times, for New York because they look more or less the same. But even though the individual letters look fine, the word spacing will be different than if you had formatted it in Times.
You will come to recognize the difference; the extra spacing doesn’t look right.

This phenomenon is known as *font substitution*, and it is controlled in the **Page Setup** dialog box as shown in Figure 5.8. Times substitutes for New York, Helvetica for Geneva, and Courier for Monaco. If you allow font substitution, what you see on the screen will not be what appears on paper. For best results when you print on a LaserWriter, use genuine laser fonts.

![Figure 5.8: The Page Setup dialog box for the LaserWriter with the font substitution option turned on.](image)

But what font should you use? It depends partly on what impression you want your letter to have on your reader. Consider the two paragraphs that follow, each written in a different laser font.

This paragraph is written in Times, a traditional font. The letters in Times each have different widths, making it a *proportional* font. Most of the letters have serifs, the little extra strokes such as those on the top of an M. Some researchers of human perception claim that serifs make type easier to read, but others dispute that claim. Using Times for the letter might create an "establishment" impression because it is such an old typeface.

This paragraph uses Courier, a font designed to imitate the Courier type ball of a typewriter. Like Times, it is a serif font, but while Times is a proportional font, Courier is *monospaced* because each letter has the same width, whether it is an "i" or
an "m." The reader may conjure up an image of a secretary pounding away on a Selectric instead of on a computer.

Let's go for the typewriter look. You may know a simple way to change the font in the entire letter: select all the text and choose Courier from the Font menu.

The trouble with this simple method is that it doesn't allow for the possibility that you have deliberately set some words in a different font. In the last sentence of the previous paragraph, for example, the word Font is set in Helvetica Narrow Bold. We need a way to change font without disturbing text that has been specially set to a different font. Styles provide the answer.

Miraculously, changes you've made to the character formats of certain words or phrases in a paragraph—such as font, font size, italic, and so forth—stick with those characters when the style of the paragraph is changed. Therefore, changing the font that belongs to the Normal style provides exactly the capability we need, because all the other styles in the letter are ultimately based on Normal.

One Way to Change the Normal Font

To change the Normal font, you will change the definition of the Normal style. While we have been defining styles by example, and we will learn to redefine them that way, that won't work with Normal because we have no Normal paragraphs! You can use the following technique to change the definition of any style:

- Select Define Styles... from the Format menu (or use the keyboard shortcut, ⌘-T).
- The dialog box has a list of the styles you have defined for the letter. Scroll the list to bring Normal into view. Select Normal with the mouse by clicking on it once. The definition of Normal, which appears in the box, is probably Font: New York 12 Point, Flush left.

If you are an experienced Macintosh user, what you are going to do next will seem a bit strange. Usually when dialog boxes occupy center screen, other features of the user interface, such as the menu bar and the ruler, remain unusable until you have closed the dialog box. But the Define Styles dialog box allows you to use some of these features, and records what you do in the definition of the style.
Select Courier from the Font menu. Figure 5.9 shows what you should see.

*It is possible that your system does not have Courier installed as a font. Courier comes on the Macintosh system disks; you can use the Font/DA Mover utility, also on the system disks, to install it in your system.*

Press the Define button to finish redefining the Normal style. Why not the OK button? Here is a gotcha!

*When OK Is Not Okay. Press Define because you want to redefine the Normal style without applying it to the paragraph. If you pressed OK, the style of the current paragraph would change to Normal.*

Finally, close the Define Styles dialog box with the close box or the Cancel button (not OK, for the same reason). The font for the entire letter, with the exception of any words or phrases in special fonts, has been changed. The change happened to all of the styles, such as body and complimentary close, because they are all based on Normal.

*Figure 5.9: Ready to press the Define button to change the definition of Normal*
When Cancel Isn’t Cancel. In almost every Macintosh application, you use the Cancel button when the action you were contemplating is not to be taken. You tell the Mac to delete your life’s work; it asks, “Are you sure?” and you click on Cancel. Here, Cancel (or the close box) means, “get me out of the Define Styles box and back to editing.” Any changes to the style sheet you made with Define are intact.

Justification and First Line Indentation: Changing the Body Style

The paragraphs of the body of the letter as you have designed it thus far have ragged right edges and a one-half inch indentation on the first line. This is a fairly informal look for a business letter. You can make the letter look cleaner and more formal if you justify the right edge of the body paragraphs and remove the extra indentation of the first line. The straight right margin will produce a look that counters the typewriter look produced with the Courier font.

While the previous section accomplished a change to all styles by changing Normal, this time we want to affect only the body style.

- Again bring up the Define Styles dialog box (use % T). Select the body style.
- The ruler contains the key to changing justification, so if it isn’t already showing, expose it now.
- Between the 3- and 4-inch marks on the ruler are the four icons that determine justification. Probably the left-most icon, for flush left, is highlighted. Click on the right-most icon to change to justified text.
- Drag the first indent (below the half-inch mark) to zero. You’ll see the definition of body change to Normal + Justified, Space Before 12 pt.
- Press the Define button and then the Cancel button to accomplish the style change and see the result.

An Exercise

Figure 5.10 shows our letter with quite a number of style changes, so that the look of the letter is quite different. Use this redesign as an inspiration for making some style changes of your own.
The Letter as a Template

It would be horribly time consuming to have to recreate a letter's style definitions for each new letter. Instead of starting with a blank document, start with a template for a letter and modify it. The template

<table>
<thead>
<tr>
<th>Victor Markovsky</th>
</tr>
</thead>
<tbody>
<tr>
<td>5269 Portola Way #201</td>
</tr>
<tr>
<td>Oakland, CA 94618</td>
</tr>
<tr>
<td>23 June 1989</td>
</tr>
</tbody>
</table>

Dear Victor,

Do you know what you're doing? Everyone I know at the Pacific Exchange is coveting every block of promised stock they can get from your investment bankers; the pundits predict the stock will go to eighteen minimum, max thirty-five. Reminds me of Aldus.

And then you show me a discrepancy between a draft of your annual report and your own figures on the company's bizarre debt situation? First, now we both go to jail if either of us trades in the stock and we get caught. Second, if you're wrong, I wish you wouldn't burden me with your suspicions. Third, if you're right, somebody at IA is going to make a major killing on this deal. Many tens of millions, all illegal. So watch your step, buddy. This reminds me of a case I heard about in the seventies. If I find a reference, I'll send you a copy.

In the meantime, my recommendation is not to play the hero. You must have some inside track on your company's stock. Best bet: get as much as you can and sell a week after it hits the street. If there's a major bust they won't bust you. Second best is forget all this and act surprised. Me, I'm shredding everything you sent me.

I hear nothing, I see nothing,

Brian Thompson
Financial Consultant

cc: Nobody.

Figure 5.10: This redesign of the letter was accomplished with five style changes.
has all the desired styles and the barest minimum of text. Figure 5.11 shows the original letter—before Helvetica—with modifications to reflect its function as a template instead of an example letter. Use the *Save As...* command in the *File* menu to give your template a descriptive name such as *Business Letter Template*.

Figure 5.11: *The text in the letter has been changed to reflect its function as a template.*
When you want to write a new letter, simply open the template. The return address and the closing will be correct; you can begin immediately to write the important parts. When you're done writing the letter, choose Save As... again, and save the letter under a new name (for example, Letter to Victor) so your template will remain unchanged.

Oops! I Used Save Instead of Save As. If you do that, your letter to Victor Markovsky will be called Business Letter Template, and the contents of your template will be gone. You saved the letter on top of the original template. The solution is to lock the template so you can't save over it.

To lock the template, use the Get Info... command on the Finder's File menu and click in the Locked box. Then when you save the modified template, Word will force you to give it a new name, thus preventing you from overwriting the original template's contents.

By the way, it is rather tedious to change a locked template, because you have to quit Word to get at the Finder's Get Info. But if you are using MultiFinder, you can switch to the Finder to lock or unlock a document and then switch back to Word to save. Certain file-utility desk accessories, such as HFS Locator Plus by PBI Software, Inc., will also do the job without leaving Word.)

Installing the Template on the Work Menu

If you use the template all the time, you should put it somewhere you can get at it easily. No place is more accessible than Word's menu bar. Just as we added a glossary entry to the Work menu in the last chapter, we can add a file name. When you select the file name, the file opens! Here's how to put the file name on the menu:

- Use %-OPTION+ (that's the % key, the OPTION key, and the plus key) to get a + for a mouse pointer.
- Using the +, choose Open from the File menu and select the document you want, in this case Business Letter Template. Instead of opening the document, Word will flash the menu bar, and the mouse pointer will return to normal.
The Work menu at the far right of the menu bar will now contain the name of your template document. Selecting its name will automatically open the document.

The contents of the Work menu will still be there tomorrow. This information, along with the default style definitions, the knowledge that you use Full Menus, and other information like that, lives in a file named "Word Settings (4)" in your System folder.

If you move the template into a different folder, Word will complain when you try to use the Work menu item. You will have to delete the command and add it again. To delete a Work menu item, use ~-OPTION-~ (that's the ~ key, the OPTION key, and the minus key) to get a — for a mouse pointer. Then select the offending menu item. The menu bar will flash and the document name will be gone.

What If the Letter Is Already Written?

Sometimes you will have to do the page layout on a document that is already written. Unless the author knows about defining styles (perhaps he or she has read this book), you will have to impose style definitions on the paragraphs in the document. Fortunately, there is a simple way to bring a set of style definitions (called a style sheet) from one Word document to another.

The letter you are about to work on should be open and, in case you have several documents open, its window should be on top.

Select Define Styles... from the Format menu, bringing up the now familiar dialog box.

Notice that the Open... command on the File menu is still active. Choose it and then select the Business Letter Template—the one that has the styles you would like to import. This does not open the template for editing, but brings in all the styles from the template instead. When Word has finished importing them, you will see their names listed in the scrollable list. Press the Cancel button to close the Define Styles dialog box.
Now go through and apply the newly imported styles to the appropriate parts of the letter. For example, select the entire body of the letter at once and choose **body** from the list of styles in the ruler's style selection box.

**Another Way to Apply a Style**

Here's a way to change the style of a paragraph without using the mouse. Type **~SHIFT-S**. The box in the lower-left corner of the screen will become highlighted with the word **Style**, as shown in Figure 5.12. Here you would type **inside address** and press RETURN. You have just changed the style of the selected paragraphs.

Word is smart enough to require you to type only enough letters in the style name to distinguish it from other style names, and it doesn't care about uppercase versus lowercase. In this case, just the letters **In** would have been sufficient. If no style matches, Word beeps at you. If more than one style matches, Word beeps twice at you. If you get stuck, type **~**. (Hold down the **~** key and press PERIOD.) You will pop back into normal editing mode without having made the change.

Importing styles from the template and applying them to the letter is much faster than building the design from scratch, and you are sure the result will conform to the standards you set in the template.
For More on Various Topics

Redefining Styles—To learn to redefine styles by example, using the style selection box, see Chapter 6.

Font substitution—For more on what happens when you allow the Mac to substitute PostScript fonts for bitmapped fonts, see Appendix E.

Page breaks—To learn how to keep the last paragraph of your letter and the closing from getting broken up by a page break, see the "About Page Break Problems" section in Chapter 11.

Page numbers—For a better way to deal with page numbering than that offered by print preview, see the discussion of headers in Chapter 12.

Page View—See Chapter 6 for more on the mode called page view.

PostScript letterheads—To see how to incorporate a beautiful PostScript letterhead into your template, see Chapter 16.
A few years back, I worked for the police, producing reports and managing office automation. I left, looking for fulfillment and adventure. In a whole year of private investigation I circled the drain of personal bankruptcy and never landed a single interesting case. I gave that up for financial security and a career in desktop publishing.

Now my best friend was being held for murder.

I looked again at the letter to the dead man that I held in my hands. He was going to go to the meeting with His Nibs last night. All the high-ups in Operations were supposed to be there. That was Brockmyer, Delgado, Chuck Hines, and a few of Brockmyer's academic cronies. I couldn't help but think the melodramatic: Victor knew too much.

I was rereading the letter for the fifteenth time when the overhead fluorescents chattered into life all over the warehouse. I slipped the letter back into the case, shut it, and stood the case in the knee well of my desk. Who was coming in at 6:15 on Saturday morning?

The whistling told me. Brahms's Viola Sonata. It had to be Chuck Hines. He would walk by my desk in a few seconds; I flipped on the Mac and the hard disk so it would look like I was working. The chime sounded like one o'clock at the foot of the Campanile. I hoped he wouldn't notice. The program for the stock bash arranged itself on the screen an instant before his head poked into my cubicle. It was wearing a frown supported by several chins. His forehead glistened and his collar was soaked. First thing in the morning, too. I took the offensive.

"You're in early, Mr. Hines," I said, as cheerily as possible, "Thanks for the material about your string quartet. Do you know who I talk to about the courses in the dinner?"

"Umm, Morton, I think."

"By the way, have you seen Victor?"

"No, why?"

"Didn't he come to your meeting last night at Dr. Brockmyer's?"

Hines has small eyes. They got smaller. "I didn't know that was public knowledge. But no, he did not. We were expecting him, but he didn't appear."

Charles Stuart Hines left a sweaty chill behind him. When I turned to my Mac, something fell into place.
Emil Brockmyer, Ph.D., founded Immaculate Assessment in 1984 fulfilling a long-standing dream of his to serve corporate needs for hard-to-get information with unobtrusive measures and sophisticated qualitative evaluation techniques.

The Emery Quartet has performed throughout the greater Bay Area since 1987. IA's own Chuck Hines wields the viola in the group. Tonight we have a special treat — the world premiere of Love and Transfiguration by local composer Alice Land.

Eleanor Hass, Violin
Edgar Spenser, Violin
Charles Stuart Hines, Viola
Alice Land-Markovsky, Cello

Turgid Sturgeon is an acclaimed Baha Nasa group that has appeared on West Coast Weekend and at Ned's Mile Hi Club in Albany. The group's first album, You're A Fish, has just been released and is available at fine record stores throughout the East Bay.

Milo Brockmyer, Vibes & Alto Sax
Stella Rose, Bass
Ed, Keyboards
E. T. Rubin, Drums
EVENT
PROGRAMS

Creating an event program is an interesting desktop publishing task. It will extend our understanding of paragraph formatting and styles. The design elements of a program—lists of pieces and performers, descriptions of the performing groups, title, place, and time—are familiar, but how do you get them to come out right on the page? We'll stress again the importance of using styles so you can experiment easily with different possibilities. You will be using some new features of Word to get the effects you want, including columns, various kinds of tab settings, and controlling page breaks. The design focus of this chapter is how to control the space that text occupies to get a balanced visual effect on the page.
The Overall Plan

Here's the plan: first we'll present a thumbnail of a program to establish what the program is roughly supposed to look like. Then we'll identify the different elements of the document and decide how they should be formatted. As we decide on the page layout, we'll find that we need layout techniques we haven't covered yet. We'll discuss these new techniques in the next section. We'll then define the styles we will use before we type any text.

When we actually type in the text and evaluate how it looks on the page, planning really starts to pay off. The solutions for the program will be generic solutions that will serve you in many similar situations.

By the way, the program will be printed sideways on the paper and folded in half.

Creating the Thumbnail

This program will cover the events that are to take place at an evening party: a string quartet, a fancy dinner, an after-dinner speech, and dancing to a live band. Elements of the printed program include a title for the event, the time and place, a list of pieces to be played by the quartet, a menu for the dinner, a brief biography of the speaker, and a list of the musicians.

Having listed the program's elements, the next step is to make the thumbnail of the program, such as the one shown in Figure 6.1.

Figure 6.1: A thumbnail for a generic program. Note that it is a two-column document on one sideways page.
While our program may not end up looking exactly like this, we can see what we have in mind. When you plan a program for your own event, sketch the whole thing on paper even before you know the words—just to get an idea of what elements you might have.

Now for the elements in our program. These are shown in another thumbnail, Figure 6.2, one specifically adapted to the program we are going to make. Remember that each of these elements will be represented by one or more paragraph styles. Because our formatting decisions will be embodied in styles, it will be easy to experiment with different possibilities.

Figure 6.2: The thumbnail for the example concert program with annotations for each element. These will correspond to paragraph styles later on.

**New Techniques**

The thumbnail makes it clear that the program will require some new page-layout techniques:

- To get the print to come out sideways on the page
- To get two columns of text on a single page
• To get the name of the piece left justified while the composer’s name is right justified on the same line

**Paper Orientation**

First let’s get the page sideways. In almost all Macintosh applications, the power to control page orientation lies in the Page Setup dialog box, which you invoke from the File menu. Figure 6.3 shows the icon for printing sideways, that is, in *landscape* orientation, being selected. The default orientation for a new document is *portrait*. The paper orientation you set in Page Setup holds for the entire document; you can’t change orientation halfway through.

![Page Setup dialog box](image)

*Figure 6.3: The Page Setup dialog box with landscape orientation selected*

Depending on what version of the LaserWriter printer driver you are using, you may see a dialog box that differs in small ways from Figure 6.3. We’ll deal with other options in later chapters.

**Margins**

Recall that margins are the milestones from which indents are measured. Most text will be printed inside the page’s margins. Word’s default margins are one inch on the top and bottom and 1.25 inches on the left and right. These rather wide margins won’t leave enough room on the page for each of our two columns of text, so we are going to reduce the left and right margins to 0.75 inches.
Margins are a property of the document, and you get to change them by selecting **Document...** from the **Format** menu. This brings up the dialog box shown in Figure 6.4. Change the left and right margins; then click on the **OK** button.

![Figure 6.4: The Document dialog box showing the left and right margins changed to 0.75 inches](image)

Word shows you the width of the working page on its ruler. With the ruler showing, scroll the document window to the right until you can see the $9 \frac{1}{2}$-inch mark. The short dotted line above the right indent shows the page margin. Figure 6.5 shows why the page width is $9 \frac{1}{2}$ inches instead of 11.

### Formatting Columns in the Section Dialog

Word’s **Format** menu shows four levels of formatting you can control: character, paragraph, section, and document. Just as paragraphs are collections of characters, **sections** are collections of paragraphs. Many documents, including our event program, have only one section. When we format the section, we can specify that we need two columns.
Select Section... from the Format menu. This brings up the powerful Section dialog box shown in Figure 6.6.

We are interested only in the box labeled Columns in the lower-left corner of the dialog box. Change the number from 1 to 2.

Figure 6.5: Putting a $3/4$-inch margin on the left and right sides leaves $9\ 1/2$ inches as the working width of the page.

Figure 6.6: The Section dialog box in its default state
The box labeled **Spacing**: is used to specify the amount of space between columns. But how much space do we want? Remember that this piece of paper is going to be folded in half. Ultimately, we'll want the left and right margins of each half of the paper to be the same. Therefore, if the left and right margins are each \(\frac{3}{4}\) inch, we'll want the space between the columns to be \(1\frac{1}{2}\) inches, as shown in Figure 6.7.

**Figure 6.7**: Allowing \(1\frac{1}{2}\) inches between the columns leaves 4 inches for text in each column.

- Set the **Spacing** to 1.5 inches.
- Click **OK**. If the ruler is showing, you will see that the right margin is at four inches. Figure 6.7 shows why. After you take away \(\frac{3}{4}\) inch each for the left and right margins, and \(1\frac{1}{2}\) inches for the space between columns, and divide the result by 2, you get 4.

**Tab Settings**

With the section formatting complete, we're ready to learn about some features of tab settings that we'll use in the program. Under the left side of the ruler numbers there are four types of tabs and the vertical bar, as you can see in Figure 6.8.
To set a tab, drag the icon for the kind of tab you want to the desired place on the ruler line. You can also click on the number line, thus deploying the currently selected tab to the place you click. To get rid of a tab, drag it anywhere off the number line.

Tab settings, like other ruler controls, apply only to the paragraph that the cursor is in or to the paragraphs represented in the selection. When you change the tab settings, be sure you know which paragraph’s formatting you are changing.

Each of the four different kinds of tab settings produces a different effect. Figure 6.9 illustrates how they behave.

We’ll be using the right tab in the program to line up the names of the composers, the groups that perform, and the speaker.

Figure 6.8: The ruler, showing four different kinds of tab settings. The left tab is the default and is currently selected.

Figure 6.9: An illustration of the four different kinds of tab settings
**Tab Leaders**

Sometimes we want to use *tab leaders*, characters that fill the space created by a tab:

Death and the Maiden.......................................................... Schubert

You could produce this effect by typing periods between the name of the piece and the composer’s name. But then you could not take full advantage of the right tab. Typing all those periods gets you into trouble the same way that typing spaces does. Word has the right tool to deal for this job, a *tab leader*. (What you are about to do will become part of the event program.)

» Make sure the concert program document window is in front.
» Drag a right tab to 3.75 inches.
» Type the name of a piece, “Death and the Maiden.”
» Press TAB. Notice how the cursor jumps to the right tab at 3.75.
» Type the name of the composer, “Franz Schubert.” Notice how old Franz’s name appears to the left of the tab. *Do not press RETURN at this time!*

» We have yet to put in the leader. Double-click the tab icon, the one you put at 3.75 inches in the ruler. This brings up a dialog box that provides additional control over tab settings in the ruler.
» As shown in Figure 6.10, select the dots leader.
» Click **OK**. You should see the program line with the periods, as shown in Figure 6.11. Notice that the tab icon on the ruler now has a small dot to remind you that it has a leader.
» Now we’ll put in another line. Press RETURN, then type “Love and Transfiguration,” a tab, and the composer, “Alice Land.”

As we hoped, the two titles line up on the left and the two composers line up on the right. The two paragraphs have the same formatting (including the same tabs and tab leaders) because the second was formatted the same as the first when you pressed RETURN. If you had pressed RETURN before formatting, the formatting would have affected only the new—empty—paragraph.
Defining the Styles

Now to define the styles that we will use in creating this document. In Chapter 5, you learned to define styles with the style selection box on the ruler and to modify them using the Define Styles dialog box. Here, we'll do the opposite: we'll create the new ones in Define Styles and modify them later using the style selection box.

We'll step through defining the first two styles carefully and then turn you loose to define the rest using style descriptions like the ones we introduced in the last chapter. Remember as you do this that each of the styles can be changed, so if you see something that isn't quite right, don't worry. We'll fix it at the appropriate time.
The Music Style: When It's Already Formatted

The first style applies to the paragraphs we've been working with—the style for the music element.

- Select both paragraphs. (Clicking in the selection bar next to the first paragraph and dragging down to the second is a good way to do this.)
- Move the left indent in one-quarter inch so it will be symmetrical with the right tab one-quarter inch in from the right. The first indent will follow the left indent.
- Select Define Styles... from the Format menu (or use \&-T). Notice the description of the paragraph format in the box. That will become the style definition.
- Type music into the Style: box. It should look like Figure 6.12.
- Click OK. You have just defined the new style and applied it to the two selected paragraphs.

Figure 6.12: The music style, ready to be defined. Note the ruler settings for the paragraph with the tab showing and the left indent moved.

The Title Style: Formatting in the Dialog Box

Looking ahead to Figure 6.14, you can see that we have been working on a portion of the event program about one quarter of the way down from the top. Let's switch now to the title line at the top.
- We need to have a blank first paragraph. Position the cursor before the first character.
- Press %0-OPTION-RETURN. This will insert a new paragraph (of style music) and put the cursor in it.
- Set the style of this new paragraph to Normal. We do this so we won’t be basing the title style on the music style.
- Select Define Styles... from the Format menu (or use %0-T). This brings up the Define Styles dialog box.
- You should see New Style selected in the list of styles. Give the new style a name by typing title into the Style: box.
- If the ruler is not visible, make it so (Show Ruler on the Format menu). Select the icon for centered text. Notice that after you select the centering icon, the style definition in the dialog box changes from Normal + to Normal + Centered. The Define Styles dialog box is recording your formatting changes in the style definition.
- The title lines for the event program should be in a larger font. With the Define Styles dialog box still open, select 18 Point from the Font menu. You should see the style definition change to Normal + Font: 18 Point, Centered, as shown in Figure 6.13.

Figure 6.13: The formatting for the title style has been set and we’re ready to press the OK button.
Press the OK button. This will define the style and apply it to the current paragraph. Now go ahead and type in the two title paragraphs.

To summarize, what you have done in this section is to define a style from scratch with the Define Styles dialog box open. It wasn't until you pressed the OK button that you actually changed the format of the current paragraph.

You can even define styles for paragraphs that don't yet exist by using the Define Styles dialog box. Just select New Style, do the formatting, and press Define. Remember not to press OK unless you want the current paragraph(s) to become that style!

The Other Styles

For the remaining styles in the event program, we'll give you the definitions, and you choose which of the following three methods you want to use to define them:

- Create a paragraph with the desired formatting and then type the new name into the style selection box (as we did throughout Chapter 5).
- Create a paragraph with the desired formatting and then bring up the Define Styles dialog box to make the definition.
- Start the style definition from scratch with the Define Styles dialog box open as we just did.

In any case, be sure to pay attention to which style your new styles are based on when you define them. They should all be based on Normal. In fact, the main thing that can go wrong when you define these styles is the following gotcha:

It's Not Based on Normal. You might forget that a new style is supposed to be based on Normal. Be sure to start each new style definition with a Normal paragraph. To check, open the Define Styles dialog box, select the style name in question, and see if Normal is written in the Based on: box. This gotcha is especially insidious, because if you mess up, the document will look fine, but strange things will happen when you redefine styles.
The following is a complete list of the style definitions, including two we have already defined. We start with **Normal**, in which we set the font—Palatino—for the entire document.

**Normal**  The entire program inherits its font from this style.  
Font: Palatino 12 Point, Flush left  

**title**  This style is for the main title of the program.  
**Normal** + Font: 18 Point, Centered  

**intro**  This style is for the large lines after the title that announce the time and place of the event.  
**Normal** + Centered  

**event**  This style is for the main divisions of the program; each such line will have the "what" left justified and the "who" (if applicable) right justified (we use a tab stop for this).  
**Normal** + Space Before 12 pt, Tab Stops: 4 in Right Flush  

**music**  This style is for the musical numbers. The name of the piece will be on the left, the composer on the right. The dots at the end of the style definition refer to the tab leader—the periods between the piece and the composer.  
**Normal** + Indent: Left 0.25in, Tab Stops: 3.75in Right Flush  

**menu**  This style is for the courses of the meal.  
**Normal** + Centered  

**artists**  This style is for the lists of artists. The artists should be separated by tabs.  
**Normal** + Font: 10 Point, Italic, Tab Stops: 1 in Centered; 3 in Centered  

**bio**  This style is for biographies of important persons or groups on the program.  
**Normal** + Font: 10 Point, Space Before 12 pt  

Notice that the text for our event program is not yet finalized—the actual dishes in the menu have not yet been typed in. You work on aspects of the design of a document even before the text has been finalized.
Identify Elements First

It is important that you identify elements of a project that will manifest themselves as paragraphs of different styles. It is not important that you know all the text before you start solving desktop publishing problems.

Typing In Text and Setting the Styles

Figure 6.14 gives overall instructions for typing the program for this gala event. The arrows point to the style changes that you should make as you type. Note the use of a SHIFT-RETURN followed by a TAB in the paragraph listing the president’s address. SHIFT-RETURN is an invaluable formatting friend. It’s called a newline character; it moves the cursor to the left indent on the next line without creating a new paragraph. If Show ¶ is on, the SHIFT-RETURN looks like ←; otherwise it’s invisible.

As you type, you’ll see a column four inches wide. That’s fine, but what happens when you get to the second column? In galley view, you won’t see the second column because...

What You See Depends on Your View

Galley view shows the document as one long continuous stream of text and graphics. Use it to enter and edit the text. What you see in galley view may not be what you get when you print.

Page view (accessed through ⌘-B or the Document menu) shows you a more accurate representation of the printed page. But editing in page view is slower than editing in galley view because Word has to take care of a lot more display details. Use page view as you refine your page layout.

Print preview shows you a reduced view of the page, nearly exactly as you will get it on paper, but you can’t edit the text. Use it liberally as you approach the last stages of page layout, just before printing.
Immaculate Assessment
Stock Offering Gala

6PM, July 1, 1989
The Grand Ballroom
Hotel Magnifique
Emeryville, California

Music
The Emery Quartet

Death and the Maiden
Franz Schubert

Love and Transfiguration
Alice Land

Dinner
Appetizer
Soup
Fish
Meat
Salad
Dessert

Address
Emil Brockmyer, Ph.D., President, Immaculate Assessment, Inc.

Emil Brockmyer, Ph.D., founded Immaculate Assessment in 1984 to fulfill his long-standing dream of serving corporate needs for hard-to-get information with unobtrusive measures and sophisticated qualitative evaluation techniques.

The Emery Quartet has performed throughout the greater Bay Area since 1987. Chuck Hines wields the viola in the group. Tonight we have a special treat—the world premiere of Love and Transfiguration by local composer Alice Land.

Eleanor Haas, Violin
Edgar Spencer, Violin

Charles Stuart Hines, Viola
Alice Land, Markovsky, Cellist

Turgid Sturgeon is an acclaimed Bahia Nova group that has appeared on West Coast Weekend and at Earl's Mile Hi Club in Albany. The group's first album, You're A Fish, has just been released and is available at fine record stores throughout the East Bay.

Milo Brockmyer, Vibes & Alto Sax
Stella Rose, Bass

E. T. Rubin, Drums

Figure 6.14: Typing the text with annotated style changes
So when you have enough text to have two columns, you can see them both at once if you use print preview (§-I) or page view (§-B). Use the same commands to get back to galley view for editing.

**Fixing the Page Layout**

If everything went well, you probably saw some pretty nice formatting happen automatically—in the event paragraphs, for example. Other parts of the program might not look so good yet. We’re going through successive refinement of the design, gradually fixing all the problems until everything looks right. Let’s divide the problems with the current layout into five broad categories:

- Horizontal positioning
- Vertical positioning
- Column breaks
- Balance

Formatting problems are often interrelated in important ways. You can’t always count on a fixed problem staying fixed when you fix something else. Part of the skill of doing page layout efficiently is recognizing how to avoid having to go back and make some time-consuming changes again.

We’ll take you through the modification of this program as we might do it.

**Horizontal Positioning of Paragraphs**

We don’t have to look at a print preview to see that the music paragraphs look too crowded. There are two obvious ways to make them look less crowded: make the margins narrower (the text column wider) or make the font smaller. If the font were smaller, the paragraphs would be less crowded because the words would take up proportionately less horizontal space. In this case, however, we have so little actual text on that first page that a smaller font is inappropriate. Therefore, we’ll make the margins narrower:

- Change the left and right margins in the Document dialog box to 0.5 inch.
Because of that column arithmetic we discussed before, you have to reduce the column spacing in the Section dialog box from 1.5 inches to 1.0 inch. All fixed? Not quite. Look at Figure 6.15, which shows what’s on our screen after we make the changes.

![Offending tab setting]

**Figure 6.15:** After changing the margins and the space between columns. The cursor is just before the word “Music.”

**Centering Has Gone Wrong.** The music lines are no longer centered under the title. Both the margin and the right indent used to be at 4 inches. Now they’re at 4.5 inches. That’s correct. But the tabs didn’t move: they are set relative to the left margin. In the paragraph with the cursor, for example—with event style—the right tab at 4 inches used to be at the right indent. Now it’s one-half inch shy. So you must redefine all the styles that have tabs.

It’s not so bad; let’s go through the first one, step by step, this time using the style selection box on the ruler instead of the Define Styles dialog box.

1. Put the cursor in the first event paragraph and move the right-justified tab at 4 inches to 4.5.
2. Select the name of the style in the box at the left of the ruler. (Click on it once.) It will turn black.
3. Press ENTER (or RETURN, or in fact, click anywhere except in the little box). A dialog box will appear.
Select "Redefine the style based on selection" and click OK. All the event paragraphs will be reformatted.

Now make appropriate changes to the other tabs in the style sheet. There is one tab in the music style and two in artists. Make the change, select the name of the style, press ENTER, and tell Word you want to redefine the style.

Check it out. The lines are now centered in the column. Still, it was a bit of a pain. This is an advertisement for planning your margins carefully before you start setting tabs.

Before we go on, though, we should reflect on the different ways we know to define and redefine styles.

> Which Way Should I Make a Style?

We've learned two ways to make and modify styles: you can use the style selection box in the ruler or use the Define Styles dialog box. In most circumstances, using the ruler is easier: you don't have to bring up a box that obscures your text; you just make what you want and define it.

So when do you use the box? First, use it if you have to modify Normal or some other style for which there's no paragraph. Second, use it if you have to fix the inheritance chain—changing which styles are based on which. Third, it's faster if you're defining a whole slew of styles and you haven't made the examples yet. Fourth, use the Define Styles dialog box to import styles from other documents. And fifth, you need the box to specify the Next Style, which we'll discuss in Chapter 7.
Vertical Positioning of Paragraphs

The next problem we'll tackle is vertical space. If your program is like ours, there should be a big jam-up at the bottom of the document, as shown in Figure 6.16. The artists' names are too close to their bios; the design would benefit from some white space around them.

One solution is to put a blank paragraph above them as vertical space. We try to avoid that for the same reasons we avoid using spaces for horizontal positioning.

A better solution is to change the definition of artists to include 12 points of space before each paragraph. That would be OK, but then there would be space before each paragraph. The names look best together; we don't want the space in the middle. Figure 6.17 shows what happens when we modify artists.

There are many ways to solve this problem. What should we do? SHIFT-RETURN will come to our rescue: replace the RETURNs after the second Violin and after Keyboards with SHIFT-RETURNs by removing the ¶ mark (selecting it left-to-right or backspacing over it from the

---

**Figure 6.16:** The artists paragraphs are too close to the bio.

---

**Figure 6.17:** With space before, the space between the bio and the artists paragraphs is OK, but they're too far apart from each other.
following line) and typing SHIFT-RETURN. Now you have two paragraphs instead of four, one for each group of artists. When we changed the artists style to include 12 points of space before, we got Figure 6.18.

The Emery Quartet has performed throughout the greater Bay Area since 1987. IA's own Chuck Hines wields the viola in the group. Tonight we have a special treat—the world premiere of Love and Transfiguration by local composer Alice Land. ¶

Turgid Sturgeon is an acclaimed Bahia Nova group that has appeared on West Coast Weekend and at Earl's Mile Hi Club in Albany. The group's first album, You're A Fish, has just been released and is available at fine record stores throughout the East Bay. ¶

Milo Brockmyer, Vibes & Alto Sax ¶ Edgar Spenser, Violin ¶
Eleanor Haas, Violin ¶ Alice Land-Markovsky, Cello ¶
Charles Stuart Hines, Viola ¶
Stella Rose, Bass ¶ E.T. Rubin, Drums ¶

Figure 6.18: The end of the document on our screen after the paragraphs have been joined by pressing SHIFT-RETURN and changing the definition of the artists style

That looks much better. The groups are set off from one another and retain their cohesion on the page. The trick was a judicious use of SHIFT-RETURN, which produces a new line without making a new paragraph.

The Return of WYSIWYG: Page View and Column Breaks

Because we have been editing in galley view, the text has appeared as one continuous stream. At last, it's time to switch to page view to find out where the first column ends and the second begins. If we're lucky, the program itself will be on the left side and the biographies and lists of artists will be on the right.

Choose Page View from the Document menu. (%-B toggles back and forth between page view and galley view.) You will see dotted lines delimiting various blocks of text; they will not appear when you print out.
Page view is so named because you work on one page of your document at a time. The entire piece of paper is represented, including the margins. In contrast to print preview, you can edit your document in page view. As you edit, changes you make are reflected in the layout on the screen. For a two-column document such as this concert program, page view offers significant advantages over galley view when you get to the stage of caring about column breaks and other layout problems.

Unless you have a very large screen, you will have to use the horizontal and vertical scroll bars to look over the entire page. Alas, when you do, you will see that there is a bad column break—the biographies start on the first page. Figure 6.19 shows the entire page at once as you would see it on a large screen. On a small screen, you may wish to switch back and forth between page view and print preview where you can see a reduced version of the page. %I takes you to print preview; once there, you can double-click on the document to be taken back to page view with the spot you clicked visible in the window.

Figure 6.19: Page view of the program as you would see it on a very large screen
Bad page breaks cause a lot of problems in layout. But in this case, because there is plenty of room, the solution is simple. Word provides a special character that forces a new page or new column to begin.

Still in page preview, position the cursor in front of the president's bio and type SHIFT-ENTER. The portion of the text at the bottom of the first column will move up to the top of the second. Figure 6.20 shows the new page. If you look back in galley view, you will see a dotted line extend across the screen, indicating that a page or column break occurs there.

Typing SHIFT-ENTER inserts a page-break character, sometimes called a hard page break. Using it in your document can cause no end of trouble, because as you edit or reformat, the hard page break you carefully inserted is no longer in the correct place. This is the only example document in this book that has a hard page break. From now on, we will use the other, more flexible tools that Word offers for solving page-break problems.
Design Issues

You can make a career out of design. This book will not tell you everything; in fact, the main purpose of this book is to tell you how to realize your design using Word rather than to tell you how to decide what you want. Nevertheless, we can give you an example and try to connect solutions to our design problems with Word techniques.

In this project, for example, we’ve really dealt with two issues: the relative importance of different elements and balance on a page.

The Relative Importance of Different Elements

The title is more important than the name of the second violinist. People need to read easily what order events come in; they can miss the blurb for the band, but they had better not miss dinner. These practical considerations demand that different elements receive different emphasis.

In this program, we have used font size, font style (italic and boldface), and paragraph spacing to differentiate various text elements. It’s only common sense that bigger is more important. It is also pleasing to the eye to have some white space surround each element to set it off from its neighbors. Using italics for one element (for example, artists) also helps to set that element off. Boldface type stands out, so you can use it to emphasize important text, such as the names in the bio paragraphs.

Too much italic or too much bold looks busy and crowded. If you’re worried your project has too much, print a draft and get somebody else’s opinion. The same goes for too many font sizes. We’re pushing the limit with four sizes (24, 14, 12, and 10) for our two-column program. We have not even mentioned different fonts as a method of setting off one type of text from another, but “hyperfontia” is an easy disease to catch.

Balance

The main thing we’ve worried about in this document is balance. You need balance, both horizontal and vertical, as well as a pleasing relationship between white space and text.

You control overall balance and use of space with the Page Setup, Document, and Section dialog boxes, because that’s where the margins, page orientation, and number of columns are set.
We did not have much trouble with horizontal spacing in this project. Word's built-in tools—the tabs, indents, and justification icons—did what we needed.

The Problem of Unbalanced Vertical Space

Although the document looks very much like a program for something, it is unbalanced. The words are too high on the page. The underlying cause of the extra white space is not enough text. (Usually you’ll be faced with the opposite problem.) A page that looks too empty is an interesting and genuine desktop publishing problem. Here are some reasonable solutions:

• Add text or graphics to fill the space. A graphic border on the top or bottom might be nice, but we won’t deal with graphics until Chapter 8, so let’s see what else we can come up with.
• Increase the space between paragraphs.
• Widen the left and right margins, squeezing the text to make it longer. This will work on the right-hand column, but we’ve widened the columns already for aesthetic reasons, so we don’t want to undo the work we’ve already done.
• Make the type larger. We have been using 12-point type for text in our left column. But 14 point is a pleasant, readable type for something that people are likely to be reading quickly in a room that is not brightly lit. The material in the bios in the right column can be increased from 10 to 12 points. You might need to increase the point size of the title style as well to keep its headline quality relative to the rest of the text.
• Increase the space between lines.
• Increase the top margin. That way you can better center the text on the page.

We will use a combination of approaches to balance the design of our program, but in this case, it makes sense to deal with font sizes first. We won’t mess with the margins until we know how far the text is going to extend. We won’t give you step-by-step directions for this, but here is what we did:

• We changed the definition of Normal from 12 point to 14 point.
• We changed blo from 10 point to 12 point.
• We changed the definition of title to 24 point and gave it 12 points of space before, so it would line up with the blo at the top of the right column. This splits the two title paragraphs too much, so ... 
• We replaced the paragraph mark (RETURN) between the two title paragraphs with a newline (SHIFT-RETURN), just as we did with the artists paragraphs.
• The music paragraphs looked too big, so we made them 12 point instead of the 14 they became when Normal was changed.
• The text still seemed too crammed together on the page, so we increased the line spacing of the Normal style to 1 1/2. The ruler has three line-spacing icons: single space, space and a half, and double.
• Finally, we increased the top margin to 1.25 inches, adding a bit more white space at the top.

Figure 6.21 is the resulting print preview. Notice how much better the balance of the page is.

Figure 6.21: Before and after views of our program showing the changes described in the text

At this point, we could go on and use other techniques to improve the balance of the page. We could print out the program to see how much we might want to change the margins. We could write additional text to fill in or get an artist to draw a border.

Word doesn't provide an option that automatically adds space between lines or paragraphs to fill out the page. It pays, therefore, to
remember a variety of approaches and to consider many of them when you are faced with a problem of text that takes up too much or too little vertical space. So let's recall the list of techniques we considered when we needed to fill up more of the columns (they can be used to shrink text as well as expand it):

- Add (Delete) Text or Graphics. People generally write too much; cutting something out usually makes the writing better. On the other hand, you will frequently have bits of text it might be helpful to include.

- Widen (Shrink) the Margins. The more space you reserve for margins, the less space you have for text. Wide margins give an expansive appearance to a document, provided text isn't crammed between them. On the other hand, narrower margins allow for more text, which might be OK if you have enough white space embedded in the text itself. Margins are controlled in the Document dialog box from the Format menu.

- Change the Paragraph Spacing. Vertical space can be created or absorbed by changing the space between your paragraphs. You can change the Space Before and Space After measurements for your paragraphs in the Paragraph dialog box from the Format menu. Of course, you can do this most elegantly if you change style definitions rather than individual paragraphs.

- Change the Font Size. Use the Font menu or the Character... command in the Format menu. Tiny letters are hard to read. If you use anything less than 10 points for something your friends need to read, lots of them will complain. On the other hand, a paragraph of text larger than 14 point looks like you're making a book for first-graders. That may not seem like a lot of play, but remember that given fixed margins, the vertical space taken up by text varies as the square of the point size. That means that you get almost a 2:1 compression by changing from 14 point to 10 point.

- Change the Line Spacing. Do this with the line-spacing icons on the ruler or with the line-spacing setting in the Paragraph dialog box. Most text is single spaced, so increasing the space between lines even a little bit makes the document seem special, important, or even extravagant. But if you increase line spacing too much, you run the risk of calling to mind all those double-spaced papers we typed in school.
Balanced but Boring

Alas, balance doesn’t necessarily do it for you. Your document may come out balanced but rigid and boring. As with so many things, the art is in breaking the rules or applying them in unusual ways. Still, boring but functional is sometimes better than innovative but useless—and always better than ridiculous.

Customization Corner

Cleaning Up the File Menu. One way you can make Word easier to use is to eliminate unnecessary items from menus. If you don’t use Microsoft Mail, the Open Mail... and Send Mail... items on the File menu are just cluttering things up. To get rid of them, type %E-OPTION-- (that’s %, OPTION, and the minus key) to get a — for a cursor, and then select one of the target items from the File menu. Repeat for the other item.

Adding Keyboard Commands for Document... and Section... You will use these two commands frequently as you do desktop publishing with Word. You may want to create keyboard shortcuts for them. (If you are using an extended keyboard, you already have shortcuts %F14 and OPTION-F14.)

► Select Command... from the Edit menu and scroll the list of commands. Select Document... by clicking once on it.
► Press the Add button.
► When asked, press a combination of keys, including %, that you wish to use. Word will give you a chance to change your mind if you have chosen a keyboard shortcut that is already in use.
► Repeat with Section....

We happen to like %TAB and %SHIFT-TAB. When you close the Command dialog box by pressing Cancel, you will find that the Format menu carries reminders of your new shortcuts in it.
For More on Various Topics

**Hard page breaks**—Though we used one here, we begin to look at better ways to control page breaks in Chapter 11.

**Multiple sections**—For how to use sections to change the number of columns midstream, see Chapter 9.

**Page view**—We'll do more work in page view throughout the rest of this book, the next time in Chapter 8 when we use it to help create a flier.

**Too many fonts**—See Chapter 3, where we have a discussion about using too many fonts.

**Vertical justification**—Problems with vertical justification come up in Chapter 13.

**White space**—Chapter 3 has more on using white space.
Alice Land, the composer, was Victor’s ex-wife. Victor had gotten a phone call from someone named Al and rushed off in a cab. That had been at 2:30, and if Hines was telling the truth, he didn’t appear at the meeting that evening. My mind rushed ahead. Victor always had a glass of slivovitz in the early evening. Suppose he sees his ex-wife. They quarrel. He thinks they make up, but they don’t. They go to his place. She poisons the slivovitz. Dead Victor.

Suppose, instead, that someone from the company wants Victor dead before the meeting. That person goes to Victor’s apartment while he’s still at work or at his ex-wife’s. Same poison, same corpse.

Now suppose that Victor hears something awful from Alice. She will expose something from his past, say. He writes the note himself and delivers it to Clara. He commits suicide without ever having to confront her. With the time she spent crying over the note, he had just enough time to die. The poison would have to be fast—cyanide, for example.

Too many possibilities, too many questions. If I was going to help Clara, I needed more information. Some was smoldering in the briefcase under the desk, and more was to be had from my old buddies in the police when they showed up, which was going to be soon. And they were going to want that briefcase. Time to be methodical for a change.

Daylight filtered through the fog and the glass-block walls of our warehouse office as I stood at the copier, pulling staples out of the documents from Victor’s case. I piled the whole lot in the feeder. I stood with my back to the machine and looked over the cubicles as it worked. Out there, somewhere, was Chuck Hines.

When I got back to my desk, I restapled the originals and put them back in the briefcase. I looked at my copy of the letter from Victor’s broker and put it aside. Then I picked up the next document in the pile. It was Victor Markovsky’s résumé.
Résumé of Victor Markovsky

Employment Objective
Tax Manager, Supervisor, or Director for financial, service, or industrial corporation

Education
Graduate work in accounting at San Francisco State University
B.S., Rutgers University

Personal Data
Age 31, divorced, excellent health

Experience
1987 - Present: Accountant, immaculate Assessment, Inc.
Responsibilities
Maintain accounts, supervise clerks and bookkeepers, upgrade software, write budget portions of proposals and balance sheets for final reports.
Contributions
Worked with auditors in preparation for public offering of stock. Streamlined accounting process, eliminating need for one clerk position. Developed method to partially automate tax preparation.

1983-1987: Assistant Accountant, Jenco Photographic Supply
Responsibilities
Maintain accounts, supervise clerks and bookkeepers, upgrade software, write budget portions of proposals and balance sheets for final reports.
Contributions
Streamlined accounting process, eliminating need for one clerk position. Developed method to partially automate tax preparation.

1981-1983: Bookkeeper, Brightway Camera Shop
Responsibilities
While in college, supervised school managed the books for this large store.
Contributions
Advised management on techniques for automating the sales and inventory recording processes.

Other Interests
Desktop publishing on the Macintosh computer

References
On request
RÉSUMÉS

In this chapter, we will create a simple chronological résumé and introduce two important tools. First, we will use Word's built-in outliner to organize and type the résumé. We'll see that the outliner provides a different view of a document, one that focuses on its structure rather than on its layout; we'll also see that the headings in the outline view are automatically assigned styles that facilitate the page-layout process. Second, we'll use Word's powerful table feature to format the résumé with main headings in a column to the left of the text, thus improving its appearance. We'll also introduce another way to make working with styles easier—the Next Style part of a style definition.
The Importance of Design in a Résumé

What a strange document a résumé is. In this brief statement, you place not only a summary of your work life, but an advertisement for yourself. Often, your résumé is one of hundreds submitted for a single job. Most are skimmed and placed in the reject pile. While a beautiful design cannot overcome deficits in writing—or in qualifications!—appearance plays an important role in convincing the personnel officer that your résumé is worth a careful reading.

Form and Function

Résumés take many different forms. Most have a clear structure based on the chronology of your work life or the different kinds of work you have done.

For such a résumé, the design question is, "How can headings and text be placed attractively on the page so that the reader will know immediately what is going on?" The form should recede into the background, bringing the function—the explanation of your career goals and why you are the right person for the job—to the foreground.

Another kind of résumé—a narrative or creative résumé—may have much less structure. To take an extreme example, if you were to look for a job as a designer with your skills in desktop publishing, you might want the page layout itself to serve as testimony to your creative powers and aesthetic sensibilities.

In our example, however, we will create a one-page, structured résumé. Most of this page will consist of a listing of the jobs held in reverse chronological order.

Outlining and Page Layout

The most obvious reason for using an outliner is that it will help you organize what you are writing. You may think of outlines as helping you organize very long documents—and they do—but there's no reason you can't use the same technology to help you organize something as short as this résumé. Outlining may also help you overcome the intimidation of the blank page.
A less obvious reason to use Word's outliner has to do with page layout. As you will see working through this chapter, each level of the outline has a style associated with it. So the outline's logical structure is eventually reflected in the visual structure of the page.

Word offers you four different views of your work, each with a different purpose:

- Outline view to create and edit the document's structure
- Galley view for normal editing
- Page view for true WYSIWYG editing, page by page
- Print preview to check that the layout is exactly right before printing

An outline view and a galley view of the same document usually look quite different, as you can see in Figure 7.1. On the top is a portion of the résumé seen in galley view. On the bottom is an outline view of the entire résumé, in which only the headings are showing.

**Using Outline View**

To use Word's outliner, select Outlining from the Document menu, or use the %U keyboard shortcut. To get back to galley view, select Outlining again. Outline view differs from galley view in several ways:

- A bar of outlining icons replaces the ruler.
- Character formatting disappears (but you can turn it back on).
- Paragraph indentation is determined by the place in the outline rather than ruler settings.
- You can use the mouse to drag entire sections around on the page, or to expand and collapse sections.
- The arrow keys and the +, −, and = keys on the keypad behave differently than in galley view.

**Setting the Outline Levels**

Let's get started. This outline will have three levels of headings. We'll work our way from the broadest down to the most detailed.
CH. 7

Employment Objective
Tax Manager, Supervisor, or Director for financial, service, or industrial corporation

Education
Graduate work in accounting at San Francisco State University
B.S., Rutgers University

Personal Data
Age 31, divorced, excellent health

Experience
1987 - Present: Accountant, Immaculate Assessment, Inc.
Responsibilities
Maintain accounts, supervise clerks and bookkeepers, upgrade to Macintosh-compatible software. Write budget portions of proposals and balance sheets for final reports.
Contributions
Worked with auditors in preparation for public offering of stock. By changing accounting software, saved $30,000 per year.

Open a new document.

Notice that in this document, the style of the paragraph containing the cursor is Normal. Switch to outline mode by selecting Outlining from the Document menu or typing ^-U. Notice that now the style, as shown in the status box, has changed to heading 1.

Type the major headings of the résumé, pressing RETURN at the end of each line. The illustration at the top of the next page shows how your document should look.
The Resume

<table>
<thead>
<tr>
<th>←</th>
<th>←</th>
<th>←</th>
<th>←</th>
<th>←</th>
<th>←</th>
<th>←</th>
<th>←</th>
<th>←</th>
<th>←</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
</tr>
</tbody>
</table>

- Employment Objective
- Education
- Personal Data
- Experience
- Other Interests
- Referenced

The ▲ in front of each paragraph indicates that the paragraph is a heading with no subtext.

Controlling the Hierarchy

An outline is, by its very nature, a hierarchical thing. The main headings have subheadings, and these have subsubheadings, and so on, as deep as you like. Word assigns the style heading 1 to the main headings, heading 2 to subheadings, heading 3 to the subsubheadings, and so on, up to heading 9.

As with many operations, Word provides several different techniques for accomplishing the same thing. Let's take a look at them.

Arrows on the Icon Bar

Just beneath the title of the document, where the ruler would be in galley view, is a strip of arrows and numbers called the icon bar. For now, we are concerned only with the first two icons on the bar, the left and right arrows shown in the illustration above.

As you might expect, the left-pointing arrow moves the paragraph containing the selection to the left, promoting it to a higher level in the hierarchy, and the right-pointing arrow moves this paragraph to the right, demoting it to a lower level. (If the selection spans more than one, all the paragraphs are moved in parallel.)

Arrow Keys

The left and right arrow keys on the keyboard accomplish the same thing as the arrows on the icon bar. If you are accustomed to using the arrow keys on the keyboard to move the cursor around, this may surprise you. For better or worse, the arrow keys behave completely differently in outline view than they do in galley view.
The TAB Key Is Not an Arrow Key. The TAB key \emph{appears} to move an entry to the right, demoting it to a lower level. But if you watch the style box in the lower left of the document window, you will see that the level does not change as TAB is pressed. What you get is a high-level heading that starts with a TAB.

**Dragging with the Mouse**

A final way to promote and demote paragraphs is to click on the icon to the left of the paragraph and drag it to the left or right. As you move the mouse pointer over the icon, the pointer becomes a $\rightarrow$, indicating that you can drag the paragraph up, down, right or left. As soon as you begin dragging, the pointer changes to a $\leftrightarrow$. If you move the pointer far enough to the right or left, a dotted vertical bar appears that indicates the new position the paragraph will assume if you release the mouse.

**Back to the Résumé**

Beneath the "Experience" heading, we want one subheading for each job:

- With the outline view showing, position the cursor after the word "Experience" and press RETURN. This opens up a new paragraph, still at the same level.

- Choose one of the above ways to demote the (still empty) paragraph to heading 2. Notice that the $\Rightarrow$ icon in front of the Experience heading changes to a $\Rightarrow$ icon, indicating the presence of a subheading underneath it.

- Type in the subheading. Your document should now look something like Figure 7.2.

- Type the remaining jobs that go under "Experience," pressing RETURN each time you want to type a new one.

**Heading 3: Responsibilities and Contributions**

Under each job heading, we would like two subsubheadings: one for responsibilities and another for contributions. Create these just as you did the subheadings.
The two arrow icons move the selected paragraphs to the left or right one level at a time.

Icon bar-

Icon indicating heading with something underneath

The paragraph containing the cursor has been demoted to heading 2.

Here is the cursor.

Figure 7.2: We have typed the first subheading under "Experience."

- With the cursor at the end of the first job heading, press RETURN. As usual, this opens a blank heading.
- Demote the heading one level (to heading 3).
- Type "Responsibilities," press RETURN, then "Contributions." You have just created two headings with the style heading 3.
- The two headings you have just typed get repeated under each of the other job entries. Copy and paste twice.

Typing Body Text in Outline Mode

With the headings of the outline complete, we have only to type the body text under the headings. In Word's outline mode, any paragraph that does not have a style named heading 1, heading 2, and so on up through heading 9 is considered body text.

- Position the cursor at the end of a heading line and press RETURN to open up a new paragraph.
Keyboard shortcut to denote body text

- Click on the icon to change the style of the new paragraph to Normal. Notice that the cursor moves over half an indent to the right. (The keyboard shortcut for is ~RIGHT ARROW for those keyboards that have a RIGHT ARROW.) The icon in front of the paragraph changes to , indicating body text.

- Type whatever text goes in this paragraph. Your document will look something like this:

You could type the entire résumé in outline view. We have reasons, however, to take you back to galley view to see what the document looks like there and explore some new properties of styles.

**Back in Galley View**

To switch back to galley view, select Outlining from the Document menu or use the ~U shortcut. (The outlining command toggles back and forth between outline view and galley view.) When you do, you get something like Figure 7.3.

Notice that first-level headings are bold, underlined Helvetica, and have 12 points of space before. Second-level headings are bold Helvetica and have 6 points of space before them. Finally, the third-level headings are in the Normal font, bold, and are indented \( \frac{1}{4} \) inch to the right. What you are seeing is the result of the default definitions for the heading styles in Word.
But where did the formats for the headings come from? Here we can begin to see the power of the integrated outliner: Word has assigned special styles to the headings to make page layout easier. Heading 1, heading 2, and so forth are examples of automatic styles.

**About Levels and Automatic Styles**

When you open a new document, it comes with one style, Normal. But Word has 32 more styles, called automatic styles, just waiting for an appropriate moment to surface! Heading 1 is one of these automatic styles, and its appropriate moment is when you enter outline view.

You may have wondered about the bullet that appears in front of Normal in the Define Styles dialog box. Word uses this bullet to inform you that Normal is one of its automatic styles. If you bring up the Define Styles dialog box (you have to have left outline mode to do this), you will see that heading 1 has been added to the list of styles.

In this dialog box (shown at the top of the next page), you can also see that Word’s default definition of the heading 1 style is Normal + Font: Helvetica, Bold Underline, Space Before 12 pt. There is nothing fixed about this definition, of course; when we get to doing the résumé’s page layout, we’ll change it.

In addition to headings, Word uses automatic styles to help you format other things, including a table of contents, an index, the headers and footers at the top and bottom of pages, and footnotes.
Defining the Body-Text Style

Time to get prepared for the rest of the body text. We need to define a style to use for those paragraphs. Let's call it para and define it as follows:

para  This style is used for most of the descriptive information in the résumé.
Normal + Indent: Left 0.5in

Eventually, when we make the résumé really pretty, we'll refine para, but this is good enough for now.

⇒ Apply the para style to any paragraphs of body text you have already typed.

Using Next Style for Convenience

Now you want to add the body text. If you position the cursor after a heading 1 heading in galley view and press RETURN, you'll find yourself in a Normal paragraph. This is Word's default behavior for heading 1. Contrast this with the default for any style you define—the new paragraph created with RETURN gets the same style as the old one. We don't want either of these behaviors.

Fortunately, there's a way to change a style's definition so that the following paragraph gets any style you want. In this case, we want the next style after a heading 1 or heading 3 paragraph to be para.
In the **Define Styles** dialog box, select the **heading 1** style. As shown below, the lower-left corner of the dialog box has a box labelled **Next Style**: Change the name in that box from **Normal** to **para**.

![Define Styles Dialog Box](image)

- Click on the **Define** button (*not* the **OK** button).
- Change the next style for **heading 3** to **para** in the same way. Click **OK**.

*We don’t need to change the style for **heading 2** in this design, because the way we’ve set up the résumé, there is no body text following a **heading 2** paragraph.*

- Now you can easily type the descriptive paragraphs that go under each heading. Simply position the cursor at the end of the heading line and press RETURN. You will see that the style of each newly opened paragraph is **para**.

---

**Next Style Saves Time**

When you create a document from scratch, you will find it extremely helpful to include a Next Style in your style definitions where appropriate.

Now when we show you a style definition, we will include the name of the Next Style if that is appropriate. For example, here is the redefinition of **heading 3**:

**heading 3**  Used for the headings under each job

Normal + Bold

Next Style: **para**
A heading is not the only kind of paragraph that is consistently followed by a paragraph of a different style. Recall the styles defined for a business letter in Chapter 5. It would have been quite appropriate to define *inside address* as the next style after *return address*, *body* after *salutation*, and so on, throughout the entire letter. A style for a paragraph that contains a figure that is followed by a caption is another good example.

**What If I Want the New Style as the Next Style?** When you define a new style, you might think that it would be perfectly all right to specify that the next style is the new style that you are defining. If you try, you will get this cryptic alert:

![Name is not a style name.](image)

Word is confused. It tries to look up the name of the next style but can't find it because it has not yet been defined. So don't specify *any* next style. Word's default behavior is to set the next style as the current style—exactly what you want.

**The Address and Title**

At the top of the résumé there are four paragraphs with two different styles. Figure 7.4 shows what they look like, along with the style definitions. The *address* style is the same as *Normal*—we define it separately to prepare for a time when we want to format it differently. Center the title using the ruler's center-justification icon.

As soon as we think about centering the title, we are at last beginning to concern ourselves with page layout. We're going to do three layouts of the résumé: one to show how easy it is to mimic a typewritten appearance, and the next two to show a more polished look.

**A Typewriter Page Layout**

While we don't imagine that you will want your résumé to look as though it has been typed, we think it is instructive to see how few
changes you need to make to produce this effect. Figure 7.5 shows what we’re aiming for.

We’ll go through the styles that need changing. Consider first the Normal style, the basis of every other style in this style sheet. As usual, we set the font for the entire document here. Because we want a typewriter font, we’ll choose Courier. The size depends on how close things are to fitting on one page. As it turns out, 12-point Courier causes the résumé to run over a few lines onto a second page, so we’ll go with 10-point Courier.

The first-level headings require the most emphasis. About the best we can do to give them a typewritten appearance is to put a blank line of space before them and underline them. (Remember that you can specify underlined text in the Character... item of the Format menu or use the $\text{X-SHIFT-U}$ shortcut.)

Remember that if you have the Define Styles dialog box open and heading 1 selected, you can change its definition to Normal + by pressing $\text{X-SHIFT-P}$.

The level 2 headings must have somewhat less emphasis than level 1. So we’ll keep the space before, but we won’t use underlining.
Résumé of Victor Markovskj

Employment Objective
Tax Manager, Supervisor or Director for financial, service, or industrial corporation

Education
Graduate work in accounting at San Francisco State University
B.S., Rutgers University

Personal Data
Age 31, divorced, excellent health

Experience
1987 - Present: Accountant, Immaculate Assessment, Inc.
Responsibilities
Maintain accounts, supervise clerks and bookkeepers, upgrade to Macintosh-compatible software. Write budget portions of proposals and balance sheets for final reports.
Contributions
Worked with auditors in preparation for public offering of stock. By changing accounting software, saved $30,000 per year.

1983-1987: Assistant Accountant, Jonco Photographic Supply
Responsibilities
At this $50,000-per-day mail-order company, handled daily transaction sheets, supervised three clerks, helped introduce computerized bookkeeping practices, trained entire staff in new system.
Contributions
Streamlined accounting process, eliminating need for one clerk position.
Devised method to partially automate tax preparation.

1981-1983: Bookkeeper, Brightway Camera Shop
Responsibilities
While at graduate school managed the books for this large store.
Contributions
Advised management on techniques for automating the sales receipts and inventory recording processes.
Kept store from attempting to computerize its books with inadequate hardware and software.

Other Interests
Desktop publishing on the Macintosh computer
Photography, including color darkroom work
Bicycle racing

References
On request

Figure 7.5: The resume formatted to mimic what you would get with a typewriter

heading 2 Used for the subheadings: the names and dates of individual jobs.
Normal + Space Before: 12 Point

The Responsibilities and Contributions headings, at level 3, should be clearly subservient to the headings for the job titles at level 2. We'll
accomplish that by removing all the space before and indenting one-quarter inch.

**heading 3**  Used for the headings under each job—“Responsibilities” and “Contributions.”  
Normal + Left Indent: 0.25 in  
Next Style: para

We will indent the paragraphs that actually give descriptive information one-quarter inch more than **heading 3**.

**para**  Used for paragraphs of descriptive information.  
Normal + Left Indent: 0.5 in

The **address** style is already OK, but we can’t resist jazzing up the title just a bit by changing its font size to 12 points. After all, you could change the type ball in the typewriter.

**title**  Applied to the title at the top of the page.  
Normal + 12 Point, Centered

Now the résumé has a clear, simple look to it—nothing special, but certainly satisfactory. Let’s see how much better we can do.

**The Résumé in a Table**

We want the résumé’s page layout to take advantage of some of the tools that Word offers us. We want it to look more attractive than a typewriter-style layout and to be even easier to read. Figure 7.6 shows one of many possibilities.

In contrast to the typewriter-style layout in which indentation and underlining are used for emphasis and to indicate the hierarchical structure, this layout separates the two highest level headings from the rest of the text by placing them in a narrow column on the left. These are known as side headings. These headings are boldfaced to make them stand out clearly from the job titles. Similarly, the third level of headings are italicized to distinguish them from the descriptive paragraphs. The pleasingly asymmetrical result allows the reader to skim down the side headings to get an overview and then zoom in on an interesting part.
Side Headings with a Table

Word provides several different ways to create side headings. We saw, in the script example at the end of Chapter 4, how outdented paragraphs can make side headings. But outdented paragraphs don’t
work at all for this résumé, because we want some of the side headings to contain several lines of text.

If you step back a bit from Figure 7.6, you can see that the text lies within a two-column table, one in which some of the rows are taller than others. Figure 7.7 shows a thumbnail of the résumé with a grid for the proposed table. Word's ability to manipulate tables makes it easy to accomplish what might otherwise be very difficult.

---

Figure 7.7: A thumbnail of the résumé showing how the layout conforms to a table with varying row height

**Ingredients of a Table**

A table contains rows. The rows may have different heights and different numbers of columns.

A row contains cells, all with the same height, one for each column.

A cell may be empty, or contain one or more paragraphs.
Perhaps you think of a table as good for manipulating rows and columns of numbers; indeed, Word handles these numeric tables with ease. But with Word’s tables you can also do some surprising things.

**Table Practice**

We’ll first practice using a table to make side headings before we try them in the context of the résumé. Using all Normal paragraphs, it will be easy to see the kinds of tangles we can get into.

Here we go, step by step, through the simplest possible example: a one-word side heading to the left of a short paragraph.

1. In a new document, type in something like this:

   - Perhaps you think of a table as good for manipulating rows and columns of numbers; indeed, Word handles these numeric tables with ease. But with Word’s tables you can also do some surprising things.

   - We’ll first practice using a table to make side headings before we try them in the context of the résumé. Using all Normal paragraphs, it will be easy to see the kinds of tangles we can get into.

   - Here we go, step by step, through the simplest possible example: a one-word side heading to the left of a short paragraph.

   - In a new document, type in something like this:

   - Perhaps Victor is tired of working at Immaculate Assessment.
   - Perhaps he’s being forced out by someone. If he’s done something wrong at IA, it might be a motive for suicide.

   - We want the first paragraph, “Reasons,” to become a side heading for the second paragraph. In terms of tables, we want a table with one row and two columns, the left column much narrower than the right.

   - Select all of both paragraphs and choose Insert Table from the Document menu. Word will convert the selected text to a table, suggesting the number of columns and rows. In this case it suggests one column and two rows.

   - But we want two columns, so change the Number of Columns box accordingly, noticing that Word alters the number of rows based on the number of paragraphs selected. When you press the OK
button, the two paragraphs will shift so that they are in two separate columns.

With the cursor somewhere in the table, press the ruler's scale icon (the last one on the right). The right-indent triangle on the ruler will disappear and two column markers will take its place, one near the 3-inch mark and the other near the 6-inch mark. These markers allow you to change the width of the columns.

![Column markers](image)

If you press the scale icon on the ruler again, you get a ruler that shows the text margins and the paper edge.

Try dragging the column markers around. The right marker will move with the left marker unless you hold down the SHIFT key as you drag. Set the left marker at 1.5 inches and the right marker near 6 inches. This gives us the narrow left column and wide right column we want.

**Adding New Rows to a Table**

We're going to need more than one row for this résumé. You might suppose that you would add a row by positioning the cursor at the end of the last row and pressing RETURN. Not so; here is what you get:
Backspace out that ¶ mark and try pressing TAB. Ah, a new row.

| Reasons* | Perhaps Victor is tired of working at Immaculate Assessment. Perhaps he's being forced out by someone. If he's done something wrong at IA, it might be a motive for suicide. |

A Cell Is Like a Page

You should think of a table cell almost as a separate page in your document. A cell can hold many paragraphs, each with its own formatting. So when you press RETURN in a cell, you get a new paragraph, not a new cell.

In a table cell, press RETURN to get a new paragraph and TAB to move to the next cell or create a new row.

Table Cells and Paragraph Formatting

Move the cursor into the "Reasons" side heading. Change the style of that paragraph to heading 1.

No Heading Styles on the Ruler. You may have tried to use the drop-down list of styles on the ruler to make the change to heading 1. If so, you probably found that it was not there. You haven't used heading 1 in this document yet, so it doesn't appear in the lists. But you can force Word to display all the automatic styles in the list by holding down the SHIFT key while you select the arrow.

Misaligned First Lines. When you do get the side heading formatted as heading 1, you will see that the top of the heading does not line up with the top of the body paragraph to its right.
By looking at the ruler, we see that the **heading 1** style includes 12 points of space before, while the right-hand paragraph, with the **Normal** style, has no space before. The simple fix is to assign the right-hand paragraph a style that includes 12 points of space before.

**Tabular Résumé**

Having experimented with formatting paragraphs in a table, we are ready to return to the résumé. Starting from the typewriter-style résumé, we want to achieve the result you saw in Figure 7.6. We are going to make some mistakes along the way so that we can point out some properties of tables.

1. Select the "Employment Objective" and "Education" sections of the résumé and issue the **Insert Table** command from the **Document** menu. Set the number of columns to 2. Your screen should resemble the top half of Figure 7.8.

2. Press the **OK** button. The bottom half of Figure 7.8 shows what you get. Let’s make a list of things that need fixing.

![Insert Table dialog box](image)

**Figure 7.8**: Before and after. The **Insert Table** dialog claimed we would get three rows, and we did.
• The column widths are wrong.
• The body paragraph is indented too far.
• The top of the heading doesn’t line up with the top of the body paragraph.
• Because there were two paragraphs under “Education,” the paragraph in the last cell in the left column belongs in the right column.

Independence of Column Width

You already know how to change the column width for a table with a single row. What about if the table has several rows? We’ll do it wrong first.

Position the cursor in the top-left cell.

The ruler must be showing. Press the scale icon once so that the column markers are visible.

With the SHIFT key held down, drag the left column marker to 1.5 inches. Here is what you get:

- Move the mouse pointer to the top of the left column. The pointer will change to a downward-pointing arrow; if you click the mouse, you will select the entire left column of the table. The illustration at the top of the next page shows what you will see.

The ruler has gone gray, to remind you that different portions of the selection have different ruler settings, but you can drag the markers anyway. First drag the left column marker (holding down the SHIFT key) to 2 inches. The ruler becomes black and white again. Finally, drag the left column marker (with the SHIFT
key still down) back to 1.5 inches. The column widths for all three rows are now correct.

**Styles Inside Cells**

The body text paragraphs are indented from the left edge of the cell, putting too much space between the side heading and body text. Because a cell is like a page, ...

---

**Indents in Table Cells**

Inside a cell, the left and right indents of a paragraph are indents from the left and right boundaries of the cell, not the page margin.

A cell paragraph’s indents are measured from the cell boundaries.

---

The fix is simple—we redefine `para` so that it has no left indent. While we’re at it, we may as well add 12 points of space before. This time, as in Chapter 6, we’ll use the style selection box on the ruler to accomplish the style redefinition instead of the `Define Styles...` command. Besides getting more practice, we learn that a paragraph in a table has a style just like any other.

1. Position the cursor in a paragraph in the right column.
2. Click on the ruler’s scale icon until you get the usual left and right triangular indent markers.
3. Drag the left indent to zero. Notice that this zero is relative to the cell’s left boundary, not the page margin.
Click on the ruler's open space icon.

Click on the ruler's style selection box. Here is what you have:

- Press ENTER. You get the dialog box asking if you want to reapply the para style paragraph (thus undoing our reformatting), or redefine the para style. Select the latter and press the OK button.

Ah, now we're getting somewhere. But what about that errant paragraph in the lower-left corner?

Moving Paragraphs in a Table

First of all, how did that paragraph get in the wrong column? Recall that we created the table with the Insert Table... command. What Word did then was to place the first paragraph in the left column, the next paragraph in the right column, the next in the left, and so on. Word had no way of knowing that we want two consecutive paragraphs in the right column.

Let's move the offender into the right column. We could put it in a right-hand cell all to itself, but let's put it in the same cell as the preceding paragraph, so we won't have extra, empty cells cluttering things up. We will experience a table gotcha.

Move the mouse pointer just to the left of the first line of the cell in question. The pointer takes on the shape of a northeast pointing arrow. Click the mouse to select the entire cell, including the end-of-cell marker.
Choose **Cut** from the **Edit** menu (or use \%-X). You might expect that the cell would disappear, but, in fact, the cell stays and its contents are cut.

Here comes the gotcha. Position the cursor at the end of the preceding paragraph and **Paste**.

**Pasting Replaced the Entire Cell.** When you copy or cut the end-of-cell marker (the ‘•’), the entire cell goes into the clipboard. Word won’t let you paste a cell within a cell; instead it replaces the selected cell with the one in the clipboard. To accomplish what we want here, we go back and get just the paragraph that we want to add to the cell.

- Select **Undo** (\%-Z) to restore the vanished cell.
- Move the cursor to the empty cell and paste. (It should appear on the **Edit** menu as **Paste Cells**.)
- This time, instead of selecting the entire cell, select only the text within the cell and cut it.
- Move the cursor to the end of the preceding paragraph and paste. Much better—the cell now has the desired two paragraphs.

**Filling in the Rest of the Table**

Having seen that the **Insert Table**... command cannot deal with this particular table, we will finish the résumé formatting by adding a new row to the bottom of the table for each set of paragraphs we have to put in the table. Along the way we’ll encounter some problems.

- Open two more rows in the table by positioning the cursor in the last cell and pressing **TAB** repeatedly.
- Select the three paragraphs from "Personal Data" to "Experience" (including the ¶ marks). Cut (\%-X) them.
- Select the two empty rows at the bottom of the table by dragging the mouse from the top-left empty cell to the bottom-right empty cell.
- Now paste (\%-V) the contents of the clipboard. As shown below, this brings up a **Text to Table** dialog box. See that it looks like the picture and click the **OK** button.

••
Because we have selected complete cells, we are not merely inserting text into a cell, but converting text into table cells. Word has to know how we want these new cells configured. Thus the dialog box. In this case (three paragraphs and four cells), we have one empty cell at the end.

If our text alternated left to right without exception, we could just cut and convert the whole thing at once. Since our text is complex, we have to be more careful. We’re ready now for the heart of the résumé.

- Make another new row in the table and cut and paste the next two paragraphs ("1987 – Present" and "Responsibilities") into it.
- The next few paragraphs—up to the next date—belong in what is currently the last cell in the table, the one with the "Responsibilities" heading. Select and cut them.
- Position the cursor after "Responsibilities" and press RETURN, thus opening up a new paragraph in the same cell. Paste the clipboard. Here is what you should have:

<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Responsibilities:</td>
</tr>
<tr>
<td>Maintain accounts, supervise clerks and bookkeepers, upgrade to Macintosh-compatible software. Write budget portions of proposals and balance sheets for final reports.</td>
</tr>
<tr>
<td>Contributions:</td>
</tr>
<tr>
<td>Worked with auditors in preparation for public offering of stock.</td>
</tr>
<tr>
<td>By changing accounting software, saved $30,000 per year.</td>
</tr>
</tbody>
</table>

- Notice that the cell contains one too many lines. You can BACKSPACE out the last line as long as its style is the same as that of the preceding paragraph. In this case, they are both para so the BACKSPACE works. Otherwise, you would first have to change the style of the last paragraph to match that of the preceding one.
→ Continue adding rows to the table and moving paragraphs up into them until the entire table has been filled.

**Finishing with Styles**

With the text of the résumé moved into the table, we can easily finish the formatting by redefining the paragraph styles. We need to use a more appealing font, clean up indents and space before, and replace ugly underlining with typeset emphasis.

### Style Redefinitions

Choose a proportionally spaced, PostScript font, such as Times, and embody that choice in the definition of **Normal**.

- **Normal** Used in this résumé only to set the font.
  - Font: Times, 12 Point, Flush Left

The **heading 1** style will look much better with bold in place of underline for emphasis.

- **heading 1** Used for the main headings.
  - Normal + Bold, Space Before: 12 Point
  - Next Style: para

The **heading 2** style is already the way we want it. Note that the only difference between **heading 1** and **heading 2** is that the former is bold. The **para** style is already good enough for now, though we'll still have one correction to make to it later.

The third-level headings must have their left indent set to zero; and they need space before—12 points to match **heading 2**—and the subtle emphasis that italics provide.

- **heading 3** Used for the headings after each job—“Responsibilities” and “Contributions.”
  - Normal + Italic, Space Before: 12 Point
  - Next Style: para
With an asymmetric page design like this, a centered title doesn't look very good. Position it over the right column instead, that's half a ruler mark past 1.5 inches.

title  Contains the title of the résumé.  
Normal + 14 Point, Bold, Left Indent: 1.56 in, Space Before: 12 Point

Two Kinds of Paras

We're getting close, but, as you can see in Figure 7.9, we have too much space between certain paragraphs. It seems that some of the paragraphs with style *para* need 12 points of space before in order to line up with their side headings, while those that do not have side headings do not need space before.

You can fix things up with the ruler's No Space Before icon applied to each of the offending paragraphs. But a cleaner way—just in case you want to make changes later on—is to embody the fix in a new style. We'll end up with two styles, *para* and *close para*, the second based on the first.

---

Résumé of Victor Markovsky

**Employment**

Tax Manager, Supervisor, or Director for financial, service, or industrial corporation

Graduate work in accounting at San Francisco State University

B.S., Rutgers University

**Personal Data**

Age 31, divorced, excellent health

**Experience**

1987 - Present: Accountant, Immaculate Assessment, Inc.

*Responsibilities*

Maintain accounts, supervise clerks and bookkeepers, upgrade to Macintosh-compatible software. Write budget portions of proposals and balance sheets for final reports.

*Contributions*

Worked with auditors in preparation for public offering of stock.

By changing accounting software, saved $30,000 per year.

These need to be closed up.

Figure 7.9: Some *para* style paragraphs need space before; others don't.
Position the cursor in a **para** style paragraph that needs to be closed up. Click on the ruler’s No Space Before icon.

Click on the ruler’s style selection box and type **close para** as the name of a new style.

Press **ENTER**. Word will ask if you want to define **close para** based on the selection. Click **OK**.

Finally, apply the **close para** style to those paragraphs that need it.

**Three Columns, Anyone?**

Each entry in the experience section has two parts: responsibilities and contributions. Let’s put each in a separate column. In Figure 7.10, we’ve added a third column and moved the “Responsibilities” and “Contributions” headings to the top.

**Adding a Column to a Table**

The Experience section of the résumé will have three columns; the rest of the résumé will continue to have two columns. How do we add a third column to a portion of a table? Because Word treats each row of a table independently, we can easily add a column to some rows and not others.

Drag the mouse from the empty cell at the right of “Experience” to the last job description cell.

Select **Table...** from the **Edit** menu. Your screen should resemble that shown in Figure 7.11.

The options chosen in the **Table** dialog box are the ones we need. We want to add a piece to the table the size of the selection (thus **Selection** is checked), and we want to shift the selected cells horizontally, so the new piece comes out as a column rather than as new rows of cells. Press the **Insert** button.

*You may be surprised to find that the new cells have been inserted to the left of the selected cells. Word always inserts cells to the left or above the selection. The new cells end up selected.*
Résumé of Victor Markovsky

Employment Objective
Tax Manager, Supervisor, or Director for financial, service, or industrial corporation

Education
Graduate work in accounting at San Francisco State University
B.S., Rutgers University

Personal Data
Age 31, divorced, excellent health

Experience
1987 - Present: Maintain accounts, supervise clerks and bookkeepers, upgrade to Macintosh compatible software. Write budget portions of proposals and balance sheets for final reports.

1983-1987: Assistant Accountant, Jonco Photographic Supply
Streamlined accounting process, eliminating need for one clerk position.

1981-1983: While at graduate school
Advised management on techniques for automating the sales receipts and inventory recording processes.

Other Interests
Desktop publishing on the Macintosh computer
Photography, including color darkroom work
Bicycle racing

References
On request

Figure 7.10: The résumé with a three-column layout
Now we have to change the column widths of the two right-hand columns so they fit within the space. Click on the ruler's scale icon. Drag the column marker to the 3.75-inch mark. Figure 7.12 shows the desired result.

Leaving the empty cells selected, scroll the document to the right until you can see the ruler's column marker for the right edge of the third column. Drag this marker just to the left of the page margin at 6 inches.

With the column widths set, all that remains is to move the text around. Copy a "Responsibilities" heading into the top cell of the middle column and a "Contributions" heading into the top cell of the right column. Similarly, cut and paste each of the responsibilities body paragraphs from the right column into the left column.
Figure 7.12: The column width of the middle column has been set, but we still need to make the third column narrower.

For More on Various Topics

Using an outline to make a table of contents—Word can use the outline to construct a table of contents. See Chapter 11.

Side headings—A table isn’t always the best tool to use to create side headings. See Chapter 14 for how to make them with fixed-position paragraphs. Also recall the scripts in Chapter 4 in which a hanging-indent paragraph creates side headings.

Tables—Chapter 9 has more about tables. There you’ll learn about doing calculations and how to add boxes and lines.
Holding the résumé made his death harder to take. This man's office was just on the other side of the partition. Why was he carrying his résumé unless he was looking for another job? Were things that bad here? Behind all the tragedy and Clara's problems, I realized I was still thinking we would all get rich off IA stock. What if we were all about to be out of a job?

Suddenly a hand was on my shoulder. If I'd had any breakfast I would've lost it right then. It was a quarter to eight, and the police were here.

"If it isn't Delilah Stone, girl detective! How's word processing?"

"Emmanuel Davis, boy Sergeant," I gulped, "it's desktop publishing to you. Don't remind me why I left the force. Are you still holding my friend?"

"Are you asking professionally?"

"Personal interest. My licence expired, but I can't help having ideas."

"You answer my questions, I'll listen to your ideas. Deal?"

"Fine. First, you'll want this." I like Manny Davis. I handed him the briefcase. I told him everything I knew about Friday afternoon including the fact that Clara had left the office around dinnertime. I told him about Clara's visit to me this morning.

"I appreciate your sending her to the police as soon as possible."

"That wasn't the idea, Manny."

"I know. But that's why I can talk to you--and why I'm not noticing the copy of Markovsky's résumé under your keyboard."

"You're a prince. Say, you must have been at the scene when Clara showed."

He pulled out his notebook. "A neighbor heard a scream around midnight. We found the body. Bottle of some liqueur on the table and a cookie in his hand, one bite out of it. At 1:30 Clara McConnell, Ph.D., Vice President of Projects at IA, used a key to walk into our arms.

"That doesn't mean she poisoned the slivovitz."

"The liqueur was clean, Delilah--the cookies were lethal. Almond macaroons and cyanide, a match made in hell. She admits she made the cookies, but denies the poison. Look, I have to check out her desk and call in. Don't go anywhere. We still need to talk."

The cookies. Things were looking down. I knew I had to work fast. Once Davis was off sniffing around, I could get back to Victor's briefcase. When I saw what was next, I knew I was on to something.
Huge Going Out of Wedlock Garage Sale

Five years of married life means an accumulation of too much stuff. Cameras and film, photographic chemicals, books, skis, a sewing machine, a computer, dishes, bicycles, clothes, clocks, furniture, and tools. Tons more!

Come to our and see.
1039 Euclid Avenue
Saturday, July 2
FLIERS

Graphics and text, text and graphics—to work with them intermingled on the Macintosh screen has got to be one of the most wonderful and exciting parts of doing desktop publishing. This chapter is an introduction to basic concepts and techniques for integrating graphics and text with Word. We will deal with how to get graphics into your documents and what you can do with them once you get them there. We’ll format them, shrink them, and stretch them. We’ll see that one simple idea enables us to predict most of how the graphics will behave: Word treats each graphic as it would a single character, moving it around on the page as you edit the paragraph that contains it. Then we’ll put it all together to make a simple document—a flier. Word lets us position text and graphics almost as simply as a graphics program does; we’ll use that capability in laying out the flier.
Basic Graphic Techniques

Not too many years ago, before there was Macintosh, text and pictures never met on any affordable computer screen. Part of the excitement of the desktop publishing revolution comes from the ease with which we can now manipulate text and graphic images together. There are only a few concepts involved in getting graphics to behave themselves, but there are many techniques you can use. This chapter introduces most of the basic concepts and a few of the techniques, leaving the rest to be introduced gradually during the rest of the book.

Pasting Graphics

You can't draw a picture in Word, but you can bring one into your Word documents from a multitude of other sources. The Mac's clipboard provides a universal means for transferring text and graphics between applications and desk accessories.

From the Scrapbook (or Other Desk Accessory)

1. Choose Scrapbook (or another desk accessory that gives you access to graphics) from the menu. Use the scroll bar to look at the scrapbook's contents. Graphic entries are identified by 'PICT' in the lower-right corner. We found this champagne with balloons graphic in the scrapbook that comes on the Macintosh system disk.

2. Select Copy (⌘-C) from the Edit menu. This puts the graphic into the Macintosh clipboard.

3. Close the scrapbook by clicking on the close box in the upper-left corner.

4. Select Show Clipboard from the Window menu. You should see the graphic you just copied from the scrapbook. Use the Show Clipboard command whenever you are not sure what you have copied or cut.

5. Paste the graphic into your document.

From a Graphics Application without MultiFinder

Desk accessories make handy sources of graphics because you never need to leave Word to use them. But a full-fledged application,
such as SuperPaint or Excel, works almost as well. Just copy the graphic while inside that application, choose Quit, and fire up Word. Finally, paste the contents of the clipboard into your document. If you need to move several graphics, paste them into the scrapbook before you quit and then copy them out of the scrapbook once you’re back in Word.

From a Graphics Application within MultiFinder

Word comes with an excellent graphics program, SuperPaint. If your Macintosh has two megabytes or more of memory, you can run both Word and SuperPaint simultaneously under MultiFinder.

- Make sure you are running MultiFinder. (When MultiFinder is running, a small icon identifying the current application is displayed on the far right of the menu bar.) If you are not, use the Set Startup... command in the Finder’s Special menu and reboot.
- Start Word from the Finder.
- Go back to the Finder (one technique is to choose Finder from the menu). Start SuperPaint.
- Draw something using SuperPaint, and copy it.
- Switch over to Word. If your Word window is showing, just click in it to switch to Word. Paste your graphic. Figure 8.1 shows a screen with two small windows, one for Word and another for SuperPaint.

SuperPaint and Word work well together, but you can use any other graphics program under MultiFinder in nearly the same way.

A Graphic Is Like a Character

The camera (or whatever graphic you paste) goes immediately after the words you type on the same line. Suppose you keep on typing. You might get this:

Victor loved to learn about images. His long hours in the darkroom disturbed his wife and may have helped lead to the divorce.
Figure 8.1: Macintosh running in MultiFinder with a window for SuperPaint (above) and another for Word (below)

Try adding or deleting text before the graphic. Notice how the graphic keeps positioning itself in the flow of the text. You can also backspace over the graphic, erasing it as you would a normal character. This insight is so important that it's worth saying again.

**Graphics Behave Mostly Like Single Characters**

A graphic moves around in its paragraph just like a character, and space between its line and the line above is generated by Word as required.

Once we understand how characters behave, we also understand how graphics behave. Sometimes, however, we would like to use graphics in a less restricted way than Word allows.

Think of a graphic as a special character.
Character Formats Applied to Graphics

Just how far can we push the idea that a graphic is like a character? Let’s try imposing some of the character formats—underline, bold, italics, outline, shadow—on the graphic. First you have to select the graphic. Do this by clicking on it. As soon as you do so, the graphic gets a frame with handles like this:

Now you can try the various character formats using the Format menu. You will see that these formats don’t actually affect the graphic; rather, they affect only any outline or underline you have given the graphic. Italic has no affect at all.

You can also try character formats that may not appear on your Format menu by choosing the Character... command from the Format menu. Double underline might prove useful, for example.

Figure 8.2 shows what the Character dialog box looks like when you choose Double Underline.

Figure 8.2: The Character dialog box, showing double underline selected
Subscripting Graphics:
Controlling Vertical Position

You may wonder how to control the vertical position of the graphic. One way is to use the Subscript control in the Character dialog box. Here is the subscripted.

Subscripting a character means lowering its baseline. That's exactly what we've done to the single character that is the camera graphic. How do you subscript a character?

1. Select the characters you want to subscript.
2. Bring up the Character dialog box from the Format menu. That’s the box that appears in Figure 8.2.
3. Click the button marked Subscript in the Position box. You’ll see that the By: box changes to look like the one at the left. You can see that the default subscript is 2 points. That’s probably not enough for us.
4. Type 18 pt (or another point size) into the box, and click OK or Apply. The selected characters will be lowered by the amount you specified.

Superscripting is the opposite of subscripting, of course, and it works similarly.

Super- and subscripting were invented to be used in such phrases as H₂O and E = mc², but you can use these tools in ways for which they might not originally have been intended; formatting graphics is an excellent example of this.

Changing the Frame

Handles appear when you click on a single graphic to select it. You can drag the handles to change the size of the frame. On the next page, we show you what happens when you do this. The current size appears in the status box in the lower-left corner of the document window.
Drag the handle on the right edge of the frame changes the width of the graphic's frame. The graphic itself stays centered within the frame.

The width of the graphic shows in the status box.

Similarly, dragging the handle on the bottom edge of the frame changes the height of the graphic's frame. The graphic remains centered within the frame.

This time it is the height of the graphic that shows in the status box.

Dragging by the bottom-right handle changes the size of the frame but keeps the proportions constant.

The percent enlargement shows in the status box.

If you make the frame smaller than the graphic, the graphic no longer stays centered. Instead, only the upper-left portion remains visible.

**Reserving Space for Artwork**

While it is really wonderful to have the final graphics show on the screen, you will often have artwork on paper that must be pasted onto the master copy. You need to reserve space in your document for the artwork. Word's **Insert Graphics** command makes this easy.
Suppose, for example, that you are going to paste in a small photograph that is 1.25 inches square. With the cursor positioned at the place you will eventually want to paste the photo, select Insert Graphics from the Document menu. This command inserts a one-inch-square blank graphic into your text. You then select the graphic and change its frame to the desired size. Here is what a portion of your screen might look like with the blank graphic selected.

I Can't Find My New Graphic! Your graphic, being blank, will be invisible when you insert it. If you click on it, the handles will show, of course, but until then, how do you know where it is? First, you can use Show, which draws a dotted line around the graphic's frame. Once you have selected it, you can give it an outline so you can see it when Show is turned off.

If you want Word to draw a frame around the artwork, you can go further: set the frame to be the actual size of the artwork, make it a little bigger, and give it a bold outline or even a shadow outline.

To print nothing—you want blank space—leave the blank graphic without an outline. Remember, though, you'll have to use Show to see where it is in galley view.

Stretching and Shrinking

One of Murphy's laws dictates that the graphic never fits the space available. With a computer-drawn illustration, this need not be a problem. Word allows you to stretch or shrink the graphic at will. Again, the handles are the key, but this time you must hold down the SHIFT key as you drag the handle. (The SHIFT key modifies the effect of dragging on the handle to include resizing the graphic.) Look at some of the interesting possibilities and try them out yourself.
While all this sizing and scaling of graphics is extremely helpful, Word cannot solve all your problems of fitting graphics into your document. Suppose, for example, you wanted to crop the camera graphic so that only the lens in the center showed. You just can’t do it in Word. Or suppose you want to enlarge the graphic to 200% and then just make the frame a bit larger. Unfortunately, as soon as you resize the frame, the graphic goes back to its original size! You cannot move or size the graphic independent of the frame.

While it’s too bad that Word doesn’t give you more control over what the graphics look like, the chances are that the real control you
want lies in the graphics program that created the graphic in the first place. And that is exactly what we want to look at next.

**Sources of Graphics**

We don’t draw very well, and, to our disappointment, the computer has not changed this situation at all. It has simply given us another medium for producing bad drawings. As a result, when we can’t afford a real artist, we find ourselves looking for illustrations that someone else has drawn that will serve the current need. You can buy collections of illustrations, called *clip art*, to paste into your publications, copyright free. As desktop publishing has proliferated, so have the number of collections of high-quality clip art on disk. But computer graphics come in several different flavors, and it’s time to taste them.

**Picture Fonts**

Picture fonts are often overlooked as a source of clip art. While ordinary fonts produce letters when you type on the keys, a picture font produces a picture with each keystroke. This really isn’t as strange as it may seem at first; after all, a letter is a kind of picture, and from the Macintosh’s point of view, both letters and pictures are displayed by putting dots on the screen or on paper.

Picture fonts are available in the public domain as well as from commercial sources. Here is a sample of the pictures that come with one of the picture fonts—Cairo.

![Picture Fonts Example](image)

Some picture fonts, like Cairo, are bit-mapped and don’t look especially good on a laser printer (though they look better if you turn on the *Smoothing* option in the *Page Setup* dialog box). Other picture
fonts, such as Carta from Adobe Systems, are designed especially for laser printers. Some of the pictures in Carta look like this:

```
STUV WXYZabcd
efgmn\sq \Omega\sim`
```

Picture fonts provide a readily available and easy-to-use source of clip art. Don’t neglect them. Since Word treats each picture as a character, you can perform any of the usual character-formatting operations on it. Here are some possibilities with the Cairo rose.

Plain  Bold  Italic  Outline  Shadow  Bold & Italic

How are these graphics different from the camera we’ve been working with? The rose really is a character, while the camera is like a character. You can make an italic rose but not an italic camera, and when you select a Cairo rose, it doesn’t get handles.

**Paint Art—Working with Bit Maps**

When the Macintosh was first introduced, MacPaint was foremost among the programs that convinced early enthusiasts, including us, that a new age of computing had dawned. Whereas computer graphics had seemed awkward to create and ugly to look at, it now seemed that those with artistic inclinations could create beautiful and subtle drawings in this new medium of small black and white dots on the Macintosh screen. While artists can make wonderful illustrations in MacPaint, or in the paint layer of SuperPaint, the result can look chunky and “computation.” Why should that be?
The first part of the problem is resolution. A MacPaint drawing is a bit map—an array of black and white dots stored as 0’s and 1’s. Each bit represents one picture element or pixel on the Macintosh screen—the size of the dot on an i in most fonts. That may look small—the screen can fit 72 of these in a single inch, remember—but the human eye is much more discerning. You can read much smaller type on paper than you can on a Mac screen. Our printers make this possible: LaserWriters put out 300 dots per inch, and high-resolution “imagesetters” such as the Linotronic L300 can produce up to 2540 dpi.

The second problem is one of black and white. The dots are never gray. That’s one advantage a genuine photograph has. When dots can be gray, some graphics look much more real.

Since every dot on the Mac screen is visible to the naked eye, and every dot is either black or white, two things happen: smooth edges appear jagged, and gray areas have to be made of patterns of black and white dots. This is the source of the computer look.

**Bit-Mapped Art and the Computer Look**

Be aware that your readers will immediately recognize low-resolution bit-mapped art and may identify your document with computers. Whether or not that is desirable or tolerable is up to you.

Suppose you don’t want your graphics to have this computer look? What do you do? Printing real grays, called half-tones, is relatively expensive, and you can’t do it on a LaserWriter. But you can take advantage of the full resolution of your Laser printer to improve the look of bit-mapped graphics.

One way is to use the **Smoothing** option in the **Page Setup** dialog box. (It’s Word’s default; you have to turn it off if you don’t want to use it.) This feature allows the computer to make an “educated” guess about what to do with the extra available dots. Smoothing will usually improve the look of a bit-mapped illustration, but sometimes—especially if there are lots of grays—the computer’s educated guess will only make things worse. And not all laser printers can do smoothing.
Higher Resolution through Reduction

Because the Macintosh screen has so much less resolution than a laser printer, each dot in a bit-mapped drawing will print as a 4×4-square array of dots (approximately) on a LaserWriter. Now suppose we drag the handle on a graphic (with the SHIFT key down) to reduce the 72 dpi original to 24% of its original size. Since 72 dpi is 24% of 300 dpi, this will use every dot in the original as one dot in the Laser-printed copy. Of course, reducing by this much works only if the reduced image fits well into your document. If you reduce the graphics to sizes other than 24% or its multiples, the computer’s method of reducing will sometimes produce strange anomalies.

For the artistically talented, SuperPaint allows you to create bit maps at the 300 dpi resolution of a laser printer and combine them with 72 dpi bit maps and even draw art (see below). Because there are sixteen times as many bits to worry about, editing at this resolution will usually take much longer than editing an equivalent size graphic at lower resolution.

Draw Art—More Flexibility, Better Resolution

After MacPaint came MacDraw and object-oriented graphics. In drawing with MacPaint, or in the paint layer of SuperPaint, once you place a circle on the page, the black pixels that make up the circle are equivalent to each of the other black pixels in your painting. The circle loses its identity as a circle, just as paint from a brush doesn’t care which stroke laid it on a canvas. In MacDraw, or in the draw layer of SuperPaint, a circle, once drawn, retains its identity. You can move it, resize it, fill it with a different pattern, or delete it from the page, all without disturbing the other graphic elements.

Object-oriented drawing is a different medium than bit-mapped drawing, not a better way to do bit maps. You lose the fine control over each bit afforded by paint software and you gain the ease of editing that comes with treating the graphic elements as objects. But you gain something else as well—printing that automatically takes full advantage of the resolution of the printer, whether that be 72 dpi on an Imagewriter or 2540 dpi on a Linotronic. During printing, the computer instructs the printer to draw a line from one point to another or draw a circle with a given center and radius at the printer’s maximum resolution. Neither Word nor the graphics program needs to know the resolution of the printer.
Object-oriented drawings can be reduced or enlarged from their original size without loss of detail or increase in jagginess. The comparisons in Figure 8.3 show some of the relative advantages and disadvantages. The draw art image at the top left was scaled to 48% in Word to produce the image on the top right. The original image was converted to the bit map at the bottom left and then scaled to 48% and 24% to produce the two images at the bottom right.

*Figure 8.3: Comparing MacDraw and bit-map graphics at full size and reduced to 48%*
Here are two things to notice about scaling:

- The fill patterns do not scale in the draw art. Gray-scale patterns do well, but the scallops and crosshatches don’t fulfill their function at the smaller scale. On the other hand, we think the fill patterns in bit-mapped graphics actually look better reduced.
- Similarly, line thickness in draw art does not scale, so lines take proportionately more of the drawing at the smaller size. In bit-mapped drawings, the lines do scale and lose their jagginess at the smaller size.

It seems to us that the character of the two versions is very different, and that the differences are enhanced by reduction. We were surprised to find that we preferred the draw art at the original size but the bit map when it was reduced. Art on the LaserWriter is a subtle business!

**To Paint or To Draw?**

*Which should you use? It depends on the effect you want. In general, the smooth scaleability of draw art recommends it, but high-resolution bit maps can pack finer detail onto your page. We tend to use draw art for charts and more technical figures and paint for anything that needs softness. In the latter case, we make a huge painting and reduce it to a multiple of 24% if possible.*

*The only way to know for sure is to try it out. SuperPaint, giving you instant access to both paint and draw art, makes that easy.*

**Other Sources**

Computer graphics on the Macintosh is a rich enough subject to fill several books. While bit-mapped art and object-oriented art cover a large portion of the computer graphics that you will encounter when you desktop publish with Word, there are other kinds of graphics:

- Digitized images fed into the computer from scanners or video cameras
• Encapsulated PostScript graphics imported from certain drawing programs that can take full advantage of the laser printer's capabilities

• PostScript code modules that you yourself write directly in Word

**Word as an Inexpensive Scrapbook**

As soon as you begin to accumulate much clip art, you are going to need a good method to store and access what you have. The scrapbook desk accessory, since it doesn't give you a way to search rapidly by keyword, doesn't serve well for more than a couple dozen graphics. Commercial programs like Picture Base and the SmartScrap desk accessory may be what you need.

But if nearly all your desktop publishing takes place in Word, and if you have a hard disk, you can use a single Word document to store your clip art. Just paste the graphics from their source program into the Word document, scale them to a reasonable size, and type a caption that includes words you can search for. Word's *Find* command will help you find all the drawings that have the desired keyword. If you organize things in rough categories, you can jump to the beginning of the category and browse through the art. When you are doing a lot of work with graphics, you can keep both your Word scrapbook and your working document open at the same time.

**Placing Paragraphs on the Page**

We have seen that because Word treats each graphic as though it were a character, we can easily combine graphic and text elements in the same paragraph. But most desktop publishing applications that use graphics, even ones as simple as the flier we're working on in this chapter, require that we be able to place graphic elements where we want them on the page. Word provides a powerful tool for controlling the position of a paragraph—whether it contains text, graphics, or both—on the page. But in order to see how this positioning works, we need to begin assembling some parts of the flier.
Preparing the Flier

Our garage-sale flier will have three text sections: the title, the main text, and information about where the garage sale takes place. We’ll place some clip art on the page to illustrate the kinds of things being sold. Figure 8.4 shows the basic plan.

![Figure 8.4: A thumbnail for a typical flier in which the text portion has to wrap around pieces of clip art](image)

We could use a drawing program such as SuperPaint to create this flier, but we would encounter some difficulties getting the text to flow around the clip art. We’ll see that Word makes this easy.

Choosing the Font

Because we are going to use a lot of clip art in the flier, we would like to keep the typeface clean. We prefer a sans serif font, such as Helvetica, to anything more decorative. Again, because the graphics may tend to make the flier busy, we use the same font throughout. Because most of the text will have the same height, 18 points, we may as well put the choice of font and font size in the Normal style.
Open a new document and redefine Normal to use 18 point Helvetica. Use the Define Styles... command from Chapter 5.

Normal Used to control the flier's font and font size.
Font: Helvetica 18 Point, Flush Left

The Text Sections

The flier has three sections of text: title, main text, and information. Each gets a style, as shown in Figure 8.5.

A problem with defining the title style is that 36 points probably doesn't appear on the Font menu. Use the Character... command on the Format menu to bring up the dialog box shown in Figure 8.6. There you can specify whatever size you like.

With the text entered and reasonable styles defined, we're ready to mix in some graphics. First an example and then the principle behind it.

**Positioning a Graphic—an Example**

We'll start with a single graphic on the page to learn the principles of positioning paragraphs.
Figure 8.6: If the font size you need isn’t on the Font menu, you can use the Character dialog box to type in whatever size you want between 4 and 127 points.

- Select Page View from the Document menu (or use the #-B shortcut). By working in page view, we’ll see the effects of placement immediately.
- With the cursor before the first character in the flier, paste a graphic (we’ll use the camera) and press RETURN.
- Be sure the new paragraph is Normal. You should have something similar to Figure 8.7.
- With the cursor in the paragraph with the graphic, select Position from the Format menu. The Position dialog box appears.

Figure 8.7: A paragraph containing a single graphic has been created at the start of the flier. We’re working in page view.
We’ll use this dialog box to center the graphic between the margins. Hold down the mouse button on the arrow underneath Horizontal. You will get a menu of possibilities, as shown. Select Center from that menu.

Press the OK button. The camera should end up in the middle of the title paragraph, as shown in Figure 8.8.

If nothing seems to happen, make sure that you have selected Page View in the Document menu.

Word has done an unexpected and wonderful thing here: the title paragraph has been broken to make room for the paragraph containing the camera. The text in the title flows around the graphic. The camera is positioned, while the title paragraph is not.

Figure 8.8: Page view of the top of the flier after the camera has been given a fixed position, centered between the margins. The cursor is in the camera paragraph. Because Show is on, the boundaries of portions of paragraphs are shown.
Repositioning a Positioned Paragraph

As happy as we may be to see the graphic take its place in the middle of the title, we need to know how to position it where we really want it. Ideally, we would like to drag it where we want it to go on the page, and that is exactly what Word lets us do.

- Select Print Preview from the File menu. As you would hope, the camera still appears in the middle of the title.
- Click on the margins icon. Look closely at the camera. It has a gray box around it as shown in Figure 8.9.

Figure 8.9: Print preview with the margins icon selected puts a gray box around positioned paragraphs.
With the margins icon selected, you can drag positioned paragraphs to new places on the page. Try dragging the camera down into the middle of the main text paragraph, as shown in Figure 8.10.

![Figure 8.10: The outline of the graphic paragraph has been moved down into the main text, but the page has not yet been redrawn.](image)

Only the outline of the camera paragraph moves as you drag, and when you release the mouse button, the camera remains where it was. Because it can take considerable time to redraw the page, especially when there are a lot of graphics, Word lets you move things around first and then tell it to redraw.

Click on the margins icon. This forces Word to redraw the page, giving you something similar to Figure 8.11.

**Adding More Graphics**

It seems that we are all set. We have the text, and we know how to position graphics. We'll just keep adding paragraphs with graphics, moving them to where we want them in print preview until we're satisfied. But a gotcha lies in wait.

Select the graphic and reapply the **Normal** style to its paragraph (recall the `⌘-SHIFT-P` shortcut from Chapter 5).

We're going back to **Normal** so we can demonstrate the gotcha.
Figure 8.11: Clicking on the margins icon forces the page to redraw, showing the camera's new position.

- With the cursor positioned just after the camera, press RETURN and paste in another graphic. We'll use a reduced bit map of a Macintosh computer.

- Select both paragraphs and choose Position from the Format menu. Figure 8.12 shows what you should have.

Figure 8.12: The two consecutive paragraphs of graphics are about to be given a fixed position.

- As before, select Center from the list of possibilities under Horizontal.

- Now we want to try moving the two graphics around on the page. The Preview button in the Position dialog box is a shortcut for getting to print preview with the margins tool already selected. Figure 8.13 shows what you get.
The Graphics Cannot Be Moved Independently. Even though the two graphics are in different paragraphs, Word treats them as a single positionable object as long as both paragraphs have the same position. Word does this so that the paragraphs will be placed underneath each other instead of on top of each other.

In order to allow the two paragraphs to be positioned independently, give them different positions to start with. Here's how:

- Close the print preview window.
- We want to go back to the Position dialog box for one of the paragraphs. A shortcut for getting there is to double-click the small black square, called a paragraph properties mark, which appears just to the left of the paragraph (provided Show is on). This will take you directly to the Position dialog box.
- Select Right under the list of horizontal positioning possibilities and press the Preview button. In print preview you will see that each paragraph has its own gray box and can be positioned independently of the other.

**Notes on Completing the Flier**

You now know all the principles you need to complete a simple flier. Figure 8.14 shows a possible design.

Even though the principles may be clear, a few production notes are in order.

For the fourth line of the flier, we found some pictures in the Cairo picture font that suited the "going out of wedlock" theme very nicely.
The key caps desk accessory helps in locating the pictures. Type the characters you want into the key caps window, copy them, and paste the result to the flier. Finally, change the font of what has been pasted to Cairo.

Figure 8.14: Print preview of the completed flier shows a design in which the clip art frames the main text.

The paragraph containing these Cairo graphics is an ordinary galley paragraph, not a positioned paragraph. The same is true of the paragraphs containing the bicycles and the butterflies. When you want
a paragraph to be positioned in the normal flow, let Word do the work for you.

We found the fancy bicycle in a collection of clip art called DrawArt. Look closely at the two bicycles on the page facing the title of this chapter. In addition to being mirror images of each other, they have slightly different resolutions. Just to make a point, we took the original object-oriented graphic and converted a mirror image of it to a bit map. Here are enlarged images of the handlebars so you can compare both types of graphics.

We pasted a bit-mapped house on top of the word “house” in the Info section at the bottom of the flier. When we first did this, the house took on the shadow character formatting, giving it extra lines to the right and underneath as shown at left. We had to remove this extra formatting by selecting Shadow in the Format menu.

**Customization Corner**

**Subscripting as a Menu Item and Keystroke Command.** If you find yourself subscripting (or superscripting) frequently by a certain amount, you can add it as a command to a Word menu, or you can add a keystroke command, or you can add both. Here’s how:

1. Select **Command...** from the **Edit** menu. Scroll the list of commands in the resulting dialog box (see Figure 8.14) down to **Subscript:** and select it.

2. Type the amount of subscripting you want in the box labeled **Subscript:**.

3. Click on the **Add** button, the one just below **Menu.** This will add the command to the **Format** menu. The title of the button will change to **Remove.**
Click on the Add... button, the one next to the empty list labeled Keys:. A dialog box comes up asking you for a keystroke combination. You can use any combination you want, as long as it includes the % key. If you choose a key combination that is already in use for some other command, Word gives you a chance to cancel your choice and make another, or you can override the other command.

Figure 8.15 shows the dialog box after a command to subscript by 18 points has been added to the Format menu and assigned a keystroke command of %-SHIFT-OPTION-. At right you can see the resulting addition to the Format menu.

For More on Various Topics

Editing graphics—Word provides Edit Link, a command that will take you immediately from Word to the program that created the selected graphic. See Chapter 11 on how this works.

PostScript illustrations—See Chapters 15 through 17.
Graphs and bar charts—See Chapters 11 and 16.

Text beside graphics—See Chapter 10.

Text on top of graphics—See Chapter 15.

Super- and subscripting—We discuss Word’s powerful mathematical typesetting language in Chapter 10.
I caught up with Davis in Clara’s office, one of the few that had walls that went all the way up. He nodded at his goon, Walters, to let me in. “Manny, I want to plant some doubts.”

He looked at his watch and put down some papers. “Okay,” he said, sitting back in her chair, “you first this time.”

I told him briefly about the three possibilities I had come up with: suicide, an IA bigwig, and Alice. I brought out the copies of the letter, the flier I had just read, and the picture of Alice with Chuck Hines.

“So?”

“Give me a break, Manny. Photography. Cyanide.” I closed the door and lowered my voice. “Charles Stuart Hines is a VP here like Clara. Alice and Hines were hanging out together; they both play in the Emery Quartet. She’s the cellist, he’s the viola player. What if he’s in it with Alice? Then there are two motives. There was plenty of hate in the old house, even though they’re divorced. And Victor wasn’t easy to get along with-just ask Clara.”

“Exactly. Victor and Clara were lovers. They’re not exactly on the same level here at IA, are they?”

“No, but...”

“Would you say they were getting on well?”

I shut up and looked out through the glass blocks of her wall.

“Delilah. All I’m after is the truth. If she’s innocent, she’ll walk. But if she killed him, friend of yours or not, she’s got to pay. You don’t have to answer me. I know already. They fought all the time. She has a temper. He was cold and closed. We think she left the cookies while she was waiting for your pizza. The Berkeley Big Z is right around the corner from Markovsky’s place.”

“But Manny, what about the note? Can I see it?”

Manny Davis sighed. “Delilah, there isn’t any note. She talks about it too, but it wasn’t in the apartment where she says she left it. By the way, you got any material on this company? What do you guys do, anyway?”

I found a company brochure in Clara’s files and slapped it onto the desk in front of him. “Got any other questions you know the answers to already?”

“Sure. What was her college minor?”

Chemistry. I went for a walk.
BROCHURES

In earlier chapters, we have discussed almost everything you need to know to put together a simple brochure. In this chapter, you will get more practice using columns, graphics, and paragraph styles. We will use section formatting to change the number of columns in the middle of a page as well as character styles to make a fancy title. We'll introduce some more techniques for dealing with the difficult problem of positioning text vertically where you want it. We will see how paragraph borders can be used to set off some parts of text from others through the addition of simple lines and boxes. Finally, narrow columns often have ugly line breaks; we'll see how manual hyphenation can help. Design considerations for the brochure will show us the limits of Word's capabilities; we will discuss where you might want to use a page-layout program or manual pasteup for this project. Although we'll look at the layout for the entire brochure, we'll design only the inside in detail.
An Overview of the Project

We want to make a brochure for a company to introduce its techniques and services to prospective clients or investors. There are many kinds of brochures; they can be simple, such as a flier, or multipage, multicolored extravaganzas. This brochure will be small, so we can mail it out cheaply. It will be practical to hand it out by the hundreds at trade shows and inexpensive enough so we can leave piles of brochures sitting on tables for people to pick up. The company is unusual, so we’ll need quite a bit of text to describe it. But since people shy away from reading, we’ll have to bury that text in the inside of the brochure and be sure to say what’s absolutely necessary in few words of large type on the outside. The company wants to be taken seriously, so the brochure should look as formal and classy as we can make it with the tools available. Finally, the company president wants his picture on the brochure somewhere.

The basic plan is simple. Our brochure will be printed sideways (in landscape mode) on a single sheet of paper and folded in thirds, so that it has a good-looking title page on the outside and all the detailed text on the inside. The back of the outside should have room for a return address, a mailing label, and postage. The third outside panel will hold a quick summary and some text showing the reader where to get more information.

Planning the Two Sides

The piece of paper that will become our brochure has two sides. We’ll call them the inside and the outside. The inside is the one with the detailed text; it will have three columns, all of which will have the same function. The outside will have three radically different panels. Which panel is which?

The best way to get it right is to take a piece of paper, 8 1/2" by 11", fold it in thirds, and write roughly what you want on the six panels (three on each side). Then unfold it and see where they fall. Figure 9.1 shows the panels for the outside folded and unfolded. Let’s agree on the names title panel, info panel, and postage panel for the panels of the outside.
Choosing a Font

Given that this brochure is supposed to look formal and classy, we'll use the LaserWriter Plus font, Palatino. As you can see, Palatino is a serif font like Times, but with just enough difference to give it the extra class we need.

Special Problems with the Inside

There's that picture of the president we have to fit in somewhere. We'll use an outlined frame as a place holder for a real photograph that will be pasted onto the master. The problem will be to position the picture on the page, reserve space for it, and make sure it's the right size.

Also, since this brochure will be folded in three, the text must be formatted in three evenly spaced columns. As we found in Chapter 6, the distance between columns must be twice the left or right margin.

Depending on the model of printer and the software, it is difficult to print closer than a half inch from the paper edge. So we'll choose that as the margin all the way around this brochure. Therefore, the distance between columns should be one inch. That full inch will let the folds work properly and provide much-needed white space.

But if we have a lot of text on the inside, even with that white space, it will look pretty boring. To make it look more interesting, we're going to put the name of the company across the top of all three
columns in huge letters. In order to get it all the way across the top, though, it will have to be in one wide column. We need to learn how to change the number of columns in a document, because the three-column text will follow the one-column company name. We'll use the same technique we might use to center an abstract above a two-column article or a headline or masthead above multiple columns in a newsletter. We'll explain that technique a bit later.

**Special Problems with the Outside**

We're not going to go into the details on the outside of the brochure. With the exception of the postage panel, no special techniques are needed except those we have already covered in Chapter 6 (such as paying close attention to the column breaks to make sure that the copy shows up on the correct panel).

The postage panel does present problems. Word just won't let you create text that is rotated ninety degrees with respect to the rest of the page! The simplest solution to this problem is to create the postage panel in a separate document, print it out, and paste it by hand onto the master copy of the brochure. Sometimes doing things “off” the computer is much simpler and faster than trying to force the computer to do it for you.

If you really wanted the postage panel to be part of your document, you could create it as a graphic in SuperPaint, which does handle rotated text, and then paste the result into the Word document.

**Doing the Inside**

We're going to use styles somewhat differently in this project than we have in previous ones. So far, we have been careful to define styles as soon as we encounter a new element in the document. Here, we'll type in much of the text and do most of the formatting before we define any styles. Then we'll define the necessary styles and demonstrate the incredibly useful ™-A shortcut as a technique for imposing styles on existing text.
Setting Up

We need to get as many global things taken care of as possible before we start typing. As with the concert program, we first call up the Page Setup dialog box to set the paper orientation (once again we'll print sideways on the paper).

The other global settings we need to establish are the margins. Use the Document command in the Format menu and set them to 0.5 inches all the way around, as shown in Figure 9.2.

![Document dialog box for the brochure. We have 0.5 inches on all sides for the margins.](image)

When we were creating the concert program, the next thing we did was change the number of columns by selecting the Section... item in the Format menu. Don't do that yet, because the first thing on the page is going to be the name of the company in large letters across the top in one column, so the current section format is correct.

Here's how to create the name of the company (worry about the size of the letters later):

- Make sure the ruler is showing (use `R`). This is just good sense. You'll need the ruler eventually.
- Make sure that Show ¶ is selected (Y) in the Edit menu. (This will make your screen match the pictures in the book.)
- Make sure you have set Page Setup to landscape (wide) mode and set the margins as described above.
- Redefine the Normal style to use Palatino in the 12-point size if you have it available. See to it that Normal doesn't have extra formats
like **Space Before** 12 pt. (If you don’t have Palatino available, use another PostScript font.)

- The name of the company should be centered and in a font somewhat larger than 12 points. So click on the ruler’s centering icon and press **=SHIFT->** to increase the size of the font. The new font size appears in the status box in the lower-left corner of the document window.

- Type in the name of the company: “Immaculate Assessment, Inc.” Press RETURN.

- The main text will begin in this paragraph, so reapply the **Normal** style to this (empty) paragraph. This will left justify the ensuing text and restore the 12-point size. The document portion of your window should look like Figure 9.3.

We are going to do some more formatting of the company name later on, but not until we have the three-column section set up.

![Figure 9.3: We have typed the company name and set the next paragraph to Normal.](image)

**Changing the Number of Columns**

Now it’s time to change to three columns. In Chapter 6, we changed the number of columns by changing the section format. That’s exactly what we’re going to do here, except that we first have to split the document into two sections: one that will be one-column (the name of the company) and one that will be three (the text that follows).

- We need to insert a section break to divide the document at the beginning of the second (still empty) paragraph. Put your cursor there. Now what is the command to insert a section break?
Remembering all of the commands for a complex program such as Word is a difficult, if not impossible, task. Word's on-line help facility can help. Word can give us help about any command, and we know we need some help about sections. How can we get it?

\[ -\text{ENTER} \]
\[ \text{Section break} \]

Press \[ \text{Esc}-?) \] to change the cursor to a question mark and then select \textbf{Section...} from the \textbf{Format} menu. A help window comes up, and, by scrolling just a little way, we find out that \[ \text{Esc}-\text{ENTER} \] inserts a section break.

When you press \[ \text{Esc}-\text{ENTER} \], a double line appears across the page. The cursor will be in the new section immediately following the break. That double line is called a \textit{section mark}; it behaves somewhat like a paragraph mark.

\[ \text{Sections Are Like Big Paragraphs} \]

Though they are larger, sections and their formatting behave just like paragraphs and their formatting. To change the format of a section, the cursor has to be in that section. If more than one section is represented in a selection, the formatting affects all sections represented in the selection.

Just as the soul of a paragraph resides in the paragraph mark (see Chapter 4), the soul of the section resides in the section mark. Unfortunately, the last section has no mark.

Now we want to change the second section to three columns.

\[ \Rightarrow \] Make sure the cursor is in the second section.

\[ \Rightarrow \] Select the \textbf{Section...} item in the \textbf{Format} menu to bring up the \textbf{Section} dialog box.

\[ \Rightarrow \] In the \textbf{Columns} subbox in the lower left of that \textbf{Section} dialog box, change the \textit{Number} of columns to 3 and the \textit{Spacing} to 1 in (as we discussed above). Click \textbf{OK}. (We have made a common mistake here that we will correct almost immediately. The mistake is still invisible, provided you have stayed in galley view.)

\[ \Rightarrow \] Look at the ruler. The indents and margin line should have moved in, as shown in Figure 9.4.
Now let's type in a paragraph or two of copy so we can see the headline above the narrow-column text. Do this:

- Type something, for example, what you see in Figure 9.5.
- It's time to see if things are working out. Select Page View (Alt-B) from the Document menu. Mysteriously, the title seems to have disappeared (see Figure 9.6).
Figure 9.6: After shifting from galley view to page view, the title of the brochure seems to have disappeared.

Where’s the title? Look for it on the previous page. Press the page back icon at the bottom of the page view window. Now you can see the title—without the text.

We need an overview of the problem. Select Print Preview... (FILE) from the File menu. Figure 9.7 shows the result. The title is on page 1; all the text is on page 2!

Figure 9.7: Print preview of the brochure with the mistake—why did the two sections come out on separate pages? Notice, by the way, the page numbers printed at the top. P1S1-P2S2 means that page 1 in section 1 to page 2 in section 2 are the pages that show.
It's possible that you see only one page in your page preview. If this is the case, click on the One Page Display icon at the lower left of the Print Preview window.

Your print preview may still not be the same as Figure 9.7. Check to make sure the scroll bar thumb is all the way at the top of the scroll bar—so you are seeing the first two pages of the document.

The mistake is in the Section dialog box. That box has options to tell Word what to do at the beginning of a section. The default is to start a new page; you don't want that.

1. Close the print preview window (Ctrl-W or the Cancel button).
2. Go back to galley view (use Ctrl-B or uncheck Page View in the Document menu).
3. Make sure the cursor is still in the second section—after the section mark.
4. Select Section from the Format menu. Since the cursor is in the second section, that's the section you'll affect.
5. Check that it still says three columns so that you know you're affecting the right section. Look at the box next to Start:. It probably says New Page. Press on the downward-pointing arrow to get a menu of possible ways to start a new section, and select No Break, as shown at left. Click the OK button to close the dialog box and make the change happen.

Galley view will look the same after you make that change. But when you move to page view (Ctrl-B), you'll see that both the headline and the text are on the same page, as shown in Figure 9.8.

**Making the Headline**

The headline looks wimpy. Let's fix it before typing the rest of the copy. We want to see the name of the company stretching across the entire page.

1. Select the entire title line. (A single click in the selection bar at the left of the window will do it.)
2. Increase the point size by pressing %-SHIFT-> until the headline no longer fits on one line. With our setup, that happens at 60 points. Your screen will look something like Figure 9.9.
At Immaculate Assessment, we specialize in unobtrusive evaluation techniques. We try to help you answer difficult questions about your workplace, your employees, your clients, or your students— in such a way that no one will be aware that some assessment is being made.

Figure 9.8: Page view of the protobrochure with the section break correctly formatted. Now there is no page break.

Figure 9.9: This is too big. At 60 points, the name of the company no longer fits on one line.
There are several things we could do here:

- Decrease the font size to 48 points by pressing `~`-SHIFT-<; the headline will still be gigantic and extend most of the way across the page.
- Bring up the Character dialog box from the Format menu and try numbers between 48 and 60 points (by typing the point sizes into the box there) until you find one that just fits the line.
- Use 36 point, expanded, small caps—more about what this means in a moment.

In real life, we might try all of these solutions and compare them. We're going to choose the last option, partly because it produces very good-looking results and partly because it gives us a chance to explain some more things about character formatting.

We decide to use smaller type—36 point—to make room for more text and because we think that 48 point is too big to balance the text properly. We also decide to use the small caps character format because we think it looks classy. But we do like the idea of stretching it across the page. We don't want to stretch the letters themselves; what we really want is additional space between the letters. This is called the expanded character format. Although you shouldn't use it frequently to emphasize text, as you would italic or boldface, the expanded character format can be very effective in the occasional display headline.

As we format the title, we can also demonstrate how to use the Apply button effectively. Here we go!

- Make sure the words “Immaculate Assessment, Inc.” are selected and at the top of the window.
- Change the text to 36 point by pressing `~`-SHIFT-< until it's the right size.
- Select Character... from the Format menu or use the `~`-D shortcut. (No one knows what the D stands for.)
- You'll see the Character dialog box appear. In the Style subbox, click in the little check box for Small Caps. (`~`-SHIFT-H is the shortcut for small caps.)
- Click on the Apply button to apply that character format to the selected text. (Pressing OK does this too, but it puts away the dialog box—and we still want to use it.) Figure 9.10 shows what your screen will look like just after you press Apply.
Figure 9.10: The screen just after you press the Apply button. The selected text is in small caps, but you can't see very much of it.

You can see that the text has changed to caps, but you can't tell what it's really like. So move the Character dialog box to the side by dragging its title bar. Because the next thing we're going to do is use the Expanded option in the Spacing subbox, which is in the lower right, we moved the box off the left of the screen, so only the part we need is showing, as shown in Figure 9.11. We're about to press the Expanded button.

The Expanded and Condensed buttons let you put extra space between characters or reduce the normal space between characters. While Word will understand inches or centimeters if you insist, the default measurement for this dialog box is points. Let's expand the text we have selected so that it fills the line.

- Move the box as we did and press the Expanded button. You'll see the box change so that it looks like the one at left. The default amount of expansion is now 3 pt. Try changing it to 6 points. Notice that nothing happens.
- You must click Apply. Do that. If you have good eyes, you can see that the letters got farther apart. Experiment with different numbers. When you find the widest spacing you can get with the text still on one line, press the OK button.
Figure 9.11: The screen with the Character box moved to the side (but still active). You can see the small caps better now. We're about to press the Expanded button.

In galley view, when you expand with Apply, the text wraps as you would expect. In page view, however, text on the next line will be invisible until you press OK.

You may have found that 14 points of space is the maximum Word will put between letters. We found that 10 points was the right amount to fill the line. Now our print preview looks like Figure 9.12.

**Paragraph Borders: Fancy Lines and Boxes**

In order to make that headline look even classier, we want a double line to separate the headline from the text. Before there was Word, when we used MacWrite, we would have to get out the old Rapidograph pen and put in the line ourselves. We tried underlining the characters and even inserting an entire paragraph of underlined spaces, but neither of those looked quite right.

Fortunately, Word has special paragraph borders accessed through the Paragraph formatting box. These borders are some of the most useful fancy features of Word for desktop publishing; we're forever needing a ruled line or a box.
Borders Apply to Paragraphs

You give borders to a paragraph or collection of paragraphs. No matter how wide the actual text is, boxes around text stretch from the left indent to the right indent. So do ruled lines above or below. To change the width of a box or the length of a line, you have to move the indents.

A border belongs to the paragraph—it is part of its format. Therefore it shows up in style definitions.

Let's put a double line under our title:

- Be sure the cursor is in the title, so we will affect it and not some other paragraph.
- To put a line under a paragraph, we have to modify the paragraph's borders, but there is no direct way to get to the dialog box
that controls borders. So first select Paragraph... (F5-M) from the
Format menu.

→ In the resulting dialog box, click on the Borders... button to bring
up a second dialog box (see Figure 9.13).

→ First, we choose the kind of border we want by selecting the
double underline box on the left.

→ Then we have to tell Word where to put the double underline by
clicking between the bottom two corner marks. The display will
look like Figure 9.14.

→ Click OK to close the Paragraph Borders dialog box and click OK
again to close the Paragraph dialog box. Now you have a double
line under the name of the company. (Don’t mistake it for the
section mark! The section mark is dotted and never prints out.)

Try making paragraphs with different borders. Often you will also
want one of the options on the right. Plain Box puts a border (you choose
which kind) around the paragraph. Shadow Box adds a shadow to the
right and bottom of an otherwise uniform border.

An Outside Bar is a vertical stroke that appears just to the left of the
paragraph. You might use one to indicate text that has been changed
during proofing or to add a special kind of emphasis. If your document
has the facing pages format (see Chapter 12), the bar will always be to
the left on left-hand pages and to the right on right-hand pages.

Figure 9.13: The Paragraph Borders dialog box (on top of the Paragraph dialog box).
First select the double underline tool and then click on the place you
want to use it.
Suppose you want a paragraph sandwiched between a line above and another below. Choose the kind of line you want and click on the top of the paragraph sketch (see Figure 9.14) and again on its bottom. If you change your mind, clicking in the same place with the same tool will delete the border.

You can use a text sandwich as you would use a box to highlight any text, such as a section heading or a quote pulled from an article. (See Chapter 13 for an example.)

My Lines Always Come Out Plain! You might be clicking in the wrong order in the Paragraph Borders dialog box. You have to click on the type of line you want first, and then where you want it. The other way around doesn’t work.

**Typing In the Text**

Now it’s time to buckle down and type the copy for the inside of the brochure. What’s actually there is unimportant, of course, but your version of this company’s brochure should have several parts, each with its own heading. Here are the headings we have used:

- Who are we? (This one is already in.)
- What sorts of questions?
• Who works for IA?
• Who uses Immaculate Assessment?
• What do we give you?

The text for each part should be a few paragraphs long and we need enough text to just barely fit on the page. Remember, we’re still typing in Normal, set to 12-point Palatino. If you type in page view, when the text reaches the bottom of a column, the cursor will jump to the top of the next column. However, the page view window, for all its WYSIWYG virtues, has a habit of jumping around as Word adjusts the page to the new text, so you may prefer to do the typing in galley view. Even though you won’t see the columns, the typing will be smoother.

By the way, don’t do any special formatting like bolding the section heads or putting space between. And certainly don’t use double returns for vertical space! First get the text in, and then we’ll fix all that.

**Styles and the \[A-\]** Shortcut for Formatting

With all the text in, it’s time for styles. Does the document on the page look disorganized? Ours did. Those headings really need to stand out. Furthermore, you can’t tell where one paragraph ends and the next begins. This is an advertisement for doing some styles ahead of time.

But what about that fancy headline we just spent so many pages working on? Shouldn’t that be in a style? It depends. If you’re going to use that type of headline in this document again, a style is a must. But if you just want to use the identical headline—like a masthead—with different text, make it into a glossary item or copy and paste from this document into the next one.

At any rate, we want two new styles, one for the section heads and one for the body. Let’s call the body style **body**, defined this way:

**body**  This style is for the main body of the text.
Normal + Space After 6 pt

You have to get into the Paragraph box to give a paragraph space after; it’s not available on the ruler.

Now we want to change all the text to **body** style (we’ll come back in a bit to change the headings):

- Select all of the text except the name of the company. One quick way is to click the cursor after the section mark, scroll to the bottom of the document, and then SHIFT-click at the end of the text.
→ Use the style selection menu on the ruler or use the %,-SHIFT-S shortcut (type body into the lower-left box) to assign the body style to all the paragraphs in the selection.

With 6 points of space after every paragraph, you can at least tell where they start! Now we need a style for the headings. Let's be really sneaky and set the style of these headings to heading 1; that way if we ever feel like it, we can use the outliner (as introduced in Chapter 7) to look at our copy. We'll see how to use %,-A as an efficient way to apply the heading 1 style to all five of the headings.

→ Position the cursor in the heading “Who are we?”
→ We want to apply the heading 1 style to this heading. Type %,-SHIFT-S and then type in the style name.

If you decide you'd rather use the ruler to apply the style, don't forget to hold down the SHIFT key while you click on the ruler's style selection arrow. The automatic style heading 1 will not be on the list until you use it.

→ Now find the next heading paragraph. Click in it.
→ Press %,-A. Voilà! The style is changed.
→ Keep finding, clicking, and changing until you're done.

We could also have promoted all the heading paragraphs to heading 1 in the outliner. That might have been even faster, but we wanted to introduce %,-A before we got any further along because it's so useful.

%,-A is a real time-saver. (A stands for Again.) This command will redo your last formatting command, whether you changed styles, italicized, bolded, cut, pasted, or even just typed.

Let's bold the headings and give them no space after so they sit on top of the paragraph they introduce. So far, the headings have the default definition of heading 1: Normal + Font: Helvetica 12 Point, Bold Underline, Space Before 12 pt. That's a lot to change just to get Normal + Bold if we do it one step at a time. One quick way is to use the Define Styles dialog box:

→ Bring up the Define Styles dialog box (%,-T). Select heading 1.
→ Type %,-SHIFT-P. You will see that the style definition becomes simply Normal. When the Define Styles dialog box is showing, this
keyboard command takes the style definition back to whatever the style is based on, **Normal** in this case.

Now add the bold character formatting to the definition, then click on **Define** to cement the definition and **Cancel** to close the dialog box.

We’re avoiding a gotcha by using space after here instead of space before. The reason is that we want the tops of the columns to line up. If we used space before, and if the top of a column is the first line of a paragraph, there will be space at the top of that column but not others. Figure 9.15 shows what we would have run into. The heading for the first part of the brochure is too low compared with the top of the second column.

---

**Immaculate Assess**

Who are we?

At Immaculate Assessment, we specialize in unobtrusive evaluation techniques. We try to help you answer difficult questions about your workplace, your employees, your clients, or your students — in such a way that no one will be aware that some assessment is being made.

What sorts of questions?

Questions about peoples’ attitudes and about their consequent behavior. How do people feel about something, and what do they really do about it?

observation and waste analysis at work and at selected homes, we were able to show conclusively that employees at the firm actually ate a greater fraction of their cafeteria meals than the meals they prepared at home. Our client avoided a costly and pointless change of food service providers.

Who works for IA?

Our founder, Emil Brockmyer, made his name in academia extending the reach of unobtrusive observation outside the traditional social research milieu. He has built this unusual corporation around academics like himself, surrounding them with the

---

Figure 9.15: The top-left portion of the brochure as it would have looked with space before formatting instead of space after. Notice that the first heading is too low.

---

**Preparing for the President’s Picture**

We almost forgot the president’s picture. Where should it go? Since there’s only one graphic, if it’s a symmetric layout we’re after, it should go in the middle column. The picture even makes sense near the heading “Who works for IA?” Let’s put in a frame to reserve space for it.
- Place the cursor at the end of the body paragraph that precedes the heading "Who works for IA?"
- Press RETURN. Now we've created a new body paragraph just for the graphic.
- Select Insert Graphics from the Document menu. A one-inch frame should appear.
- Press SHIFT-RETURN. We want this graphic to have a caption.
- Type "Emil Brockmyer, Ph.D." (SHIFT-RETURN) "Founder of Immaculate Assessment." Now the caption is in the same paragraph as the frame for the graphic.

Gotcha avoided here: If we had placed the cursor before the "Who" of "Who works for IA?", the graphic would have been in a heading 1 paragraph, and the caption we typed for it would have been boldfaced.

- We would like the figure and its caption centered in the column, so click on the ruler's centering icon.
- The picture we have has a wide orientation. Resize the frame to 1.5 inches high by 2.5 inches wide. Figure 9.16 shows what you should see if you are working in page view.

| Figure 9.16: Working in page view, the paragraph containing the placeholder for the president's picture and its caption |
While you've got the frame selected, give it an outline by selecting **Outline** from the **Format** menu. The frame will then print, making it easier to paste in the photograph correctly.

We have deliberately set up this example to generate a problem: with the space this picture and its caption take, we now have too much material. Our print preview looks like Figure 9.17. We have two-page-display mode set.

The quick remedy is to change the font size: reduce **Normal** to 10 points (9 if you have to!). After changing the style, your screen should look like Figure 9.18.

Ouch! Solve one problem, create another! Now we have a lot of white space at the end of the third column. We could fill it with something, but there ought to be a way just to make the three columns the same length.

**Getting the Bottom to Line Up**

Miraculously, if you start a new section with **No Break** selected in the **Section** dialog box, the three columns will even out as much as possible. The alignment may not be perfect, especially if you have used special formats from the **Paragraph** dialog box, such as **Keep With Next** or **Keep Lines Together**, thus forcing Word to break columns at unaligned places. Also, if **Widow Control** is selected in the **Document** dialog box,
Word will consider it more important not to leave lonely lines of text than to align the bottoms of columns.

The idea, then, is to start a new section at the end of the brochure. It won't have any text, but it will force Word to even out the columns. This gives you a chance to practice inserting a section break:

1. Place the cursor at the end of the document. It will appear before the final paragraph mark.
2. Press RETURN. Now you have a new paragraph in what will become the new section. This will put the cursor after the paragraph mark that terminates the last paragraph of text.
3. Press CONTROL-ENTER. This creates a section mark—the double line across the screen.
4. Let's check the section start. Select Section... from the Format menu. The Section dialog box appears. Amazingly, the start is already set as No Break. Click OK.

You're done. But why didn’t you have to select No Break?
When you create a new section (as when you create a new paragraph), it has the same format as the one you were in when you created the section mark. You might have already noticed that this new section also has three columns. If you want to change to one column (for example, to put a nice double line at the bottom of the page to match the one at the top) you'll have to do it in the Section dialog box.

Figure 9.18: A two-page spread with Normal set to 10 points. It fits, but the layout is terrible! Now Brockmyer's picture is at the top of the second column.
Aligning Space after the Headline

One more thing we can see in Figure 9.18 is that there isn't enough room between the name of the company and the text. We can easily fix that by adding 18 points of space after the paragraph at the top; remember that the line stays next to the previous text. Figure 9.19 shows the (one-page) print preview of the current version of the brochure.

This is pretty good. It's classy looking, it has room for the picture, there's good white space between the columns, and there's a nice white band at the bottom that is bigger than the one at the top, which is what some design experts think is good.

We could continue to mess with it, for example, by changing the top margin to make the space more even. We could add more ruled lines—maybe one at the bottom and one at the top. We could try making the headings 12 point and leaving the body 10 point. It would also
be instructive to try an asymmetric layout, with the photograph positioned off to the side.

All of these are possible, but instead we’re going to take on—briefly—another type of problem. Full justification.

**Full Justification and Manual Hyphenation**

Suppose, in our desire to be more and more classy and formal, we decide we want the body text fully justified, that is, we want the right edge of the body paragraphs to be straight instead of ragged, the way it is now.

That’s easy to implement; just change the style of body to full justification. You can see some sample before-and-after paragraphs in Figure 9.20. We’ve (finally) selected Hide ¶ in order to help us see the word spacing more clearly.

![Figure 9.20](image)

The employees hated the food, but they had a nagging doubt familiar to many psychometric researchers: doesn’t everybody always say that they hate cafeteria food? What really mattered was how the employees behaved, not how they filled out a questionnaire. That’s where Immaculate Assessment came in.

After a thorough program of participant observation and waste analysis at work and at selected homes, we were able to show conclusively that employees at the firm actually ate a greater fraction of their meals.

In the figure, you can see that full justification stretches each line so that its right edge is at the right indent. That means that most lines are longer than they used to be, reducing the amount of white space that will appear between the columns. What happens to that space? It gets put between the words. In most lines, that’s fine, but Word inserts large spaces in the shortest lines, and the text looks ridiculous.
What we need is hyphenation. If the words were shorter, Word could better fit them into lines.

You could just type in hyphens, but that would be wrong: if you subsequently edit or reformat, the line breaks might well occur in new places, and the hyphens would remain in words that may end up in the middle of the line.

Word provides something much better—an optional hyphen character, made by pressing `--` (X-hyphen). If a line break occurs at an optional hyphen, Word hyphenates the word and prints it out correctly. Otherwise no hyphen prints. If Show ¶ is selected, you can see the optional hyphen as a hyphen with a little dot attached to the bottom of it.

Where would be a good place to use an optional hyphen? Judging from the third line in Figure 9.20 (beginning with “psychometric”), we should split the word “everybody,” which is now on the following line. Let’s do it:

- If you don’t have the same text that we do, find some that has similar line-length problems.
- Next, put the cursor after “every” in “everybody.”
- Hold down the X key and press hyphen. Wham! The word splits and half of it moves to the previous line. The paragraph automatically reformats.
- Let’s try splitting “psychometric.” Put the cursor after “psycho.”
- Insert an optional hyphen by pressing `--`. This doesn’t work. It hasn’t changed because “psycho-” will not fit on the preceding line. You don’t need to remove the optional hyphen, however. Just leave it there, in case future editing or reformatting bring it into play.
- To see what your text looks like, select Show ¶. You can see it all in Figure 9.21.

Word has an automatic hyphenator, too. It will go through your document and either hyphenate automatically wherever possible or present you with suggestions. It can be useful and powerful as well as treacherous. For most small projects like this, manual hyphenation is fine and gives you excellent control.
had a nagging doubt familiar to many psychometric researchers: doesn't everybody always say that they hate cafeteria food? What really mattered

Before hyphenation

had a nagging doubt familiar to many psychometric researchers: doesn't everybody always say that they hate cafeteria food? What really mattered was how the

After we put optional hyphens into 'everybody' and 'psychometric'

The same thing with Show ¶ selected

had a nagging doubt familiar to many psychometric researchers: doesn't everybody always say that they hate cafeteria food? What really mattered was how the

Figure 9.21: The effects of manual hyphenation. In the middle example, see how the text is denser and more readable. In the final example, notice the optional hyphen in "psychometric" that doesn't appear with Show ¶ turned off.

Customization Corner

In this chapter, we've used some important commands that don't appear on any menus. You can add them. Here's how:

Adding Insert New Section to the Document Menu. We found that we needed to insert section breaks fairly often, but we had trouble remembering the keyboard command. So we added it to Word's menus. Here's how:

• Press %+OPTION+++ (Hold down %+ and OPTION and press the plus key). The mouse pointer changes to a + to show that the next command you give will be added to the menus.

• Give the section break command by pressing %+ENTER. The menu bar will flash (but the section break will not be inserted).

• Look on the Document menu to see the Insert New Section command and a reminder about its keyboard equivalent.
Adding Paragraph Borders... to the Format Menus. If you find it annoying (as we do) to have to go through two steps to get to the Paragraph Borders dialog box, add a direct route through the menus. With the Paragraph dialog box in front, press $\&$-OPTION→ to turn the mouse pointer into a plus sign. Now click on the Borders... button. You will not get the Paragraph Borders dialog box, but the menu bar will flash to indicate that you have added a command. You'll find the new command in the Format menu.

For More on Various Topics

Columns—See Chapter 10 for other ways to make multiple columns.

Automatic hyphenation—See Chapter 12.

Graphics—Chapter 8 introduces more techniques for using graphics.

Vertical justification—In Chapter 13 we make the bottoms of columns come out even again.

Widow control—See Chapter 13.

Borders—We do more with borders and boxes, including controlling the space between the border and the text, in Chapter 10.
By ten, the fog had turned to low clouds. I watched the gulls at the edge of the bay and looked at the sculptures in the mud flats. I could see masts in the marina, rigid as telephone poles. I had to admit Manny’s case sounded good. Logical. Not tight, but tightening.

But I had seen Clara in the middle of the night; I had looked into those eyes. I knew her. For all her frustration, she loved him, and she was no murderer.

Back at the office I exchanged a few words with Morton Delgado, the marketing maven. He seemed pretty broken up about it, off his usual cheery track. More than anyone besides Emil Himself, he had built our company. This was a terrible blow right when we were doing so well and doing it so publicly. He confirmed what Hines had told me, that Victor didn’t make the meeting.

"Do you know why Victor was coming to the meeting? Did he usually come?"

"Never before. I’ve no idea why he was coming. I know it’s hard, Ms. Stone, but the show must go on. Tonight’s in particular."

I had almost forgotten about the stock bash. Delgado gave me the menu for the dinner, so I could finish the program and get it off to the printer. I hoped against hope that Clara could be there.

There was a note from Sergeant Davis on my desk. The autopsy reports were back: time of death was six to eight P.M.; cause, cyanide poisoning; body had not been moved; stomach contents were consistent with a Big Mac, almond macaroons, and slivovitz.

So he died that early. If Clara was telling the truth, Victor probably did not kill himself. The only way for a note to get to Clara at midnight was for someone else to knock on her door. Most likely the killer.

I realized I had been noodling around with motives all morning and never really thought about means and opportunity. How was Victor killed? The killer needed cyanide, needed access to his apartment, and needed to be able to make cyanide macaroons. Alice fit the bill. Unfortunately, so did my friend Clara.

I turned back to my copies of the stuff from Victor’s briefcase. The next item was a year-old bill for some slivovitz. My moment of clarity evaporated. It was time, again, to write down what I knew.
**INVOICE**

*PLEASE PAY THIS INVOICE. NO STATEMENT WILL BE SENT.*

<table>
<thead>
<tr>
<th>Cat #</th>
<th>Quantity</th>
<th>Description of item</th>
</tr>
</thead>
<tbody>
<tr>
<td>K3741</td>
<td>2 cartons</td>
<td>Yugoslavian Slivovitz</td>
</tr>
<tr>
<td>K3725</td>
<td>1 carton</td>
<td>Turkish Raki</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unit</th>
<th>Price</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$63.00</td>
<td>$126.00</td>
</tr>
<tr>
<td></td>
<td>23.50</td>
<td>23.50</td>
</tr>
</tbody>
</table>

| Sub Total | 149.50 |
| Sales Tax  | 8.97   |
| Shipping/Handling Amount Due | 6.00   |
| **Amount Due** | **$164.47** |

Send payment to:
European Liqueur Imports
7300 North Warehouse Road
Trenton, NJ 08608

Customer name: Victor Markovsky
Company: Immaculate Assessment, Incorporated
Street: 6 Marina Vista Parkway
City/State/Zip: Emeryville, CA 94608

Invoice number: 66892
Date: 5/6/98
Order number: 2055
Sales person: MKK
Shipped by: UGY

Thank you for your order!
Forms, though usually short, have complex layouts. In this chapter we’ll concentrate nearly all the techniques we have learned thus far on an invoice that occupies only half a page. In the process we’ll cover how to make intricate tables with column headings and subtotal boxes. Though Word’s table feature is the right choice of tools for making the table in this invoice, we will devote some time to discussing how to decide which of Word’s column-making tools is right in which setting. Word’s built-in calculator will come in handy for doing the arithmetic on the invoice, and we’ll think about how to store the invoice as a blank template optimized for easy data entry.
Thinking about Forms

If we must clutter the world with forms, let us at least make them easy to use and to look at. A clear layout for a form makes it much easier to fill out and to read, thus speeding the transaction for which the form was designed.

Computers are especially good tools for handling forms. We can use computers to design the forms as well as to fill in those forms that are not meant to be filled in by hand. Many kinds of software can do these jobs. You can use painting or drawing programs, especially object-oriented drawing programs, for example, the draw layer of SuperPaint. Most database programs, such as Double Helix, Reflex Plus, or Fourth Dimension, will do a presentable job of handling forms. Some software, such as SmartForms, is specifically designed for dealing with forms. If you use an accounting package, the relevant forms are probably part of it.

You can also use a powerful word processor like Word. Perhaps you don't have another program. A drawing program, once you know how to use it, is easier to use; a database will simplify handling the data you enter; and form-design software will have special features aimed at the task. But Word works, and we'll show you how to make it work well.

Thumbnail Planning

We are going to create an invoice that you can either fill in on the screen or print out and fill in by hand. An invoice has a lot of information on it, so we’ll work from a thumbnail. The layout will center around a ruled table, but above and below the table lie blocks of text that contain important information about the customer, the order, and the payment. For each element of the invoice, we’ll have to choose Word techniques to create it, allow easy data entry, and still let you make changes easily.

We compared invoices from our file cabinets to see what parts they have in common. Then we sketched thumbnails until we found one that looked pretty good, as shown in Figure 10.1. This design went through several passes; we’ll try to illuminate some of the problems we had getting Word to make everything show up in the right place.
What page size and orientation should we use? This thumbnail suggests there will be plenty of space left at the bottom of the page, but that's a bit deceptive. The table on our invoice will expand or contract depending on the size of the order—so we'll stick with the full 8.5-by-11-inch page. We'll also accept Word's generous default margins of 1.25 inches on each side. We'll use portrait (tall) orientation because we need only four narrow columns and one wide column.

It was easy to decide about page size and orientation, but what now? It makes sense to begin with the element that is functionally most important—the table—and then work the rest of the page around that.

**Four Ways to Make Columns**

One way to look at the table is as a document made of columns. We'll benefit from a brief recapitulation of the column-making techniques we've talked about so far. In previous chapters, we have seen that Word offers at least four ways to produce columns of text:

- Using tabs (Chapter 6)
- Using hanging indents (for example, bulleted lists) (Chapter 4)
- Specifying the number of columns in the Section dialog box (Chapters 6 and 9)
- Using tables (Chapter 7)

Which method should we use? It depends on the situation.
Tab Settings

You can use tab settings to create columns when the text flows from left to right in a single line, as in Figure 10.2.

<table>
<thead>
<tr>
<th>Sequence of events — firsthand knowledge</th>
</tr>
</thead>
<tbody>
<tr>
<td>Friday 2:30 p.m.  Victor  Gets phone call</td>
</tr>
<tr>
<td>Friday 2:45 p.m.  Victor  Leaves IA by cab</td>
</tr>
<tr>
<td>Friday 5:30 p.m.  Clara  Leaves for takeout</td>
</tr>
<tr>
<td>Friday 6:15 p.m.  Clara  Returns with dinner</td>
</tr>
<tr>
<td>Saturday 1:00 a.m.  Clara  Shows up at my place</td>
</tr>
<tr>
<td>Saturday 4:00 a.m.  Clara  Calls me from the station</td>
</tr>
</tbody>
</table>

Figure 10.2: The items in each column are separated by tabs.

Hanging Indents

You can use hanging indents—outdented paragraph settings—when the last column in the table needs more than one line for each item. The last column wraps between the left and right indents. The rest of the columns appear between the first indent and the left. It’s as if the first columns function as bullets in a bulleted list. There is an example in Figure 10.3. (Remember, though, that only the last column can have items of more than one line.)

<table>
<thead>
<tr>
<th>Information from Davis at EPD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time of death 6-8 PM  Progress of rigor, body temp.</td>
</tr>
<tr>
<td>Cause Cyanide  Contents of stomach.</td>
</tr>
<tr>
<td>Delivery Cookies  Lab analysis of almond cookies found on the plate in V’s apartment and the half cookie found in his hand. No cyanide in the open bottle of Slivovitz.</td>
</tr>
<tr>
<td>Prints Clara  All over the apartment including cooking utensils; ingredients for cookies present.</td>
</tr>
<tr>
<td>The Note  Still missing!</td>
</tr>
</tbody>
</table>

Figure 10.3: The paragraphs are formatted with hanging indents. Use tabs to separate items when you type this in.
Using Columns in Section Format

You can set the number of columns in the Section dialog box when the text flows all the way to the bottom of one column before continuing on to the top of the next, as shown in Figure 10.4.

<table>
<thead>
<tr>
<th>What I understand so far:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Something illegal is going on here at Immaculate Assessment, and Victor knew about it. If there were a lot of money involved, it might have been worth someone's while to bump off Victor and frame Clara. There was also something going on with Victor and Alice. If he saw her Friday afternoon, who knows what could have happened? Then there's my friend Clara, the obvious suspect. Why do I believe her? Suppose V and A were still married and C just found out? It makes me glad I'm single by nature. What do I need to know? Who had access to cyanide? Who can get into Victor's apartment? What was Victor's financial position? How much IA stock did he own? Were V and A still married? Did he have a will? And where is that note?</td>
</tr>
</tbody>
</table>

Figure 10.4: "Snaking" text formatted as three columns

Table Formatting

Though tab settings work just fine for a simple table, when you want anything more complex, Word has a powerful and flexible set of table-making tools.

Suppose, for example, that you wanted each of the items in the table in Figure 10.2 to appear in a box. You could accomplish the task, with difficulty, using tab settings and vertical bars, but with Word's table tools, it is child's play to get Figure 10.5:

<table>
<thead>
<tr>
<th>Sequence of events—firsthand knowledge</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Friday</strong> 2:30 p.m. Victor Gets phone call</td>
</tr>
<tr>
<td><strong>Friday</strong> 2:45 p.m. Victor Leaves IA by cab</td>
</tr>
<tr>
<td><strong>Friday</strong> 5:30 p.m. Clara Leaves for takeout</td>
</tr>
<tr>
<td><strong>Friday</strong> 6:15 p.m. Clara Returns with dinner</td>
</tr>
<tr>
<td><strong>Saturday</strong> 1:00 a.m. Clara Shows up at my place</td>
</tr>
<tr>
<td><strong>Saturday</strong> 4:00 a.m. Clara Calls me from the station</td>
</tr>
</tbody>
</table>

Figure 10.5: At last, a real table created using the table commands
As we saw as we formatted the résumé in Chapter 7, table formatting also works well when the text in any of the columns contains more than one line but still flows from left to right, as in Figure 10.6.

<table>
<thead>
<tr>
<th>Suspect</th>
<th>Reasons For</th>
<th>Reasons Against</th>
</tr>
</thead>
<tbody>
<tr>
<td>Victor—suicide</td>
<td>He was depressed, having a kind of 30's crisis, getting divorced, unhappy at work (résumé!).</td>
<td>Why make it look like murder? Why give Clara the note?</td>
</tr>
<tr>
<td>Somebody at IA:</td>
<td>There's a stock scam, and Victor knew too much. As an accountant, he was in a position to know a lot.</td>
<td>Sounds melodramatic.</td>
</tr>
<tr>
<td>Brockmyer? Delgado? Hines?</td>
<td></td>
<td>Besides, who would kill to cover a stock scam? And who could get into the apartment?</td>
</tr>
<tr>
<td>Alice—his ex</td>
<td>They hated each other. Also, is their divorce final? What does she get if he dies? Cherchez la buck. Did she make the phone call?</td>
<td>She has hated him for years. Why kill him now?</td>
</tr>
<tr>
<td>Clara poisoned him</td>
<td>Lots of opportunity and access. She could have done it while she was getting takeout. She makes almond cookies and she discovered the body. Maybe V was going back to A?</td>
<td>She loved Victor. Seemed genuinely distraught.</td>
</tr>
</tbody>
</table>

Figure 10.6: Multiline paragraphs in a table

The Table Section of the Invoice

Let’s begin assembling the table section of our invoice. We’ll use Word’s table-making tools.
The Main Grid

We want to format the main part of the table so it has room for all the columns on a traditional invoice. It might look like this:

<table>
<thead>
<tr>
<th>K3741</th>
<th>2 cartons</th>
<th>Yugoslavian Slivovitz</th>
<th>$65.00</th>
<th>$125.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>K3725</td>
<td>1 carton</td>
<td>Turkish Raki</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Let's think about what features this table should have:

- Five columns and seven rows (the number of rows will vary eventually)
- Horizontal and vertical lines between all cells
- Last two columns aligned on a decimal point

First we'll create the table and put lines around the cells. After that, we'll set the widths and alignment of the cells using the ruler.

- Open a new document. Use Show Ruler and Show ¶.
- Choose the Insert Table... command in the Document menu.
- We've seen this dialog box before, in Chapter 7. It's very straightforward in the present context. Fill it out as shown at left. Word computes column width for you as you change the number of columns, so that the resulting table will span the width of the page.
- Don't press the OK button. (That would insert a plain 5 x 7 table.) Instead, press the Format button. Figure 10.7 shows the Cells dialog box that appears.
- Press the Borders... button. Figure 10.8 shows what you see.

The Cell Borders dialog box contains the controls we need to put lines around all the cells. It looks like the Paragraph Borders dialog box we used in Chapter 9. On the left are five tools for specifying the kind of line we want. Which tool should we use? The hairline tool will be ideal since it will make the thinnest possible line the printer can handle.
**Cells** dialog box contains controls for the width, height, and alignment of cells in a table, none of which we need now. The **Borders...** button takes us to the dialog box we need to use.

**Cell Borders** dialog box lets us place ruled lines around and between table cells. We’ve chosen the thinnest possible line, a hairline, and used it everywhere.

- Click on the hairline tool to select it.
- Notice the sketch of cells in the dialog box. We want to apply the hairline tool to the top, bottom, right, and left of each cell. You could do that by clicking five times. But you can also shortcut by double-clicking in the center. Figure 10.8 shows what you get.
Press the OK button to get back to **Cells** and again to get back to the window. The resulting table will be highlighted. Click in the top-left cell to get the result in Figure 10.9.

![Figure 10.9: The cursor is in the top-left cell of the table and Show \( \text{f} \) is on, so we can see the end-of-cell markers and the end-of-row markers.](image)

Practice moving from cell to cell in the table. The TAB key takes you to the next cell; SHIFT-TAB takes you to the previous cell. The up and down arrows move you to the previous and next rows respectively.

Now we’re ready to set the column widths. But we can’t really set these until we have chosen a font. How about the compact and readable Times 12?

- Put the decision about choice of font into effect by redefining **Normal**, leaving the justification at its default—flush left.
- Enter some sample data in the table. Don’t worry if a row in the table expands to double height; that’s why we’re about to change the column widths.

### Column Widths and Tab Settings

- Select the entire table. You can do that by dragging from the upper-left cell to the lower-right, but a handy shortcut is to hold down the OPTION key and double-click anywhere in the table.
- Click on the ruler’s scale icon to get access to the column markers.
Move the column markers around until you get a satisfactory width for each column. Normally, when you drag a column marker, all the markers to its right move with it. But you can move a marker without moving those to its right by holding down the SHIFT key as you drag. You can see the result for the example invoice in Figure 10.10.

All that remains for this part of the table is to set decimal tab stops in the two right columns, so that the dollar amounts will line up nicely. We'll do that for both columns at once:

1. Select the two right columns. A shortcut for selecting a complete column is to hold down the OPTION key while clicking on any cell in the column. If you also drag into the other column, you will select both columns.

2. Click on the ruler's scale icon until it shows the paragraph indents (see Figure 10.11). Only the indents for the left selected column will show, but our operations will affect both columns.

3. Drag a decimal tab icon into the desired position in the column. The dollar amounts in both columns will line up on the tab.

Why do the dollar amounts line up when no tab characters appear in the text? Word's designers decided that alignment on the decimal point in a table column is such a common occurrence that it should be the default behavior for decimal tabs in a table cell. Left and right tab settings behave as normal in a table cell.
So suppose you needed a tab in a table cell. Since the TAB key moves the cursor to the next cell, how do you insert a tab character? With OPTION-TAB.

Later on, when we get to the cells below the table that hold the sales tax through the total, we’re going to need this same decimal tab setting. So it behooves us to define a style; call it \texttt{amount}.

\begin{itemize}
\item \texttt{amount} For cells in table that require decimal alignment.
\item Normal + Tab stops: 0.5556in Number Aligned
\end{itemize}

All it takes to define this style is to click in the ruler’s style selection box (with the two columns still selected), type the style name, and press RETURN twice.

\section*{Overview of Table Commands}

Commands for dealing with tables are remarkably spread around in Word’s default menu setup. Figure 10.12 contains a table to help you remember where they are and what they do.
<table>
<thead>
<tr>
<th>Command</th>
<th>Where</th>
<th>What It Does</th>
<th>The Dialog</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Table...</td>
<td>Document menu</td>
<td>Creates a new table from scratch or from existing text. If the selection is in an existing table, will appear as Table to Text..., in which case it converts the table back to ordinary paragraphs.</td>
<td><img src="image" alt="Insert Table dialog" /></td>
</tr>
<tr>
<td>Table...</td>
<td>Edit menu</td>
<td>Enabled only when the selection is in a table, this command allows you to insert, delete, or merge cells.</td>
<td><img src="image" alt="Table dialog" /></td>
</tr>
<tr>
<td>Cells...</td>
<td>Format menu</td>
<td>Like the Table... command, enabled only when the selection is in a table. Used to change the width of columns and height and alignment of rows.</td>
<td><img src="image" alt="Cells dialog" /></td>
</tr>
<tr>
<td>Cell Borders...</td>
<td>Not on any default menu. Accessible through the Borders... button in Cells dialog box.</td>
<td>Changes the width and placement of borders. Can handle borders around individual cells and around blocks of cells.</td>
<td><img src="image" alt="Cell Borders dialog" /></td>
</tr>
</tbody>
</table>

Figure 10.12: The four dialog boxes that control table formatting all appear in different places; you can customize Word so that they are easier to find.

**The Table Header**

Our table needs a line above it containing headings for each of the columns. Since we forgot to leave an empty row at the top of the table for these headings, we get to learn how to insert new rows.

- Position the cursor in any cell in the top row. (Newly inserted rows always appear above the row that contains the selection and newly inserted columns appear to the left of the column containing the selection.)
Select the Table... command from the Edit menu. In the resulting dialog box, choose the Row option and click on the Insert button. A new row will appear above the top row, and the width and formatting of each of the cells will be the same as that of the existing rows.

The remaining formatting of the table header will be easier if we have some text in each cell. Position the cursor in the first cell and type "Cat #." Then tab to the next cell. Type "Quantity," and so forth, until your table looks like Figure 10.13.

![Figure 10.13: The table now has a header, but the header's formatting needs some work. The cursor is in the header's last cell.](image)

While Word did a good thing for us in making the header's columns widths the same as those for the rest of the table, we don't want borders around the header cells. We'll have to get rid of these borders, bold all the headings, and fix the alignment of the text in the two rightmost cells.

Select the entire top row. The easiest way to do this is to double-click in the selection bar just to the left of the row. (The mouse pointer changes to a northeast-pointing arrow when you're in the right place.)

Since the entire row is selected, we can bold all the text. Select Bold from the Format menu (or use % - SHIFT - B).

The row is still selected. Choose the Cells... command from the Format menu and click on the Borders... button in the Cells dialog box. This brings up the Cell Borders dialog box.

Choose the Every Cell in Selection option.
Remove the border on the left, top, and right of the cell sketch. (You still want the bottom border.) Figure 10.14 shows how the dialog box should look.

Figure 10.14: The Cell Borders dialog box for the table header with the left, top, and right border removed.

Click on the OK button in the Cell Borders dialog box and again in the Cells dialog box.

Select the two rightmost cells in the header. Drag the decimal tab setting out of the ruler to eliminate it and click on the ruler's right-justification icon.

The Bottom Section

Below the main part of the table, we want two things: on the left, a polite thank you and the address to which payment should be sent; and on the right, a column in which we calculate the total amount due, adding tax and shipping. Figure 10.15 shows what we'll get. These two elements, side by side, look like two columns. But instead of any of the column-making techniques we've used so far, this time we'll use a fifth method, positioned paragraphs, to get the effect we need.

The overall plan is this: first we'll put in the thank-you and send-address paragraphs. Then we'll put in a small table that will align with the main table. The thank you will be positioned on the left margin.
Thank you for your order!

Send payment to:
European Liqueur Imports
7300 North Warehouse Road
Trenton, NJ 08608

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub Total</td>
<td>149.50</td>
</tr>
<tr>
<td>Sales Tax</td>
<td>8.97</td>
</tr>
<tr>
<td>Shipping/Handling</td>
<td>6.00</td>
</tr>
<tr>
<td>Amount Due</td>
<td>$164.47</td>
</tr>
</tbody>
</table>

Figure 10.15: We want the thank you and send address to fit up under the bottom-left portion of the main table.

When we make the lower table narrow enough, it will fit to the right of the positioned object and move up there, just as text would flow around a graphic. Throughout this process we need to remember two principles of positioned objects:

What Makes Something Positioned?
To position an object, you have to set the parameters in the Position dialog box to something other than the defaults. No matter what the official width of the object might be, if it's set to Left with respect to column, In Line, and Auto width, it won't really be positioned.

Control Horizontal Size of Text with Paragraph Width
You can’t position objects on top of one another in ordinary circumstances, so whether text flows around a positioned object or positioned objects really appear beside one another depends on their not overlapping. Unfortunately, while the default (Auto) horizontal size of a graphic is its size, and that of a table is the ruler value of the righthand edge, the default horizontal extent of text is the distance between the margins (not the indents).

In order to make positioned text the right width, set it in the Position dialog box as a Paragraph Width entry.
The Thank You and Send Address

Following what we learned in Chapter 8, we will use the Position dialog box on the thank-you and send-address paragraphs.

- Format the thank you in 14 point bold and the send address with a plain box around it. (The box will extend across the width of the page; we'll change that soon.)

- Select all this text and bring up the Position dialog box. Fill in the Paragraph Width field with something reasonable, say 2.5 inches, as shown in Figure 10.16.

![Figure 10.16: The two selected portions of text are being set as positioned objects with a width of 2.5 inches. You can see the box around the send address extending to the right.](image)

- After you click OK, the box will extend only 2.5 inches left to right. In page view, you'll see a gray box around the whole ensemble—the thank you and the send box.

A Table under the Total Column

Now it's time to make the small table that will live on the right margin. We also need to allow for labels (such as "Subtotal") for these boxes. A four-row-by-two-column table underneath the main table will handle this very nicely. The small table we're about to create has entirely different formatting from the existing table, so we need to start it from scratch.
Underneath the send address, create a new empty paragraph. If the new paragraph is inside the box, make it Normal and eliminate its border by pressing ⌘-SHIFT-P.

Use the Insert Table... command in the Document menu to create a table with two columns and four rows. The new table appears in Figure 10.17.

![Figure 10.17: The new four-row-by-two-column table appears below the send address in galley view.](image)

Go to page view (⌘-B) to see this happen.

Select the new table and press the scale icon on the ruler. This gives you access to the column markers. Roughly line up the right and left edges of the right column with those of the main table up above. Ours are at 6 and 5.125 inches.

Now, do something counterintuitive: drag both those column markers (grab the left one without the SHIFT key) to the left about three inches. Let go. After a delay, the table should move up to the right of the send address.

What happened? You made the horizontal size of the table small enough that it fits to the right of the positioned text, which itself had a width of only 2.5 inches.
Now adjust the columns of the new table so they line up exactly with the old. You may have to adjust the old ones a little to get them to a good spot on the ruler.

The four labels should be right justified. You can accomplish that for all four cells at once by dragging the cursor from the top to the bottom and clicking on the ruler's right-justification icon. Type the labels (but not the dollar amounts). The result appears in Figure 10.18.

![Figure 10.18: In page view, the boundaries of the bottom-right cells line up with the main table, and the labels are right justified.](image)

The four bottom-right cells do not yet contain decimal tabs. Already having a style for amount boxes makes adding the decimal tabs easy:

- Select the four bottom-right cells and use the style-selection list on the ruler to apply the amount style to them. You will see the end-of-cell markers shift into alignment (provided you have Show ¶ turned on).

- These same cells need borders around them. While they are still selected, open the Cell Borders dialog box (if you didn’t add it as a menu command you have to go through the Cells... command in the Format menu). As shown at left, select the Every Cell In Selection option and place a hairline border around the entire cell. (Recall that double-clicking is a shortcut for boxing the cell.)
When I Print, There’s a Gap between the Tables! That’s right. The boxes of those two tables don’t quite overlap; there’s a little gap between them. The business of positioned objects and tables is tricky; we’re near the edge of Word’s capabilities. There is a tortuous way of getting rid of the gap, but frankly, it’s not worth the effort.

The Amount Due

The last box in the Total column will contain the amount due. Because we want this number to be easy for the customer to find, we’ll give it more emphasis with a shadowed box that takes up two lines.

- You’ve already typed the Amount Due label. Insert a newline character (SHIFT-RETURN) just before “Due.”
- Similarly, insert a hard carriage return just before the end-of-cell marker in the Amount Due box.
- To give the Amount Due box a drop shadow, bring up the Cell Borders dialog box again. (The cursor is still in the Amount Due box, isn’t it?) Use the thick line tool to apply a thick border on the right and bottom.

You may wonder why we did not apply a shadow border to the paragraph within the Amount Due cell; after all, the Paragraph Borders dialog box includes a shadow option. The answer, as shown at left, is that a shadowed paragraph within the cell would have borders that don’t line up with the rest of the table, and the right border of the shadow lies outside of the cell.

Adding a New, Blank Row

What happens when the number of blank rows we’ve provided is not enough for a given order? No problem. As the table grows, our positioned thank you will move down to accommodate the additional information. The key lies in keeping that positioned object vertically inline rather than absolutely positioned on the page. Then, like an ordinary paragraph, it will move down as you add new material before it.

You don’t have to go to some dialog box to add the new row. Just position the cursor in the Total (rightmost) column of the last row in the main table and press TAB. A new row gets added and the thank you and send address remain under the table!
The Top of the Invoice—Tricks with Tables

Having completed the most complex portion of the invoice, the remainder will be much easier. First, we’ll work on the top portion where the company’s logo and the document title appear; then, we’ll format the columns that contain customer and order information.

Logo and Title

We want the company logo, a graphic created in Illustrator, to line up across the top of the document with a box containing the title. Can you see that a one-row table with two columns is what we need? The left cell will contain the logo and the right cell will contain the title of the invoice.

So how do we insert a two-column table in front of the table that is already there? We could use the Insert button that appears in the Table dialog box, but that would insert a row with five columns and we would have to delete and reformat. It would be better to insert a brand new table, but if you try, you will see that with the cursor positioned at the beginning of the document (the top-left cell of the table), the Insert Table... command in the Document menu has become Table to Text.... Word has a special command for what we need here—Insert ¶ Above Row. It doesn’t appear on any default menu, so you have to find out the keyboard shortcut—⌘-OPTION-SPACE.

- With the cursor anywhere in the heading row of the table, press ⌘-OPTION-SPACE. You will get a blank paragraph above the heading.

If we’d thought of it ahead of time, we could’ve started the document with a blank paragraph. Now we can go ahead and insert the table we need:

- With the cursor at the very start of the document, select Insert Table... from the Document menu. The default in the resulting dialog box is just what we need, so click the OK button.
- Paste whatever graphic you will use for a logo in the left cell of the table. You may need to resize the graphic to fit, or increase the cell width to contain the graphic.
In the right-hand cell, we'll have two boxed paragraphs separated by a line. With the cursor in this cell, bring up the **Paragraph Borders** dialog box. First click on the **Plain Box** option. Then, with the hairline tool, click between the two paragraphs in the sketch, as shown below.

The outside border of the paragraph will look the same on the screen as the line between, but when you print on a laser printer, you'll see that the line between is thinner.

Type the two paragraphs as shown in Figure 10.19. Note the small caps formatting and the use of the centering alignment tool on the ruler.

You may find that the top and right borders of the title paragraphs don't show in galley view, but when you switch to print preview they will show (and they will print).

![Paragraph Borders Dialog Box](image)

**Figure 10.19:** The logo and invoice title are positioned and formatted within the cells of a single-row table.
Customer and Order Information

Take a look at Figure 10.20. Below the invoice's logo and title is a band that contains customer information on the left and order information on the right.

Figure 10.20: The top of the invoice in page view. The customer and order information are actually two tables, positioned beside each other.

What is the best way to format the customer and order information? Consider these possibilities:

- Four columns. This isn't right because the flow of text has a left-to-right component.

- Two columns, each with tab stops to line up the entered data. That would certainly be better, but to speed data entry, we would do well to take advantage of Word's tables.

- A four-column table. While better than using tab stops, a four-column table doesn't acknowledge that there are two separate sections to the data. Besides, not all the columns will have the same number of rows—and that's impossible in Word.
• Two two-column tables, positioned side by side. This has real possibilities, if we can figure out how to do it.

It's a lot like the bottom of this invoice; we'll show you a slightly different way to get a similar effect. First we'll create and format the two-column tables one under another. Then we'll place them next to each other as positioned objects.

In Figure 10.21 you can see how the galley view will look (with Show on) before the positioning. You know all you need to make these tables, but here are some notes:

• The order information table (on the right) comes before the customer information table. This means that we have only to make this table a positioned object; the other table will fall right where we want it. If you put the customer information table first, both tables will have to be positioned.

• To get the underlining in the order information entries, use the Cell Borders dialog box to put a border under each line. A hairline border will look especially elegant.

• The paragraphs in the label cells are all right aligned.

![Invoice Image]

Figure 10.21: The two tables lie one under the other in galley view. Note the space before each of the top rows.
• Notice the way the company name cell has opened up to accommodate a long name—exactly what you want!
• Add space before the paragraphs in the first row of each of the tables to separate them from the preceding table.
  ➞ Select the order information table by dragging from its top-left cell to its bottom-right cell. Bring up the Position dialog box (on the Format menu). Pull down the menu under Horizontal and select Right (see Figure 10.22). This will position the table to fit snugly against the right margin, leaving room for the customer information table next to it.
  ➞ Press the Preview button or use page view to see the effect of this positioning. It should be as we have already seen in Figure 10.20.

**Figure 10.22:** The order information table is being positioned to line up with the right margin.

**Filling In the Table**

All that remains is to fill in the amounts that appear below the main part of the table. In doing so, we'll encounter a slick feature of Word—the built-in calculator.
Practicing with Word's Calculator

First we’ll learn a bit about the calculator by practicing on a blank document. Then we’ll come back and use what we’ve learned to do the totals in the table.

- Open up a new document.
- Type in an arithmetic expression, such as 3 + 4, and then select it.
- Press %-=. You should see the sum appear in the status box as shown at left.
- The result of the arithmetic expression is also on the clipboard. To verify this, paste the contents of the clipboard. The result, 7, should take the place of 3 + 4.
- Try some other expressions. Here are some interesting ones:

<table>
<thead>
<tr>
<th>Expression</th>
<th>Result and Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>2*3 + 4</td>
<td>The result is 10. The asterisk tells Word to multiply.</td>
</tr>
<tr>
<td>4 + (2*3)</td>
<td>This time the result is 18, because Word always does arithmetic from left to right, paying no attention to parentheses or algebraic precedence.</td>
</tr>
<tr>
<td>1.000/3</td>
<td>The result is 0.333. The number of places to the right of the decimal point is determined by the maximum number of decimal places in the expression.</td>
</tr>
<tr>
<td>1/3</td>
<td>The result is 0! Neither the numerator nor the denominator has any places to the right of the decimal point, so the result doesn’t either.</td>
</tr>
<tr>
<td>3 + (4)</td>
<td>We get −1. Word treats single numbers in parentheses as negative—as the IRS does.</td>
</tr>
<tr>
<td>3 7</td>
<td>The result is 10. When no operator separates numbers, Word always adds.</td>
</tr>
<tr>
<td>24.99*6.5%</td>
<td>The result is 1.624; that is, 6.5 percent of 24.99. You can see how this might come in handy for computing sales tax.</td>
</tr>
</tbody>
</table>
Type two dollar amounts with a RETURN between them, select both paragraphs, and type =. As shown at left, Word still adds the numbers even though they are in separate paragraphs, and it ignores the dollar signs.

Often documents, especially forms like invoices, contain numbers that are part of calculations. While Word can't perform these calculations automatically, you don't need to pull out your calculator. You can just select the numbers and tell Word to calculate the result. Let's see how this works in the invoice's table.

### Calculations in the Invoice's Table

- Fill in at least two lines of the invoice table, so we have some arithmetic to do. (For the sake of clarity, we've deleted the table's empty rows in the following figures.)
- We want to add the dollar amounts in the Total column and paste the result in the Sub Total box. It's easy to select the numbers to add; just drag the mouse from the first cell to the last. Calculate the sum with = and paste the result in the Sub Total box.
- Assume a 6 percent sales tax. Type "6%" to the right of the subtotal. Select the entire expression. Calculate and paste the calculated amount into the Sales Tax box. Remove the "6%.
- Put a reasonable amount in the Shipping/Handling box.
- Now we want to find the amount due. Drag through the three relevant cells and calculate with =. Paste the result in the Amount Due box.

Not bad for a word processor! Still, Word’s ability to calculate doesn’t come close to what you could do with a spreadsheet, such as Excel, or a database, such as Reflex.

### Customization Corner

If you do a lot of work with tables, you'll want to make it easy on yourself by configuring Word so you can remember common commands and execute them easily. We have three suggestions.
Adding Cell Borders... to the Format Menu. If you find that you need the Cell Borders dialog box frequently, you will get tired of having to go through the Cells dialog box to get there. With the Cells dialog box showing, type ⌘-OPTION-++; with the resulting + for a mouse pointer, click on the Borders button. The flashing of the menu bar tells you that the Cell Borders... command has been added to the Format menu.

Adding Insert ¶ Above Row to the Document Menu. We find that we use Insert ¶ Above Row (⌘-OPTION-SPACE) often enough to warrant adding it to the menus. To do so, press ⌘-OPTION-+, and with the resulting + for a mouse pointer, give the command with ⌘-OPTION-SPACE. The menu bar will flash and the command will appear, with its keyboard shortcut, on the Document menu. This is the same procedure we used to install Insert New Section in Chapter 9.

Adding an Invoice Template to the Work Menu. Like the business letter that we created in Chapter 5, this invoice will be most useful as a blank template to be filled in each time a new one is needed.

⇒ Remove all the specific information in the invoice. To do so, simply drag the cursor through the cells that contain text to be removed and press ⌘-X to cut it. The text will be removed, but the table structure will remain intact.

⇒ Save this template invoice under a new name, such as “Invoice Template.”

⇒ Now you can install the template on Word’s Work menu. As we explained in Chapter 5, press ⌘-OPTION-+ to change the mouse pointer to a +. While the + is showing, use the Open command to open the template. The menu bar will flash and the template’s name will appear on the Work menu.

⇒ When you’re back in the Finder, be sure to lock your template. That way, when you save the template, Word will force you to give the saved invoice a new name, thus protecting the blank.

Now you can open a fresh, blank template any time you want by selecting it from the Work menu. Filling out this invoice from the template is easy and fast, once you get used to it. You can move from one field to another using the TAB and arrow keys.
For More on Various Topics

Templates and the Work menu—We first discussed these in Chapter 5.

Graphics—We didn’t say much about the logo at the top of the invoice. For more on using graphics in Word, see Chapter 8.

Positioned objects—These were introduced in Chapter 8 in the context of graphics on a flier; we’ll do a lot more in Chapters 11 and 12.

Tables—We first used tables in Chapter 7 to create side headings.
I stared at the lists on my screen and then stared for a while at the invoice for the liqueur. Something was hovering there, just below the surface. Manny Davis walked in.

"If it helps, I'm sorry."

"It does. Thanks. Manny, talk to me about the cookies. It doesn't make sense. If I were going to poison Victor, I'd poison the slivovitz. That's what he always drinks; there's no guarantee he'd eat an almond cookie."

"He would if you handed it to him. But I'd poison the slivovitz, too. Strong stuff, hides anything."

"Then there's this invoice from his briefcase."

"Yeah, I saw that. Why would he be carrying around a bill from over a year ago?"

Lights went on in my head for the first time in hours. "Manny. He was running out of slivovitz. He needed the address to reorder. If he ordered in case lots, it would take at least a year to go dry."

"OK, so what?"

"These liqueurs are imported--the feds stamp them with date-of-entry. The bottle from the table will be recent. Then check for other bottles in the apartment. There won't be any."

"Which means?"

"Whoever killed Victor poisoned the slivovitz. The killer switched bottles afterwards. Victor had run out, so the killer had to buy a new one to substitute. I predict you'll find slivovitz and cyanide in the sink trap, a broken bottle with a year-old date stamp in a dumpster, and a sale to Alice Land at a local liquor store yesterday. The cookies are a frame."

"Full of holes, Detective Stone. Too complicated for a crime of passion."

"Then it's a crime of planning, isn't it? Get on it, Sergeant!"

He shook his head and got. The next document was our expansion proposal, with Hines's name burned into the cover. I glanced at it, set it aside, and worked on the event program.
PROPOSALS

Leaving behind the relative simplicity of single-page documents, we venture into the complexities of multiple-page documents. We'll use a business proposal to introduce page numbering, multiple sections, and tables of contents. The toughest problem in longer documents is ensuring pages break at logical and aesthetically pleasing places—not, for example, just after a heading or in the middle of a figure caption. We'll introduce **Keep Lines Together** and **Keep With Next** and show how useful they are in dealing with page-break problems. Proposals often involve a cooperative effort, and Word, through hidden text, provides a mechanism for commenting on writing. Finally, searching for occurrences of formatting can be just as important as searching for words or phrases, so we'll see how Word meets this need.
General Design Considerations

A proposal's job is to convince the reader that a particular project is worthwhile. While the merits of the project are paramount, good writing and attractive page layout can help.

Thinking about the Reader

In many situations, the people reading the proposal will also be reading many other competing proposals. These readers are busy people who resent having to take extra time to search for information in a badly laid out document. Some proposals, such as this chapter's example, may be handed out during a meeting; they require that the reader be able to grasp the main points in a quick skim.

Let's think about a few of the ways that careful design can enhance a proposal's chances for success.

- Easy-to-find section titles and headings help the reader to see the structure of the proposal and keep oriented within it.
- A table of contents not only helps the reader find particular information but also presents an overview of the project.
- Well-designed pages attract the reader, making the proposal more a pleasure to read than a burden.

Beware of overdoing it. You don't want to draw the reader's attention away from the proposed project, and you don't want the reader to wonder if abundance of form hides an absence of content. As always, the purpose of page design is to bring life to what is on the page, not to overshadow it.

Writing as a Cooperative Endeavor

Writing a major proposal is usually a team effort. Sometimes the authors live and work in different locations. Working with word processors, they can edit and comment on each other's work, merge small pieces into a single whole, and share writing electronically on a network or through modems.
But computers offer new opportunities for screwing things up, as well. Files can be lost; it can become difficult to see what changes have been made; two people can inadvertently edit the proposal at the same time, making it difficult or impossible to incorporate both sets of changes.

Word has two mechanisms that help with cooperative writing—style sheets and hidden text.

**Writing within a Preliminary Design**

All through the writing process, the writers must judge the effectiveness of the proposal. Since page layout bears on effectiveness, it helps the writers to see the words more or less as the readers will see them. It makes sense, therefore, to create a preliminary design for the proposal at the same time as an overall outline. That way, each writer can work within the same design. Another reason to work within a preliminary design is that the final formatting will go much faster if all the paragraphs have agreed-upon styles.

The design for the proposal is embodied in the styles you define. With the **Define Styles** dialog box showing, you can select **Print...** from the **File** menu, and Word will print a list of all the styles in the document along with their definitions. Each writer can have a copy of this printout with comments written in about how the styles should be used.

Each writer should be given a template document with all the styles already defined. This way, the work of defining styles has to be done only once. If the design changes, the changes can be imported into individual writers' documents using the **Open** command while the **Define Styles** dialog box is showing.

**Commenting with Hidden Text**

When you write comments on hard copy, it's easy to tell your scribbles from the original. But if you try the same thing with Word, your comments easily blend in with the existing text. Furthermore, once you replace a sentence, the original is obliterated. Especially if it's someone else's sentence, it's both practical and polite to keep the original for review. Word has a handy formatting feature that can, to some extent, solve both these problems—hidden text.
The "hidden" in hidden text refers to a character format, just as italic or bold does. You apply the hidden format to the selected text through the Character dialog box or the Alt-SHIFT-X shortcut.

You can make your hidden comments visible or invisible, as desired. Figure 11.1 shows the dialog box you see when you use the Preferences... command on the Edit menu.

![Preferences dialog box with the Show Hidden Text option selected]

You can add Show Hidden Text to the Edit menu using the same techniques we've described in earlier chapters.

To write a comment with hidden text, do the following:

1. Make sure hidden text is showing (otherwise you can't see what you're typing).
2. Position the cursor where you want the comment to start.
3. Change the character formatting to Hidden. The Alt-SHIFT-X keyboard shortcut is much simpler to use for this purpose than the Character dialog.
4. Type in the comment. Figure 11.2 shows an example of what you might see on your screen.
The planned public stock offering provides the necessary capital to accomplish the expansion. MD — How much can we count on to come from the offering and what percentage comes our way? CH.

Figure 11.2: A sentence in the proposal with a comment in hidden text

When you revise another writer's words, you can save the old version as hidden text so you can compare it later with the new. After reviewing the changes, the original writer can delete the hidden text.

The Print dialog box has an option that allows you to say whether or not you want hidden text printed. A warning with respect to hidden text and page layout is appropriate: Line breaks and page breaks will be different with hidden text showing than when it is not showing.

As an alternative to Word's hidden text, you might consider a desk accessory called Comment, made by Deneba Systems. It simulates those ubiquitous sticky notes, allowing you to attach pop-up comments to particular phrases in your documents.

A coupon for another aid to group writing comes with Word—DocuComp. With it, you can compare two versions of a document.

**Laying Out the Sections**

The sections of a proposal, though they contain quite different kinds of information, should still have a uniform feel. A reader confronted with great variation from section to section will wonder if the project itself suffers from lack of planning. Here are some techniques to achieve consistency of style:

- A uniform grid for all sections, that is, the same margins, column widths, and placement of headers
- The same font throughout
- Consistent styles for section titles and headings
We'll go through each of the five parts of the example proposal—the cover, abstract, background, plan, and budget—looking at the page layout of each. We have introduced most of the techniques in earlier chapters, but a few fine points will come up.

The first major organizational decision we make is to format each part of the proposal as a new section in Word. This has some advantages we'll see later on.

**Paper and Fonts**

We have to decide a few things before we do the first section, because they will apply to all sections:

- Paper and margins. Word's defaults will do fine here: 8.5" x 11" paper in tall orientation with 1.25" for left and right margins and 1" for top and bottom margins.
- Body font. Legibility is important. Bookman is a LaserWriter Plus font that the Adobe Type Catalog describes as highly legible, used "to give a document a strong, straightforward look." (The vocabulary of typeface appreciation rivals that of wine tasting.)
- Heading and title fonts. We could switch to a sans serif font, such as Helvetica or Avant Garde for headings, but we'll resist the temptation and stick with Bookman.

**The Cover—the First Section**

Figure 11.3 contrasts two possible layouts for the cover: one centered and the other flush left. Take your pick. We think the centered version looks too stable for a proposal about change, so we'll opt for the more interesting, asymmetric version. Since mixing symmetric and asymmetric layouts isn't usually a good idea, you will see how this choice stays with us throughout the document.

Formatting the cover presents us with a dilemma. On the one hand, it hardly seems worthwhile to define a style for each of the paragraphs, especially when we are sure that these styles will not be used later on in the proposal. On the other hand, we would like to retain the ability to experiment with different layouts.

To solve this problem, notice that there are a few characteristics that all the paragraphs in the cover share: the same indents, justification, and font (though not font size or character format). A good way to
work with the cover page is to define one style called \texttt{cover} and put the common formatting in it:

\texttt{cover} All paragraphs on the cover inherit from this style.
Normal + Indent: Left 1.5in

Now we can work with each of the paragraphs on the cover page separately, first applying \texttt{cover} to it and then modifying it as we need. Figure 11.4 shows the asymmetric cover page showing the formats that apply to each paragraph.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{cover_page_examples.png}
\caption{Two versions of a cover page, one symmetric and the other asymmetric}
\end{figure}
The Abstract

This abstract occupies a page by itself, as you can see in Figure 11.5. The flush-left proposal and section titles repeat the design theme we established on the cover. The graphic succinctly states the proposal's main idea—expansion. The two paragraphs of the abstract lie high on the page, leaving plenty of white space on the bottom to balance the graphic on the top.
Contrary to predictions made a year ago, Immaculate Assessment has saturated the assessment market in the San Francisco Bay Area. Because of the expansion undertaken at that time, we are now top-heavy with professional staff and management who are, nevertheless, fully trained and anxious to undertake more contract work. At the same time, an increasing number of contracts have come in from places outside the Bay Area, concentrated in large cities in the West.

The time seems ripe for opening branch offices. This proposal details plans over the next nine months for eight branches at the locations shown on the above map. The cost, estimated at $1.7 million, will be born by loans to be paid back from sale of public stock in June, 1989.

Figure 11.5: The proposal's abstract

One reason to put the abstract into its own section is to force it onto a new page. Another use of separate sections, one that we will meet in Chapter 15, is to put the section title in a line of text, called a running head, at the top of the page. Let's go through the layout of this page.
The top of the page shown in Figure 11.5 presents a formatting problem. How do we get the map of the U.S. beside the title of the section? (The map itself is bit-mapped clip art labeled in the draw layer of SuperPaint.) Word offers two possible solutions:

- As we did for the logo and title of the invoice in Chapter 10, create a table and put the title in the left cell and the map in the right cell.
- Format the map as a positioned object as we did graphics on the flier in Chapter 8.

Either of these alternatives will work quite well. Let’s pursue the second—the map as a positioned object—because we can explore some additional options in the Position dialog box.

- Put a section mark (¶-ENTER) at the beginning of the abstract section. Use the Section dialog box to make sure this section starts on a new page.
- Format the title using the style definition below. You can see how it appears in editing mode with Show ¶ in Figure 11.6. We used the 36 points of space before to center the text vertically with the graphic:

  title  The proposal title reappears at the top of the abstract page.
  Normal + Font: 18 Point, Space Before 36 pt

- The map goes in a Normal paragraph underneath the title, as shown in Figure 11.6.
- Now we’re ready to position the map. (Make sure you are in page view so you can see the effect of the positioning.) Select the graphic and bring up the Position dialog box. (The command is on the Format menu.)
- For Horizontal positioning, choose Right. (Since this section has only one column, Relative to: Column is the same as Relative to: Margin.)
- For Vertical positioning, choose Top (as shown in Figure 11.7). Press the OK button and, provided you are in page view, the map will move into place.
Immaculate Assessment Expansion Proposal

Figure 11.6: The two top paragraphs of the abstract as they appear on the screen

- Define the style for the abstract heading. Give this paragraph this heading 1 style, clicking Yes in the dialog box you get that asks if you want to change this automatic style:

  heading 1 Use this for the section titles.
  Normal + Font: 18 Point, Space Before 36 pt, Border: Bottom (Single)

- 36 points of space before will work well for the titles of other sections in the proposal. But this particular title needs a bit more

Figure 11.7: We're using the Position dialog box to position the map snugly against the right and top margins.
space. Using the **Paragraph...** command, give it 1.5 inches of space before. Its formatting becomes heading 1 + Space Before 108 pt.

Finally, define the **body** style:

**body**  Use this style for narrative paragraphs.
Normal + Justified, Space Before 12 pt

With these styles and the map positioned, you’re ready to format the abstract. It will look like the sample document at the beginning of this chapter. Using **heading 1** for the section headings will save us a lot of work later on when we make a table of contents. We won’t want the abstract in the table, so we’ll remember to deal with that.

---

**Heading Styles and the Table of Contents**

Word can generate a table of contents from the titles and headings in the document that have one of the outlining styles, **heading 1** through **heading 9**.

If you plan to have a table of contents that shows the page numbers of headings, use the **heading** styles for them—even if you don’t use Word’s outliner.

---

**The Background Section**

- With the cursor after the abstract, hit RETURN and then ⌘-ENTER to start a new section. Type the section title, “Background.”
- Apply the **heading 1** style to the section title.

As you can see in Figures 11.8 and 11.9, the Background section of the example proposal has five subsections, titled Recent History, Reasons for Expansion, Why Branch Offices?, Availability of Resources, and Financing. They will all need headings; each heading will be a **heading 2** paragraph so it will show up properly in outline view and in the table of contents. In addition, this first subsection, Recent History, has paragraphs and labels of its own.
Second-Level Headings

- Create the text for the section, leaving the subsection titles temporarily in their own body paragraphs. For a moment, don't worry about the side headings under Recent History.
- Define the heading 2 style below and apply it to each of the subheadings in the section (36-A can speed up this process):

heading 2 Use these for headings within a section.
Normal + Font: 14 Point, Bold, Space Before 24 pt

---

Figure 11.8: The first two pages of the Background section
we must come in significantly higher than the local competition. Our reputation has kept us competitive thus far, but this will not last long.

Branch offices will have their own advertising and marketing staff, thus making it easier to reach out into the business community and find new contacts. So growth in number of contracts will be all that much faster.

According to an analysis made by our marketing department, opening branch offices will bring in an additional $10 million in contracts per office by 1991, as compared with an additional $25 million in contracts total under the assumption of expansion from the main office. In short, marketing research shows that Immaculate Assessment will enjoy the same success in other cities that it has enjoyed in the Bay Area provided it expands by opening branch offices.

Availability of Resources

Part of the point of opening branch offices is to take advantage of the newly trained staff. Fortunately, these new staff members are nearly all young and mobile, having recently graduated from universities. Many are former students of our president. An informal poll has shown that more than enough of these new staff are anxious to try out their wings in a new location where they can assume more responsibility than they can here.

But Immaculate Assessment cannot entrust the new offices entirely to the new recruits. A research director for each new office must be found. Four of the new directors will come from the senior staff of the home office. But the other half must be new hires. Feelers put out by president Brockmeyer among his colleagues at universities near the proposed sites have been encouraging. Though the search will be time-consuming and expensive, we anticipate that the required four new directors of research can be located.

Financing

Opening the proposed branch offices will not be cheap. Each branch will require approximately $400,000 up front to get started, and then subsidy for losses incurred during the first six to nine months of operation. Immaculate Assessment’s coffers cannot currently support the proposed level of investment. But the stock offering that has been proposed for July of this year will generate the required capital. Indeed, this proposal is completely dependent on the stock offering for its feasibility, as Immaculate Assessment’s outstanding loans already impose a financial burden on the company.

Figure 11.9: The third page of the Background section

Outdenting or a Table?

There are five similar paragraphs under Recent History, each of which gets a side heading showing the aspect of recent history it discusses. The top of the page appears in Figure 11.10. How should we format this section—with a table, as we did in Chapter 7; with positioned objects, as in Chapter 9; or with outdented paragraphs, as we did in Chapter 4? We choose the simpler alternative, outdenting. We
can use it because each side heading requires only one line within the narrow column. Figure 11.10 shows the ruler setting and the tab characters. From the ruler’s style selection box, you can see that we have defined a style for these paragraphs, called outdented. Also note that the side headings currently are underlined. Later on we’ll go through and find all instances of underlining and change them to the more elegant italics.

![Figure 11.10: The first paragraphs of the Recent History subsection have an outdented format.](image)

**Wrapping Text under a Graphic**

We would like to format the Reasons for Expansion subsection so that it looks like Figure 11.11. It contains a graph imported from Excel.

This kind of formatting problem is exactly what Word’s Position command is good for. We’ll fix the position of the graph and its caption, letting the body text flow around it.

Working in galley view, we have to decide where the graph and caption come: after the heading or after the body paragraph?
Reasons for Expansion

As the graph at right shows, company profits have leveled off while the amount earned per professional staff member has taken a dive. Factors contributing to this state of affairs are the previously mentioned local market saturation, which has resulted in a much smaller number of contracts than anticipated, and the increased overhead staff members incur when they handle nonlocal contracts. The sharp downturn at 1987 is largely due to the over-optimistic hiring that began then.

Immaculate Assessment has come to a crucial moment in its history. Should it cut back its staff in the face of the reality of a smaller-than-anticipated market, or should it expand into other markets?

Figure 11.11: The paragraph to the left of the graph wraps under it. (As seen in page-view.)

Let Word Do as Much of the Positioning as Possible

Using the In Line option is generally better than moving an object around in print preview. Once you’ve moved an object in print preview, it will stay in that spot on the page even when you add or delete text. Not so with In Line objects. When you add or delete text, they move up or down, so they stay in the same order relative to the ordinary text that surrounds them.

To decide where an In Line paragraph should go in galley view, decide what you want it to appear under. Put the paragraph to be positioned after that.
So we want the graph just under the heading. Figure 11.12 shows a galley view for the first part of this subsection.

![Figure 11.12: In galley view, before we position the graph and caption, the text is too wide and does not wrap around the chart.](image)

As the graph at right shows, company profits have leveled off while the amount earned per professional staff member has taken a dive. Factors contributing to this state of affairs are the previously mentioned local market saturation which has resulted in a much smaller number of contracts than anticipated and the increased overhead staff members incur when they handle non-local contracts. The sharp downturn at 1987 is largely due to the over-optimistic hiring that began then.

The title at the top has the heading 2 style and the paragraph after the caption is an ordinary body paragraph. The styles for the graph and caption are defined as follows:

**graph**  
Used for a figure that is to appear in a box.  
Normal + Centered, Space Before 12 pt, Border: Top Bottom Left Right (Single)

**caption**  
For paragraphs that follow a figure.  
Normal + Font: 10 Point, Italic

Select both the graph and its caption. Then bring up the **Position** dialog box. Select **Right** in the **Horizontal** menu; leave the **Vertical** alignment set at In Line. Type in an appropriate width; with the ruler showing, as in Figure 11.13, you can eyeball the width of your graph as 3.5 inches. Put that in the **Paragraph Width** box.
As the graph and caption are in the same area, we can superimpose them while the amount earned remains the same. Factors contributing to the number of contracts handled by market saturated members is the number of contracts that anticipated the increased overhead staff members incur when they handle non-local contracts. The sharp downturn at 1987 is largely due to the over-optimistic hiring that began then.

Figure 11.13: With the ruler showing, we estimate the width of the graph. We’ve positioned it horizontally flush right with the column (same as margin), and vertically in line.

- Press the OK button. The graph and caption will narrow, and, if you switch to page view, you will see the text flow we wanted.

The Plan Section

Begin the Plan section with a section mark. Like the Background section, the Plan section has several heading 2 headings. It also has a graphic and caption, but since they stretch across the full width of the page, they present no special problems. In fact we can use the same graph and caption styles defined for the Reasons for Expansion section. Figure 11.14 shows the first portion of this section with Show ¶ on.

The work plan, created in MacProject II, looks good centered in a boxed paragraph. Note the SHIFT-RETURNS just before and after the graphic. Without these, the top and bottom of the graphic would lie uncomfortably close to the top and bottom lines of the box.
As Vice President in charge of operations, Charles Stuart Hines will oversee all phases of the opening of the branch offices. He will appoint a coordinator to serve under him to handle the details. Three months are allotted for planning so that the actual opening can go as smoothly and as inexpensively as possible. During the planning period, additional contacts in each of the eight cities will be made in the usual way so that the new offices will have new contacts waiting for them. Because Immaculate Assessment already has contracts in the areas to be served by the branches, professional staff will have work to do as soon as they can get settled in. Hiring of support staff will begin well before the offices open.

During the three-month planning phase, Mr. Hines will build up a small staff to coordinate the opening. Most of this staff will be taken from those professionals and support staff who will eventually move to the new locations.

Two-thirds of the way through the planning phase, a report will be made back to the board and approval sought for the next phase.

Figure 11.14: The first portion of the Plan section presents few formatting problems.

The Budget Section—Pasting, Editing, and Updating Links

The last section of the proposal contains a budget imported from an Excel spreadsheet. Figure 11.15 shows the top portion of the first budget page. We will produce the budget in Excel but format it in Word, creating a link to the appropriate spreadsheet cells. When the proposal budget changes at the last minute, we'll have Word ask Excel
for the contents of those cells; we won't have to cut and paste, and the formatting will be preserved.

We'll describe communication with Excel, but it's also possible to make hot links—logical connections between documents created by different applications so that you have to change only one of them to update both—to graphics in SuperPaint and to use a feature called QuickSwitch with a number of other programs, including MacDraw and MacPaint. See the Microsoft Word User's Guide for details.

Let's see how this works:

- Start, as usual, by inserting a section mark before the heading.
- In Excel (Version 1.5 or later), select from the top left to the bottom right of the desired table. Choose Copy in the Edit menu. This puts the table into the clipboard along with some information about where the data comes from.

<table>
<thead>
<tr>
<th>Table</th>
<th>Name</th>
<th>Budget Breakdown</th>
<th>Phases of the Plan</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Costs</td>
<td>Planning Phase</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Salaries</td>
<td>$178,917</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Personnel Costs</td>
<td>$65,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Salaries</td>
<td>$20,750</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Salaries</td>
<td>$178,917</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Other Expenses</td>
<td>$48,500</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Phase Total</td>
<td>$227,417</td>
</tr>
</tbody>
</table>

Figure 11.15: The first few paragraphs of the Budget section include a table imported from Excel.
Back in Word, position the cursor immediately in front of the paragraph that is to follow the table and choose Paste Link from the Edit menu.

The text of the Excel cells appears, separated by tabs, each row in a new Normal paragraph. Format them any way you like; for example, if you select the new lines and choose Insert Table from the Document menu, you create a Word table.

When your budget changes, don’t change it directly in Word. Change it in Excel. Then, in Word, select the entire table and choose Update Link from the Edit menu. Word will fetch the cells from the spreadsheet and replace them in your Word document.

A lot can go wrong; it helps to know how it works. Excel sticks a paragraph of hidden text on the clipboard with the text of the cells so Word will know which cells to fetch from which document. Consequently, if you change the location of the cells in Excel, Word will find the wrong stuff! Next, even if you don’t have Show Hidden Text turned on, you’ll see the vertical space for that hidden text in galley view. Don’t worry; it vanishes in page view or in print. Third, Update Link won’t work unless the hidden paragraph is selected. Just be sure to select the whole table and it’ll work fine.

**Detailed Formatting**

This proposal is nowroughed out, but the polishing has only begun. Minor flaws catch readers’ eyes and draw them away from what the proposal is trying to say. Let’s polish things up.

**Changing Underlining to Italics**

Some character formatting within paragraphs may be incorrect at this stage. Perhaps a typist reading from hand-written notes has used underlining instead of italics for emphasis. Word provides a way to go through the entire document and change occurrences of underlining to italics. Here’s how:

At the very beginning of the proposal, create a paragraph with Normal style and type in a word. Select the word and underline it.
Word has a keyboard command for finding the next occurrence of a given character style. With the underlined word selected, type ~-OPTION-R. Word will scan forward in the document looking for the next occurrence of underlined text.

In the example, the word "Personnel" appears underlined, but it should be italicized. Press ~-SHIFT-U to remove the underlining and ~-SHIFT-I to italicize.

You now want to go on to find the next underlined text. ~-OPTION-R will not work this time, because the selected text is now italicized rather than underlined. For this situation, Word provides the Find Again command on the Utilities menu and its ~-OPTION-A keyboard shortcut (the A is for Again). This command finds the same style as was last found. Do it.

Change the underlining to italics in the newly found text. Continue this sequence of finding and changing until an alert box appears asking if you want to continue the search from the beginning of the document.

Clicking the OK button takes you back to the initial underlined text that you created. Delete this paragraph.

Searching for character styles is also useful for finding hidden text. Supposing comments are in hidden text format, you can quickly move from one comment to another using ~-OPTION-A.

Sometimes it is not character formatting that you want to find, but paragraph formatting. Word can tell the difference. First double-click in the selection bar to select a paragraph with the formatting you want to find. Then type ~-OPTION-R to search for the next paragraph with that formatting. ~-OPTION-A will continue the search for the next occurrence of the same formatting.

About Page-Break Problems

Murphy's Law of desktop publishing says that the page break will always occur at the most awkward place. Word has a number of tools that will defeat Murphy a surprising percentage of the time. In this chapter, we'll see how two of these tools apply to the proposal.
A Stranded Heading  
and the Hard-Page-Break Temptation

We discover page-break problems using print preview. Consider Figure 11.16. It shows a heading, Moving Phase, which has gotten separated from its body text by a page break.

Word offers a tempting solution to the problem of stranded headings—the hard page break. You insert this character into a document to force Word to move on to the next page.

If you must use hard page breaks, reserve them for the very last formatting pass before you print. When you do that, be sure to start at the beginning of the document—and never look back.

We feel so strongly about not using hard page breaks that we would almost rather not inform you that you can create them with the Insert Page Break command on the Document menu or with the keyboard shortcut, SHIFT-ENTER.

Figure 11.16: Print preview shows that the bottom of a page in the Plan section has a stranded heading.

Keep With Next to the Rescue

Word deals with the problem of stranded headings so magnificently that you will rarely worry about them once you start formatting them with the Keep With Next option in the Paragraph dialog box. Word guarantees that paragraphs with Keep With Next formatting will have at least their last line on the same page as the next paragraph. Since headings usually have only one line, they will be forced to the next page.
rather than being separated from the following paragraph by a page break. When you edit your document, Word sets page breaks depending on whether the heading and the next paragraph fit on the page.

**Keep With Next □**  **Keep Lines Together □**

Using the Paragraph dialog box, redefine the heading 2 style to include Keep With Next, as shown below. Check that this solves the stranded heading problem in page preview.

**heading 2** Use these for headings within a section.
Normal + Font: 14 Point, Bold, Space Before 24 pt, Keep With Next

Another prime candidate for Keep With Next is a figure that must be kept with its caption. The graph style in the proposal is a good example. It could easily have happened that a page break comes between the figure and the caption. Keep With Next formatting assures that this will not happen.

**graph** For paragraphs that contain a boxed graphic.
Normal + Centered, Space Before 12 pt, Keep With Next, Border: Top Bottom Left Right (Single)

**Bind Two Paragraphs with Keep With Next**
Heading paragraphs, figure paragraphs, and some others become confusing if they are stranded at the bottom of a page, separated from the following paragraph by a page break.

Define a style that includes Keep With Next formatting for these paragraphs.

**The Split Caption and Keep Lines Together**

While we’re talking about captions, think about another possible problem—if a page break came right in the middle of a long caption, the reader would have to deal with the last lines of the caption stranded at the top of the next page.
Keep With Next ¶  Keep Lines Together

Word's solution is Keep Lines Together, which also appears in the Paragraph dialog box. Paragraphs with this format will be forced entirely to the next page if a break threatens to occur in the middle. Here is the redefinition of caption:

caption  Use with captions to graphics.
Normal + Font: 10 Point, Italic, Keep Lines Together

Bind Lines in One Paragraph with Keep Lines Together

Certain paragraphs, notably figure captions or text in a box, become confusing or lose their impact if broken by a page break.

Define a style that includes Keep Lines Together formatting for these paragraphs.

Word will try to satisfy all of the page-break formatting information you give it. For instance, suppose you have a figure formatted with Keep With Next and its caption formatted with Keep Lines Together. Then, if a page break falls in the middle of the caption, Word moves both the caption and the figure to the next page (leaving you to figure out how to deal with the resulting white space).

Tirade against Hard Page Breaks

You will frequently be tempted to insert hard page breaks. No matter how innocuous they seem at the time, they will come back to bite you with a skimpy, lonely paragraph at the top of some page in your supposedly final printout.

Inserting hard page breaks in a document to get the pages to work right is like inserting hard RETURNs to make the text wrap the way you want. Avoid it. It's better to tell Word what you want kept together than what you want separated.
Making a Table of Contents

Word can construct a table of contents for you automatically, based on the heading styles. A table of contents isn't much good, however, unless the pages are numbered.

Placing Page Numbers

In this proposal, page 1 will be the first page of the Background section. We won't number the cover or the abstract. One easy way to place these numbers is through the Section dialog box.

⇒ Position the cursor somewhere in the Background section and give the Section... command.

⇒ Notice that the bottom part of the Page Number box is shaded. Click on the Auto option. The From Top and From Right boxes become available. Word's default placement for page numbers is 0.5 inches from the top and 0.5 inches from the right of the page.

⇒ Since you want page numbering to start from 1 in this section, click on the Restart at 1 option.

⇒ Make sure the First Page Special option is not checked. When it is, Word doesn't put a page number on the first page of the section.

⇒ Press OK, then use print preview or page view to see how the page numbers look. Figure 11.17 shows the upper-right corner.

⇒ Page ahead until you get to the next section. No page number!

Page Numbering Stopped in the Next Section. Although you told Word to number the Plan section, it did not change the section formatting of any of the sections that follow. You have to do that section by section.

⇒ Move the cursor into the next section and use the Section dialog box to turn on page numbering. (Click the Auto box but don't turn on Restart at 1 this time.)

If you had added the page number to the Background section before creating later sections, they would each have had the same section format—and the page numbers would have been present.
In the five years since Immaculate Assessment's founding, the company has expanded to over 200 employees, including 82 professionals and 110 administrative and support staff. A large part of this expansion happened in January, 1987. Morale is currently quite low because many of the new staff members are still under-utilized.

Figure 11.17: Page view of the first page of the Plan section shows the page number in the upper-right corner.

Creating the Table Itself

Now that the pages are numbered, we can create the table of contents for our proposal.

- Select Table of Contents... from the Utilities menu. The resulting dialog box is shown in Figure 11.18.

Figure 11.18: The Table of Contents dialog box
The dialog box you get is probably already set up as shown in the figure. **Outline** is checked, because you want to generate the table of contents from the outline. **Show Page Numbers** is checked, because you do want to have the page numbers listed. And **All** is checked, so that Word will use all the levels in the outline. (If the outline had many levels, you might want only the first few to show in the table of contents.)

- Press the **Start** button. Word will first repaginate the entire document and then go through gathering up all the headings into a table of contents. The result gets pasted at the front of the document, as shown in Figure 11.19.

- Word leaves the table of contents selected. That’s good, because you need to position it between the Abstract and Background sections. Just use **Cut and Paste**. (Position the cursor just before Background, as shown in the margin, before you paste.)

### Editing the Table of Contents

Once you have created the table of contents and put it in the right place, it becomes ordinary, editable text. That means you can simply delete the first line because it shows the entry for the Abstract. Another...
A good thing to do is to add a heading to the whole table of contents section (using the heading 1 style). Finally, give the first line 12 points of space before. Figure 11.20 shows the result.

Each line in the table of contents is a complete paragraph. Word assigns these paragraphs an automatic style corresponding to their level. Heading 1 headings show up in toc 1 paragraphs, heading 2 headings in toc 2 paragraphs, and so on, up to heading 9. You can redefine these styles just as you would any other to match the particular formatting for a table of contents that suits you:

**toc 1** This is the outermost table-of-contents style.
Normal + Indent: Right 0.5in, Tab Stops: 5.75in ...; 6 in Right Flush

![Table of Contents](image)

**Figure 11.20**: The final table of contents. Notice that we’ve added 12 points of space before the first line.

---

### For More on Various Topics

**Hyphenation**—This proposal would look better if it were hyphenated. See Chapters 9 and 12.
Spelling—You would want to check the spelling on a proposal. See Chapter 13 about how to use Word’s spelling checker.

Text beside a graphic—We mixed text and graphics in Chapter 8 and in Chapter 10. In Chapter 7, where we used side headings in a résumé, we learned the fundamentals of side-by-side paragraphs.

Page numbering—in this chapter we used the Section dialog box, but you’ll learn much more flexible schemes starting in Chapter 12.

Tables—in this chapter, we imported a table from Excel. We introduced tables in Chapter 7 and expanded on them in Chapter 10.

Table of contents—Word has another way to construct a table of contents besides the outlining styles. Chapter 12 shows how to use hidden text commands to do it in the context of a simple book.

Headers in sections—in a long proposal, it would help the reader if a header with the title of the section appeared at the top of each page. See Chapter 15 for how to do this.

Widows and orphans—Single lines of paragraphs stranded at the top (widows) or bottom (orphans) of a page don’t look good. See Chapter 18 for how to deal with them automatically.
An hour later, the program was on its way to the printer and I was getting hungry. I tried to call Manny Davis, but they said he was in the field.

Practically everyone was at work, on assessment projects, the stock bash, or preparing for the offering itself. But the usual bedlam was muffled. An electric edge kept everyone wanting to gossip, morbidly, about the night's events, but not quite knowing whether it was proper. It was a strange feeling. Everyone knew Victor, but no one would miss him.

I took some calls from the press and didn't tell them anything. Finally, at a quarter to one, Manny showed up with a smile.

"Delilah, how do you know these things? I'd arrest you if you didn't have a good alibi. Slivovitz in the trap, a bottle in the garage dumpster."

"Do you know where she bought the bottle?"

"We're working on it."

"So you're going to release Clara?"

"What if she bought the bottle?"

"Come on, Manny, why would she go to such lengths to frame herself?"

"You said yourself, a crime of planning. Why would the killer go to such lengths to frame Clara McConnell? What if she poisoned both the slivovitz and the cookies, just to be safe. She was coming back because she forgot to dump the macaroons."

"It makes a lot more sense if it's Alice. Look, I'm starved. How about if I buy you lunch and tell you why Alice killed him."

As we were leaving the building, I saw a package in Victor's incoming mail. I handed it to Manny; he had the warrant. It was a paperback from Brian Thompson, that broker at Phelan and Co. A bookmark was inserted at Chapter 4.

Manny and I headed for the Marina Deli. He put the book into his jacket pocket. "You said it makes more sense if Alice killed him. It depends on the motive. We looked into Alice," said Manny, "and they're not divorced."

"But he told Clara they were!"
EVER SINCE THE SEC CAME INTO BEING AS A watchdog agency, shenanigans such as the one Vanderbilt pulled off in the "Nickelplate Railway" case are harder to get away with. It's not that fraud is any less legal now than it was in the nineteenth century, but the existence of the SEC has made the more straightforward bilking of stockholders, major and minor, easier to prosecute.

But the SEC's leash extends most comprehensively only over the public securities markets. In this chapter you'll meet Elizabeth Oleander, a slippery practitioner of the gentle art of fraud who made her millions in a series of private stock transactions.

Her scam was a new twist on another classic ploy the Barons used to get rich off the rails—the one we met in Chapter Two: sell out your large interest in a company that only you know is junk. The corporate shell provides both immunity from creditors and the confidence that brings investors in. It is always easier to make a company look good than to make it a genuinely profitable venture, and Elizabeth Oleander was a master of corporate disguise. She was also in the right place at the right time.

That was Silicon Valley in the early seventies, just before the invention of the microprocessor. Oleander Electronics was assembling a highly profitable line of gadgets and components that sold to middlemen from
SIMPLE BOOKS

In this chapter, we will design and format a chapter of a simple book. What do we mean by simple? It will be all prose, there won’t be many headings, and there certainly won’t be any forms or boxes. What is it about books that presents problems? First, books are always printed on both sides of the paper. We say that books printed on both sides have *facing pages*, and that two pages that face one another form a *spread*. Second, like the proposal we made in Chapter 11, books need page numbers. These numbers usually appear (with some text) at the top of every page; the text and the page number together make up the *header* of the page. After creating the header, we’ll take some time to make the chapter title look good and learn to create a *drop cap*. We’ll learn to use automatic hyphenation. Finally, since books are long, they rarely fit into one file. We’ll deal with problems common to multifile documents, such as sequential page numbering and making a table of contents.
An Overview of the Project

We're going to write a chapter of a book and format it like a standard paperback. We'll format a few pages of manuscript (any long section of text without headings will do) in small type. We'll change the size of the page to match a standard paperback. We will then add headers to the pages that include page numbers.

After that, we'll play around with the beginning of the chapter to get it to look nice and hyphenate the rest of the text to get rid of the unsightly gaps that full justification produces.

Because this is only one chapter in a book, new problems surface. How do you get the pages numbered correctly? Where do you keep the other chapters? How can Word help make a table of contents?

Along the way, we'll mostly be applying techniques from earlier chapters. We will need only one really new concept, facing pages, and one spectacularly useful feature; headers and footers. Before we begin, though, let's get some things straight about facing pages.

Facing Pages: Theory and Tradition

First of all, even a LaserWriter can't print on both sides of a page at once. As a desktop publisher, you will produce one-sided originals, which you will then give to a printer or feed into a capable photocopier to create your final product. Printing back to back, as it's called, can be a formidable intellectual challenge. We will not tackle it here.

Actually, it's the appearance of a spread that most interests us. A spread is what you see when you open up a document that's printed back to back, that is, on both the left and right pages (see Figure 12.1). The page on the left faces the one on the right. There are three interrelated traditions that you should adhere to if you want to please your readers and your printers:

- Odd-numbered pages are on the right; even-numbered pages are on the left. You might think it's a silly convention, but printers will remorselessly screw up your print jobs if you don't adhere to it. And they will be right.
- If you want your work bound, it is customary to leave additional space on the inside margin to accommodate binding. Binding includes hole-punching and stapling. The additional margin on the
inside is called a \textit{gutter}. Printers appreciate a gutter because it makes binding easier, and readers appreciate it because they don't have to read into the crack or too close to the holes.

- The page number is frequently on an outside corner, usually at the top of the page. The implication for formatting is that there will be elements on your pages that will be \textit{different} for odd pages than for even pages.

Figure 12.1 shows pages 2 and 3 of the example book chapter we'll be making. (We call it Chapter 4.) The two pages form a spread, with page 2 on the left. Though you can't read them, you can see the page numbers in the upper-outside corners as well as the text (the book name on the left and the chapter name on the right) that forms the rest of the headers. The book you're reading has similar headers.

There are two more traditions of bookmaking:

- Whole books begin on a right-hand page (page 1). In many books of nonfiction, chapters also begin on a right-hand (odd) page.
- Header material (such as the page number or the name of the book) that appears at the top of every page is usually absent from the first page of every chapter.

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{figure12_1.png}
\caption{A two page spread—pages 2 and 3 of our chapter}
\end{figure}
Figure 12.2 shows the first page of our Chapter 4. Notice that there is no header (just the name of the chapter, which is set in regular, large text) and that the chapter starts on a right-hand page.

So there are really three different types of pages in our document: first pages, which have no header; even pages, which appear on the left; and odd pages, which appear on the right.

Preparing the Manuscript

For this project, let's assume that you have typed the entire manuscript in Normal style. We'll need quite a bit of text to format, because we'll have to see how the different kinds of pages (first, odd, and even) look. So take about a thousand words of something that you've written that's all prose and get it ready to format. A thousand words is about four double-spaced typewritten pages.
The first change will be to define **Normal** to set the font and a new style, named **body**, which will describe most of the text. So do this, watching the text change appearance:

- Select the whole text by holding down the % key and clicking in the selection bar at the far left of the window. There are a lot of other ways to select all the text, but this is the fastest.
- Apply the **Normal** style. If the ruler is showing, you can do that using the style selection list. Another shortcut for applying **Normal** is %-SHIFT-P.
- Using the **Define Styles** dialog box, redefine **Normal** as shown here:

  **Normal**  Used here to set the font and the size.
  Font: Times 10 point, Flush Left

- Now we'll define the **body** style. (**Define Styles** is still showing.) Click on **New Style** in the list. Using the ruler, move the first indent right to 0.25 inches. That is, all of our paragraphs will have a 0.25-inch indent. Also, make the text justified instead of flush left.
- Give this new style the name **body**. Click on **OK**. Since the whole document was selected, you have just made every paragraph a body paragraph. The definition is shown here:

  **body**  Used for the text in our book chapter.
  **Normal + Indent:** First 0.25 in, Justified

**Setting Up the Pages**

Next, we set up the pages. There are two main things we need to tell Word: the size of the paper that we want to use and that we'll be printing on both sides. Both of these functions are controlled through the **Document** dialog box.

What size should the paper be? We pulled a paperback off the shelf and found its pages to be 4.25 by 7 inches. (Word's default is 8.5 by 11.) The margins were narrow—less than 0.5 inch. (We'll refer to this randomly chosen paperback book several times after this.) Let's settle on 1/2 inch for the top and bottom margins, and 3/8 inch for the left and right margins.

Assuming that we're printing on a LaserWriter, we have some bothersome arithmetic to do because the LaserWriter printer driver
does not support nonstandard paper sizes. (If you are printing on an ImageWriter or some other printer that does support nonstandard paper sizes, you can avoid this arithmetic by setting a custom size in the Preferences dialog box.) We'll set it up so that the small pages print on the standard 8.5-by-11-inch paper, as shown in Figure 12.3. The critical values for creating the small page are the outside margin, 4.625 inches, and the bottom margin, 4.5 inches.

If you like formulas more than drawings, use the following to compute the outside and bottom margins in terms of the page dimensions you want to get:

- Outside margin = 8.5 - page width + page left margin;
- Bottom margin = 11 - page height + page bottom margin.
Before we start to specify this page layout, look at the **Document** menu. (Just look.) You will be using the top part of it, which should look like what you see at left, to get access to the header and footer. After we set up the pages, we'll see how this menu has changed.

1. Select **Document**... from the **Format** menu. The **Document** dialog box appears.
2. Turn on the **Mirror Even/Odd Margins** option. Doing so will change the **Left** and **Right** margin labels to **Inside** and **Outside**.
3. Similarly, turn on the **Even/Odd Headers** option. This is what allows us to specify different headers at the top of the left and right pages of a spread.
4. Fill in the four values for margins as shown in Figure 12.4. It is these values that restrict the text to the smaller page size we are using and position it conveniently on the 8.5" x 11" paper.
5. Now type **0.25 In** into the **Gutter** box. You’re telling Word you want to give the bindery an additional 0.25 inch on the inside edge of each page. After all this, your **Document** dialog box should look like Figure 12.4. When you’re done, click on **OK**.

![Figure 12.4: The Document dialog box for a chapter in a book.](image)

---

**Figure 12.4:** The **Document** dialog box for a chapter in a book. The wide outside and bottom margins force the print to the top and inside of the 8.5" x 11" page.
Once again, look at the Document menu. See how it has changed? Since we turned on the Even/Odd Headers option in the Document dialog box, Word provides separate menu items for opening headers and footers on each kind of page.

But what about the first page of the chapter? Shouldn't that have an option for having no header at all? Yes. In fact, you can even give it its own header in which you can put anything you want, such as a special graphic that heads each of your chapters.

You control making the first page special in the Section dialog box. If you had more than one chapter in a file, you would make each a separate section. You can tell Word whether each section's first page should get the special treatment.

- Select Section... from the Format menu. That brings up the Section dialog box.
- In the Header/Footer subbox, click on the check box marked First Page Special.
- Now look at the list of possibilities that you get by holding down the mouse button on the arrow to the right of the Start selection box. Since you want the section to begin on a right-hand page, select the Odd Page option. Then click on OK.

We have told Word that the first page of this section is special, because it gets its own header and footer, distinct from the odd and even headers and footers. We have also made sure that the section will begin on an odd (right) page no matter what comes before it.

Now we have six header and footer items in the Document menu.

**Headers and No Footers**

Our randomly chosen paperback had a typical format for its headers and footers. There were no footers. That's convenient for us here—one less thing to set up. (Footers work just like headers except that they get placed at the bottom of the page; you'll use them in Chapter 13.)

Figure 12.5 shows the headers of two facing pages from our example chapter. The left (even) header includes the name of the book, and the right (odd) header has the title of the chapter. The first page of each chapter will have no header at all; not even a page number.
The way you work with headers depends a bit on what view of the document you are using. In galley view, headers have their own window, separate from that of the main text. But in page view, you see and edit the headers right on the page. The techniques are straightforward in both views. We'll create the headers in galley view and then take a look at them in page view.

From galley view, you open the window you want by selecting it from the Document menu. Figure 12.6 shows the header editing windows set up for the even and odd headers. Before we actually format the headers, let's examine what appears in these windows. (Notice that you have to use Show Ruler in the header window to make the ruler show, even if it is already showing in the main window.)

For the most part, what you can do in a header window is the same as what you can do in a normal editing window, but there are some new things to see and use—a set of three icons and a button below the window's title bar and above the ruler.
The page number icon is most important. When you click on it, it inserts the page number in the window wherever the cursor is. Of course, what number actually gets printed depends on which page it is. If you want to change the format of the numbers (to roman numerals, for example) you can do that in the Section dialog box.

The date icon inserts the current date. Be aware that if you insert the date on January 10 but don't print the page until the fifteenth, the later date appears.

The time icon inserts the current time. It shows up on the printed page as the time of printing.

In the even header window, clicking this Same As Previous button will make the even header identical to the odd header. If there were more than one section, the button in the odd header would make the header identical to the odd header in the preceding section.

**Header Formatting Considerations**

Let's think for a moment about the formatting shown in Figure 12.6. First, we wanted the page number right justified on the right-hand page. Therefore we placed a right tab at the margin—at 3.25 inches. Allowing 0.25 inch between the text and page number on both pages, we put a left tab at 0.25 inch on the left-hand page and a right tab at 3 inches on the right.

Also, we like the appearance of a line separating the header and the text, so both sides have a single line below for a paragraph border. Since the text starts immediately following the header, we gave each side 12 points of space after to provide some breathing room. (We don't want the reader to confuse the header with the main text.)

Finally, formatting the text in small caps is consistent with the paperback we have been imitating and further convinces the reader that the words are in the running head and are not part of the text.

**I Ran out of Space in the Header Window!** There's not much room in the header window, especially if you make the ruler show. So expand it. The header window is like all other windows. This is a perfect place to use the zoom box in the upper-right corner.

As we mentioned, you can do anything in a header window that you can in a normal editing window. If you want to make the page numbers italic, for example, select the page number in the window, as you would any other text, and italicize it. The numbers will be italicized on every page.
How do you know just where the header is going to appear? We have already told Word, in the Section dialog box, that the header is supposed to be 0.5 inch from the top (as shown at left). That means that the top of the header starts 0.5 inch from the top of the page, not from the margin. The text starts immediately after the header or at the margin, whichever comes last. The same is true of footers; the measurement in the box is the width of the clear space at the bottom of the page.

Creating Styles for the Headers

Now let's do the actual formatting and style definition for the headers. There is an automatic style called header, which is Word's default in the header windows. We'll modify header to include the paragraph formatting that is common to both the odd and even headers. Then we'll define two new styles: one for odd and one for even.

- Still working in galley view, select Open Even Header... from the Document menu. Notice that the current style in this window is header, the automatic style.
- Open the Define Styles dialog box and click on header in the list of styles. It has tab settings at 3 and 6 inches. Get rid of those; the simplest way is to type %SHIFT-P. This brings the current style to whatever is in the Based on box, in this case Normal. Notice that the tab settings are gone.
- Finish redefining the header style to match the definition below. Then define two new styles, one called odd header and the other called even header. Both of these new styles should be based on header. Here are the style definitions for these three styles:

header  Parent style for both odd and even headers.
Normal + Small Caps, Space After 12 pt, Border: Bottom (Single)

OH, odd header  Header style for right-hand pages.
header + Tab Stops: 3 in Right Flush; 3.25 in Right Flush

EH, even header  Header style for left-hand pages.
header + Tab Stops: 0.25 in

How to Make Aliases—Alternate Names for Styles

When we defined the two header styles, we used style name aliases. You can give a style more than one name; Word will recognize any of them. For example, we can use EH or even header to refer to that style.
Here's how it works: instead of typing in just one name, type a list of names separated by commas. It helps to have a short name for the style when you use the %-SHIFT-S shortcut and to show in the ruler's style selection box. But a longer, descriptive name appearing in the style name box in the lower-left corner of the window and in the Define Styles dialog box will remind you of the style's purpose.

Always put the abbreviation first. The first name is what gets put into the style selection box; if it's too long, it will get truncated, and you might not remember what it's called—or worse yet, what appears may be ambiguous.

**Viewing and Editing the Finished Headers**

It's time to see how these headers look on the page. Select Page View in the Document menu and you'll be rewarded with a view of a page as it will appear when printed, including the header. If you find yourself on the first page of the document, there won’t be a header, so click on the icon at the bottom of the window to move to the next page.

Try moving the cursor into the header. It behaves the same as normal text; you can edit it and reformat it and the changes will show up on all even (or odd) pages.

Another way to view headers is, as you would expect, in print preview. Here, although you can't edit the header text, you can reposition it by first clicking on the margins icon and then dragging the header to the place you want it.

**Making the Chapter Title Page Special**

What we're about to do doesn't involve new techniques as much as the application of those you already know in ways you might not expect. The main idea is to get the beginning of the chapter to look elegant. After all, since the rest of the book is plain old text, how else can we show off what Word can do?

**The Chapter Title**

We need a good-looking title for the chapter. Figure 12.7 shows the top of the page view of the finished product. (We will discuss the drop cap later.)
Friends and Fraud: The Case of Oleander Electronics

Ever since the SEC came into being as a watchdog agency, shenanigans such as the one Vanderbilt pulled off in the "Nickelplate Railway"

Figure 12.7: Page view of the finished chapter's beginning showing the chapter title and the drop cap

How did we get the chapter title and the number that way? Text beside text—we could do it with positioned objects or with a table. We'll use a table here (and save fixed positioned objects for the drop cap E). The words are right justified; the number is left justified. The font size is large compared to body text. We have also added space before and space after these paragraphs to keep them away from the top of the page and away from the text in the chapter. We pressed SHIFT-RETURN to break the line in the title, as you can just barely make out in Figure 12.8. In that figure you can see the single-row table and the ruler as it is set up for the title text.

Creating the table and formatting its cells is very nearly the same here as it was in Chapter 11 in the section on laying out a proposal's abstract page. Here's a sketch of what you need to do. For more details, refer to Chapter 11.

1. Position the cursor in front of the first word in the document.
2. Select Insert Table... from the Document menu. Because the defaults in the resulting dialog box are what we want, press the OK button.
Click on the ruler's scale icon once to gain access to the column markers. Drag the marker in the middle of the ruler to the 2.75 inch mark.

With the cursor in the left-hand cell, define the following style:

**CT, chapter title**  For displaying the name of the chapter; should be two lines separated by a newline character (SHIFT-RETURN). Normal + Font: 14 Point, Flush Right, Space Before 72 pt After 36 pt

Type in the chapter title, pressing SHIFT-RETURN between its two lines to force the line break where you want it.

With the cursor in the right-hand cell, define another style, based on the previous one, for the chapter number:

**CN, chapter number**  For displaying the chapter number:
CT + Font: 36 Point, Flush Left

Type the chapter number into the right-hand cell.

How did we know that two 14-point lines come out to the same height as a 36-point line? We didn't. We messed around until it came out right. As we will discuss in Appendix E, font-size arithmetic doesn't always turn out the way you would expect.
A Drop Cap

At left, you can see the part of page view with the drop cap. A drop cap is a large capital letter that extends into the paragraph below it. Drop caps look great at the beginnings of chapters and are easily formatted with Word’s fixed-position objects.

- Work in page view because it will immediately show you whether or not things are working out as expected. Insert a RETURN after the initial E so it’s in its own paragraph.
- Give the E a size of 36 points. Figure 12.9 shows what you’ll see.
- Also in Figure 12.9 you can see that the left indent of the first full paragraph of text has been set to zero and small caps formatting has been applied to the first phrase. Do it.

Figure 12.9: The drop cap E lives alone in a paragraph just before the text it introduces. You can eyeball its width using the ruler.

- With the cursor in the drop-cap paragraph, bring up the Position dialog box.

Isn’t it already set just the way it should be? Nope, in order for the text in the main paragraph to move up next to the drop cap, the drop cap paragraph has to have some width other than Auto.

- Use the ruler to estimate a reasonable width for the paragraph. It seems to be about 5/16 or 0.3125 inches. Type this value into the Paragraph Width box.
- Click the OK button and prepare yourself for a rude surprise, as shown in Figure 12.10.
EVER SINCE THE SEC CAME INTO BEING AS A watchdog agency, shenanigans such as the one Vanderbilt pulled off in the "Nickelplate Railway" case are harder to get away with. It's not that fraud is any less legal now than it was in the nineteenth century, but the existence of the SEC has made the more straightforward bilking of stockholders, major and minor, easier to prosecute.

Figure 12.10: This is close to what we want, but the drop cap is too far from the text, both on the right and bottom.

Why is there so much space between the drop-cap E and the surrounding text? Two reasons: one having to do with space around positioned objects and the other with descenders. Let's deal with them one at a time.

Too Much Space to the Right of the Drop Cap. You may have noticed in the Position dialog box a setting called Distance From Text. This is the horizontal distance Word will keep between the positioned object and surrounding text. The default is 0.125 inches, and that's just too much for this purpose. Bring up the Position dialog box and change it to something much smaller, say 0.05 inches.

Better, but still unacceptable. If Distance From Text controls horizontal spacing, what controls the vertical? It's the vertical extent of the positioned object itself. The trouble is with descenders.

Space Left Below for a Descender That Isn't There. The remaining problem—the space between the third and fourth lines—is subtler. The bottom of the E is well above the bottom of the third line. What is pushing the next paragraph down?

If you put your cursor next to the E, you'll see that the cursor extends down below the bottom of the letter. The height of the letter includes that space; after all, some letters of the alphabet extend below the bottom of a capital E. The solution is to convert the E to a graphic and replace the text E with the graphic E.
Word won’t let you convert a text into a graphic while you are in page view, so go back to galley view.

Select the large letter E (not including the paragraph mark that follows it).

Turn Show ¶ off, so you won’t get a graphic ¶.

Word has a mechanism for converting selected text into an object-oriented graphic. Type #-OPTION-D. The text-as-graphic is in the clipboard. With the E still selected, paste the contents of the clipboard. When you select the E you will see the familiar graphic handles around it.

Now you can crop the graphic E just as you would any other graphic. Make the frame fit as tight as possible around the letter, as shown at left.

Finally, back in page view, the text wraps around the drop cap as we hoped it would.

**Automatic Hyphenation**

The last thing we need to do to improve the appearance of our book chapter is hyphenate it. In Chapter 9 we saw how fully justified text in narrow columns develops ugly gaps. We learned how to get rid of these gaps by embedding optional hyphens in the words at the ends of lines using the #- (#-hyphen) command.

For a short document, doing hyphenation manually doesn’t take much time. But for a very long document, such as our book, it makes sense to get the computer to help. Word’s Hyphenate... command will detect lines that are ripe for hyphenation and suggest a place to put the hyphen. You have to decide whether the line will really benefit and whether the suggested place is the correct one.

Using the **Chooser** desk accessory from the ⌁ menu, be sure that you have selected the icon representing the printer you’ll print your final copy on. Different printer drivers place the words slightly differently on the page, causing the line breaks to come out differently; your efforts at hyphenation will come to naught unless you have the right printer driver selected.

Position the cursor at the beginning of the document. The hyphenation command starts from the current location of the cursor.
Select **Hyphenate...** from the **Utilities** menu. This brings up the **Hyphenate** dialog box, as shown below.

![Hyphenate dialog box](image)

You have the option to include capitalized words among those that Word considers for hyphenation. Ordinarily you don’t want to hyphenate a proper name, but sometimes that proves to be a lesser evil than leaving very long gaps in a line. So make sure this box is checked.

Click the **Start Hyphenation** button. Word will begin going through the text looking for a line that could contain more text if the first word on the next line were hyphenated. Figure 12.11 shows a typical case.

Each time a word shows up, you have the choice of hyphenating at the proposed place by pressing the **Change** button, choosing a different place in the word by clicking the mouse pointer where desired and then pressing the **Change** button, or continuing onward by pressing **No Change**. Recognizing that hyphens generally make the text more difficult to read, here are some guidelines.

![Figure 12.11: Word has suggested that “traditional” be hyphenated. Because the gaps in the previous line are significant, press the **Change** button.](image)
• If the gaps on the preceding line are very large, you will do well to hyphenate. If no suitable hyphenation is possible, consider rewording the text.

• If hyphenation will result in a part of a word on a line by itself, do not hyphenate.

• Hyphens at the ends of two consecutive lines are tolerable, but more are to be avoided.

• Do not hyphenate if a single letter of the word will be left on either line.

Word hyphenates liberally, so do not use the Hyphenate All button or you will probably end up with more hyphens than you want.

Dealing with Long Documents

Our chapter is now complete and ready to print. But it is just a single chapter in a longer book. What do we have to do to make all the chapters hang together?

First of all, a big project must consist of many small files, not one big file. In general, store one chapter in each file if you’re doing something book length. This helps you organize your work and keeps you from losing too much if something disastrous happens while you’re editing. Of course, you back up your files frequently.

Now that your project is spread among many files, there are new considerations. You have to plan more carefully than if you were writing a single-file document.

Making Styles Consistent among Many Files

You can’t make a style change apply automatically to all files in your project. If you decide, after writing the whole thing, that you want it in Bookman instead of Times, you have to go to each file to change the styles. (You’d probably have to change the root style, Normal, to effect the filewide change.) You may want to do that manually, but you can make all the style changes you want in one chapter, and then import them into the rest from the model.

It might be even better to make a template for your chapters—a set of sample pages with dummy text and all the elements you want—that will hold the official definitions of all your styles. Then you could
import the new styles into all of your chapters after making the changes in the template.

- With the file you want to change on the screen, select Define Styles... from the Format menu.
- Select Open... from the File menu.
- Find the template file in the dialog box (Select a style sheet:) and open it. It may take a while to read in the styles. When it’s done, the Open box disappears. Click Cancel and you’re done.

Warning: Once you click the Open button, this action will take place whether or not you click OK in the Define Styles dialog box. You can’t undo it, and Word doesn’t ask you to confirm your decision.

Ordinarily, when you select Open, you are trying to open a file for editing. But if the Define Styles dialog box is active, Open reads in the styles of the file you select.

Which styles are read in? All that are in the template file. If you have made special styles in your file, they are still intact. Only the styles with exactly the same name are replaced. And style names are case sensitive.

**Numbering Pages in Many Files**

In the Document dialog box (from the Format menu), there is a box labeled Number Pages From:. Type the number of the first page of your file into this box, and the page numbers in the headers and footers will adjust themselves. Bear in mind that if your section starts on an odd page and you type in 18, Word will start pagination at 19. For our Chapter 4, the first page will be page 51.

Number Pages From: [51]

When it is finally time to number your book pages sequentially, start with Chapter 1. Use Repaginate and write down the number of the last page; add one and put the result in the Number Pages From: box in Chapter 2’s Document dialog box.

Continue, tediously, until you’re done. Later, if you do something that changes the number of pages in Chapter 1, you will have to do it all over. For that reason, don’t sweat the actual page numbers until you’re really done with the book. Until then, use fake page numbers, such as 101 to start Chapter 1 and 201 to start Chapter 2.
File Sequences

Word allows you to specify a Next File in the Document dialog box. If you want to use this feature, press the Next File button and select the file that comes after the current one. For example, we would select Chapter 5 for the next file after Chapter 4.

What will this feature do for you? First of all, when you check the Print Next File option in the Print dialog box, you can print a series of documents. Word will automatically continue printing from one document to the next until it reaches a document that has no next file specified. Furthermore, if you have left the Number Pages From field in the Document menu blank, Word will automatically start the page numbers of each document at the correct place.

You might suppose that Word's Next File feature has saved you from the need to insert starting page numbers in each of a series of linked documents. Unfortunately, that is only the case if you are always going to print the entire series—surely the exception rather than the rule. If you want to print just Chapter 4, or just Chapters 4 through 6, you must have specified the starting page number of at least the first chapter to print.

If you are using MultiFinder, you may find it more useful to print big jobs using background printing to queue up exactly which chapters you want printed and when you want them printed. In that case, you will need to remove the Next File links by pressing the Reset Next File button in the Document dialog box.

While chaining files together with Next File may be only marginally useful for printing, it's tremendously useful for making a table of contents, provided you've put in the right page numbers for all your files; for an index, it's indispensable. (We'll learn about indexes in Chapter 14.) In both cases, Word will collect information from all of the files in the sequence, put it in the correct order, and create the merged table of contents or index in the first or last file, respectively.

Making a Table of Contents

Let's make a table of contents for our book. There are two ways to do this. The first collects the text of paragraphs with styles heading 1, heading 2, and so forth. The second allows you to specify exactly what text you want. We'll do the latter here. (See Chapter 11 for making a table of contents using heading styles.)

In order to make a table of contents for a multifile document, you need more than one file.
→ Create four more small files—Chapters 1, 2, 3, and 5—to go with our Chapter 4.

→ Link the files by selecting Chapter 2 as the Next File for Chapter 1, Chapter 3 as the Next File for Chapter 2, and so forth.

→ While you have the Document dialog boxes open, put in the starting page numbers: 1, 16, 31, 51, and 67.

→ Open all the Section dialog boxes and make sure that each chapter begins on an odd page. (You’ll see shortly how Word deals with the fact that we told it to start a chapter on page 16.)

Now we need to make the table of contents entries. We don’t necessarily want the information to appear on the page, so we will format it as hidden text. Do the following at the beginning of each chapter (you can save time with judicious cutting and pasting):

→ Set Show Hidden Text (as described in Chapter 11) so you can see what you’re doing.

→ Insert a blank paragraph in front of the table that contains the chapter title. (Recall that ⌘-OPTION-SPACE does this.)

→ Select Insert TOC Entry from the Document menu. Doing so will insert .c; in hidden text, leaving the cursor before the semicolon for you to type “Chapter 4—Oleander Electronics.” (The Insert TOC Entry command is just a convenience feature; you can type the hidden text yourself if you like.) The beginning of Chapter 4 should look something like Figure 12.12.

Whether it’s an upper- or lowercase c doesn’t matter, but it is important that there be a period immediately preceding and following the c. If the line ends in a paragraph mark or newline, you don’t need the semicolon, but put it in anyway, just to be safe. Finally, don’t use any semicolons in the titles, and please don’t use colons until you’ve read Chapter 14.

→ Now that you’ve set up all your files, go to Chapter 1 and select Table of Contents from the Utilities menu. You’ll see a box like the one in Figure 12.13.

→ Click the .C. Paragraphs button, as we’re just about to do in the figure, then click Start.
Word repaginates all the files in the sequence and collects the information for the table of contents. When it is done, a new section will appear at the beginning of the first file of your document with a table of contents in it, such as the one shown in Figure 12.14.

Word's table of contents utility is extremely versatile; we have only scratched the surface. We'll learn more about it in Chapter 14.
Figure 12.14: The beginning of Chapter 1 after Word created the table of contents. Note that Chapter 2, in spite of being told to begin on page 16, begins on 17 because of being forced to begin on an odd page. Notice also the automatic style toc 1.

For More on Various Topics

Footers—In Chapter 13, we’ll create footers. They’re just like headers, but at the bottom of the page.

Hidden text for comments—We used hidden text to produce the table of contents entries in this chapter. We discussed using it for comments in Chapter 11.

Hyphenation—We introduced manual hyphenation in Chapter 9.

Page numbering—The footers in Chapter 13 show another example of page numbering.

Tables of contents—We’ll explore more advanced features of tables of contents when we discuss indexing in Chapter 14.
So Victor and Alice were not divorced. What a bombshell. Manny went on: “It becomes final next month. And before you jump to conclusions, he named Clara the beneficiary of his insurance. The way we figure it, Clara found out he had lied to her and killed him.”

This man was hopeless. “Manny, Manny. What can I do? Insurance isn’t the only motive,” I reminded him. “What about Victor’s estate?”

“What estate? He was just an accountant.”

“But savvy. Remember about IA’s public stock offering? He may have securities and options that devolve to his legal wife on his death. They’ve only recently become valuable, so they may not be in his divorce settlement—and he might not have changed his will.”

“It’s a slow day. I’ll have it checked out. After lunch.”

The stratus was finally burning off, and the sun warmed the asphalt. I could finally take off the down vest. Ah, summer! “Manny, old bean, why are you being so nice to a young never-was like me?”

“Frankly, I have my doubts that she did it too. But there’s evidence to keep her in her cell. If she didn’t do it, somebody went to a lot of trouble to frame her. You think it’s Alice, but I’m not convinced.”

“But what evidence points to Clara more than anyone else?”

“You talk about a scenario making sense. In every one of your theories, the killer delivers the note to McConnell at midnight. I want you to remember something about this note: it doesn’t exist.”

“OK, but what else?”

“Motive, cookies, and this.” He pulled a photostat of an article from his inside jacket pocket. “I found it in her desk. She was brushing up on her college chemistry.”
Danger in the Darkroom

Cyanide as an Oxidizer — Photographic Bleach and Human Poison
Lauren T. Baccile, PhD; Jonathan R. McFin, PhD

Cyanide is easily obtained from photographic toners — solutions whose job it is to change the tone or color of a print or negative. In toner solutions cyanide is present as potassium ferricyanide which is capable of converting metallic silver to silver ferrocyanide. In the body, the cyanide ion also exhibits its attraction to metals by binding the iron and copper ions in cytochrome oxidases, enzymes vital to cellular respiration.

Many a mystery writer has relied on the presence of cyanide in common darkroom chemicals as a source for the murderer’s poison. But is it really a reasonable source? What equipment and knowledge would the murderer need? The role of cyanide in darkroom processing bears an interesting relationship to its role as a bodily poison. In both cases it is the powerful attraction of the cyanide ion for a metallic ion that is at the root of its action.

Cyanide In the Darkroom
Potassium ferricyanide is present in such solutions as Kodak’s sulfide sepia toner T-7a, which contains 15 grams per liter of stock solution.1 It reacts with metallic silver to form silver ferrocyanide according to the following reaction:

\[ 4\text{Ag} + 4\text{K}_2\text{Fe(CN)}_6 \rightarrow 3\text{K}_2\text{Fe(CN)}_6 + 4\text{AgFe(CN)}_6 \]

The equilibrium constant of this reaction is expressed as

\[ K_e = \frac{[\text{AgFe(CN)}_6]^4}{[\text{Ag}]^4[\text{K}_2\text{Fe(CN)}_6]^3} \]

where the quantities in brackets are the concentrations of the reactants.

The silver ferrocyanide reacts with potassium bromide, also present in the solution to form silver bromide:

\[ \text{Ag}_2\text{Fe(CN)}_6 + 4\text{KBr} \rightarrow 2\text{AgBr} + \text{K}_4\text{Fe(CN)}_6 + 4\text{AgBr} \]

Finally, the silver bromide is converted to silver sulfide:

\[ 2\text{AgBr} + \text{Na}_2\text{S} \rightarrow 2\text{NaBr} + \text{Ag}_2\text{S} \]

It is the silver sulfide that is responsible for the bleached look of the resulting print or negative, as it has a yellowish-brown or purplish-brown tint to it, depending on the size of the grains.2

Conversion to HCN
With plentiful cyanide available in the potassium ferricyanide, it remains to discover how to extract the cyanide in an aqueous form. The addition of ammonium chloride precipitates ferric chloride leaving behind the cyanide ion.3

\[ \text{Ni"tze H, Paper, Developer and Bleach in Sulphide-Toning, Brit. J. Phot. 1932; 79:486.} \]

SCHOLARLY ARTICLES

Compared to the layout of the simple book in Chapter 12, an article presents many challenges, some having to do with coordinating a large number of design elements on the page and others with getting Word to produce certain effects. The example article we'll use here is for a chemistry journal, complete with footnotes and mathematical formulas. Though the example is only two pages long, it will force us to plan carefully during the layout process to avoid time-consuming backtracking. Word's spelling checker will speed some of the final stages before printing. Column- and page-break problems will give us a chance to discuss techniques for getting around Word's lack of a vertical-justification feature. Laying out an article like this one, camera ready for publication, is a task we could not have done on personal computers just a few years ago. Now, it seems almost easy. And even though you may never have to lay out an article for a chemistry journal, you can use some of the techniques we'll discuss in a surprising variety of settings.
The Problem

Imagine that we are preparing an article for publication in a chemistry journal. The article comes complete with footnotes, formulas, figures, captions, and headings. The problem is to get it camera ready, that is, ready for a printer to photograph and then make a plate for offset printing. Two scenarios come to mind in which this would be necessary and in which desktop publishing would be the medium of choice. In the first, you are the author, and the journal requests camera-ready copy—possibly in return for a reduction in astronomical page charges. In the second, you are on the publication staff and the author has submitted the text in electronic form. In both cases, your job is to format the article according to the publication's specifications.

The Style Sheet

Both the author preparing to submit and the staff member will be dealing with a set of specifications usually called a style sheet. Figure 13.1 shows the one we'll be using.

Figure 13.1: The style sheet for the article
Comments on the Article's Design

Given the formal, academic nature of the publication, this style sheet has an appropriate simplicity. White space occupies 46% of the page, even on pages that are cramped with text. The small type size will reinforce the expectation of a publication packed with information. Referring to Figure 13.2, you can see that the first page of the article breaks the page symmetry by left justifying the title, giving the eye a clear place to start reading.

The Plan

In this chapter, we're going to assume that most of the text of the article has already been typed into a Word document. We will also assume that any figures are in place. The only elements we need to incorporate ourselves are the footnotes.

---

**Figure 13.2:** Print preview of the finished article, how the style sheet works out in practice.
There are several reasonable orders for doing things, but methods that may work well with simple, small documents (such as our example) may lead to endless duplication of effort as the number of pages increases. For example, in a two-page article, fixing page breaks may take only five minutes, while a long article may consume several hours for the same task.

We need a guiding principle.

**From Large to Small**

Start with the largest features of the document, such as page size and orientation and section formatting, because these will have an effect on all other aspects of the layout. Leave small-scale formatting, such as hyphenation and fixing page and column breaks, until last.

Going from large to small suggests the following order for laying out the article:

- **Large-scale changes**
  1. Working in the Document dialog box, set the gutter and margins. Prepare for facing pages with **Even/Odd Headers**.
  2. Create two sections: one for title and abstract, and a second for the main part of the article.
  3. Set up the columns in the second section.
  4. Define the styles, starting with **Normal**.

- **Medium-scale changes**
  1. Fix the formulas.
  2. Add the footnotes and redefine their style, if necessary.
  3. Create the footers for odd and even pages.
  4. Look for layout problems in page view and fix them.

- **Small-scale changes**
  1. Run the spelling checker.
  2. Do the final proofreading.
  3. Hyphenate to clean up bad line breaks.
  4. Fix bad column and page breaks.
  5. Deal with any special problems on the last page.
  6. Set the starting page number.
Setting Pages and Styles

With the thumbnail sketch of Figure 13.1 in front of us, we can fill in the Document dialog box as shown in Figure 13.3.

The top and inside margins are those given in the style sheet. The bottom and outside margins are computed in the same way we used in Chapter 12 for a book chapter: the bottom margin is the paper height (11 inches) minus the page height, plus the page bottom margin; the outside margin is the paper width (8.5 inches) minus the page width, plus the page outside margin. As we did in Chapter 12, we have also turned on the Mirror Even/Odd Margins and Even/Odd Headers options.

One new thing we have had to worry about in this Document dialog box is the placement of footnotes. From the choices available in the selection list we have chosen Bottom of Page, because that will place the footnotes at the bottom of the columns as specified in the style sheet. Another possibility would be Beneath Text, which would also put the footnotes under the columns but flush against the bottom of the text. Our choice will come back to haunt us when we deal with trying to get the bottoms of the columns to align.

The other two choices, End of Section and End of Document, force Word to gather up the footnotes and display them all together, either at the end of the section or at the end of the document.

![Figure 13.3: The Document dialog box for the article](image-url)
**Sections and Columns**

Although the bulk of our article is formatted in two columns, the very first part, from the title through the abstract, will span the entire page width in a single column. (We discussed how to change from single to multiple columns in Chapter 9.) After the abstract, we’ll add a second section formatted with two columns.

- Start out in galley view. This will make it easy to revisit a gotcha we first met in Chapter 9.
- Position the cursor after the abstract, in front of the first real paragraph of the article, and type `Ctrl`-`Enter`. You can see the section mark in Figure 13.4.

![Figure 13.4: We have created a second section by typing `Ctrl`-`Enter` with the cursor positioned in front of the first body paragraph.](image)

- Switch to page view (`F5`-`B`). One section disappears! As discussed in Chapter 9, that’s because the default start for a new section is on a new page, and in page view you can see only one page at a time.
- With the cursor in the newly created second section (you can either page forward or switch back to galley view to get it there), bring up the **Section** dialog box. Because we want this section to begin immediately below the abstract, select the **No Break** option from the **Start** selection list.
Set the number of columns to two. Set the spacing to 0.375 inches, as specified in the style sheet.

According to the style sheet, we should put a footer 0.5 inch from the bottom of each page. Be sure From Bottom: is set at 0.5 in.

*An author would not include footers, because page numbers cannot be determined until the whole publication is assembled.*

Make sure the First Page Special box is not checked. The same footer will go on the first page of the article as on every other page.

Because the article has footnotes, you may wonder why the Include Endnotes option is grayed out. If we had specified End of Document as the position for footnotes in the Document dialog box, and if there were several different sections with footnotes, we would have to tell Word in which section or sections to put the footnotes. Very likely we would add a separate section at the end of the article just for the footnotes. That section’s Include Endnotes box would be checked.

**Title Section Styles**

Most of the styles in this article will be straightforward. Refer back to the style sheet in Figure 13.1 and to the miniature of the article on the page facing this chapter’s title as you study the style definitions below.

Always start with Normal, because many other styles will depend on its font and font size. We follow the descriptions on the style sheet and set the font to 10-point Helvetica. Many styles will inherit the font from Normal; the body will inherit its size as well.

**Normal**  Controls the font and the font size in the body.  
Font: Helvetica 10 pt, Flush left

The title, in 18-point Helvetica, starts one-half inch, or 36 points, from the top margin. The subtitle and authors styles have no surprises in them.

**title**  Controls the format of the article’s title.  
Normal + Font: 18 Point, Space Before 36 Point
subtitle Under the title is a subtitle with this style.
Normal + Font: 14 Point, Italic, Indent: Left 0.25 in

authors The authors are listed under the article's subtitle.
Normal + Font: 12 Point, Indent: Left 0.25 in

So that it will attract the eye, the abstract gets bold character formatting. A line below separates it from the body of the article. Also, it has some extra space both above and below.

abstract This style is used for the paragraph that contains an abstract of the article.
Normal + Bold, Justified, Space Before 12 pt, Space After 24 pt,
Border: Bottom (Single)

On the screen, the first section of the article should look like Figure 13.5.

Danger in the Darkroom
Cyanide as an Oxidizer—Photographic Bleach and Human Poison
Lauren T. Bacolle, PhD; Jonathan R. McFin, PhD

Cyanide is easily obtained from photographic toners—solutions whose job it is to change the tone or color of a print or negative. In toner solutions cyanide is present as potassium ferricyanide which is capable of converting metallic silver to silver ferrocyanide. In the body, the cyanide ion also exhibits its attraction to metals by binding the iron and copper ions in cytochrome oxidases, enzymes vital to cellular respiration.

Many a mystery writer has relied on the presence of cyanide in common brown or purplish-brown tint to it, depending on the size of the grains.2

Figure 13.5: As seen in this page view, the first section of the article now has all its styles defined.

Body Section Styles
Just a few styles cover all the rest of the paragraphs in the article. We'll show you their definitions and you can apply them to the appropriate paragraphs.
The style sheet says that regular body paragraphs should have a first indent of 0.1875 (3/16) inch and that they should be fully justified. According to the style sheet, no extra space goes between body paragraphs. Here is the definition:

**body**  This style is for text in the body of the article.
Normal + Indent: First 0.1875 In Justified

Headings also have a simple definition. We’ll use Word’s heading 1 automatic style for these, so that the outliner will show them correctly. (See the Outlining section of Chapter 7 for details about automatic styles.) Although we have assumed that we are working on existing text, we should prepare for when we import these styles into a blank document and write an article from scratch. In that case, we would like the paragraph after a heading to get the body style automatically when we press RETURN. Setting Next Style to body accomplishes this nicely.

**heading 1**  Use this style for main headings.
Normal + Font: 12 Point, Bold, Centered, Space Before 12 pt,
Space After 12 pt
Next Style: body

Finally, a paragraph at the end for notes about the authors gets formatting just a little different from the body paragraphs.

**author note**  At the end of the article is some information about the authors and funding for the research.
body + 9 Point, Space Before 12 pt

All the style sheet says about figures is that they get 6 points of space before them. But we also want to be sure that the figure and caption do not get separated by a page break, so we include Keep With Next in figure’s style.

The captions need 6 points of space after them, and we would never want a page break to come in the middle of one. Figure’s Next Style is to be caption, but you can’t actually set it until after caption has been defined. Thus, the definitions of caption and figure are:

**caption**  This style is for captions under figures.
Normal + Space After: 6 Point, Keep Lines Together
Next Style: body
This style is for paragraphs that contain a figure.
Normal + Space Before: 6 Point, Keep With Next
Next Style: caption

Formulas get paragraphs of their own. The style sheet is not specific about how they are set up, except that they get 6 points before and after. Figure 13.6 shows a reasonable way to handle the most difficult case—when the formula won't fit on one line. Notice that the left indent is at 0.125 inch for the formula number. The tab at 0.375 inch sets the starting point for the formula itself. The right tab at 2.25 inches allows the second line of the formula to be right aligned as far as possible. A SHIFT-RETURN at the end of the first line allows us to keep the two lines in the same paragraph—somewhat simpler than defining a separate style for each line.

The style definition below contains the indentation and the two tab settings and also sets the Next Style to body. Finally, because we don't want the two lines of the formula to get separated, we give them the Keep Lines Together attribute.

Use for paragraphs that contain a formula.
Normal + Indent: Left 0.125 in, Space Before 6pt, Space After 6pt, Keep Lines Together, Tab Stops: 0.375 in; 2.25 in, Right Flush
Next Style: body

Figure 13.6: A two-line formula. Notice the SHIFT-RETURN at the end of the first line and the two tabs at the beginning of the second.
Typesetting Mathematical Formulas

You can format many mathematical expressions using just superscripting and subscripting, as discussed in Chapter 8. Sometimes, however, you need to do something more sophisticated, such as the article's Formula 2:

\[
K_e = \frac{[K_4Fe(CN)_6]^3[Ag_4Fe(CN)_6]}{[Ag]^4[K_3Fe(CN)_6]^4}
\]

Word contains a small language for expressing mathematical formulas and even does a creditable job of showing you on the screen what you are going to get. Learning this language takes some time, but if you deal with formulas frequently in your writing or desktop publishing, it will be time well spent. We’ll introduce the basics here, enough to get you started with the material in Word’s reference manual.

If you find Word’s mathematical typesetting abilities too limited, you should look at some of the equation editors that can be installed as desk accessories.

You build formulas by typing commands directly into the document instead of selecting them from menus or dialog boxes. Like compiling a table of contents using .C. paragraphs, this is a throwback to the pre-Mac days when all formatting was done with the dot commands we mentioned in Chapter 2. It works, but how do you tell Word when to write the expressions in this command language and when to show you the results?

Formulas and Show ¶

You can choose to see formulas in the command language with Show ¶, or you can see them as they will appear with Hide ¶.

A Fraction Example

Even if you don’t use a lot of mathematical formulas, you may occasionally need to create a good-looking fraction. A fraction is simply one quantity placed directly over another with a bar between them. The
example article contains, in Formula 2, a complicated fraction. Let’s try a simpler one, such as 3 over 4.

- Be sure you’re in galley view. While fractions show up in page view, you can’t edit them there very well.
- Turn on Show ¶.
- Type `%O\OPTION-` (that’s backslash). A `\` will appear—the signal to Word that the next character is a formula command.
- Type “F,” the command for a fraction, followed by “(3,4)” as in the expression at left. The 3 and 4 are the two arguments of the fraction command. All formula arguments are enclosed in parentheses and separated by commas.
- When you turn on Hide ¶, you will see the fraction as shown in the margin.

When you use the fraction command, Word puts whatever is before the comma over whatever is after the comma. Furthermore, the bar is centered vertically in the line. The arguments don’t have to be numbers. If we typed “fractional increase in earnings = %O\F(this year’s earnings, last year’s earnings) – 1,” we would see

\[
\text{fractional increase in earnings} = \frac{\text{this year's earnings}}{\text{last year's earnings}} - 1
\]

When the Formula Doesn’t Show. It’s easy to type a complicated formula incorrectly, leaving off a parenthesis, forgetting a comma, or using an unrecognized command letter. Word won’t help you figure out what is wrong, it just doesn’t display the formula when you use Hide ¶. Make a copy of the formula and keep simplifying it until you get it to display again and find the mistake. If you work in Hide ¶, the fraction will suddenly display itself when you get your formula syntactically correct.

**A Brackets Example**

Both the numerator and denominator of Formula 2 contain some chemical symbols enclosed in brackets. Those brackets are not quite what you would get by typing [ and ] from the keyboard. Instead, the bracket is created with a formula command. Word makes the bracket as tall as required to encompass whatever is inside. You can see the difference between the figures in the margin.
The bracket command is more complicated than the fraction command, because we have to tell it not only what to bracket but what character to use as a bracket. In computer lingo, the bracket command has options.

If we don't tell Word what character to use, it chooses parentheses as its default. First look at what you get if you use the command without any options. Typing

\( \text{\textbackslash B(K}_3\text{Fe(CN)}_6\text{)} \)

produces

\( (K_3\text{Fe(CN)}_6) \)

The \textbackslash B is the bracket command. The chemical formula, the argument, is enclosed in parentheses. See how the options are specified:

\( \text{\textbackslash B\textbackslash BC[(K}_3\text{Fe(CN)}_6\text{)]} \)

produces

\( [K_3\text{Fe(CN)}_6] \)

The options come between the command and its argument. In this case, the \textbackslash BC tells Word that the next option will contain the character you want for the left bracket. The \textbackslash ] tells Word you want a square bracket. Word knows to use \textbackslash ] to close the bracketed expression. (Always use \textbackslash -OPTION-\textbackslash to make \textbackslash.)

**Miscellaneous Examples of Formulas**

We have covered most of the uses of formulas that appear in the article. The table on the next page contains additional examples for you to use and modify in your own mathematical typesetting. Consult the Word reference manual for details on how they work.

**Footnotes**

Word takes the pain out of footnoting. Here are the things it does automatically for you.

- The footnote numbers are kept in sequence for you, even when you insert or delete a footnote.
- Setting the placement of footnotes at the bottom of the page, the end of a section, or the end of the document is as simple as selecting from a list of options.
### EXAMPLE

\[
\sqrt{9} = \sqrt[3]{27}
\]

### COMMAND

\[
\text{\textbackslash R}(9) = \text{\textbackslash R}(3, 27)
\]

### NOTES

R is the radical command. With only one argument, the exponent of the radical is omitted. Note the different sizes of the numbers.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>the \text{\textbackslash RETURN} key</td>
<td>the \text{\textbackslash X(\text{\textbackslash RETURN})} key</td>
<td>\text{\textbackslash X} is the box command. It draws a box around its argument.</td>
</tr>
<tr>
<td>1 3</td>
<td>2 4</td>
<td>\text{\textbackslash A\textbackslash CO2\textbackslash HS10}(1, 3, 2, 4)</td>
</tr>
<tr>
<td>\pi</td>
<td>\text{\textbackslash I}(0, \pi, \sin x \text{\textbackslash dx})</td>
<td>The integral command takes three arguments: the lower limit, the upper limit, and the integrand. A lot of options are available for this command.</td>
</tr>
<tr>
<td>\sum_{t \leq x} \binom{n}{t} p^t q^{n-t}</td>
<td>\text{\textbackslash I}\text{\textbackslash SU}(t \leq x, \backslash B(\backslash A(n, t)) p^t q^{n-t})</td>
<td>You can combine commands. Here, the third argument of the integral command with the summation option is the result of putting a bracket around an array. Note, too, that the upper limit of the summation has been entirely eliminated.</td>
</tr>
</tbody>
</table>

- In galley view, footnotes all appear in one window (actually a window split off the main window). Scrolling through the list of footnotes also scrolls the document, so you can find the footnote reference in the text easily.
- In page view, footnotes appear on the screen as they will on the printed page, and you can edit them in place.
- Word gives footnote paragraphs the automatic style \textit{footnote text}, so you can change the font size or other formatting characteristics of the footnotes all at once.
- Footnotes can be as many paragraphs long as you like, and Word will continue them, as necessary, on following pages and even give you control over the continuation notice that appears just before the break.
Entering a Footnote

Let's assume that although all the text of the article has been entered, none of the footnotes have been created. Entering a footnote is really easy.

- Working in galley view, position the cursor where you want the footnote reference number to appear.

  You could work in page view just as well, but what you see on the screen will be different than what we show you here.

- Select Footnote... from the Document menu. This brings up the Footnote dialog box, as shown in Figure 13.7. Notice that the box labeled Auto-numbered Reference is checked, indicating that Word's default is to number each footnote.

  ![Footnote dialog box](image)

  Figure 13.7: The Footnote dialog box comes up with Auto-numbered Reference checked.

  You can put old-fashioned reference marks, such as *, †, or ‡ in the box if you prefer them to numbers.

- Click OK. The text window splits into two parts separated by a thick black line. As shown in Figure 13.8, the upper part contains the document proper, and the lower part contains the first footnote reference number with the cursor ready for you to type the footnote itself.

- Type in the footnote text.

  If you want the footnote portion of the window to disappear, drag the split bar, shown in the margin, to the bottom of the window. (The finger-stretching shortcut for making the footnote window appear and disappear is `⌘-OPTION-SHIFT-S`. Just try that with one hand.)
such solutions as Kodak's sulfide sepia
toner T-7a, which contains 15 grams
per liter of stock solution.¹ It reacts
with metallic silver to form silver
ferrocyanide according to the following
reaction:

\[
4Ag + 4K_3Fe(CN)_6 \rightarrow 3K_4Fe(CN)_6 + Ag_4Fe(CN)_6
\]

Footnote

Footnote text

The footnote reference number
appears here, where the cursor was.

You can return to editing in the top part of the window by clicking
where you want to edit or with the 3:OPTION-Z shortcut.

Check out how things look in page view. You can see the bottom of
the first column of the example article in Figure 13.9.

The equilibrium constant of this
reaction is expressed as

\[
K_e = \frac{[K_4Fe(CN)_6]^3[Ag_4Fe(CN)_6]}{[Ag]^4[K_3Fe(CN)_6]^4}
\]

where the quantities in brackets are the
concentrations of the reactants.

¹Haisst G: Modern Photographic
Processing, John Wiley and Sons NY
1979;109.

Figure 13.8: A portion of the screen showing how the Footnote... command splits the window and moves the cursor into
the footnote area.

Figure 13.9: The bottom of the first column in the article, showing how the footnote is
formatted
Adding and Deleting Footnotes

Go ahead and add the rest of the footnotes to the article. As mentioned above, you do not have to add them in any particular order, because Word will keep them numbered sequentially.

Deleting a footnote is almost too easy. Delete the reference number in the main document, and the entire footnote disappears. Trying to delete it in the footnote window leaves an empty paragraph for a footnote, and the reference number remains in the text. Cutting and pasting footnote numbers (moving the footnotes and resequencing the numbers) works exactly as you would expect. All the usual undo rules apply.

The Footnote Text and Footnote Reference Styles

You may have noticed that the size of the font in the footnote text is 10 points, the same as in body paragraphs. We can change that by redefining the footnote text style, an automatic style Word uses for footnotes. Following the style sheet, we'll use 9 points, so that footnotes are clearly differentiated from body text and take up less space on the page.

footnote text The automatic style for footnotes.
Normal + Font: 9 Point

If you open the footnote window after you redefine the style, you will see, as you would expect, that the font size there has changed to 9 points. But we are about to encounter a case in which changing the style does not change the text!

Footnote reference numbers look better if they are slightly smaller than the text they superscript. In the Define Styles dialog box, you will see an entry for footnote reference. Its current definition is shown here:

footnote reference The automatic style for footnote reference numbers.
Normal + Font: 9 Point, Superscript 3 Point

Something odd is going on. All styles we have encountered thus far refer to entire paragraphs. But the footnote reference number is only one or two characters in a paragraph. Redefine this style to 8 points and look carefully at the reference numbers.
Changing the Footnote Reference Style Didn't Change the Size of the Numbers. Neither in the footnote window nor in the main document window have the footnote reference numbers changed to 8 points. Word uses the footnote reference style when it creates the reference number, but not when the style is redefined. New footnotes will, however, receive the new character formatting.

To change the formatting of an existing footnote reference, you have to recreate it:

1. Change the footnote reference style to the size you want.
2. In the footnote window, cut (⌘-X) the text of the footnote.
3. In the main document, delete the reference number. This eliminates the footnote.
4. Give the Footnote command. This creates a new reference number and transports you to the footnote window.
5. Paste (⌘-V) the old text back in.

The lesson of this gotcha is that it pays to get the footnote reference style right before you enter the footnotes.

Footers

You learned about how to put headers at the tops of pages in Chapter 12. Instead of headers, this article needs footers at the bottoms of pages. The journal name, date, and volume number go in the even footers (left-hand page) and the article title and authors' names go in the odd footers. As with the book (see Chapter 12), page numbers line up with the outside margin of each page.

We want to make sure that the reader doesn't see headers and footers as part of the body text. We will ensure that separation here by using vertical space and character style.

The bottom margin of the page is 1 inch, so placing the footers 0.5 inch from the bottom of the page will leave 0.5 inch between the bottom of the footer and the bottom of the text—plenty of room, especially considering the small type in this article.

Using 9-point italic Helvetica would further distinguish the footer from the body, but to make it even easier for the reader to find the page
number, we’ll format it in nonitalic bold. Figure 13.10 shows how the
two footers appear on the screen.
Word has an automatic style for footers, which we can redefine:

**footer**  The footer appears at the bottom of each page.
Normal + Font: 9 Point, Italic, Tab Stops: 5.25 in Right Flush

The page number that shows in Figure 13.10 is not 1 but 324. You
have to determine what page this article starts on and set that number
using the **Number Pages From** option in the **Document** dialog box.

![Figure 13.10: The even and odd footers in galley view. Note the right tab setting at 5.25 inches. In the even footer, the
journal title is flush right with that tab, while in the odd footer, the page number is preceded by a tab.](image)

---

**Preparing for Printing**

The article now has all its text, and the formatting is complete. The
can’t check grammar or make sure all the words that
check most typos and spelling errors. It makes sense to run the spelling
checker before you do final proofing, so the computer can take some of
the burden from you.
Word has a built-in spelling checker with over 80,000 words in its main dictionary. You can also make your own dictionaries, called user dictionaries, with 64,000 words in each of them, although Microsoft recommends restricting the number to 1,000 words per user dictionary to avoid seriously degrading the speed of the spelling checker.

- Position the cursor at the beginning of the document. No text should be selected.

Word's spelling checker has a couple of features that can cause some confusion at first.

- Checking starts from the position of the cursor and continues to the end of the document. You are then given the option to continue checking from the beginning.
- If something is selected, only that selection will be checked.

The easiest thing to do, therefore, is to move to the beginning of the document before you start.

- Put the cursor at the beginning of the document.
- Select Spelling... from the Utilities menu.
- The first time you use the spelling checker in a session, there is a pause while Word loads the main dictionary and the User 1 dictionary. Then the Spelling dialog box comes up. Click on the Start Check button.

As you can see in Figure 13.11, the first unrecognized word in the example document is the name of one of the authors. It frequently happens that a spelling checker does not recognize a correctly spelled word. In any case, you have three choices.

- Assuming the word is spelled correctly, continue to check the rest of the document by clicking on No Change. You would do this if you did not expect to encounter this name or word again in future spelling checks. If the word appears later in the document, Word will skip past it, saving you from having to think about it again.
- Add the word to the User 1 dictionary by clicking on the + button. You would do this with words that you expect to encounter as you work on a variety of documents. For example, if you are the author, you would certainly add your own name to the User 1 dictionary.
Figure 13.11: The spelling checker does not recognize the author's last name.

- Create a new user dictionary to use with this or similar documents and add the word to this new dictionary. (We'll explain how to do this in a moment.) Use new, special-purpose dictionaries for documents or groups of documents that contain proper nouns or technical words that you will encounter only when you work on those documents.

Let's assume that you will be working on other chemistry articles by this author. You would benefit from having a separate dictionary for that work—the third of the three options.

- Choose `New` from the `File` menu. Immediately a new dictionary, named User 2, appears in the list of open dictionaries. (Ctrl-N will not work as a keyboard shortcut, because Word will interpret it as pushing the `No Change` button.)

- You must tell Word that you wish to add words to the new dictionary by clicking on User 2.

- Click on the + button. The word appears as the first and only item in the `Words:` list.

- Click on the `Continue Check` button. The spelling checker will find the unrecognized word, "PhD," in the example document.

- Probably "PhD" is a common enough abbreviation that you would like to store it in the User 1 dictionary, not the special-purpose User 2 dictionary. To do so, click on User 1 and then on the + button.
If we had written "Ph.D.", Word would not have complained. It assumes that words with periods in the inside, like U.N.C.L.E., are not to be checked.

Continue checking the document. You will find more words that are spelled correctly but unrecognized by the spelling checker. Finally, you will encounter a genuine misspelling. Figure 13.12 shows the first one in the example document—obtrained. You have two choices:

- Type the correct spelling into the Change To: box, then press the Change button; Word will make the change and continue checking. OR...
- Press the Suggest button. As shown in Figure 13.12, you get a list of possible correct spellings from Word. If the spelling you want is not already highlighted, click on it and press Change.

When the spelling checker reaches the end of the document, the Spelling dialog box will disappear. But the words that you have put into your dictionaries have not been saved! Word will give you a chance to save the dictionaries when you quit, but now is a better time—when the changes are fresh in your mind.

- Bring up the Spelling dialog box again.
- Click on User 1.
- Choose Save from the File menu.
- Click on User 2.

Figure 13.12: The spelling checker suggests "obtained" to substitute for the unknown word, "obtrained."
• Choose **Save As...** from the **File** menu. Give this dictionary a name that will make sense to you later, such as "Chemistry," and put it in a folder that will be easy to find when you work on this or related articles again.

The first time you use Word to check the spelling of a document, especially one with many technical words, as in this article, you may feel that you have not saved yourself any time. But the next time you check this document, Word will move much faster because it will not stop to ask you about the words you have stored in the User 1 and Chemistry dictionaries. When you quit Word and then come back at some future time, it will automatically open the User 1 but *not* the Chemistry dictionary. You must do so yourself, any time the **Spelling** dialog box is showing, by choosing **Open...** from the **File** menu in the usual way.

In the excitement of using the computer to check spelling, don't forget to do a careful proofreading. Most people find they make fewer errors if they work from hard copy (paper). The hard copy will also come in handy as you fix the remaining layout problems.

**Checking the Design**

Does this design really work, and have we conformed to the style sheet? Print preview does only a partial job of answering that question. As we print a draft for proofreading, we should look carefully at the results.

A good example of the kind of thinking that we should do at this stage includes worrying about the many font sizes and character styles on the first page of the article. Do these detract from the simplicity of the format, making it too busy? If you think so, you could consider eliminating some of the variety. For instance, the **subtitle** and **authors** paragraphs could have the same style, and the abstract could be formatted without bold. You have to decide now, because changing styles later on will undo some of the small-scale work that comes up next.

**Page- and Column-Break Problems**

We are now prepared to grapple with page and column breaks. Start from the first page and work toward the last, because each change you make affects the flow of text that comes after it. By the same reasoning, be sure to set the printer in the Chooser and to hyphenate
before you mess around with page and column breaks. If you don’t, you’ll just have to do them over again.

If you have used Keep Lines Together for captions and Keep With Next for figures and headings, Word will do a pretty good job of choosing page and column breaks.

At times, though, a figure with its caption will be forced to the next page, leaving a large white space on the previous page. In this case, you can shrink the graphic to fit in the available space or move some text to a position before the figure. (With fully justified text, such as we used in the example article, it is not a good idea to move part of a paragraph ahead of the figure, because the line immediately preceding the figure will be difficult to justify.)

Another common occurrence is that a heading, because of its Keep With Next formatting, goes to the next page, leaving too much space at the bottom of the preceding page. You either have to delete something before the heading, so that the heading and following couple of lines will fit, or live with the extra white space.

Widow control, available in the Document dialog box, strongly affects page and column breaks. Generally, you will want to leave it turned on, because a less-than-full column or page is preferable to a stranded single line of a paragraph. If, under exceptional circumstances, you do turn off widow control, you will find yourself drawn more and more to insert the dreaded hard page break.

**Vertical Justification and the Last Page**

How can we get the bottoms of the columns to come out even? Word figures out how much extra space to add between words to make the right edge of a column even, but it doesn’t figure out how much extra space to add between lines or paragraphs to make columns stretch exactly to the bottom margin. You can fine tune the line spacing in the paragraphs on a page until you get it right, but usually it won’t be worth the fuss. As soon as you change anything that changes the number of lines in any paragraph, all your work will be for naught.

The last page of this two-column article is another matter. Figure 13.13 shows how different the two columns are in length. In Chapter 9, we used a technique for getting these columns lined up: all we have to do is to add a third, empty section to the end of the article. You do that by positioning the cursor at the end of the last paragraph, pressing RETURN to get a new, empty paragraph, then pressing ASCII-ENTER to get a section mark before the paragraph.
The Columns Still Didn’t Come Out Even. If we followed the above instructions, we see that the bottoms of the columns on the last page came out just as uneven as ever.

The placement of footnotes is to blame. If you look back at Figure 13.3, you can see that we set footnotes to be placed at the bottom of the page. Word dutifully puts the footnote at the bottom of the page under the first column and fills in the text down to the footnote. The remaining text goes in the second column. The simple solution is to keep the new section and choose the Beneath Text option for footnote position in the Document dialog box. Then you will get a spread like the one shown in Figure 13.14.

The Article as a Template

The finished article, even with its text, can serve as a template that an author can use to write succeeding articles for the same journal. A page-layout person working for a publisher might go to the trouble of making a bare-bones template that contains all the styles but only a minimum of text, much as we did with the business letter in Chapter 5. If you needed to use it frequently, it would be worthwhile to install it as an item on Word’s Work menu.
Figure 13.14: With the footnotes placed beneath the text, the columns on the last page come out nearly even. (The columns on the previous page, however, are not as well aligned!)

For More on Various Topics

Automatic styles—The footnote styles are examples of automatic styles, which we talked about in connection with outlining in Chapter 7 and in connection with headers in Chapter 12.

Columns—Multicolumn layouts occur in many chapters. Pay particular attention to the four-column layout in Chapter 16 and the newsletter columns in Chapter 17.

Headers—Only footers were required for this article. We introduced headers in Chapter 12.

Hyphenation—We discussed manual hyphenation in Chapter 9, automatic hyphenation in Chapter 12.

Outlining—If the article had subheadings in addition to main headings, you would want to use Word’s outliner, introduced in Chapters 7 and 11. For more outlining techniques, see Chapter 14.

Page breaks—We do still more with these in Chapter 18 in the context of large desktop publishing projects.

Spell checking—We first introduce using Word’s spell checker in Chapter 11.
Manny got avocado, tomato, and cheese on a croissant. I ordered my usual: liverwurst on light rye, no mustard. Manny looked at me like I was from another planet. I looked at the article and shook my head.

“It’s too good, Manny. It’s not even twelve hours since you made the arrest. Somebody wanted you to find this. I know she had a chemistry minor and that she and Victor were both interested in photography. It’s true that she and Victor were not at the peak of their romance. I know she was at the Big Z, in the neighborhood, at a time when she could have poisoned the slivovitz. But none of those mean she’s the murderer. As to this,” I shook the article at him, “I can’t believe that she would leave the article around if she had just used it to find the recipe for a poison.”

“We’re following other leads. But you’re forgetting: she appeared at the scene, she made the cookies, and there was no note.”

“Grant me the note for a moment, OK?” He nodded. “Given the note, she had to go to Victor’s place.”

“What about the cookies?”

Almond macaroons were Clara’s signature cookie. I ate while I thought.

“Everybody knows she makes those cookies. How about this: Alice goes with Victor to his apartment and poisons the slivovitz while he isn’t looking. The macaroons are on the table. She decides to throw you off, so she makes a nonstandard batch while he cools, subs tutes them, and switches the liqueur. There was one bite out of the cookie, right?”

“The one in his hand. Yes.”

“Bet the bite was not made by teeth.”

“I’ll add it to my list. Why do you have it in for Alice Land, Delilah?”

“Call it a hunch. She was the Al on the phone, wasn’t she?”

Manny nodded. “She says they talked about the software she was working on, some cello simulator.”

“She’s lying. The draft manual is in the briefcase. He didn’t take it with him to her place yesterday afternoon.” Manny looked at me with new respect. He knew I was right.
In this chapter, we are going to write a manual for a program that runs on the Macintosh. This will give us a taste of what it's like to work on a document with a complex, formal structure, complete with numbered sections and subsections. We get a chance to use Word's outliner to represent this structure and learn some advanced outlining commands. In doing the page layout, we'll have to deal with headings that we want to span both the side and main columns as well as headings that are to be restricted to the side column. We will also see how Word can help us number the sections automatically, make a table of contents from the outline, and compile an index using index codes formatted as hidden text.
Introduction

Our product is MacCello, an electronic cello with a serial interface that plugs into the printer port of a Macintosh. The software that comes with it runs on a Mac. The sound can come out of the computer's internal speakers or external speakers. Optionally, the program can send signals to a MIDI device to create the sounds. Like some other Macintosh products, MacCello is vaporware, but we have to write the manual anyway.

The Design

How can we make it easy for readers of our manual to find their way around? Lots of white space and plainly visible headings with a clear hierarchy will help immensely. Let's look at a two-column layout in which a narrow left column contains headings and small figures, while a wide right column contains the body text. The thumbnail in Figure 14.1 shows the basic plan.

On 8 1/2-by-11-inch paper, with one-inch margins, we have 6 1/2 inches of horizontal space to work with. Reserving a 4 1/4-inch column on the right side for body text and a 2-inch column on the left for headings and graphics leaves 1/4 inch between columns. Allowing main headings to span both columns will emphasize their importance.

One more thing: since we'll be making a table of contents and an index, it will be important to have page numbers! We'll put them in a header on the upper-right corner of the page. We expect this manual to be copied on one side only, so we won't worry about facing pages.

You can look at the page facing the title page of this chapter to see some sample pages from the manual. Additional sample pages appear later in Figure 14.9. After we've covered two techniques that writers of Mac manuals need and learned more outlining techniques, we'll come back to the actual formatting of these pages. Finally, we'll look at three important ways Word can help us organize our document: numbering paragraphs, creating a table of contents, and compiling an index.

Special Techniques for Writing Mac Manuals

The two techniques we'll talk about are how to make pictures of the Macintosh screen and how to make the % character show up. Though you will not use these every day, you may find them useful.
Macintosh Screen Shots

This part is easy. Press Ò-SHIFT-3, and the Macintosh will create a snapshot of your screen in a MacPaint document. This document appears in the root (top-level) directory of your startup disk. The name of the first such document will be Screen 0, and subsequent screen shots will be named Screen 1, Screen 2, and so forth. With SuperPaint—preferably in MultiFinder—edit the picture the way you want. Then select the portion of the picture that you want to put into your manual,
switch to Word, and paste. The graphic will appear in your document and you can adjust it using the techniques we described in Chapter 8.

Two problems often come up:

- If you want a picture of something that interrupts the normal flow of things—such as a menu selection—the Mac will wait to take the snapshot until the menu selection is already made. How do you get a picture of a menu while it’s pulled down? Use Camera, a desk accessory by Keith Esau. With Camera, you specify a number of seconds of delay and close the desk accessory. After that number of seconds, Camera will take a picture of the screen regardless of whether a menu is selected. You can decide whether to include the mouse pointer in the picture.

- When you are working on a large screen, depending on the screen, % -SHIFT -3 may capture only the upper-left portion, or it may grossly distort it. Sometimes this proves inconvenient. A utility called Capture, from Mainstay, allows you to drag out a rectangle of any size and copy it directly to the clipboard or to a file. It even captures menus (but not the mouse pointer).

The Clover Character

How do you put the % character into a document? You can use the Key Caps desk accessory to find the key combinations that produce many obscure graphics, such as & (OPTION-SHIFT-K in fonts that live on Apple LaserWriters). Unless your keyboard has a CONTROL key, however, you won’t find %. (If you’re using a Mac SE or a Mac II, you can make % by pressing CONTROL-Q in the Chicago font.)

Here’s why: every character has a number code called an ASCII code (American Standard Code for Information Interchange). Capital A, for example, is 65. Every key, and every SHIFT- or OPTION-key combination has its own code. But there are codes that usually require a CONTROL key! 17 is one of these. And while it doesn’t do anything in most fonts, it appears as a % in the Chicago font.

If you don’t have a CONTROL key, here’s how to get your first Chicago clover:

1. Position the cursor where you want the %.
2. Change the font to Chicago.
- Press \%-OPTION-Q (the Paste Special Character command). The lower-left corner gets selected just as it does when you type in style names.

- Type in the number you want—17. Press RETURN or ENTER.

The \% character will appear in your window. There’s one problem, though—you’ve changed the font to Chicago, and you have to change back. Press \%-SHIFT-SPACE to return to plain text, and the font that belongs to the paragraph’s style. If you use a lot of \%s, these gyrations are too painful.

Here’s our solution: we’ll make a glossary entry. Type a hyphen in that plain text. You almost always want a hyphen after a \%, anyway. Select the two characters "\%-" (no trailing paragraph marks!) and create a glossary item by selecting the Glossary... command and pressing the Define button. You’ll never have to do that Chicago shuffle again.

You may still not be satisfied. Chicago is a bit-mapped font and the bits will be visible in a laser-written document. This may be what you want, as it will remind the reader of the Mac screen, but if you prefer a smoother version of the symbol, get a copy of ChicagoSymbols, a free PostScript font with only a few characters in it; one is the clover.

**Advanced Outlining**

After the introduction in Chapters 7 and 11, it’s time to learn more about outlining. We’ll write the bulk of the manual in outline mode, leaving the formatting until we are sure of the text and the order of the sections. Figure 14.2 shows a picture of part of the outline. Here are some things to remember as you create it:

- Enter or exit outline mode with \%-U.
- Demote a heading with the right arrow—on the keyboard or on the icon bar. Don’t use tabs for this!
- Promote with the left arrow.
- You will see the automatic styles heading 1, heading 2, and so forth, appear in the style box as you work.

You can add the body text while in outline mode just as easily as in galley view, but if you are not careful, it will all end up with the Normal style, making later formatting needlessly difficult. Before you begin
typing the body text, define a style called body. Right now, the important thing about this style is not its definition, but that you apply it to the body text. By the way, you have to be in galley view or page view to define a style; the only way to apply a style while in outline view is with the `~SHIFT-S` keyboard shortcut. In Figure 14.3 you can see how a typical portion of the outline with some body text looks.

Figure 14.3: We have typed some body text under the second-level headings. Notice that the show-body-text icon is highlighted.
If Word displays only the first line of the body text paragraph, you probably have not selected the show-body-text icon (see Figure 14.3). Sometimes you want to see all the body text, and sometimes you don’t.

The finished outline with all the body text showing is pretty unwieldy. It’s even worse if the graphics (such as the screen shots) have been inserted. What good is an outline if it takes up that much room? Outlines are supposed to be short, right?

**Controlling What You See in the Outline**

Fortunately, there are ways to tell Word how much to show in outline mode. The icon bar at the top of the window in outline view contains six tools that control what you can see. We have identified the new parts of the icon bar in Figure 14.4.

![Figure 14.4: Anatomy of the icon bar](image)

**The Show All Icon**

The simplest tool is near the right of the icon bar: the show-all icon. When you click on the show all icon, Word expands the outline to show everything. If everything is already showing, it collapses the outline to show only headings. When only headings show, the outline looks rather like Figure 14.2, except there are gray lines between the headings. The gray lines show where body text has been collapsed.

If you click on the icon again, the text reappears. The asterisk key on the keypad functions in the same way as the icon on the icon bar. We find that a frequently used keyboard sequence after opening a long document is `²-U to get into outline view, followed by the asterisk to hide the body text so we can find the section we want to work on.
The Expand and Collapse Buttons

Sometimes you'll want to expand or collapse individual headings and their associated subheadings and text. These two buttons will do the trick. There are two rules governing how they work:

- If the cursor is in a heading paragraph, clicking on the collapse button first collapses all the text subordinate to that heading, then the headings, one level per click.
- If a heading is selected, everything subordinate to any level in the selection is collapsed in one click.

Figure 14.5 shows the effect of the collapse button; the expand button works the same way in reverse.

Word has a shortcut for completely expanding or collapsing a heading: double-click on the icon next to the heading.

Each paragraph of body text gets one line in the outline view. The cursor is at the top of the window in a level 1 heading.

One click on the collapse button. All the body text is gone. Now you can see level 4 headings at the bottom of the window.

**Figure 14.5a:** The first two screens in a sequence of five showing what happens if you press the collapse button repeatedly.
Another click. The level 4 headings at the bottom of the window have vanished.

Another click. This time the level 3 headings have collapsed.

The last click, and the level 2 headings are gone. Note that the placeholder body text under "Glossary" is not collapsed—it isn't subordinate to the heading with the cursor, so it isn't affected.

Figure 14.5b: The remaining three screens take us all the way to level 1 headings. The expand button works the same way in reverse.

The Number Icons

You can also use the numbers between the collapse and show-all buttons on the icon bar to control what you see in outline mode. Clicking on a number collapses all body text in the window as well as all headings subordinate to the number you chose. For instance, as Figure 14.6 shows, when you click on number 2, all text and all headings level 3 and below are collapsed.
This may look like the first screen in Figure 14.5, but instead of pressing the collapse button, we're going to press the 2.

We have just clicked on 2. The difference between this and the third screen in Figure 14.5 is that in this case, the collapse is global—not just in the region subordinate to the heading with the cursor.

Figure 14.6: Notice that though we clicked 2, even the body text under Glossary and Index collapsed.

Only the numbers from 1 through 4 appear on the icon bar, but you can restrict an outline (and a complicated outline it would have to be) to any level from 5 to 9 by pressing %-OPTION-T, and then the desired level number.

The Show Body Text Icon

We've already mentioned the icon in the context of typing in body text. Clicking on it toggles between showing all the body text (the icon is highlighted) and showing only the first line of each paragraph of body text (the icon is unhighlighted). If you have chosen to do real editing in outline view, you'll probably want to see all the body text, but if you're working on the organization of your document, you'll probably be content with just the first lines.
The Show Formatting Icon

The final icon on the bar in outline view, ff, controls whether Word displays the character formatting of the text you see. You can see a portion of the outline with the character formatting on in Figure 14.7. We find we leave this control off when working with the document's organization (after all, the indenting shows the hierarchy) and turn it on when we're editing text (where we care about character formatting).

Figure 14.7: The show-formatting icon, ff, allows you to see the character formatting of the text in the outline.

Printing the Outline

Sometimes you will want a hard copy of the outline to share with others or to mark up. Choose Print... from the File menu and you will get a copy of the outline—just the headings that would show on the screen. If body paragraphs appear—even in their shortened, elliptical form—the whole paragraphs print. Use print preview to see what you'll get.

Returning to the Editing Window

After you're through outlining, you return to galley view by reselecting outlining or typing %S-U. (If you want page view, select it from the Document menu or type %S-B.) Remember that the cursor may not be on the screen. Here's what happens when you return to normal editing:

- The window shows the same top line as the outliner did.
- The cursor is in the same place as it was in the outliner—even if it is not in the window.
That seems normal enough, but when it happens, it can be confusing. Suppose, in outline mode, the cursor was in the middle of the screen. If the outline was collapsed (as it usually is for a long document), the top of the screen may have been ten real pages from the cursor. So when you return to editing mode, your window shows a spot ten pages from where you were just editing. That can mean a lot of scrolling unless you know how to find the cursor.

Fortunately, $\text{\textasciicircum}-\text{OPTION-Z}$ finds the cursor and moves your window to that place in the document. If you have a numeric keypad (and NUM. LOCK is off), the 0 (zero) on the keypad does the same thing. (Pressing $\text{\textasciicircum}-\text{OPTION-Z}$ repeatedly cycles through the last four places your cursor did anything—even if they were in different documents.)

### Moving Sections Around

The outliner is great for looking at the structure of your document and seeing if your headings are parallel, but it also allows you to reorganize. Imagine, for example, that we want to take the level 3 sections “Recording” and “The One-Hand Option” out of “Special Topics” and make them level 2 sections to follow “Getting Started.” In galley view, we could select, cut, and paste them, and then change the styles of the headings. It’s much easier, however, in outline view. Here’s how:

1. First, collapse the outline to level 3—the level of the sections you want to move.
2. Next, select both headings you want to move. In selecting the heading paragraphs, you automatically select any collapsed text under them.
3. Press the up arrow to move the selection up past the “Special Topics” heading.
4. Press the left arrow to promote the selection to level 2. The sections including all of their text have moved. Figure 14.8 shows it all.

Moving whole sections around is extremely powerful. Just collapse everything you want to stay with a heading and use the arrow keys: up or down to move past neighboring lines, left or right to promote or demote the sections in the hierarchy. If you have ever struggled with moving large blocks of text around, you know how difficult it is to get the selection right when it doesn’t all show on the screen at once, and you can appreciate how much easier it is in outline view.
The two paragraphs are selected, ready to move.

Click the up arrow, and they move past the “Special Topics” heading.

Click the left arrow and they’re promoted to be parallel with “Getting Started.”

Figure 14.8: Moving sections around with the up and down arrows

You don’t have to restrict your use of these techniques to headings and their sections. If you want to move a single paragraph, just put the cursor in it and arrow it to its rightful place. You don’t even have to use the keys! The mouse works too: just drag whole sections or paragraphs by the icons to their left to move them or change their levels.

By the way, you can also cut and paste in outline mode; if a section is collapsed, the whole section gets cut, body text and all.
Formatting Headings

With the headings and body text entered, it's time at last to return to the design sketched in Figure 14.1. How are we going to manage the two columns and the headings, anyway? Figure 14.9 shows what we want to achieve.

Thinking about the Two Columns

If you have been following along with us sequentially in this book, you may be puzzled about how to format the two columns in this manual's design. Although we have dealt with multiple columns repeatedly, none of the techniques we have used so far seem quite right.

- Hanging indents would not only combine heading and body text in the same paragraph, but won't work because the headings often don't fit entirely on one line in the left column.
- The Columns setting in the Section dialog box won't work because these columns are unequal in width and the text doesn't flow from the bottom of the left column to the top of the right.
- You might think a table, such as we used while formatting a résumé in Chapter 7, would work, though clumsily, but it won't because Word doesn't let a table cell break in the middle of a page.

Have we found a formatting problem Word cannot solve? Of course not.

The key here is realizing that nearly all the text is in the wide right column. We'll set the document's left margin wide, leaving the space we need to its left. Then we'll use two techniques to put things in that space: negative indents for the main headings and positioned objects for the lesser headings and graphics.

Margins: Top: 1 in | Left: 3.25 in | Right: 1 in
Bottom: 1 in

Referring again to Figure 14.1, we see that the distance from the left edge of the page to the left edge of the right column is 3.25 inches. That's what we want for a left margin. Set it in the Document dialog box.
Negative Indents and the Main Headings

The manual's main headings span both columns. How can we get it to start to the left of the left margin?
In this case, the thing to do is simply to drag the left indent to the left! (You have to persist in dragging through a slight pause before the entire document window starts scrolling to the left.) Our trusty thumbnail of Figure 14.1 informs us that the proper place for the left indent is 2.25 inches to the left of zero. Your screen should resemble that shown in Figure 14.10.

\[ \text{Figure 14.10: By (persistently) dragging the ruler's left indent marker to the left, the window scrolls and the heading acquires a negative left indent.} \]

Another way to scroll to the left of the ruler's zero is to hold down the SHIFT key while clicking the mouse in the left scroll arrow. With the window thus scrolled, you can set the indent where you want it.

Still another way to specify a negative left indent is to type it directly into the Indents settings of the Paragraph dialog box.

**Lesser Headings as Positioned Objects**

The manual's headings below the first level differ from the main headings in that they are restricted to the 2-inch-wide left column; the body text to their right starts flush with the top of the heading. This is a perfect chance to use Word's ability to position objects on the page.
With the cursor in a heading 2 paragraph, bring up the **Position** dialog box.

First consider the horizontal positioning. None of the options in the selection list is appropriate. What we want (referring again to Figure 14.1) is that the paragraph begin one inch from the left edge of the page. You can click on the horizontal selection box and type **1 in**—you are not restricted to the options on the list!

Then we have to restrict the heading to the desired 2-inch column. This is easily done by changing **Auto** to **2 in** in the **Paragraph Width** box. Figure 14.11 shows the finished dialog box, ready for you to click the **OK** button.

After clicking **OK**, be sure to redefine the style. Click in the style selection box to highlight it, press **RETURN** or **ENTER**, and tell the resulting dialog box to redefine (rather than reapply) the style.

Now when you look at the manual in page view or print preview, the heading will appear in the left column, as desired.

---

**Numbering Paragraphs**

Word has a versatile feature: it can number paragraph as well as pages. That may seem odd at first. Why do you need to number paragraphs? We'll show you, using two examples: one simple and useful, one complex and amazing.

![Figure 14.11: The cursor is in a second-level heading; the Position dialog box has been set to position the heading 1 inch from the left edge of the page and allow it 2 inches of width.](image)
Early in the manual we’re creating, the readers are told to make sure they have everything they need. The manual gives them a list to check. It’s like the lists discussed in Chapter 4, but instead of bullets, let’s use numbers. Before we begin, all the paragraphs have been formatted in the BL style; they are outdented 1/4 inch. We have not inserted bullets or the tabs that follow them.

Figure 14.12 shows how the first part of the list looks in page view.

![Figure 14.12: Page view showing the beginning of the list. The cursor is in front of the first item; note the style (BL) and the last visible paragraph, showing the outdentedness of the BL paragraphs.](image)

We can do the numbering in any of the views that allow editing. Let’s do it here in page view for this example.

- Select all the paragraphs in the list.

  If the text you are selecting crosses a page boundary, this can be confusing in page view (though it does work). Better switch to galley view.

- Select **Renumber**... from the **Utilities** menu. Figure 14.13 shows the dialog box that you’ll see.

- Click on **OK**. Word will put numbers, periods, and tabs in front of all the paragraphs you selected.
This technique is perfect for numbered lists, because Word inserts the tab that makes the left side of multiline items line up. Figure 14.14 shows the results.

You're not limited to this format of the number followed by a period followed by a tab. You can't avoid the tab, but you have a lot of control over the number and the punctuation. Suppose, for example, that you want the list to have letters instead of numbers, and you want the letters in brackets instead of followed by periods. In that case, you fill in the Reumber dialog box as shown in Figure 14.15.
Here's how it works: you type an example of how you want the numbering done into the Format box. Here are the types of labels Word understands:

- 1 Arabic numerals
- I or i Roman numerals
- A or a Letters of the alphabet

Then you may surround or follow the label with some punctuation, which the Word manual calls a separator. There are only a few of them:

- Period
- Comma
- Hyphen
- Slash
- Semicolon
- Colon
- ()[]{} Left and right parentheses, brackets, or braces

If you don’t want the list to start with 1, you can type a number (not a letter or roman numeral) into the Start at: box.

If you want to show Word how you want it done, label the first item in your list yourself (don’t forget the tab!) and check the By Example option. Word will fill in what it thinks your format is. For example, if your first item begins with -v- and a tab, Word will put 5 in the Start At: box and -i- in the Format.

Of course, if you want the numbers removed, select Remove.
Renumber Operates on Paragraphs and Uses Tabs

Renumber numbers paragraphs in a selection—nothing else. Don’t forget that Renumber always inserts tabs or you will produce some strange and unwieldy formatting.

Our next task will be a bit more ambitious. Instead of numbering just paragraphs, we’re going to number entire sections. We will use the outliner and the Renumber command in concert:

- Go to outline view.
- Click on the show-all button (El) until only the headings (all of the headings) are showing.
- Select the whole document. (Hold down the % key and click in the selection bar.)
- Renumber the whole document, but this time select the 1.1... button, so that the Renumber dialog box looks like Figure 14.16. Then click OK and watch Word go to work.

If you scroll in outline mode to the software section of the manual, you will see the screen shown in Figure 14.17. Word has numbered the visible paragraphs hierarchically (like many government documents and some math textbooks).

Figure 14.16: The Renumber dialog box ready to number the sections. We have pressed the 1.1... button to enable hierarchical numbering.
This hierarchical numbering is amazing in two ways. First, Word knew what level each item was by its style. Renumbering is as intricately tied to the styles as is outlining. Second, it did not renumber the body paragraphs in between. Our bulleted list, for example, is intact.

Second, renumbering operates only on visible selected paragraphs in outline view; this means that we can be selective about our numbering. (By the way, you can’t renumber hidden paragraphs, whether they’re visible or not.) In the MacCello manual, only the main sections and level 2 subheads need to be numbered. How do you do that?

- Remove the numbering from all of the headings by selecting everything again, selecting the Remove option in the Renumber... dialog box, and pressing the OK button (or use Undo).
- Click on the number 2 on the icon bar to collapse all of the text except the top two levels of the hierarchy.
- Making sure everything visible is selected, renumber these headings. This time, let’s be daring and use [A-1] format. (You can experiment to find one you like.) Figure 14.18 shows the Renumber dialog box we used and the result.
Figure 14.18: A new renumbering of two levels of the outline. Note especially the Format entry in the Renumber dialog box.

Before we move on, we should make two comments. First, Word doesn't have to have paragraphs in heading styles to number hierarchically. Any indented list will do. Second, we have now created a formatting problem with our headings—especially with level 2, which is in the narrow column. What's the problem? The tabs. Every one of those labeled headings has a tab between the label and the text. We won't fix the problem here — just be aware when you number headings that you have to account for the tabs. Besides, we're going to have to deal with them in the table of contents, and that's soon enough!

Creating a Table of Contents

In Chapter 11, we saw how easy it is to make a table of contents using outline headings. But there are a few things we have to watch out for. Go ahead and do this:

- Select Table of Contents... from the Utilities menu.
- Be sure that Outline is selected in the Collect box.
- Click Start and wait while Word collects the headings and formats a hierarchical table of contents, putting it in its own section at the start of the document.

If we do not use the Renumber command to label the headings, everything will be fine. The table will look like Figure 14.19.
Unfortunately, the tabs that **Renumber** inserts throw a monkey-wrench into the works. The problem is in the style definitions. Word reserves the automatic styles **toc1**, **toc2**, and so forth, for tables of contents. These styles get added to your document the first time you make a table of contents. The default definitions don’t allow for the tabs. Worse than that, the process of making the table of contents inserts two tabs after the heading text: one to make the periods (using a tab leader, as we explained in Chapter 6) and another to align the page number. Since there are one too many tabs in each table-of-contents line, the whole thing gets screwed up. Look at the result with labels in Figure 14.20.

The solution is to redefine **toc1** and **toc2**. We don’t have to go any deeper, because those are the only levels that we numbered; levels 3 and 4 have neither numbers nor ungainly tabs.

- Using the **Define Styles** dialog box, select **toc1**.
- Insert a tab at 0.5 inch, a half inch from the left indent. That will allow enough room for the label and the tab. Press **Define**.
- Do the same for **toc2**, again inserting a tab setting a half inch from the left indent. Define and close the box. You’ll see the table of contents much improved, as shown in Figure 14.21.
Figure 14.20: What a mess! The automatic table-of-contents styles—toc1, toc2, and so forth—don't allow for the extra tab inserted by Renumber.

Figure 14.21: Much better! Notice the tab in the ruler for the current style, toc1. Compare it to the default toc1 in Figure 14.20.
Creating an Index

If you are a proficient reader of manuals, you probably first turn to the index when you need to know something. Our sample manual is only about ten pages long; still, let's give it an index.

We will embed codes in the document, formatted as hidden text. This index text begins with a special prefix and ends with a semicolon. When we want to create the index, we select Index... from the Utilities menu. Word will compile the hidden entries and create an index at the end of the document. If you have specified a sequence of files, the index appears at the end of the last file in the sequence. Word's indexer works a lot like the table-of-contents processor does when you use the \section paragraphs, but there are differences:

- Instead of \section, the prefix is \index or \i (for index).
- Word collects the entries and alphabetizes them instead of presenting them in page order.
- Instead of appearing at the beginning of a document, the new section appears at the end.

Thus, if you want an entry to look like this in the index

\textbf{MIDI compatibility 3}

you would type, "\index{MIDI compatibility}" where it came up in the text (in this case, page 3). If you typed "\index{MIDI compatibility}" again on page 10, the index would show

\textbf{MIDI compatibility 3, 10}

Using the Insert Index Entry Command

On the Document menu you will find a handy shortcut for indexing, the Insert Index Entry command (analogous to the Insert TOC Entry command). Selecting this command puts \index at the insertion point and leaves the cursor positioned just before the semicolon, ready for you to type the entry. Furthermore, if you have text selected, Word inserts \index before and \index after your selection, leaving your selection visible.

When you sit down for a long session of indexing, you will certainly find it convenient to create a keyboard shortcut for the Insert Index Entry command. Use the Commands... command in the Edit menu.
Use colons to separate subentries.

(See the section in Chapter 6 in which we added a keyboard shortcut for \textit{Section...} and \textit{Document...} for details on how to do this.)

\textbf{Formatting Subentries}

Another feature the indexer has in common with the table-of-contents processor is the ability to format subentries. For example, if you want the following entry

\begin{quote}
Recording
dialog box 6
options 8
\end{quote}

you would type \texttt{``i.Recording:dialog box;''} and \texttt{``i.Recording:options;''} at the appropriate places in the text. Colons work the same in index entries as in table-of-contents entries.

\begin{quote}
\textbf{Does the Text \textit{Have} to Be Hidden?}
\end{quote}

Only the \texttt{``i.''} has to be hidden. Furthermore, the entry can end with a RETURN or a SHIFT-RETURN as well as a semicolon. So it is possible to create index entries in your text by surrounding existing text with hidden punctuation and index codes.

\begin{quote}
\textbf{Different Index Formats}
\end{quote}

Word supports both nested and run-in indexes. The "Recording" example above is an example of a nested index. A run-in entry for the same text would be

\begin{quote}
Recording: dialog box, 6; options, 8
\end{quote}

You can select which format you want in the \texttt{Index} dialog box, as shown in Figure 14.22.
The bottom half of the dialog box shown in Figure 14.22 allows you to index only a portion of the alphabet at a time. You might, for example, index your document in three passes: from a-i, then from j-r, and finally from s-z. Why would one want to do that? Only because indexing uses a lot of memory; Word may not have enough to do the entire index in one pass. If this is the case, in order to get a complete index, you must do it with small enough passes that Word can handle the job.

**Indexing Conventions**

Before you make an index, you have to decide what items to index and what words you should use in the index entries. Over the years, the people who do these things have established some conventions. You’re probably aware of them subliminally by virtue of having read so many indexes in your life. You can read a lovely exposition of these conventions in the *Chicago Manual of Style*. Briefly, here are the most important ones:

- Think like your readers. What will they need to look up? What words are they most likely to look things up under?
- Capitalize main entries; capitalize subentries only if they are always capitalized in the text.
- Use nouns for main entries in preference to other parts of speech; use the -ing form of verbs—for example, “Smoothen” rather than “Smooth” or “Smoothed.” Adjectives usually work better as subentries or as modifiers of nouns, as in “Waveforms:smoothed” or “Smoothed waveforms.”
• Use plurals for main entries unless the object is referred to only in the singular. Use “Windows” rather than “Window,” but “Mouse,” not “Mice”—if you’re not writing about rodents.

• Subentries should expand on the main entry. If there are a lot of references for your main entry, split them into subentries.

• Make sure the relationship of the subentries to the main entry makes syntactic sense. The subentries can be different parts of speech, but they must all treat the main entry the same. Thus, we should not see

Options
  intonation 7
  menu 12
  recording 6

In this example, “Options” modifies “menu” in the second case but is modified by “intonation” and “recording” in the first and third. This should be split into two entries:

Options
  intonation 7
  recording 6
Options menu 12

• Alternatively, subentries may be subcategories of the main entry, in which case they make logical sense, even if they don’t make syntactic sense:

Menus 11-15
  Edit menu 11, 20
  Options menu 12
  Waveform menu 15

More Indexing Features and More Examples

In our sample manual, we have a long section on recording. We’d like to see a range of pages, such as “Recording 5-6,” appear in the index. Getting a range of pages requires two entries; Figure 14.23 shows what they look like in a (split) galley-view window, with Show Hidden Text turned on.
The recording feature is one of the most straightforward. Controls in the Recording window on your screen (if it is not showing, be sure it is checked in the Windows menu) act like the transport controls of a tape deck. The "tape counter" records the time in minutes and seconds. By clicking on the menu lets you save the recording up to the current time on the counter, or load the "tape deck" with a previously recorded sequence, erasing the current contents.

In case the beginning and end pages are the same, don't worry—Word is smart enough not to give you "Recording 6-6."

Sometimes you might want a page number boldfaced or italic. For example, you might want to have references to figures boldfaced. You should use .ii. and .ib. for italic or bold, respectively. Case is unimportant in any index code, so .IB. works, too. As you might expect, .iib. does bold italic. Figure 14.24 shows a sample of several index entries, including one for a figure, whose reference is to be bold. Word's indexer will render the entries you see in the figure as

Cello
intonation option 6
Intonation dialog 6
defaults 6

Word's indexer supports cross-referencing. Suppose you wonder about playing your cello in tune, so you look up "Tuning." Unfortunately, tuning is a different (but related) issue; the index should tell you to look up "Intonation" instead.
Word lets you insert text instead of a page number into the index if you introduce it with the number sign, as in "i.Tuning #(See also Intonation)." You can see an example in Figure 14.25. In the example,
we also want a reference to tuning—a topic in its own right. Since we want both the page number and the text, we need two index entries. You would use “See” instead of “See also” if there were no page reference, as in “Out of tune (See intonation).”

After making this index entry, we asked Word to build a nested index. A new section appeared at the end of our document. Figure 14.25 also shows what part of this embryonic index looks like. Unfortunately, the indexer does not preserve character formatting. As you can see, the italics in (See also intonation) didn’t come through; we’ll have to italicize by hand.

**Tips—and What to Watch Out For**

Now you know enough to make a creditable index. Keeping your reader in mind, go through your document from beginning to end, inserting the appropriate index codes and entries. When you’re through, create the index and check it carefully. When you make an index, there are many things that can bite you and some ways to make your life easier. As we close the chapter, let’s list some general recommendations and warnings.

A good index is a lot of work. The first thing you have to get straight is what names you’re using for your main index entries. For example, if you have an entry “Menus: Options” in one place and “i.Menus: Options menu” in another, you’ll get

```
Menus
Options 17
Options menu 24
instead of
Menus
Options menu 17, 24
```

Everything you want Word to list together has to be worded (and spelled) exactly the same! The consequences of carelessness are horrific. There are several things working against you. First, you probably don’t need an index unless the document is long. Second, under most circumstances, index entries are invisible (formatted as hidden text). Third, if you make a mistake, there’s no automatic way to track it down. So, even though word processing may induce an I’ll-fix-it-later attitude, you had better be more cautious than usual with your index.

We recommend first indexing only a portion of your document in order to get the feel of it. You’ll quickly find which terms appear most often and what kind of trouble they give you. It will take some practice before you get parallel subentries right.
Use your glossary!

Word's glossary can help you keep names consistent. Define glossary entries for commonly used index entries, especially the main categories. Put them on the Work menu so that they are easily selectable. When you come to add a new index entry, check the Work menu first to see if you already have the desired entry there. If so, simply select it. This can save you a lot of time because your index will be more consistent on the first pass than it would otherwise.

You should also remember that character formatting doesn't stick to the characters in a table of contents or an index. Font changes (such as to Chicago for a ß character), boldface, font-size changes, or italics (such as the See also we tried to use in Figure 14.25) don't appear. You have to fix them yourself. That means that you should not do the character formatting until you're ready to print, because if you redo your index, the formatting changes will be wiped out.

Finally, remember that the index, table-of-contents, and numbering processors produce only text; we need to treat that text like the rest of the words and numbers in our documents. But be aware that these tools are not like the footnote processor, which keeps the numbers in order for us. So remember:

- If you move a numbered paragraph, its number won't get changed until you fix it either by hand or with Renumber.
- If you change the order of sections, those changes will not be reflected in the table of contents until you tell Word to make a new table of contents.
- If you make changes that move page breaks, the index references won't be correct any more; you will have to make a new index.

Even though numbering paragraphs, making tables of contents, and indexing require a lot of work and careful thought, Word is a big improvement over a desk buried in index cards.

Character formats don't survive indexing or tabling.

Indexes, tables of contents, and numberings are just text.

The Styles in MacCello™

The rest of this manual's formatting uses techniques that we have covered in previous chapters. You can probably figure them out from the sample pages, but in case you particularly like the MacCello™ manual layout, here are the style definitions we used. Remember that the position attributes of a paragraph can become part of a style definition.
Normal  Set the font and justification.
Font: New Century Schlbk 12 Point, Flush left

Body  Use for bread-and-butter paragraphs.
Normal + Space Before 12 pt

BL, bulleted list  Use for lists.
body + Indent: Left 0.625in First -0.375in

Left  Use for anything that appears in narrow left column.
Normal + Position: 1 in Horiz. Relative To Page, Width: 2.125in

Figure  Use for figures in wide column.
body + Border: Top Bottom Left Right (Single Shadowed) Between (Single)

Heading 1  Use for section headings.
Normal + Font: Avant Garde 18 Point, Bold, Indent: Left -2.25in, Page Break
Before, Keep With Next

Heading 2  Use for subheadings that appear to left of text.
Normal + Font: Avant Garde 14 Point, Bold, Space Before 12 pt, Keep With
Next, Position: 1 in Horiz. Relative To Page, Width: 2 in

Heading 3  Use for subsubheadings in left column.
heading 2 + Font: 12 Point

Heading 4  Lowest level of headings.
heading 3 + Not Bold

Index 1  Use for main index entries.
Normal +

Index 2  Use for index subentries.
Normal + Indent: Left 0.25in

toc 1
Normal + Tab stops: 0.5in; 4 in ...; 4.25in Right Flush

toc 2
Normal + Indent: Left 0.5in, Tab stops: 1 in; 4 in ...; 4.25in Right Flush
For More on Various Topics

Bulleted lists—We introduced these in Chapter 4.

Glossaries—See Chapter 4 for details on how to define a glossary item and how to put it on the Work menu.

Headings—You may profit from a comparison of the headings we have formatted for this manual with the headings in the résumé in Chapter 7. There we used a table; here we used negative indents and positioned objects.

Indexing—We’ll tell you about the travails of indexing this book in Chapter 18.

Outlining—We introduced the basics of outlining in Chapter 7.

Page numbering—See Chapter 12 for a detailed account of how to number the manual’s pages.

Positioned objects—We introduced positioned objects in Chapter 8.

Sequences of files—A real manual would be more than ten pages long and require some of the techniques for handling sequences of files we introduced in Chapter 12.

Table of contents—We constructed two simple tables of contents in Chapters 11 and 12.
Manny left after lunch. I went back to the office and put my feet up. I’d been up since Clara got me out of bed at one. I leaned back, and closed my eyes. The memories of the day competed for attention.

I heard Victor talking to Alice on the phone. I saw Hines’s eyes narrow when I mentioned the meeting at Brockmyer’s. I saw Clara talking about how odd the note looked. Finally, a few pieces fell into place. It was like one of those games where you’re forever second- and third-guessing your opponents.

If it was a frameup, then Clara was telling the truth, and there really was a note. If there was a note, the killer made it. There was no way to be sure Clara would bring it and drop it. The killer would have to make it look as if Clara herself made the note. It was not signed, typical of Victor’s notes. But if I were framing Clara, I would still have to make it look as if Victor wrote the note. What a tangled web! But it told me where to look.

At Victor’s cubicle, I woke up the cop, Walters, sitting in his chair. He recognized me from Clara’s office and let me poke around the computer. It was two levels deep in folders. It had been written using Microsoft Word. By someone who didn’t fully understand the Macintosh or that program. Even without printing it, I could see what Clara meant about the note.

I explained to the cop what he had found—but not what was strange—and told him that Sergeant Davis would be interested. Then I sent it to myself over the net, leaving the original where I found it.

I had been so stupid not to figure out that Alice had an inside partner. And I knew who it was. My palms were sweaty as I called Hines. He was out. I knew I had to sew this up tight.

Breathing hard, I wrote him a note on our confidential stationery. I hoped it would get his immediate attention and still not make him run.

“Chuck,” I wrote, “who did the layout for you on the expansion proposal? It looks great. I need to know fast.”
Immaculate Assessment
6 Marina Vista Parkway
Emeryville, CA 94608
(415) 578-6000

April 1, 1989

OFFICERS
Emil Brodsky, Ph. D.
Founder and President
Charles Stull
Vice President, Operations
Circa McConnell, Ph. D.
Vice President, Projects
Janet Beaver, Ph. D.
Vice President, Research
Sally Odel
Senior Manager, Evaluation Manager
Morton Delgado
Senior Manager, Marketing Manager
Donald Faries
Senior Manager, Training Manager
Lynda Sondrom, J. D.
Senior Manager, Legal Affairs Manager
Myrna Johnson
Senior Manager, Contracts Manager
Delores Stone
Senior Manager, Publications Manager
Sue Ann Chiu
Senior Manager, Advertising Manager
Margaret Winters
Senior Manager, Personnel Manager
LETTERHEADS

For all the flexibility of the techniques we have demonstrated so far, you may still be feeling some limitations. How can you print in *inverse type* (white on black)? How can you print in shades of gray? How can you get greater control over where the text prints, flowing text down the side of the page, or writing in big letters diagonally across the page? In this chapter, we will ponder these questions and more as we meet more positioning techniques and the wonders of *PostScript programming*. We'll discover that if you are willing to give up WYSIWYG entirely and learn a new programming language, any text or graphic effect is possible within Word.
The Plan

Word, combined with graphics programs such as SuperPaint, MacDraw and Illustrator, lets you make elegant and beautiful letterheads. No longer will you be forced to make a special trip to the laser printer to put in a sheet of letterhead; your personal or company letterhead can be part of your Word document.

Our plan is to work through a number of examples, starting simply and getting gradually more complex. The final product will be the example facing the title page of this chapter.

In going through the examples, we'll look at some new ways to combine graphics and text using positioned objects. Using a header, we will be able to flow text down the side of the page. We'll use Word's method for incorporating PostScript into the document: we will learn to write PostScript programs directly in Word.

Setting Up

For most of the chapter, Word's default page size (US letter, or 8.5 by 11 inches) and margins (1.25 inches left and right, 1 inch top and bottom) will do nicely.

Our font will be Avant Garde, a simple, sans-serif typeface in which the letters are formed almost entirely from portions of circles and straight lines. The Adobe Type Catalog suggests that it be used "to give a distinctive modern feel to a document." (If you don't have access to Avant Garde, use Helvetica.)

Simple Techniques

We'll start with some techniques that are not too different from those we have used in other chapters.

Words across the Top

We'll use shadowed and expanded small-caps characters and center the company name in large letters across the top of the page. Nothing could be simpler, and the results are pleasing, as you can see in Figure 15.1.
As you can see below in the definition of the head style, we put an extra point of space between the characters. (In Chapter 9, we used the Expanded character format for the title of the brochure.) We won’t do anything fancy with the inside address, just center it under the company name.

**head**  Use for the letterhead’s logo.  
Normal + Font: 24 Point, Bold Shadow SmallCaps, Expanded 1 Points, Centered

**inside address**  For the address information just below the head.  
Normal + Centered

As shown in Figure 15.2, you can’t judge the appearance of the letterhead very well on the screen. The screen version of shadowed characters appears much heavier than the laser-printed version.

**White-on-Black with Positioning**

Figure 15.3, with white-on-black text, is a relief after so many chapters of black-on-white. The broad black banner makes a strong statement. Word has no character or paragraph format for white-on-black, so how is it done? We’ll modify our existing letterhead.

Word can’t produce this effect without the help of a black rectangle from SuperPaint. We import a black rectangle and position outlined text on top of it.
Figure 15.2: What you see on the screen. This does not compare well with what gets printed.

- Make a black rectangle in SuperPaint (or any other graphics program) about 3/4 inches high and 7 inches long. Copy it to the clipboard.

  Why 7 inches? Centered on the page, that will leave 3/4 inches on each side of the rectangle—a good amount.

- With the cursor at the beginning of the letterhead, paste the rectangle and press RETURN.

- Using the Paragraph dialog box, add 12 points of space after to the paragraph with the rectangle. Doing so will ensure that there is adequate space between it and the inside address.

Figure 15.3: The banner of white on black catches your eye.
Using the **Position** dialog box, center the paragraph horizontally relative to the page with a width of 7 inches. The dialog box will look like the one at left.

Giving the paragraph a width of 7 inches will keep the ¶ mark from adding an extra blank line to the paragraph. You can define a style for this box paragraph if you like. The complete definition is

**black box**  Use for a graphic background rectangle.  
Normal + Space After 12 pt, Position: Center Horiz. Relative To Page,  
Width: 7 in

The paragraph after the rectangle contains the name of the company. Change the shadowed characters to outline so they will show up white and make them bold because they need a little extra width. Finally, add two points of expanded character formatting so the text more nearly fills the width of the page.

*Instead of outline formatting, you could use the ‘color’ white, available in the Character dialog box. But the white characters don’t show up as you edit, a distinct disadvantage compared with outlines!*

With the cursor still in the text paragraph, bring up the **Position** dialog box. All you need do this time is choose **Center** from the list of **Horizontal** positions. The dialog box will look like the one at left.

When you click the OK button, you should see the result shown in Figure 15.4.

So far the style definition is

**Head**  Use for the company name.  
Normal + Font: 24 Point, Bold Outline Small Caps, Expanded 2 Points,  
Centered, Position: Center Horiz. Relative to margin

Go into print preview so you can move the text up on top of the black background. (The easiest way to do this is to press the Preview button in the Position dialog box.) Once in print preview, make sure the margins icon is highlighted, allowing you to move positioned objects.
Drag the text up on top of the black rectangle, being careful to leave it centered between the margins. Figure 15.5 shows what you should see.

Click on the margins tool to force Word to redraw the page.

The Black Rectangle Covers the Text! Appearances deceive. Print preview always displays graphics after text, so the rectangle obliterates the text. But the printer prints in the order the text appears in the document, as we need in this case. That is, the paragraph containing the black box prints first, and the paragraph containing the text gets printed on top of it. So this gotcha will getcha only if you think you need to do something about it. (If you look at the letterhead in page view, you will be able to see the text on top of the rectangle and edit it as well.)
Moving the text has changed the paragraph style, giving it an absolute position relative to the page:

- **Head**: Use for the company name.

We have printed text on top of a graphic. For this example, the purpose of the graphic was to provide a black background for the text. Another use for this technique is annotation of an illustration. The advantage of putting the annotation in Word rather than in the graphics program is that it remains easily editable. The disadvantage is that positioning the text accurately is somewhat more difficult in Word than in a graphics program.

**White on Black with Formulas**

Another way to get highlighted text, white text on a black background, is to use Word’s typesetting language (introduced in Chapter 13) to displace some outlined text backwards until it lies on top of an imported black rectangle. To produce the inverse text shown at left, you import a black rectangle from a drawing program and type a formula such as the following after it:

```
D~BA900white on black text
```

Recall that the `~` is produced with `\-OPTION-\`. D is for the displace command, BA is for backwards, and the 90 means 90 points. Even though the open and closed parentheses don’t enclose anything, you have to put them in.

**Text Down the Left Margin**

We have already seen, in Chapter 14, that we can use the **Position** command to place text to the left of the left margin without disturbing other text on the page. Here we’ll use this technique for a specialized purpose—printing our letterhead text down the left side of the page. Furthermore, we’ll put the text in the document’s first header so that it won’t get in the way of editing the text of the letter.
The Company Name

Figure 15.6 shows our goal. The company name appears vertically down the left side of the page. Achieving this effect is relatively simple:

⇒ Start with a new document. Make sure you are in galley view.

Figure 15.6: Letterhead in which the company name flows down the left side
In Chapter 12, we used the First Page Special option to format a book chapter with headers on pages only after the first. This time we need to use First Page Special to allow a header on the first page but none on the following pages. So bring up the Section dialog box and click on this option.

Select Open First Header... from the Document menu. Click on the window’s zoom box. We need lots of room for this.

Set the paragraph’s justification to Centered and turn on Outline, Shadow, and Small Caps. Set font size to 24 points.

Type in the company name, pressing SHIFT-RETURN between each letter.

With the cursor in this long skinny paragraph, bring up the Position dialog box. Where do we want to place the paragraph? 0.5 inch from the left edge of the page is as close as we can get on a LaserWriter, so type that into the Horizontal selection box. Vertically, we can try Center; if that doesn’t work, we’ll try different measurements from the top of the page until we get it the way we want it.

Finally, we have to decide on a Paragraph Width. We want something wide enough to center the letters in, but not something so wide that it impinges on the body text of the letter. 3/8 inch will do nicely. Use 0.375 for the box. See the completed Position dialog box at left.

After you press the OK button, the top part of the first header window should look like Figure 15.7. On the ruler we can see the 3/8-inch paragraph width. The right and left indents are both zero—no indentation from the paragraph width. The black square to the left of the ‘I’ is the paragraph properties mark, informing us that this paragraph has special formatting. If you double-click on it, you will bring up the Position dialog box.

Back in the main editing window, type in the usual address and phone number lines. Having these lines will help us see whether the company-name-down-the-side formatting is working.

After you move into page view and scroll the window a bit to the left, you will find that the company name is exactly where we hoped it would be. Furthermore, we can edit both the header and the body of the letter.
The Officers' Names

Using the header to flow text down the side of the page opens up all kinds of letterhead possibilities. Figure 15.8 shows stationery in which the company name is on the top of the page, but the company officers are listed down the left side.

You don't need step-by-step instructions for this; the setup is similar to the previous example. Some comments about the setup and the style definition for the paragraphs with the names of the officers will help.

- The company name is back in the main editing window, along with the address and phone information.
- The left margin is set in the Document dialog box to 2.25 inches to make room for the column of officers' names.
- There are SHIFT-RETURNs between the officers' names and their positions.
- The style definition for the paragraphs containing the officers' names is

```
officers For paragraphs with officers' names down the left side of the page.
Normal + Font: 7 Point, Centered, Space Before 18 pt, Position: 0.5in Horiz.
Relative To Page, Center Vert. Relative to Page, Width 1.25in
```
Figure 15.8: Another use for flowing text down the left side of the page

This technique works partly because of the nature of positioned objects. We created positioned text in the margin; normal text in the body of the document flows around. Of course, it doesn’t need to do anything special because we’ve made the paragraphs narrow enough so that they don’t intrude on the active area of the page. If we’d made the header paragraphs three inches wide, say, the body text would be shoved to the right to avoid them. You could see it in page view.
And why didn't all those officers' names print on top of one another? We learned in Chapter 8 that Word treats sequential, identically positioned paragraphs as a single object whose vertical extent is that of the collection of paragraphs, not of the largest individual.

**Another Way to Make Long Headers**

There's a way to flow header text down the page that doesn't use positioned objects. It's less aesthetically pleasing, but it still works.

First, format your header using regular (not positioned) paragraphs. Then use a negative value for the top margin in the **Document** dialog box. For example, a top margin of $-1$ in is a signal to Word to start formatting the body of the document one inch from the top of the page, no matter where the header is. It's a powerful command, but it needs to be handled with care: if you don't want the header on top of the text, it's up to you to make sure they don't overlap—there's no positioning to make text flow around. Of course, if you **want** the header on top of the text, this is one way to do it!

You may think of other uses for headers that put text beside (or even on top of) the rest of the text on the page in addition to personal stationery. The covers of proposals or reports are places where you might use this technique. We'll see another one in Chapter 17.

**PostScript Effects**

While Word can use different fonts and character formats to produce a wide variety of textual effects, it cannot ordinarily take full advantage of the capability of a PostScript-equipped printer, such as the LaserWriter. In this section we'll look at two out-of-the-ordinary ways that you can incorporate PostScript effects in your Word documents. The topic is a big one, so we'll get started in this chapter and continue in the following three chapters. Even so, you'll have had no more than an introduction to PostScript.

**What Is PostScript?**

Adobe Systems created PostScript as a language for specifying exactly what text and graphics should go on a page, that is, as a page description language. In that sense PostScript is a relative of the
typesetting languages we talked about in Chapter 2. But PostScript is also a full-blown programming language, similar in many ways to the FORTH language, but incorporating ideas from the artificial-intelligence language LISP.

To understand what PostScript is, you must compare what happens when you print on an ImageWriter with what happens when you print on a LaserWriter. In the system folder of your disk are two files, called drivers, one for the Imagewriter and another for the LaserWriter. These files contain software that mediates between an application program like Word and a printer. The Imagewriter driver converts Word’s output into a digital picture of the page and sends that picture as a stream of 0’s and 1’s to the ImageWriter printer. In contrast, the LaserWriter driver takes Word’s output, converts it into a program written in PostScript, and sends the program to the LaserWriter. This program describes the page; it is the job of the processor inside the LaserWriter to interpret the program as something to be printed on the page.

For example, to print the letter A on the Imagewriter, the Macintosh sends the 0’s and 1’s that represent spaces and dots. To make the A appear on the LaserWriter, the Macintosh sends a PostScript command to create an A. The LaserWriter (not the Mac) converts that PostScript into the 0’s and 1’s that make up the LaserWriter’s A.

You can look at the PostScript program the driver writes. Immediately after clicking OK in the Print dialog box, hold down ⌘-F. Instead of printing, the Mac will generate a file called PostScript(n) (n can be any number from 0 to 9). You can then open that file in Word.

So far this all sounds pretty esoteric. It’s useful, though, because Word lets you incorporate your own PostScript directly into the program that is sent to the printer. Let’s see what possibilities that allows.

**Word’s PostScript Conventions**

Word lets you write your PostScript as hidden text in paragraphs formatted with a special, automatic style named, appropriately enough, PostScript.

During printing, when Word encounters a paragraph with the PostScript style, provided that the Print Hidden Text option is not checked in the Print dialog box, Word puts the paragraph’s contents into the PostScript program exactly as you typed it, leaving the printer to attempt to carry out your instructions.
Gray Text

Let's try a simple, but useful, example. We'll print the company name across the top of the page in gray. Figure 15.9 shows the result. In the next section we'll use a straightforward method that will be easy to understand. The trouble with this first way is that it won't be easily modifiable for different text, fonts, or font sizes. We'll do the example in a more flexible way in the section after next.

Immaculate Assessment
6 Marina Vista Parkway
Emeryville, CA 94608
(415) 578-6000

Figure 15.9: The company name appears in gray text, as generated by a PostScript code inserted in the document.

We Provide the Coordinates

In the first method, we have to know exactly where on the page we want the text to start. First, set things up in Word using ordinary text formatting. Then use the arrow pointer in Print Preview to get the measurements. When you hold the mouse button down, Word displays the distance from the top-left corner of the page above the preview area (see Figure 15.10).

A little computation is required because we need the distance from the bottom, not the top, of the page, and we need it in points, not inches. With 24-point Avant Garde and Word's default margins, we get 2 \( \frac{1}{4} \) inches from the left and 9 \( \frac{3}{4} \) inches from the bottom. PostScript measurements are usually in points, so we have to multiply these two numbers by 72 (there are 72 points in an inch) to get 162 points from the left and 702 points from the bottom. Armed with these measurements, we can write the PostScript code. For example, to move to the right place on the page, the code will be:

\[ 162 \quad 702 \quad \text{moveto} \]
Now let’s set up the whole thing.

- Make sure hidden text is showing. (See Chapter 11 for how to show hidden text.)
- Set the document’s top margin to 1.32 inches using the Page Setup dialog box. The extra 0.07 inches (beyond the 1.25 inches we measured) will leave room for the space between the PostScript-generated text and the inside address.
- Type in the usual return address at the top of the page (or delete the company name from your test letterhead).
- Create a new first paragraph in the document, press $\mathbb{F}_2$-SHIFT-S, and apply the PostScript style to it by typing “PostScript” into the status box.
- The default definition of the PostScript style is Normal + Font: 10 point Bold Hidden with a next style of Normal. This definition produces text that is hard to read; in addition, everytime you press RETURN, the new paragraph is back in Normal. Redefine PostScript so that it corresponds to the definition below. (Be sure you end up with PostScript spelled with a capital P and capital S. Otherwise your code will be ignored because Word won’t recognize the style name.) We’ve used Courier as the font because it is easier to see the spaces in a monospaced font than in a proportionally spaced font—and the spaces are important.

**PostScript**

A redefinition of the automatic style for easier reading.

Normal + Font: Courier 10 Point, Hidden, Indent: Left 0.5in First -0.5in

Next Style: PostScript
390  Desktop Publishing with Microsoft Word

CH. 15

% is the comment delimiter in PostScript. → Type in the PostScript paragraphs shown in Figure 15.11. Spelling and spacing are important in PostScript. Your screen needn’t look exactly the same as Figure 15.11, but you must have at least one space or tab between words. We used tabs to line up the percent signs. Whatever appears in a paragraph after the % is a comment. You don’t have to type the comments if you don’t want to; they are there to help make the PostScript more understandable.

If you don’t have Avant Garde on your printer, change AvantGarde-Book to Helvetica.

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostScript</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

/AvantGarde-Book findfont 24 scalefont setfont
162 702 moveto % 2.25" from the left 9.75" from bottom of page
0 4 setgray % This number must be between 0 (black) and 1 (white)
(Immaculate Assessment)show

6 Marina Vista Parkway
Emeryville, CA 94608
(415) 578-6000
April 1, 1989

Figure 15.11: A screen shot of the PostScript code that prints the company name in gray text. Hidden text is showing. The cursor is in the last PostScript paragraph.

→ Print the document. (You have to use a PostScript printer, of course. You won’t see the gray text in print preview on an ImageWriter, or even on a non-PostScript laser printer, such as the LaserWriter SC.) It should look like Figure 15.9.

You won’t get much help from Word when your PostScript doesn’t work. Often the only symptom is that nothing comes out of the printer at all. One strategy for finding out what is wrong is to place percent signs in front of lines, thus commenting them out, until the document prints again. The last line you comment out when printing starts working usually contains an error.
We won't go into any details about PostScript commands, but here are a few notes. (We refer to the four lines of PostScript in Figure 15.11.)

- The font is set in the first line. PostScript's name for the font, AvantGarde-Book, is just a bit different than the standard Macintosh name, Avant Garde. The font size is set to 24 in the same line.

- In the second line, the PostScript moveto command sets the starting point for the text. Notice that the coordinates of the point are written before the command.

- In the third line, the setgray command sets the gray scale to 0.4—a 60 percent screen. This can be changed to any number between 0 for black and 1 for white.

- In the fourth line it is the show command that actually prints the text on the paper. The text itself is between parentheses, and you can change it. The result, however, will no longer be centered on the paper unless you also change the coordinates.

The PostScript Text Came Out in the Wrong Place! Sometimes, even when you've written the PostScript correctly, it still comes out wrong. You may have to fiddle around to get everything to work out. For several years we found that PostScript worked perfectly on our printer as long as it was not on the first page we printed. A call to Microsoft revealed a known incompatibility between Word's PostScript and Apple's print spooler, the Backgrounder. Turn that off in the Chooser and everything worked fine. Finally, Version 6 of the LaserWriter driver fixed that bug, but who knows what else is lurking!

PostScript Computes the Coordinates

The preceding example would be much more useful if it didn't depend on our finding the coordinates for each new heading, font, and font size. PostScript can easily compute the coordinates for us.

We might also like to be able to print the gray text wherever we want it—not necessarily at the top of the page. Word lets us base our coordinates on the next non-PostScript paragraph from within the PostScript code. By filling the paragraph after the PostScript paragraphs with an empty graphic, we can reserve space for the gray text. All this will become clear as we proceed with an example.
Add a paragraph to the existing letterhead document just before the return address. It gets the following simple style:

**head**  Use for blank paragraph to contain PostScript-generated text. Normal + Centered

In the newly created blank paragraph, insert a graphic using the Insert Graphics command in the Document menu. For testing purposes, give the graphic an outline character format; the resulting frame will let you know whether the PostScript code is working properly.

Change the PostScript code from the previous example to correspond to what you see in Listing 15.1. As before, you may omit the percent signs and any comments that follow them, but you do need to pay careful attention to spelling and spacing in the PostScript code.

The comments in Listing 15.1 do a pretty good job of explaining what is going on. But they don't show the communication between Word and PostScript. Here's how that happens.

- The command .para. is not standard PostScript; it is an instruction to Word to set things up so that any subsequent PostScript will refer to the next paragraph for its drawing area.

- Word allows a few special variables to be used in PostScript. Two of these, wp$x and wp$y, are set to the width and height of the drawing area before our PostScript code gets a chance to run. In this example, the PostScript code uses these two numbers to figure out where the text should start.

- You will see a reference to a rotation angle. It's set to zero here because we don't want to rotate the text. But in the next example, we will use this angle.

The bottom portion of the PostScript code should appear on your screen as shown in Figure 15.12. Once you get it to print correctly, you can experiment with different text and different values for the font size and the gray scale.
% This PostScript code will center text in the next non-PostScript
% paragraph and print it in gray.

.parra.              % Tell Word we want to draw in the next paragraph.
/message (Immaculate Assessment) def     % You can change this text,
/fontSize 24 def       % the size,
/AvantGarde-Book findfont fontSize scalefont setfont % the font,
/myRotation 0 def      % or the rotation angle.

% Define a procedure to center text within the printing area.
/centerText
{
    wp$x 2 div wp$y 2 div translate    % Transform to the center of the box.
    myRotation rotate                 % Rotate by the desired
    % number of degrees.
    % Now find the x offset.
    dup
    stringwidth pop 2 div neg         % Copy the string. When the procedure finishes,
    % the string will still be on top of the stack.
    fontSize .67 mul 2 div neg mul    % y component of width not needed
    % divided by 2 and negated gives the x offset
    % Find the y offset.
    fontSize .67 mul 2 div neg mul    % The approximate height of the text
    % divided by 2 and negated gives the y offset.
    moveto
} def

% Having defined the procedure we need, actual printing is easy.
0.4 setgray              % Change this to however gray you want the text.
message centerText show
% The next paragraph should reserve space for the printed text.

Listing 15.1: The PostScript code to print a gray heading centered in the next non-PostScript paragraph

Figure 15.12: The last portion of the PostScript code, followed by a paragraph containing an inserted graphic. Right now, we have selected the inserted graphic. You can see that the graphic (in head style) is still outlined. You will want to remove the outlining before the final printing.
Confidential

With a few modifications, we can use the preceding example to mark the letter as confidential. The effect we're after is shown below in Figure 15.13

Figure 15.13: We've used PostScript to write “Confidential” lightly across the page.
This may look like a drastic change from the previous example, but because we have set up the PostScript carefully, it's really simple. We just have to change the parameters that are laid out in the first part of the code. Listing 15.2 shows the relevant changes.

A gray of 0.95 doesn't look very light when we print it on a LaserWriter. Subtlety costs; to get a real 5 percent screen, you'll have to go to a more expensive printer. We'll discuss one in Chapter 16.

The code begins here, just as in the previous example.
% This PostScript code will center gray text on the page
% and rotate it by a specified angle.

$page. % Tell Word we want to draw on the page as a whole.
/message (CONFIDENTIAL) def % You can change the
text,
/fontSize 100 def % size,
/AvantGarde-Book findfont fontSize scalefont setfont % font,
/myRotation 45 def % or rotation angle.

Insert the definition of centerText here. At the end, there's one more change:

0.95 setgray % very light gray
message centerText show % This actually
prints the
% words.

Listing 15.2: The PostScript code to print rotated gray text centered on the page.

Framing the Page with PostScript

Word does not provide an easy way to draw a frame around an entire page. Figure 15.14 shows how desirable a frame just outside the margins could be.

PostScript can draw anywhere on the page, and Word can give it access to the margins. Listing 15.3 shows how to do it.

You can place the PostScript code for drawing a frame anywhere you want in your document. For our letterhead, somewhere on the first page would work, but putting it in the document's first header would get it out of the way of the text of the letter. If you put the PostScript code in the regular header as well, it will frame every page. A little PostScript code can go a long way when placed in a header.
Figure 15.14: The letter has a frame.
% Draw a frame a specified amount outside the page margins.

% Tell Word we want to draw on the whole page.
.page.

% The next line contains the number of points outside the margins
% to draw the frame.
extraSpace 18 def               % 18 points is 1/4 inch

% Compute the positions of the four sides of the frame.
% Word gives us the four margins, the width, and height of
% the page in the 'wp$' variables.
/left wp$left extraSpace sub def
/bottom wp$bottom extraSpace sub def
/right wp$x wp$right sub extraSpace add def
/top wp$y wp$top neg sub extraSpace add def

% Now set up the frame.
left bottom moveto
right bottom lineto
right top lineto
left top lineto
closepath

% Finally, draw it.
stroke

Listing 15.3: The PostScript code to draw a frame around a page leaving a certain amount of extra space

This chapter has introduced PostScript, showing how you can incorporate graphics from programs that make use of PostScript effects and how you can solve some difficult page-layout problems, such as framing the page by inserting PostScript code as hidden text. In the following three chapters we’ll use PostScript to

- Put a gray screen behind a paragraph
- Print white page numbers on a gray background
- Make a fancy masthead
- Print page numbers sideways
- Put registration marks on page proofs
For More on Various Topics

Headers—The basics of using headers are introduced in Chapter 12.

Positioning—We introduced this in Chapter 8.

PostScript glossary—Word comes with some useful PostScript code stored in a glossary. See Chapter 17.

PostScript—Chapters 16, 17, and 18 continue to introduce more PostScript techniques.

Registration marks—Framing the page with a rectangle may have brought up the related problem of placing registration (or crop) marks on the page. See Chapter 18.

Templates—You will use letterhead stationery as a template, of course. Some hints for using templates are in Chapter 5.
For an hour, I looked over my shoulder and rearranged my desktop. Finally, Walters told me there was a call for me on the pay phone at the corner Shell station. He tugged at his ear. I was tempted to steal third.

Instead, I picked up the last document from the briefcase set and left the building. As I got to the booth, the phone rang. It was Manny.

“Delilah, you’re an Einstein!”

“Curie, please. Thanks.”

“You know how it is when you’re looking for something and you can’t find it until somebody tells you it’s really there?”

“You mean that happens to the police?”

“Don’t be snide. That “nonexistent” note was under the passenger seat in her car. We missed it. What can I say?”

“How about, ‘We arrested Alice Land and Clara can go free’?”

“We did have a chat with Alice down here at the station. She admitted that she didn’t talk to him about the cello program. Alice called Victor in order to get him to include stock options in the divorce settlement. They hadn’t been valuable when they filed last July, and she felt cheated by Immaculate’s success.”

“Fantastic! What a motive!”

“Almost. He gave in. He signed them all over to her at her place yesterday at about four. Sorry, kid.”

“Forgeroy?”

“Give it up. We checked.”

“Coercion?”

“He’s the one that’s dead, not her. We have dropped the charges on Dr. McConnell, but we’re keeping her here. And I don’t think you’re safe at IA any more, Delilah. Go home.”

I looked at the annual report in my hand and hung up.
Immaculate Assessment is a dream come true. A place to work with dedicated colleagues outside the confines of Academia.

Yet we are tied, appropriately and inevitably, to our academic roots. We write papers and reports, we attend scientific meetings. We invite academic visitors here and visit Universities ourselves to bathe in the shower of cross-fertilizing ideas. We receive the criticism and praise of our peers and give back in like kind. Here academic freedom and market economics come together to create an organization the likes of which social scientists seldom see from the inside: a thoughtful contributor to the solution of practical problems on a large scale, and at the same time, a profit-making enterprise.

We at IA are proud to include student interns from around the country on our staff, and to provide them with on-site professional advice. Twenty-eight of our staff hold concurrent positions at major universities that allow them to act as advisors to and committee members for IA interns. We are delighted to announce the completion of four dissertations and eight first publications by students at IA this year.

Twenty-eight of our staff hold concurrent positions at major universities.

Student Interns at work.
ANNUAL REPORTS

After designing an annual report, we’ll learn how to make the headers and footers of pages tell the reader what part of the document they’re in. We’ll also learn a little more about PostScript—how to put gray screens behind text. We’ll use some special characters, called ligatures, to improve the text’s appearance and see why they should be inserted in the document only in the final stages. A final report should look even sharper than a LaserWriter can make it, so we’ll learn how to use a high-resolution "imagesetter" to print our final copy, and we’ll use Word’s fractional widths feature to improve character spacing. All of these techniques apply to other projects that merit extra care and polish.
The Project

Out of the many types of annual reports, we've chosen one that gives an overview of the year's operations, both in text and in numbers. Big corporations put out slick, glossy booklets filled with essays on the progress of the company, lots of color photographs, and tables of financial data. Our report will have the same elements on a more modest scale. It will be black and white with spreadsheets imported from Excel, and we'll leave spaces for photos that a pasteup artist will fill in.

Design Considerations

As always, the first question to ask is "who are the readers?" Since the readers of an annual report are busy prospective investors and clients, not auditors or business students, we want to paint a brief, glowing (but accurate) picture of the company, with text and financial data that give a good overview of the situation without accounting for every paper clip.

What does that mean for design? First, the report should be spacious, with plenty of white. Second, it should have lots of pictures. Finally, though the information in it varies from text to tables, the report should be coherent enough to seem like one document, not two. Big corporations vary on their adherence to this last point. Many annual reports actually change the typeface and quality of paper for the financial section. (Maybe they expect you to tear the section out and throw it away.)

Beginning the Project

You need a document to work on. In the business world, bits of text will come from some people, pictures from others, and charts from others still. Let us begin by assuming that all the pieces have been collected and edited and that it's time to put it all together. Open a new document and create an outline, such as the one shown in Figure 16.1. This outline will help you think about the structure and design the report; when you get to the stage of bringing in the actual text, it will help you keep track of where things go.

Before bringing in any text, let's discuss the settings in the Document dialog box and go through the reasoning behind a plausible set of style definitions. Only after these steps will we bring in the actual material.
Page Setup for the Report

If you browse through annual reports from different sources, you will find that some are boring but easy to lay out, while others are terrific but just can't be done easily in Word. The design for our report uses layout techniques that Word is good at, and it has the look of a professionally designed and pasted-up report. Eventually we'll have one section for each of the first- and second-level headings in the outline. Each section will have two columns, yet the pages will have a four-column appearance because we'll make extensive use of two-column tables within each column. A broad band across the top of the page contains the heading for each section. The page facing the title page of this chapter shows you what we're aiming for.

Figure 16.2 shows the Document dialog box for our project. We checked Even/Odd Headers and allowed a 1/2-inch gutter, so that the finished report can be bound. The 3-inch top margin leaves room for the heading in a gray band and for some white space to set it off. For the more financial sections of the report, we'll use this space at the top for balance sheets but keep the two-column grid beneath for commentary. We've also allowed a generous bottom margin and set the starting page to 2. Page 1 would be a title page created elsewhere.

Finally, go to the Section dialog box and specify that this report have two columns.
Styles for the Report

We're going to define the styles for all the elements of the report. As usual, we expect that considerations which come up when we actually see the text on the page will force modifications in these definitions.

Start with the styles for the headings. The need for lots of white space suggests that each of the first- and second-level headings begin a new page. If we put a section mark before each heading, Word will start a new page by default. But, as you will see, we have reasons for waiting until later to put in the section marks. Meanwhile, we'll use Page Break Before formatting in the heading 1 and heading 2 styles.

The report will have lots of photographs, charts, and tables, each with its own caption. This suggests the need for a style photo that has Keep With Next formatting and a style caption that has Keep Lines Together. The next style for photo should be caption. If we include the Outline character format in our photo style, we'll automatically get frames for the pictures, which we'll insert as empty graphics.

As usual, we'll need a vanilla text style for all the ordinary paragraphs of text that we'll call para.

A design technique that is frequently used in the essay portions of annual reports is pulling out juicy quotations from the accompanying text and displaying them somewhere else. These elements, called pull quotes, let the reader get the punchline without reading everything on the page.

Our pull quotes will appear beside the paragraphs they come from, necessitating two more styles: pull quote for the quote and quoted para for
the place it came from. We'll get them to lie beside each other using a two-column table with a single row in it.

Within these guidelines, we can pin down the style definitions as shown in Figure 16.3, where you also see a thumbnail for a typical page of the report.

![Figure 16.3: A thumbnail of a page of our annual report with appropriate style definitions](image-url)

- **Normal** Use this style to set the font and size. Font: Palatino, 10 Point
- **heading 1** This style is for main headings. Normal + Font: 12 Point, Bold, Page Break Before Next style: para
- **heading 2** This style for subheads. Same as heading 1. heading 1 + Next style: para
- **photo** This style is for any photo, chart, or table. Normal + Outline, Centered, Space Before: 24 Point, Keep With Next Next style: caption
- **caption** This is for the captions of the figures. Normal + Font: 9 Point, Centered, Space After: 24 Point, Keep Lines Together Next style: para
- **para** This is the style for body text. Normal + Indent: Left 1 In First 0.25 In
- **normal** This is for body paragraphs opposite pull quotes. para + Indent: Left 0 In
- **QP, quoted para** This is for body paragraphs opposite pull quotes. para + Indent: Left 0 In
- **QP, pull quote** This is for pull quotes, set opposite QP. Normal + Font: 9 Point, Flush Right
Placing the Text

Once you have the outline, the page setup, and all of the styles, you're ready to import the text. Let's suppose you're going to do the "Message from the President" section. You have a disk with the text on it as well as some photographs and captions from the art department. Here's a possible set of actions, broadly sketched:

- With both the President's-message file and your report file open, select all the text in the message, copy it, and paste it under the heading that says "A Message from the President."
- Change the style of all of the new text to para.
- You need a picture frame for each picture, chart, or table. In each appropriate place, insert a picture frame by creating a new paragraph, with the style photo, and inserting a graphic frame with the Insert Graphics command in the Document menu.
- After you insert each frame, press RETURN. This creates a caption paragraph. Type the caption.
- Resize the pictures. In our example, we made them as wide as the column and proportionately tall. This requires that you measure the photographs and compute how tall they would be if they were as wide as a column.
- Just before a paragraph that is supposed to have a pull quote beside it, create a one-row, two-column table using the Insert Table... command in the Document menu.
- Using the column markers on the ruler, set the width of the left column to $\frac{15}{16}$ (see Figure 16.4.
- Apply the pull quote style to the paragraph in the left column and the quoted para style to the paragraph in the right column.
- Copy the text of the quoted paragraph (but not the ¶ mark) into the right cell. Copy the quotation and paste it into the left cell.
- Add as many SHIFT-RETURNs as necessary to bring the quotation into rough alignment with the place in the paragraph from which it comes. Figure 16.4 shows what you should see.
- Cut the original paragraph from the text.
Hyphenate if you need to, because, with such narrow columns, hyphenation can have a strong effect on column length, and column length affects where we want to place the pictures.

Under ordinary circumstances, hyphenation doesn’t have such a strong effect on layout, and we would hyphenate later.

Use print preview to check. Make adjustments.

Figure 16.4: A pull quote and its quoted paragraph live in a single-row table. You can see the SHIFT-RETURNS in the left column used to position the pull quote vertically.

What sort of adjustments do we expect?

- You might have too much or too little text to fill the space. If so, you need to cut, add, change font size, or change the margins—whatever is necessary. (If you change the margins, you’ll have to rehyphenate.)
- A picture might be separated from the text that it goes with. If so, cut the offending picture and its caption and move them both to where they belong.
- A picture may be out of balance on the page. If it doesn’t matter whether a picture appears before or after the referencing paragraph, you are free to move it.
• Pull quotes may look better when they are placed partway down their paragraph than when they are lined up at the top. Insert SHIFT-RETURNS in front of their first characters to move them down on the page. Occasionally you may need to move a pull quote higher on the page. If so, copy the preceding paragraph into the right-hand table cell and make its paragraph style quoted paragraph.

• The tops of the columns might be uneven because of white space attached to the pictures. In this case, use the no-space-before icon on the ruler to remove the white space from those pictures that come out at the tops of columns.

Figure 16.5 shows our page preview before adjustments. You can see that the last three problems are present here. Figure 16.6 shows our response: we have lowered pull quotes, moved pictures around, and made the tops line up.

Follow this procedure for each part of the report. The financial sections will require some special treatment because they’ll have charts near the top of the page. You’ll see how we do that later.
Figure 16.6: The same spread, adjusted for balance. The left-hand page is the one we used in Figure 16.3.

The Major Headings

We have two problems. First, there’s a huge blank area at the top of the page. Second, even in the improved thumbnail of Figure 16.6, the heading looks weak. By enlarging and raising the heading, we can fill the empty space and strengthen the heading in one move. The new importance and isolation of the heading will balance the weight of all that text and all those pictures on the rest of the page.

We have three inches of margin at the top of our page; how do we put text up there? We’ll put the text of the heading in the header.

The terms header and heading are easily mixed up, and here we confuse them further by placing one in the other. A heading is a label for a section of body text. A header is text that appears at the top of the page and has been entered into a Header window. Headers pay no attention to the document’s top margin. They start wherever you tell them to in the From Top: setting of the Section dialog box. Headers also do not respect the columns in their section; you can stretch them across the page without changing the number of columns in the regular text.
There's a problem with this: there's only one header—and whatever we put there will appear on every (even and odd) page. How will we get the heading text to change where it's supposed to? We'll divide the document into sections.

There is a different header for every section. We'll set it up so that every page of the President's message will have "A Message from the President" at the top, which is just what we want. (In the next section, Projects, the text will change.) Moreover, if we make the headers in the different sections look similar, it will help tie the document together.

But don't divide the document yet. Doing so now would only make it difficult to try out design ideas. Wait until you have settled on a final header design.

---

**Design Your Headers Early**

Design your headers while your document still has only one section. Once you split it into sections, although you can make global changes in section format, you cannot make them in the headers except through styles. If you want to add the date to the header, for example, do so before you have ten sections or you'll have to change ten (or even thirty) headers.

Finish your headers while your document is still one section.

---

The design of the headers is handled separately from the text that goes in them. We want the design to be uniform, but the text will change from section to section.

**What Do I Do with the Existing Headings?**

You will be tempted to cut the first- and second-level headings and paste them into the headers. Don't do it. Headers lie outside the sequential part of the file, so if you place the existing headings in the headers, you won't even see them in the outline any more.

So what do you do with the headings? Hide them! As hidden text, you can use them for outlining, but not have them show when you preview pages or print. Furthermore, if you take the time to prefix them with .c., you will still be able to generate a table of contents. Since we
have defined heading 2 as based on heading 1, all you need do to hide the headings is redefine heading 1 so that it has the Hidden character format.

Bearing all this in mind, we'll make a set of headers (odd and even) for the President's message section of the report. Here are the style definitions. Notice that the even header is based on odd header for convenience in making changes. Figure 16.7 shows the two headers as seen on the screen in galley view.

**OH, odd header**  Header for right-hand (odd) pages.
Normal + Font: 18 Point, Small Caps, Space Before 18 pt, Border, Bottom (Double), Tab stops: 5.5 in Right Flush; 6 in Right Flush

**EH, even header**  Header for left-hand (even) pages.
OH, odd header + Tab stops: 0.5 in; Not at 5.5 in, 6 in

![Figure 16.7: A set of headers for the President's-message section. We inserted the page numbers using the page-numbering icon in the header windows. Tabs separate the text from the numbers.](image)

Figure 16.8 shows a two-page spread with headers. It really looks like part of a final report: the pages are balanced, there's lots of white space, and there are places for the photographs.

**Splitting the Document into Sections**
Right now, every page of the document has the header "A Message from the President." Whenever you add a section to a document, Word
Figure 16.8: A preview of the same pages with the headings hidden and the heading
text in the header.

gives the new section the same formats and headers that the previous
section had. This means that when you split the report into sections,
every section will have the same set of even and odd headers. You will
have to scroll to each section and change the text in the header to match
the text in the (now hidden) first- or second-level heading that applies
to the section.

You also have to be sure that the Restart at 1 option in the Section
dialog box is set only in the section that you want to start on page 1—
the Summary section—otherwise the page numbers will be wrong.

It's easy to get confused when you are editing headers for a lot of
different sections. At least once, the following will happen to you:

Word Changed the Header in the Wrong Section! Sometimes you edit
a header carefully and then find out in page preview that the header
was for a different section than you thought. While the page number in
the corner of the editing window is for the page (and section) of the line
located at the top of that window, the header window that comes up is
the one for the section the cursor is in. Word lets you know which
header you're editing; the section number appears in the window title,
as in Annual Report: Odd Header (S5), which means section 5. Always be
sure to check the cursor position and the section number in the header window when you edit a header.

Exactly the same sort of thing can happen with the Section dialog box. Fortunately, you don’t need to change it as frequently; unfortunately, the number of the section does not appear in the title bar. It’s extremely easy, for example, to change the number of columns in the wrong section. Watch your cursor.

You now have a perfectly serviceable header design and have been warned of possible problems, so you could go ahead and split the document into sections. But before you do, let’s consider an alternative header design, one that is quite a bit more attractive and that also provides a chance to expand your knowledge of PostScript.

**A PostScript Header**

In this section, we’re going to learn how to make text appear in white on a gray band that stretches across the page. You can see this gray band in the illustration opposite the title page for this chapter. Such a design element is a job for PostScript. In Chapter 15, you learned how to use a MacDraw rectangle and outline formatting to produce white text on a black background. We could use white text on an imported gray rectangle, but let’s see how to do this with PostScript.

Here’s the plan:

- The PostScript code will go into the header. After all, we want the material to appear on every page.
- We’ll make PostScript refer to a single paragraph. This paragraph, in the header, will be 1/2 inch tall and the width of the page.
- The first thing to do is to make the paragraph gray. We’ll use the PostScript `setgray` command to tell it how gray and the `fill` command to fill it.
- Then we’ll put the text in white. That requires a 1 `setgray` (remember, 1 is white and 0 is black) and a `show` command to make the text appear.
- One more thing: as in the normal headers above, we’ll want the page number on the outside and the text on the inside. This will create some special problems on the right-hand pages.
Making a Gray Bar

We'll begin with the gray bar in the header for the left-hand page. Remember that PostScript comments start with a percent sign (%). You should also remember from Chapter 15 that all PostScript code has to be formatted in the PostScript style. You can redefine that style as long as it remains hidden.

Listing 16.1 shows this first part of our header code—the part that makes the gray band. The comments explain most of the code. Because of the \texttt{.para.} statement, this code fills the next non-PostScript paragraph. But what does filling a paragraph mean?

In Word, a paragraph occupies a rectangle on the screen—from its left indent to its right indent and from its top to its bottom. It's the same size as the rectangle you see if you use the \texttt{Plain Box} paragraph border. When you use the PostScript \texttt{fill} command, you fill that rectangle with whatever gray is currently specified by \texttt{setgray}. We'll use \texttt{.7} for ours; it comes out closer to \texttt{white} (1) than \texttt{black} (0), so it's a light gray.

How do you make a paragraph the size you want it? One way is to insert a graphic (X-I) and stretch it vertically to get the height you want; the width will be determined by the indents.

\begin{verbatim}
.para. % This means we'll operate on a paragraph.
.7 setgray % a light gray background
wp$box % wp$box is a special word that Word provides;
% it means, "the whole drawing area," in this case,
% the paragraph.
fill % fill that path - the paragraph
\end{verbatim}

\textbf{Listing 16.1:} PostScript code for the header. It will produce a gray band the size of the next non-PostScript paragraph that follows it.

Here's what you do to edit the even header:

\begin{itemize}
  \item Working in galley view, open the even header window, delete the text, and give the paragraph the \texttt{header} style. (This gets rid of the double-underline paragraph format carried by \texttt{EH} and \texttt{OH}. \texttt{Header} is the style you get by default when you open a new header window; it has no double underline.)
  \item Insert a graphic frame using the \texttt{Insert Graphics} command on the \texttt{Document} menu. Shrink it vertically so it is only 0.5 inch high. (You'll see the measurement in the status box.)
\end{itemize}
Make sure Show Hidden Text is on. Type in the PostScript code shown in Listing 16.1 before the paragraph with the graphic frame. Give it the PostScript style. Your window should look something like Figure 16.9.

Figure 16.9: The header window with Show f/ on and hidden text showing. The first two paragraphs are the PostScript code, shown in Listing 16.1. (We've left out the comments and combined the last three lines of Listing 16.1 into one.)

That should give you a half-inch-high gray bar across the even pages. Try printing just one page of the report. Since PostScript is so unforgiving, it's good to print pieces of your work as you go along to make sure you have that much right. Often, if you've made some mistake in PostScript, the error will flash by in your LaserWriter status box for an instant, and then nothing will print.

Remember about PostScript:

- You see the results only when you print—never in page preview.
- It works only on a PostScript device, such as a LaserWriter, never on an Imagewriter.

**Adding a White Page Number**

Now you're ready to add white text to the even header. As we decided above, we're going to use 1 setgray (white) and draw the characters on the page. We'll draw the page number first. We need to
tell PostScript what font to use, how to find the page number, and where to start writing.

Since Palatino is the font for the body of the report, we’ll use it for the header, too, but bigger—18 points. Here’s the PostScript code that prepares the font. Note the official PostScript name for the font. You can check the end of Appendix D for a list of font names.

/Palatino-Roman findfont 18 scalefont setfont

How do you access the current page number from within PostScript? Word provides a special variable, wp$fpage, which you can use in PostScript. (The f in $fpage stands for formatted.) To paint the page number in white on the page, we would use

1 setgray wp$fpage show

How to move into position to print this number is the tricky part. You have to tell PostScript to move to the coordinates of the lower-left corner of the character string you’re going to put on the page. Fortunately, the origin of the coordinate system is the lower-left corner of the drawing rectangle—the paragraph. That means we don’t have to calculate the distance from the bottom of the page. You’ll use the moveto command, which you used in Chapter 15. But to what coordinates? The x coordinate is easy. Let’s start the page number \( \frac{1}{6} \) inch from the left margin; that’s 12 points.

The y coordinate is tougher. The bar is \( \frac{1}{2} \) inch thick—36 points. We’re using 18-point Palatino; as we will see in Appendix E, that doesn’t necessarily mean the letters are 18 points tall, but let’s assume they are. So we could say that there are 18 points of space left of the 36 points of gray—nine for the top and nine for the bottom.

It turns out, though, that the coordinate we give it is for the baseline of the letters; some letters extend below the baseline. We need a little more space. 12 looks better than 9. The command is

12 12 moveto

We learn by trial and error. Listing 16.2 shows the code in the right order for putting the page number in the bar.

Again, try it out. Now it’s time to add the text that will change—the name of the section.
Adding the Name of the Section

This part is easy. The relevant code (for the President’s message section) is

\[ \text{Listing 16.2: PostScript code for a header that will put a white page number near the left edge of a half-inch-thick gray bar. The code precedes the paragraph in which all this will happen.} \]

18 0 rmoveto

We could just append that to the previous code, but then we would see the section title concatenated with the page number. We need some space between them. The PostScript command \texttt{rmoveto (relative move to)} will move us relative to the current position. After we paint the page number, PostScript is positioned right after the number on the baseline. So we use

\[ 18 \ 0 \ \text{rmoveto} \]

to move us 18 points (1/4 inch) to the right and no points up or down. 

\[ \text{Listing 16.3 shows our code for the even headers.} \]

The Odd Header

The problem with the odd header is that we don’t know where to start drawing the string. We’re going to have to calculate backwards
In reverse Polish notation, the arguments come first and are followed by the function. For example, 3 4 5 mul add is PostScript for \(3 + 4 \times 5\).

Unfortunately, these calculations require knowledge of some idiosyncratic PostScript and reverse Polish mathematical syntax, which aren't that hard to learn but are beyond the scope of this book. If you want to learn more, look in Appendix G for some books to read. We'll just give you the commented code in Listing 16.4 and let you modify it. You can see the result at the beginning of this chapter, facing the title page, or later on in Figures 16.11 and 16.12.

```
% We'll operate on a paragraph.
% make the paragraph gray
.newpath
/Palatine-Roman findfont 18 scalefont setfont % set Palatino 18
1 setgray % set up for painting in white
wp$x 12 moveto % move to right edge of the box
-12 0 rmoveto % move back 12 points from edge
(A Message from the President) stringwidth pop % the width of the string
wp$fpage stringwidth pop % the width of the page number
18 add add % add those two to 18 (space)
18 0 rmoveto % move back that far
(A Message from the President) show % paint the section name first
18 0 rmoveto % then space 18 points
wp$fpage show % and paint the page number
```

Listing 16.4: The code with comments for the odd (right-hand) headers. This code right justifies the section name, which is then followed by a page number in white on a gray bar.

## Finishing Touches

Once the PostScript code is working, you can put the final polish on your document. We'll briefly consider six things: smart quotes, ligatures, special dashes, fractional widths, a reminder about the table of contents, and printing your work on a high-resolution printer.

### Smart Quotes

When you type on a typewriter, there's usually only one kind of quote you can get—one that goes straight up and down. But in books and magazines (and fancy annual reports), there are curly quotes that
are different depending on whether they begin or end the quote. Apostrophes have the same problem; they should look like curly, single close quotes. Compare "She won't be coming" and "She won't be coming."

While there are key combinations that you can use to create these, the easiest way is to use Word’s Smart Quotes feature, which you can turn on in the Preferences dialog box. (Just remember that the abbreviations for feet and inches do not use these quotes!)

**Ligatures**

Certain combinations of letters look different together than they do separately. Lowercase fi and fl are two examples. The letters attach to one another and form what is called a *ligature*. Figure 16.10 shows the difference between the ligature and the nonligature versions of the same word, both Laser printed and as they appear on the screen in 24-point Times.

<table>
<thead>
<tr>
<th>With ligatures</th>
<th>Without ligatures</th>
</tr>
</thead>
<tbody>
<tr>
<td>As seen on screen</td>
<td>fluffiest</td>
</tr>
<tr>
<td>As printed</td>
<td>fluffiest</td>
</tr>
</tbody>
</table>

*Figure 16.10: Comparison of letter combinations with and without ligatures, as seen on screen and as printed with PostScript.*

You can get these ligatures by using OPTION-SHIFT-5 and OPTION-SHIFT-6 for fi and fl, respectively. But there are problems:

- The spell checker does not know about ligatures, so it will complain about all words that contain them.
- The **Find** and **Replace** commands will detect ligatures only if you ask them to. So you may think you are finding all instances of "fluffiest" when, in reality, you are finding only those that don’t have ligatures.
If you want to use ligatures, wait until after spell checking is done. Then use **Change** to substitute ligatures for their counterparts. But be careful! If you ask Word to change all occurrences of *fi* to *fi*, say, be sure that **Match Upper/Lowercase** is checked in the **Change** box. There is no ligature for *Fi*!

### Em and En Dashes

A typesetter has more than one kind of dash available. Using them correctly adds a touch more quality to your document.

When people type text on a typewriter, they use double hyphens for dashes (--) . In typeset books and reports, printers have used what is called an em dash (—). How do you get an em dash? **OPTION-SHIFT-** (hyphen). It is called an em dash because it is supposed to be the width of an *M*.

If you have double hyphens in your text, you can make the change by using the **Change** command, as you would for ligatures. By the way, no space belongs on either side of the em dash.

Another kind of dash is intermediate in size between a hyphen and an em dash—the en dash, used for indicating a range of numbers, as in the years 1980–89 or pages 460–467. Make an en dash with **OPTION-** (hyphen). An en is one-half of an em, about the width of an *N*.

### Fractional Widths

In the **Page Setup** dialog box you will find an option called **Fractional Widths**; you can use it to further improve the appearance of your documents. During display, Word computes the start of each word on the page to the nearest point because that is the best it can do on the screen. Normally it sends this correct-to-the-nearest-point value to the printer. But if you check the **Fractional Widths** option, Word does a bit better—it computes the starting position of each character to a fraction of a point and sends this value to the printer.

Using this option results in somewhat tighter text on the printed page and presents another opportunity for line and page breaks to change. So, if you’re going to use it, turn it on **before** you do hyphenation. On the screen, letter spacing will look strange, and the normally straight right borders of justified text will be ragged. Figure 16.11 shows a comparison of screen and printed page, with and without fractional widths.
We, at IA, are proud to include student interns from around the country on our staff, and to provide them with on-site professional advice. Twenty-eight of our staff hold concurrent positions at major universities that allow them to act as advisors to and committee members for IA interns. We are delighted to announce the completion of four dissertations and eight first publications by students at IA this year.
The Table of Contents

You already know how to make a table of contents, but remember the pitfalls we discussed in Chapter 11.

- The table-of-contents processor will create a new section at the beginning of your document. This will change your section numbers.
- You have to be sure that only the section in which you want to begin the page numbers has Restart at 1 checked in its Section dialog box.
- If you want the table of contents to appear on the inside cover, you'll have to format its section to start on an even page (you'll want the gutter to appear on the right side).

A Trip to the Print Shop

Your document is completely formatted, ligatured, em-dashed, fractionalized, tabled, and you have beautiful PostScript headers across every page. It's a report that will bring in investors by the bushel. You print it on the LaserWriter and realize the unthinkable has finally happened: LaserWriter output doesn't look good enough.

Despair not! If you're in a metropolitan area, there's a place nearby with a typesetting machine connected to a Macintosh. The most common such machine is a Linotronic 300.

The Linotronic 300 connects to an AppleTalk network in exactly the same way as a LaserWriter does. You don't need any additional software, because the Linotronic even uses the same printer driver. You simply select the LaserWriter icon when you use the Chooser to choose a printer.

What is it like to use the Linotronic? We selected Print, as usual, and waited a little longer than for a LaserWriter. Then we had to wait some more. We looked at the printer, expecting output. Lights stopped flashing on the printer. The man who got us set up had left that part of the shop. Customers came and went. Still no printout. Strongly worded signs threatened mayhem if we touched the Linotronic without proper authorization.

At last our host returned, opened the printer, and took out a black plastic cartridge. We followed him downstairs into the back room where he fed the cartridge into another machine. Finally, the printout came—very slowly—out the other end. He trimmed it to $8 \frac{1}{2}$ by 11. It was beautiful.
The cartridge contains a special paper that is exposed during printing, just as film is exposed in a camera. The second machine functions as a developer, to blacken the exposed areas on the paper so you can read it.

Oh yes. It cost $8.50 per page for highest resolution, $6.00 if you printed enough pages to warrant the discount. Figures 16.12 and 16.13 show parts of two pages at full size: one done on a Linotronic at 1270 dots per inch, and another done on the LaserWriter at 300 dpi. Look especially at the quality of the gray in the header as well as the sharpness of the white text.

<table>
<thead>
<tr>
<th>(Dollar amounts in thousands)</th>
<th>Fiscal year 1989</th>
<th>Fiscal year 1988</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Income</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local contracts</td>
<td>$10,394</td>
<td>$5,509</td>
</tr>
<tr>
<td>Nonlocal contracts</td>
<td>$9,709</td>
<td>$1,302</td>
</tr>
<tr>
<td><strong>Gross receipts</strong></td>
<td>$20,103</td>
<td>$6,811</td>
</tr>
<tr>
<td>Project costs</td>
<td>$8,637</td>
<td>$3,287</td>
</tr>
<tr>
<td>Operations costs</td>
<td>$7,251</td>
<td>$2,134</td>
</tr>
<tr>
<td>Branch setup</td>
<td>$2,102</td>
<td></td>
</tr>
<tr>
<td><strong>Total operating expenses</strong></td>
<td>$17,990</td>
<td>$5,421</td>
</tr>
<tr>
<td><strong>Income from contract activities</strong></td>
<td>$2,113</td>
<td>$1,390</td>
</tr>
<tr>
<td>Interest expense</td>
<td>$971</td>
<td>$206</td>
</tr>
<tr>
<td>Income before taxes</td>
<td>$1,142</td>
<td>$1,184</td>
</tr>
<tr>
<td>Provision for income tax</td>
<td>($171)</td>
<td>($178)</td>
</tr>
<tr>
<td><strong>Net income</strong></td>
<td>$971</td>
<td>$1,006</td>
</tr>
</tbody>
</table>

*Figure 16.12: This is one of the comparison pages. The chart is closer to the header than previous text has been; for the financial sections, we put the charts in the header with the heading text.*
At those prices, you want to be absolutely sure you are going to get what you want, so go armed with a 300-dpi copy. Look carefully at the on-screen version of your document before you print, because sometimes the print shop will not have the fonts you need installed or will have them installed in a slightly different way than you do.

### Consolidated Statement of Income

<table>
<thead>
<tr>
<th>(Dollar amounts in thousands)</th>
<th>Fiscal year 1989</th>
<th>Fiscal year 1988</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Income</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local contracts</td>
<td>$10,394</td>
<td>$5,509</td>
</tr>
<tr>
<td>Nonlocal contracts</td>
<td>$9,709</td>
<td>$1,302</td>
</tr>
<tr>
<td>Gross receipts</td>
<td>$20,103</td>
<td>$6,811</td>
</tr>
<tr>
<td>Project costs</td>
<td>$8,637</td>
<td>$3,287</td>
</tr>
<tr>
<td>Operations costs</td>
<td>$7,251</td>
<td>$2,134</td>
</tr>
<tr>
<td>Branch setup</td>
<td>$2,102</td>
<td></td>
</tr>
<tr>
<td><strong>Total operating expenses</strong></td>
<td>$17,990</td>
<td>$5,421</td>
</tr>
<tr>
<td><strong>Income from contract activities</strong></td>
<td>$2,113</td>
<td>$1,390</td>
</tr>
<tr>
<td><strong>Interest expense</strong></td>
<td>$971</td>
<td>$206</td>
</tr>
<tr>
<td><strong>Income before taxes</strong></td>
<td>$1,142</td>
<td>$1,184</td>
</tr>
<tr>
<td><strong>Provision for income tax</strong></td>
<td>($171)</td>
<td>($178)</td>
</tr>
<tr>
<td><strong>Net income</strong></td>
<td>$971</td>
<td>$1,006</td>
</tr>
</tbody>
</table>

Figure 16.13: This is the other comparison page. Which one is the Linotronic?
For More on Various Topics

Even/Odd headers and gutters—We explained about these in Chapter 12 when we formatted a simple book.

Graphics—If your annual report needs more graphics, check out Chapter 8, where we introduced graphics and graphic frames. We’ve also used them in many chapters since then.

Headers—We introduced headers in Chapter 12.

Page and column breaks—We avoided problems here with advice from Chapter 14 about using Keep Lines Together and Keep With Next.

Paragraph borders—Like boxes and lines, we first discussed borders in Chapter 6.

PostScript—We introduced PostScript in Chapter 15 and discuss it further in Chapters 17 and 18.

Pull quotes—We do these again slightly differently in Chapter 17.

Table of contents—We didn’t actually generate the table of contents here. See Chapter 11 for an introduction to it.

Tables—The headings in the résumé of Chapter 7 are very much like the pull quotes used in this annual report. You can learn how to choose between tables and two-column formatting in the “Four Ways to Make Columns” section of Chapter 10.

Two-column formatting—We first used two columns in Chapter 6.
Victor had clipped his original draft of the Statement of Income inside the annual report. If Victor's draft were accurate, the final report had been falsified. If the true financial state of the company remained undetected only a few weeks, Immaculate Assessment stock would skyrocket. What had Brian Thompson said? Many tens of millions, all illegal.

I went as far as the parking lot. I got in my Valiant and sat. If I were a real detective, I'd go in there and finish this case. But there was a killer in that upscale, refurbished warehouse. It was a crisis of courage. I looked at my watch and realized I had an excuse. It was five o'clock, one hour until the stock bash started. I still had to pick up the programs, go home, shower, shake out the silk, and get to the Hotel Magnifique.

At 5:58 I was doing my bit, helping to pass out the programs to the glitterati, even though I now knew they were being taken for a ride. I saw Manny Davis and his bulging comrades scattered around the room.

As I was making my way through a clot of fancy clothes, a paw gripped my arm and propelled me into an alcove. When I turned, it was Chuck Hines in a tux-sweat, chins and all. He spoke before I could scream.

"I did it," he said, "I thought you knew."

"Yes. Ever since this morning." My voice came out steadier than I had feared. "I've followed some blind alleys along the way."

"I don't understand why you don't want it made public."

"But I do, Mr. Hines. What made you think I didn't?"

"The confidential stationery."

I realized my mistake, my foolish, stupid mistake. He meant he had done the layout on the expansion proposal. And now I knew he hadn't killed Victor. I thanked him as gracefully as I could. My mind was racing. The cookies were the key. Who could make Clara's cookies besides Clara?

Then I knew who did it. I made for the door. I had to know for sure.

Back at IA, my heart still pounding, I opened the second file drawer.

There were six copies of the November 1988 newsletter with the amoeba races. Only three from October. I was right.
at the Veeps

Unobtrusive News

awsmth finally strikes the

October 1988, Page 1
NEWSLETTERS

Newsletters are one of the first applications we think of for desktop publishing. You already understand all of the major techniques you need to create the sample newsletter you see on the facing page. In this chapter, we will concentrate on some additional effects that are useful in newsletters and on ways to make the job of laying out a newsletter easier. We’ll do some more PostScript coding, both for the masthead and for marking illustrations. We’ll also create a glossary entry for some PostScript code and introduce you to the PostScript glossary that comes with Word. In addition, we’ll create a new format for pull quotes using Oxford rules and discuss the styles that make it possible to do that efficiently. Finally, a questionnaire to cut out and send in gives us another chance to practice with tables.
The Page Design

The first step is to design the page. We're going to allow an extra-wide right margin to contain the page number and issue information. Most of the text will be in 9-point Times and set in three ragged-right columns. We'll use Avant Garde for the headlines and Bookman for the masthead and other special text. Figure 17.1 shows the dimensions of the page; Figure 17.2 shows the Document box for the newsletter.

Figure 17.1: The page design for our newsletter. The text on the right side will be for the issue (October 1988) and page numbers.
You have to set up the three columns in the **Section** dialog box, of course, with 1/4 inch between the columns. We’ll be going back and forth between one and three columns by making new sections. We’ll use one column for headlines that span the page and for special parts of the newsletter, such as this issue’s questionnaire. We’ll use three columns for running stories.

**Our Big Mistake** the first time we made the sample newsletter was to try to use 3/8-inch margins. The LaserWriter cut off a little bit of text on each side—we had gone too close to the edge. If you look closely in print preview (but not page view), you will see this loss of text when you specify too narrow a margin.

The LaserWriter driver (Version 5.2 or later) provides a way out, though. If you don’t need many downloadable fonts, you can choose **Larger Print Area** in the **LaserWriter Options** dialog box (Go to **Page Setup** and press the **Options** button). Figure 17.3 shows what this seldom-seen dialog box looks like.

**Easy and Difficult Newsletter Layouts in Word**

Word’s layout tools enable you to accomplish most newsletter layouts. Figure 17.4 shows some configurations of stories that are easy to do in Word and some that require using positioned objects.
LaserWriter Options dialog box lets you use a slightly larger area of the page (among other things). The border around the dog changes visibly as you check and uncheck the option.

Figure 17.3: The LaserWriter Options dialog box lets you use a slightly larger area of the page (among other things). The border around the dog changes visibly as you check and uncheck the option.

Figure 17.4: Some example newsletter layouts

Easy: Little story simply follows big one.

Harder: Little story still follows big one. Left headline is positioned object.

Easy: Three columns and one column, but only one at a time.

Harder: Little story is positioned object in the middle of the big story.
The fourth example in Figure 17.4 is particularly interesting, because it points out both a strength and a weakness in Word. The little story in that layout can break up the big story because it is small enough to be a self-contained positioned object. But if that story were longer, so that it didn’t fit in one column or needed to be continued on another page, Word would not be able to deal with it conveniently. Except for positioned objects and headers, Word expects a single flow of text from the beginning of the document to its end. It doesn’t deal well with newspaper-style articles that start on one page and are continued at arbitrary places on later pages.

With this limitation in mind, we can design the styles we’ll use. We’ll need a style for body text and several styles of headlines, depending on whether the headline is one, two, or three columns wide. We’ll also create a picture-caption pair as we did in Chapter 16. Instead of showing you all of the definitions, we’ll just describe the styles:

- **Normal** is 9-point Times, flush left.
- **masthead**’s right indent extends past the right margin \( \frac{5}{8} \) inch to \( 7 \frac{1}{2} \) inches.
- **para** is the bread-and-butter paragraph. It’s indented \( \frac{1}{4} \) inch.
- **3head** is a three-column headline in 48-point bold Avant Garde.
- **3sub** is a three-column subheadline in 18-point Avant Garde.
- **2sub** is for two-column subheadlines. It’s a positioned object with a width of 4.5 inches and centered text; otherwise it’s the same as **3sub**.
- **1head** uses 14-point bold Avant Garde for one-column headlines.
- **illus** is for an illustration, has **Keep With Next**, and is followed by **caption**.
- **caption** is centered, italic, and has **Keep Lines Together**.

There are a number of other styles, especially associated with pull quotes, but we’ll address them when the time comes.

**Using Sections in This Newsletter**

Figure 17.5 shows a page preview of the finished pages annotated with style names and section breaks. We used the section breaks primarily to change the number of columns, but also to act as column eveners and page breaks.
The Masthead in PostScript

The masthead of our newsletter (which, of course, doesn't show up in print preview) demonstrates more of PostScript's versatility because it uses the \texttt{clip} operator. We will show you how to code this fancy header as well as the text that lies along the right-hand edge of the page. But before we do that, we'll take this opportunity to talk about setting defaults in Word.

Defaults: Redefining the PostScript Style Again

In Chapter 15, we redefined the \texttt{PostScript} style for our convenience. We made its next style \texttt{PostScript} and its font Courier (so we could read it more easily), and we gave it an outdented paragraph format, so that long lines wouldn't wrap all the way to the left indent. Our definition follows.
**PostScript**  This is the style for PostScript code.
Normal + Font: Courier 10 point, Hidden, Indent: Left 0.5in, First-0.5in
Next Style: PostScript

This definition is much more convenient than Word's default definition. Now that you’re becoming a PostScript wizard, it would be nice to have Word remember this style definition for you, so that you don’t have to redefine it every time you need it. In the Define Styles dialog box is the Set Default button, which we’ve avoided until now. Figure 17.6 shows what the box looks like when you are ready to press the button.

![Figure 17.6: PostScript is redefined—in order to work, all that’s required is that it’s hidden. We are about to make this definition the default.](image)

When you click on Set Default, Word will store the new definition of PostScript in the Word Settings (4) file—the same place Word keeps track of whether you use Full Menus and, in fact, all your customization of keyboard commands and menus. This new definition of PostScript will become the default definition—the one Word uses in the absence of other instructions.

You can also change Normal this way. You can even set a style you define yourself as a default. If you do this, the style will be available in every new document you create. (It will not be available in previously created documents, however.) This ability to add to the default styles is great, but you can overdo it.
Clutter: The Danger of Defaults

When we first discovered we could add our own styles to the defaults, we started making all our favorite styles into defaults, so they would be generally available. We soon learned better.

All our new default styles as well as our redefined automatic styles showed up in every new document, even those that had no use for any of them. Unlike Word's default automatic styles, which stay hidden until used, styles that you add to the default set and automatic styles whose definitions you change always show up on the lists of styles. This creates a lot of clutter and confusion in the Define Styles box.

Set defaults only when you're sure. Putting your favorite font in Normal and changing PostScript are good examples of sensible changes.

You can get rid of defaults that you have added. Bring up the Define Styles dialog box, click on the style you want to delete, and select Cut from the Edit menu. Word will ask if you want to delete the style from the current document. If you press the OK button, Word will ask if you want to delete the style from the default style sheet. If you answer OK again, Word will delete your default style. If the style was an automatic style, such as PostScript, Word will revert to the original definition of that style.

Clipping and PostScript

Let's do the masthead. The masthead paragraph itself will be in masthead style, of course. Because it's in the first section, one column wide, the masthead will span across the top of the page, as shown in Figure 17.1. We need to set its vertical extent; we do that by inserting a graphics frame and stretching it to a height of two inches.

Now we're ready for PostScript:

```
..para.
.6 setgray wp$box fill
```

This will fill the banner with gray, a good start. Next we want to write NEWS in big white letters. We'll use a modification of the centerText
procedure we used in Chapter 15 to center the text in the paragraph. Listing 17.1 shows the `centerText` procedure. It requires the variable `tSize`, which we use to hold the point size of the text.

```latex
\begin{verbatim}
//centerText {
    wp$x 2 div wp$y 2 div moveto  % move to the middle
    dup stringwidth pop 2 div neg  % get x coordinate on stack
    tSize .33 mul neg              % y coordinate on stack
    rmoveto)                      % ready to show
    def                           % string left on stack
}

Listing 17.1: The `centerText` procedure
```

We'll also use the `tSize` variable when we invoke the font, as you'll see. To use `centerText`, instead of writing

```
/Bookman-Demi findfont 108 scalefont setfont
1 setgray (NEWS) show
```

as we ordinarily would, we write

```
/tSize 108 def
/Bookman-Demi findfont tSize scalefont setfont
1 setgray (NEWS) centerText show
```

to center the text in the paragraph in white. The `centerText` procedure takes care of moving to the right place, so the text will be centered vertically and horizontally. Here's what we have:

![NEWS](image)

The next step is to write UNOBTUSIVE in white. In white? Yes, first in white; hang in there. We use the same code as before, but with a different font, font size, and text:

```
/tSize 36 def
/AvantGarde-Demi findfont tSize scalefont setfont
(UNOBTUSIVE) centerText show
```
We don't need to repeat the 1 setgray because white is still in effect from when we wrote NEWS. Now we have

Can't read it, right? We need to paint gray in the portions of UNOBTRUSIVE that cross the letters of NEWS. This calls for clipping. We will instruct PostScript to paint the page only in a certain area—the area occupied by the letters NEWS. It's just like putting down electronic masking tape. The next section of code makes the mask, using the PostScript charpath and clip operators:

/tSize 108 def
/Bookman-Demi findfont tSize scalefont setfont (NEWS) centerText true charpath clip

The true charpath phrase instructs PostScript to treat the text as an outline rather than paint it, and the clip operator tells PostScript to restrict further drawing to the inside of that outline. Finally,

/tSize 36 def
/AvantGarde-Demi findfont tSize scalefont setfont .6 setgray (UNOBTRUSIVE) centerText show

paints gray within the outline. Now we have something readable.

Listing 17.2 shows the complete PostScript code.
The Right-Hand Side

The material down the right-hand side of each page is similar to PostScript we’ve done before. It’s gray on white, rotated, and includes the page number. We put this code in a header because it applies to every page. Usually we prefer to paint in a paragraph so we don’t have to figure out many coordinates. But this time we are happy to paint relative to the whole page, because our page design (Figure 17.1) tells us all the measurements we need. All we have to do is remember that the origin is the lower-left corner and that measurements have to be in points. First we move the coordinate system to the lower-right corner. Then we move up to the edge of the margin and back off 42 points to the left (that’s one-half inch for the LaserWriter plus enough more for a little extra white space):
Next we rotate the coordinate system and move to the origin:

\begin{verbatim}
90 rotate
0 0 moveto
\end{verbatim}

We then draw the text:

\begin{verbatim}
/Bookman-Demi findfont 36 scalefont setfont
(October 1988, Page ) show
\end{verbatim}

Don’t forget the space after “Page”!

**The Questionnaire**

The second page of the newsletter has a questionnaire occupying the bottom half of the page. The questionnaire was easy to make, using a single table with four rows and six columns. Figure 17.7 shows the result in the finished document.

![Figure 17.7: The questionnaire section of the document](image)

Figure 17.8 shows a galley view of the questionnaire. The check boxes are outlined graphics frames. Note that we had to use SHIFT-RETURNs to force some of the column headings and the last row of boxes down to the bottom of their cells, because Word does not provide any kind of vertical alignment for paragraphs within table cells.

In defining a set of styles for a portion of a document, such as the questionnaire, it is helpful to have a parent style, here called `table root`, from which all the styles in the set can inherit. Here we use it to set the
font and font size for the questionnaire, as you can see in the style definitions that follow.

Figure 17.8: The questionnaire is formatted as a table; the check boxes are inserted graphics with outlines.

<table>
<thead>
<tr>
<th>Column markers</th>
<th>SHIFT-RETURNS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. I am satisfied with my commuting arrangements at LA.
2. This year's company Winter Carnival should be held indoors.
3. The childcare center should be moved off the main floor of the building.

The only other formatting problem for the questionnaire section is the dashed line and the scissors. The scissors is a Zapf Dingbat character. The dashed line comes from two tab settings, one at the center point of the ruler and another at the right indent, both having dashed...
leaders. At the top of the next page you can see the tab settings on the ruler and the tab characters before and after the scissors.

**Special Techniques**

There are two issues we'd like to explore here: a chain of styles for making Oxford rules with pull quotes, and using the glossary and PostScript together to make reserving space for illustrations easier.

**Pull Quotes and Oxford Rules**

We used pull quotes in Chapter 16. In that chapter, we pulled the quotes out to a special column. Sometimes, though, we see pull quotes in the column of text. When that happens, we need something to set the quote apart from the surrounding text. One such separator is a pair of Oxford rules: a thick line followed by a thin line at the top, and a thin followed by a thick at the bottom.

Our newsletter has a pull quote on page 1 and a reminder to the employees formatted as a pull quote on page 2.

**A Style Chain**

Each Oxford rule is a single paragraph with two borders, one thick and one thin. The upper rule has space before to separate it from preceding text, and the lower rule has space after to separate it from the following text. The middle (text) paragraph has no border. Since we don't want the pull quote divided by a page or column break, we use Keep With Next formatting for the top rule and the text, and Keep Lines Together for the text.

We have to specify how much gap should be between the thick and thin line of a rule. The easiest way to do this is to change the Line Spacing, set in the Paragraph dialog box. But if you change this spacing from the default of Auto to, say, 2 points, you won't see any difference. This is because Word interprets the line spacing as a minimum and will set the spacing to the font size of the paragraph—even if there are no characters—plus a point or two. Word’s convention is that when you
specify a negative line spacing, this means a uniform line spacing. So we set the line spacing for the paragraph containing the top and bottom rules to -2 points. Figure 17.9 shows the relevant section of the newsletter and the style definitions.

**Figure 17.9: A pull quote is made of three styles, each one pointing to the next.**

Note how we have chained the three styles together through **Next Style**, so we advance from one to the next automatically by pressing RETURN. When you need to insert a pull quote, just apply **PQ1** to the first place you want the rule to start and press RETURN. That makes a **PQ2**. Type the text, pressing SHIFT-RETURN when needed, and press **RETURN**, making a **PQ3**. Pressing **RETURN** a final time takes you back to **para**.

You should go through the trouble of making these definitions only once. Keep these styles in a newsletter template that you will use as the skeleton of future newsletters or in a single glossary item that contains all three paragraphs.

**Illustration Screens**

In Chapter 16, we used outlined graphic frames to reserve space for illustrations. Those outlined frames reserve space, but the outlines are fairly heavy. If the person pasting up the illustrations prefers, they may reserve the space in a more subtle way.
We can ask PostScript to put in a gray screen. Up until now we've asked PostScript to operate on the whole page and on paragraphs. PostScript can also operate on picture frames.

For example,

```
.pic.
.9 setgray wp$box fill
```

will lightly gray (medium gray, on a LaserWriter) the first picture frame in the following non-PostScript paragraph. (See Figure 17.10.) The `.pic.` command asks that PostScript operate only on the graphics frame and its contents, not on the whole paragraph. That is, the gray box will not extend from indent to indent, but only to the extent of the graphics frame.

---

You can't see the results on the screen or in page preview, so the graphic will still be invisible. During editing, you may want to define the style for paragraphs containing illustrations to include character outlining so you can see the frames. Then, just before printing, you can redefine the illustration style without outlining, so you end up with just the gray screen.

If you use this combination a great deal, you would benefit from defining it as a glossary item: select the PostScript and the frame, call up the glossary (⌘-K), type in a name, such as `screenpic`, and click Define.

We often forget that glossary items can be several paragraphs long. You can keep your letterhead in your glossary, for example, or you can
make the PostScript masthead for this newsletter a glossary item. We have already suggested that you make glossary items for other specially formatted paragraphs, such as Oxford rules.

The PostScript Glossary

Another reason to remind you about the glossary in connection with PostScript is that Word comes with a special glossary of PostScript procedures you can insert in your documents. With the Glossary dialog box open, you can select Open from the File menu. (This is analogous to opening another file from the Define Styles box.) Select the PostScript glossary file that came with your copy of Word. Word will load it, and you can see the evocative names of the entries:

- **column grey** [sic] fills a column of your choice with gray. Unfortunately, the routine can’t handle a change in the number of columns; it figures the column from the section in effect at the beginning of the page.

- **column lines** draws lines down the gutters between columns. Notice that you can’t quite do that with vertical bars without getting one extra line on the page! Unfortunately, this one can’t handle a change in number of columns either.

- **crop marks** draws little registration marks outside the borders of the page. This is useful if you’re printing pages that are smaller than your paper, as we did in Chapter 12.

- **sideways page #** makes a black, 30-point Times page indication in the bottom-right margin. We’ve done something like that here.

- **smearword** and **spinword** are both fun effects. The former looks a little like the letterhead text we imported from Illustrator in Chapter 16. The latter appears in the Word reference manual as an example. It features the word “Word” rotated through 360 degrees and overprinted.

You can try these procedures and modify them to suit your needs.

Why Did My Glossary Get So Cluttered? Unfortunately, if you load these glossary items and then save your glossary as the Standard Glossary when Word quits, they will be incorporated in your everyday glossary until you take them out. So save your glossary before you load the PostScript glossary items.
For More on Various Topics

Columns—This newsletter is formatted in three columns. See Chapter 6 for an introduction to multiple columns and Chapter 10 for a comparison of different methods of formatting columns.

Glossaries—Look in Chapter 4 for an introduction to how to use glossaries.

Graphics frames—We introduced them in Chapter 8 and learned to resize them there. We used them in Chapters 9 and 16 to reserve space.

Line spacing—We discussed line spacing in Chapter 8.

PostScript—We introduced PostScript in Chapter 15 and continued the discussion in Chapter 16; we’ll finish up in Chapter 18.

Sections—We first introduced multiple sections in Chapter 9.

Tab leaders—We used tab leaders in Chapter 6.

Tabs—Chapter 6 introduced us to different kinds of tabs; we also used tabs extensively in Chapter 10.
Everyone, even the cops, had gone to the bash. The place was deserted. The lights were out, but sunlight streamed in through the translucent walls. Dust motes swirled all the way up to the whispering ductwork.

Morton Delgado had taken a copy of the October edition, not the November. And that told him all he needed to know to finish his frame. I remembered his going out Friday afternoon; that’s when he must have poisoned the slivovitz. I had to get back to the Magnifique and tell Manny Davis what I knew. But this time I’d have the proof with me.

Slowly, carefully, I got a copy of the newsletter and printed two copies of the note—one correctly and one the way Delgado had done it. All my copies of the contents of the briefcase went to the shredder and made confetti. I picked up my copy of *Desktop Publishing with Microsoft Word* so I could explain the problem with the note to Manny.

More proof occurred to me. I went to Victor’s computer and checked the creation date of the original note file. It was 2:00 PM Friday afternoon. Which was before Victor left. It didn’t make sense.

Then I realized what happened. Though his ignorance of Word would take him to San Quentin, Morton did understand computers. He had changed the system time, but he didn’t know how neurotic Victor was about his clocks. My watch read 6:48. The Macintosh control panel read 6:47. If Victor had set the time, it would be five minutes slow.

“All we have to do,” I said aloud, “is find the watch that matches this computer. You’re too clever, Morton. It will see you hang.”

“We’re in California, Ms. Stone; we use the gas chamber here, if anything.”

I jumped up, clutching my evidence. Morton Delgado was standing in the doorway. The knife in his right hand came up fast. He buried it deep in the book.
LARGE PROJECTS

It's time to think about large-scale desktop publishing projects, say the size of this book. With
that said, let's use our example document for this chapter. We'll use our example document for this chapter.

We'll talk about what to do when a project is easy to deal with the many changes that
make it easy to deal with the many changes that result in a completed book. We've looked briefly at how
a book was printed and how that affected the

looking at the text on the page. We've seen how
the photo-offset changes in the edge of the

the edge of the page. The table of contents and index for a large book require some special considerations to
look at. We'll see how that turns out...

Finally, we'll want you to look around at the
problems we encountered with Word -

deal with them.

For More on

LARGE PROJECTS

It's time to think about large-scale desktop publishing projects, say the size of this book. With that delightful, if perverse, self-reflection that occurs so often in the computer world, we use this book as the example document for this chapter. We used Word to write and lay out this book. With the exception of the pages facing the chapter title pages and a few pasted-in illustrations, we printed all the originals on a Linotronic 300 at 1270 dots per inch directly from Word. We'll talk about what to do to make it easy to deal with the many chapters that make up a complete book. We'll look briefly at how this book was printed and how that affected the positioning of the text on the paper. We'll see how to substitute one character formatting for another. Finally, we'll warn you about a few troublesome problems we encountered with Word and how to deal with them.
Designing for a Large Project

Large projects differ from small ones in fundamental ways. Once the number of people involved, the number of words written, and the number of decisions to make exceeds some critical level, opportunities for disastrous error present themselves at every turn, and deviation from the established course becomes nearly impossible. With planning and some foreknowledge, we can prevent those disastrous errors and maintain flexibility all the way to the printing of the last page.

Word works well for book-sized projects. (From now on, when we refer to a book, we mean any project of similar scope and complexity.) It handles chapter-sized documents efficiently and has mechanisms for maintaining consistency between chapters. You have to know how to use Word's features to help with this process, though, and that's what this chapter is about.

Designing Early

A book involves a lot of words. Desktop publishing makes it possible for writers to write while they look at a fairly close approximation of the printed page. As we discussed in Chapter 2, this results in a better-written book, because the writer sees the words as the reader will see them.

If writers are to write within a design, however, some design must already exist as the first words are being written. If you are an author, ask to meet with the designer to come up with a preliminary design as early in the writing process as possible. Similarly, if you are the designer, ask to meet with the authors as soon as possible to help them to write within a preliminary design.

We made our first design for this book by mimicking design elements of other Sybex books. We found we enjoyed the creative interplay between writing and design. Often what we wanted to say suggested a new way to lay things out on the page and, just as often, seeing the layout suggested new ways to communicate what we wanted to say. When we met with a professional book designer, we had already identified all the design elements for the book and she had the task of putting them into a finished, polished whole.

But designing is different from implementing the design in Word. For instance, it became important in several of our example projects to decide on the large-scale aspects of our page design—page size, margins, number of columns, and so forth—as early as possible.
First, Sybex books like this one have pages that are 7.5" by 9". We decided to print our LaserWriter page proofs on letter-sized paper, centering the smaller page. Therefore, there is an extra half inch on the left and right, and a full inch on top and bottom. We have to account for that in our margin calculations. A thumbnail appears in Figure 18.1.

![Figure 18.1: A thumbnail for a right-hand page with measurements in points (72 points is 1 inch). The book’s page (□) is centered on letter-size paper(■). Note the difference between left and right margins. That difference—12 points—is the gutter.](image)

Next, we decided to have the text in a wide column on the right-hand side of each page; small explanatory graphics and keyboard
shortcuts would appear in a side bar—a narrower column—on the left. Though we were used to thinking in inches, and the design came to us in picas (a pica is 12 points; if they write 3.06, they mean 3 picas and 6 points—$3\frac{1}{2}$ picas), we changed the unit of measurement to points in the Preferences dialog box in order to make the arithmetic easier. That’s why the thumbnail has dimensions in points.

Having decided on these two columns of unequal width, what’s the best way to implement that design in Word? Thinking back to Chapter 14 (the computer manual), we decided to set the margins to match the wide column and to use positioned objects to fill the narrow left column or side bar. In the manual, we set the side-bar elements vertically in line and horizontally at a fixed distance from the left edge of the page. Looking at the thumbnail, we add up the margins and the side bar and subtract the 12-point gutter to get the measurements to use for the margins—the limits of the wide column. Figure 18.2 shows the way we set up the Document dialog box.

![Figure 18.2: The Document dialog box for chapters of this book. The numbers are huge, again, because they’re in points.](image)

Everything was great until we positioned the side-bar objects.

The Side-Bar Elements Were Messed Up! They looked OK, but they were not the same distance from the text column on even and odd pages. The problem had to do with the gutter. The following section details this problem and how we worked around it.
The Gutter Bug

Looking back at the thumbnail and the margin settings, you might wonder why we used the point values we did. And what values did we use to position the side-bar objects?

It turns out that when you set a margin, Word starts counting after the gutter on the right page and from the page edge on a left page. That makes sense; it’s as if the right-page gutter isn’t there and the paper is narrower than it actually is. In fact, if you were in page view and you clicked on the scale icon to see the ruler settings of the margins, you’d see that the ruler value at the left margin is different for odd and even pages by the width of the gutter. (In galley view, the ruler shows distance from the margin, not from the page edge.)

Alas, the same is not true of horizontal position. Word measures position relative to the page from the left edge of the paper whether or not there’s a gutter. As a result, graphics on the right pages show up one gutter width farther from the main text column than their left-page counterparts. The whole business gets so convoluted, we’ll try to save a thousand words in Figure 18.3.

Figure 18.3: The gutter bug in gory detail. Even though we format the two pages identically, they come out looking different.
Squashing the Gutter Bug

In the computer manual we didn’t have this problem, because Alice Land was writing only right-hand pages and had no gutter. But what can we do here? Our first idea (a great one, we thought) was to give the positioned objects a fixed negative offset from the margin instead of a positive offset from the page. That way the gutter would be irrelevant. But Word doesn’t like that; it accepts only positive offsets.

We discovered the solution by accident. Instead of a fixed position relative to the page or margin, we simply positioned the objects at the left relative to the page, with a paragraph width equal to the width of the side bar and a spacing equal to the distance between the side bar and the text column.

You’d think, given everything we’ve seen, that such objects would appear snugly against the left edge of the physical page, possibly overlapping the gutter. But the rule for objects that are set horizontally left is that their right edges (less the spacing) line up with the left margin. You can see the resulting Position dialog box in Figure 18.4. Of course, we included those settings in a style for the generic side-bar graphic; everything else in the side bar inherits from that style.

![Position dialog box](image)

**Figure 18.4:** The Position dialog box we used for objects in the side bar
Mirrored Margins

A design we chose not to use is worth mentioning. What if we wanted the narrow column on the outside of the pages instead of always on the left? We would have checked the **Mirror Even/Odd Margins** option in the **Document** dialog box. Then we would position our side-bar objects vertically in line, but horizontally on the outside relative to the page. This design avoids the bizarre gutter behavior entirely. Some people like this type of design; others hate it. We've given you a sample spread to peruse in Figure 18.5.

![Figure 18.5: A spread with mirrored margins](image)

The Beauty of Styles

When the page design was finally finished, we could concentrate on how to implement other design decisions, such as bulleted lists and headings. Styles saved our lives many times. It is impossible to consider using any less elegant method. Suppose, after all the chapters are
written, the designer decides that there is too much space after the third-level headings and that they need to be brought 2 points closer to the text that follows them. Without styles, someone would have to do a time-consuming, error-prone search through all the chapters for each third-level heading—probably a day's work on this book. With styles, however, we simply alter the definition of the heading 3 style in the master template—two minutes of work! (We’ll consider the master template in detail soon.)

This incredible flexibility is possible only if everyone who works with the files maintains the integrity of the style definitions within each document and follows the philosophy that each design element on the page has its own style (or styles) that produce it.

**An Example—Bulleted Lists and How-To Lists**

Let's take an example from this book, showing a right way and a wrong way to go about introducing a new design element. In this book we use two kinds of bulleted lists: those with bullets (•) and those with arrows (↑•) in front of the items in the lists. We call the second kind how-to lists because they contain instructions for how to do something in Word.

The two kinds of lists are similar; both consist of outdented paragraphs. Early in the design of the book, we were tempted to use the same style for the items in both kinds of lists. Perhaps we were feeling lazy, and it seemed like too much work to define a separate style for each. So we wrote chapter after chapter with a single style for both the bulleted and the how-to lists.

Then the designer looked carefully at the bulleted lists and decided that they would look much better if the space between the bullet and the text were tightened up. Well, we learned the error of our ways, for when we redefined the bulleted-list style to move the text closer to the bullets, we discovered that arrows, because they are wider than bullets, didn’t fit. The text following the arrows moved to the next tab setting, much too far away.

To get things right, we had to do what we should have done in the first place—define a separate style for items in a how-to list and apply that style to all such paragraphs. Because we had written many chapters, we were faced with mind-numbing hours of work going through the documents, finding all how-to lists, and applying the new style. We might have been tempted to patch things up, say, by adding a tab setting at the place we would like the text to begin after the arrow.
Such a patch would have worked, and we could have gone on our merry way writing still more chapters in which the two kinds of lists had a single style.

It wouldn't have been long, however, before someone would have recognized the need for another kind of change that would further differentiate bulleted lists from how-to lists. Perhaps the items in a bulleted list should be italicized or should have wider spaces between them, or their right indent should come in. At that point we would have had no choice but to bite the bullet and create the two styles, but the cost would have been a full day's work.

So, as soon as you perceive that two design elements are different, define a style for each, even if, at the time, it seems that a single style will do for both.

**Keeping Flexible**

In addition to defining separate styles for separate design elements, there are some other things we should do to ensure that design changes remain easy to implement.

**The Master Template**

In Chapter 12, we discussed keeping a template of styles for a simple book. This template holds the official style definitions, page setup, sample headers and footers, and some sample pages that show how each of the design elements is used. Such a template is convenient for a simple book and essential for a complex book with many design elements. Figure 18.6 shows a portion of the master template we used for this book.

Anytime anyone involved in the project introduces a new style, that person should make sure the new style gets into the master template. When styles need modification, they should be modified in the master template. Probably one person will be in charge of maintaining the master template. When we wrote this book, one of the authors cared for the template, and all changes went through him. He had to make sure that others involved with the book had current versions of the template. When the book's designer began readying the chapters for final printing, she took charge of the template.
Using a master template lets you be sure that all the chapters have the same style definitions. Here is a checklist you would use before you begin work on a chapter, say, to prepare it for final printing.

Import the style definitions from the template. See Chapter 12.

Make sure that the Document dialog box for the chapter is identical to the one in the template. As we’ll discuss below, one way to do that is with a macro.

For each section in the chapter, make sure the Section dialog box has the same settings as those in the template. We’re going to show you how to store section marks in a master glossary to facilitate this process.
Compare the headers and footers in each section of the chapter with those in the template, making sure they are the same. Here again, the master glossary proves useful.

Check the print preview to make sure everything came out exactly right.

Organizing Large Style Sheets

As the number of styles becomes large (the template for this book has over 50), keeping track of them all gets difficult. We found it useful to have a list of styles with comments about how to use them. A new person working on the book could use the list of styles as a reference. (You can use Word to print a list of styles with their definitions. With the Define Styles dialog box showing, select Print from the File menu.)

Organizing styles in a hierarchy pays off even more when the number of styles is large than when it is small. Consider an example from this book. In the chapter template, six styles control the formatting of text and graphics that appear in the side bar. Five of these styles are based on the sixth and inherit their paragraph width (as set in the Position dialog box) from it. When the time came to change this width, we could do it by changing the width of the one parent style without having to redefine any of the other five styles. If the six styles had all been independent of one another, we would have had to go through the list of styles looking for those that should be changed. We would have certainly gotten it wrong at least once.

Document Setup with Macros

You can appreciate how easy Word makes maintaining consistent styles across chapters when you contrast that process to maintaining consistency in page and section setups. While you can import all the styles from the template into a chapter, you have to make any changes in page and section setups by hand. It's easy to make a mistake.

A good practice is to make a printout of the template's Document and Section dialog boxes. If you are printing on an ImageWriter, you can do this directly with $\text{-SHIFT}-4$ while the dialog box is showing. With a LaserWriter, you must first make a MacPaint document using $\text{-SHIFT}-3$ and then print from within MacPaint or SuperPaint. With the printouts in front of you, you can open up each chapter, check its page and section setups, and change whatever is necessary.
You have at your command two ways to automate the laborious process of changing Document and Section dialog boxes. A utility called MacroMaker comes with the Macintosh (Version 6.0 or later of the system software); a similar utility called AutoMac comes with Word. MacroMaker is the more intuitive of the two, while AutoMac is the more powerful.

We don't have room in this book to go into detail about using a macro utility, but we'll sketch the idea in general terms. You install either of them once by placing its init files in the System Folder of your hard disk. Then, at any time, you are ready to record a new macro or play back a previously recorded macro. What is a macro? A macro is a series of keypresses and mouse-button pushes that have been stored in such a way that they can be played back any time you want.

So, to make all the Document setups consistent, you would record a macro in which you open the Document dialog box for the master template, go through each field and type in the correct value, and finally close the dialog box. Then, when you are ready to work on a chapter, you play back the macro, and the exact same sequence of commands will operate on it. When the macro has finished (and it will work much faster than you can), the Document dialog box for the chapter will be identical to the one for the master template. Macros are not everyone's cup of tea; using them is a bit like programming. But if you learn to use them, they can save a lot of time and headaches.

The Master Glossary

Just as a master template keeps track of style definitions for the project, a master glossary can keep track of words, phrases, paragraphs, graphics, tables, and other special formatting. The same person who is in charge of the master template can maintain the master glossary and distribute new versions of it along with the template. As each person working on the project receives a new version of the master glossary, he or she can merge it with the standard glossary using the Open command on the File menu while the Glossary window is open.

We kept words we wanted to spell and format consistently such as "PostScript" and "Document menu" in our master glossary. This saved us time and errors as we were writing.

We also kept templates of difficult formats in our glossary, an example of which is the paragraph with the hand next to it that we use to emphasize habits you should develop as you use Word. We format
this as a table and store a template for the table in our glossary. On the screen, with Show on, the table looks like this:

```
| To format the paragraph with a hand, use a one-row table. Both cells get the style soap hand. This template is stored in the glossary under, you guessed it, soap hand. |
```

Headers and footers are a potential source of headaches in a multi-file document, and a master glossary can help you keep things straight. Fortunately, many changes to headers and footers are made through the styles of their paragraphs, and these take care of themselves when you import the template styles. Changes that cannot be handled through styles—changing the wording or switching the position of the page number and chapter title, to take two examples—are tedious to make and ripe for screwups. For these, the safest method is to store templates for headers and footers in the master glossary, paste them into the individual files, and then make final changes, such as typing in the correct chapter name. Always check your work in print preview, because it’s easy to get things wrong. We had a wrong chapter name for one chapter of this book up through the final page proofs!

**Section Marks in the Master Glossary**

Like the settings in the Document dialog box, the settings in Section dialog boxes need to be made consistent throughout the files for your project. You could accomplish this by hand or with macros, as we recommended for the Document dialog box. But the simplest method is to store the section mark as a glossary item. Here’s how:

> Find the section mark for the desired section. It’s the double dotted line at the end of the section.

*If your document has only one section, or if the section you want is the last in the document, you’ll have to create a dummy section at the end of the document. Position the cursor there and type `⌘-ENTER`.*

> Select the section mark by clicking with the mouse pointer from the selection bar.
• Bring up the Glossary dialog box and click on the Define button. Figure 18.7 shows what you should see.

• Now open one of the project files and select the section mark in it corresponding to the one you pasted in the glossary (creating a new end section if necessary).

• Bring up the Glossary dialog box and select the item for the section mark. Press the Insert button.

If, at any time during the defining or inserting of this section mark, you get a dialog box asking if it is OK to use the Normal style instead of copying styles, you can press Yes.

Recall that you can also use the ⌘-BACKSPACE shortcut for inserting glossary items, and you can even install a glossary item on the Work menu (see Chapter 4).

![Figure 18.7: A section mark at the end of the book template has been defined as a glossary item named book section mark, ready for pasting into individual chapters.](image)

**Why Changing Margins Can Be a Big Deal**

It pays to get the page margins and gutters correct from the start. Many tab settings and graphics depend on the margins in ways that Word won’t adjust automatically when you change the margins. Consider the page numbers at the top of this book’s odd-numbered pages. They are positioned by a right tab on top of the right indent. When we changed the margins, the right indent moved, but the tab setting in the odd header stayed in the same place. We were forced to change every
tab setting that was supposed to remain a fixed distance from the right page boundary.

You generally enlarge or reduce graphics so that they fit snugly within their column. But if you change margins, the width of columns changes and the graphics may no longer fit. You have to go through your document looking for graphics that are now too wide for their column or that now need enlargement to fill the space.

**Character Styles**

Finally, think about character styles. We don't mean the character style that you set for an entire paragraph using a style definition, but those that you apply to characters within a paragraph. Let's take an example. We wrote two-thirds of the first edition using the Chicago font to refer to words and phrases that appear on the Macintosh screen, such as menu commands and dialog box names. The book designer decided that Helvetica Narrow Bold would be a better choice.

Unfortunately, Word doesn't provide a style sheet for character formatting to supplement the style sheet for paragraph formatting. If it did, we could have identified the formatting of menu commands with a name, such as *program font*. Then, when we made the decision to change from Chicago to Helvetica Narrow Bold, we could have changed the definition of *program font*, and the changes would have been made automatically.

What can you do in lieu of such a style sheet? You can make sure you apply some unique character formatting to the words or phrases in question. Then, if the formatting must be changed, you will at least be able to search for all the words that need changing. Imagine how much more difficult things would have been for us had we not used a different font (Chicago) for all the menu commands and dialog box names. At least we were able to go through each chapter using the `%OPTION-R`, `%OPTION-A`, and `%A` commands to search for each instance of Chicago and change it to Helvetica Narrow Bold. Later in this chapter we are going to discuss a faster and less error-prone way to make this kind of change. (See Chapter 11 for details on how to search for and change character styles.)
Two Formatting Issues

As you can imagine, we made countless decisions having to do with formatting. Exactly what styles did we need? What styles should be based on which others? Out of the multiplicity of such problems in a large project, we'll look at two: the family of styles used to format how-to lists, and the problem of page breaks (one more time).

After that, we'll discuss production problems—problems having to do with getting the book printed the way we wanted—and how we dealt with producing the table of contents and index for this big project.

A Family of Styles for How-To Lists

We want to consider the family of styles that provide the formatting for a list of instructions (the kind with an arrow in front of each paragraph). Figure 18.8 shows a typical example of such a list along with style definitions for all the paragraphs.

Let's assume that you will be working on other chemistry articles by this author. Therefore you will benefit from having a separate dictionary for that work—the third of the three options.

Choose New from the File menu. Immediately a new dictionary, named "User 2," appears in the list of open dictionaries. (§N will not work as a keyboard shortcut because Word will interpret it as pushing the No Change button.)

You must tell Word that you wish to add words to the new dictionary, not User 1. Do this by clicking on "User 2."

Click on the - button. The word appears as the first and only item in the list on the left.

Click on the Continue Check button. The spelling checker will go on to find the next unrecognized word, "PhD" in the example document.

Probably "PhD" is a common enough abbreviation that you would like to store it in the User 1 dictionary, not the special purpose User 2 dictionary. To do so, click on "User 1" and then on the + button.

Continue checking the document. You will find more words that are spelled correctly but unrecognized by the spelling checker.

Notice that the first paragraph in the list is a blank paragraph with the style DHT1, delimit how to head. Its purpose is to provide some space between the list and the paragraphs that come before. When such a list
immediately follows a figure caption or some other paragraph that has delimiting space built into it, we don’t include the DHT1 paragraph. Similarly, the last paragraph in the list is another delimiter, this time with the style DHT2, delimit how to tail. At the moment, it has the same definition as DHT1, but that needn’t always be the case. When the first paragraph following a how-to list has delimiting space built into it (as headings do, for example), we omit the DHT2 paragraph.

Another thing to notice is the way the styles depend on each other. Figure 18.9 shows this dependence graphically.

![Hierarchy of styles used to create a how-to list](image)

**Figure 18.9: The hierarchy of styles used to create a how-to list**

### Planning for Page Breaks

The large figures and other graphics in this book made it hard to get the text on the pages to come out evenly. We had to move things around just before printing. With help, however, Word handles most page breaks perfectly. Here’s how to handle some common problems:

- **Widow control**—In the Document dialog box, the Widow Control option tells Word never to leave a single line of a multiline paragraph by itself at the bottom of a page (orphan) or at the top of a page (widow). Widows and orphans are confusing to the reader and are signs of poor layout, so turn this option on.

- **Headings**—These are formatted with styles heading 2, heading 3, and heading 4 (the chapter title is heading 1), so that Word can use them to generate the table of contents. Giving them Keep With Next formatting guarantees that we won’t find a heading stranded on the bottom of a page.
- **Figures and captions**—These must not be separated from each other. Furthermore, if the captions have more than one line, the lines must be kept together. We format the figures with **Keep With Next** and the captions with **Keep Lines Together**. Figures and captions may have to be moved, reduced, or enlarged to get the bottoms of the text on each page to come out within some predetermined distance of the bottom of the page. (For this book, the designer decided that one inch was a reasonable amount of slop.)

**Production Notes**

So far, we have talked in general terms about considerations and problems that come up in large projects and have discussed two solutions we used for common formatting problems. We now turn to particular techniques that have proved useful in the writing and layout of this book. We'll look at how the process of photo-offset printing affects the way you think about positioning the page on the paper.

This book was printed using a process called photo-offset lithography. The originals that came out of the L300 imagesetter were photographed, and the film images were used to expose specially prepared metal plates. These plates served as the actual masters during printing.

Why have we brought this up? Does whether printing is done on an office copy machine or a fancy photo-offset press affect the layout? In one way, yes—it affects how we should position the pages on the paper. And that, in turn, affects how we set up the fundamental structure of the book in the **Document** dialog box.

**Small Pages on Large Paper—Registration Marks**

The pages of this book are 7½ by 9 inches. We have already dealt with how to compute the margins for a similar situation in Chapter 12, when we discussed printing the small pages of a book on letter-size paper. But for this book we have an extra complication—we want to provide registration marks for the camera to line up on when it produces the master plates. (PostScript will produce these marks for us in the next section.) Recalling that the printer cannot print within about 3/8 inch of the page edge, we see that we have to center the page carefully on the paper to have enough room for these marks. Refer back to the template in Figure 18.1.
The net result of centering the small page on the larger paper is that we have to allow an extra inch on the top and bottom as well as an extra half inch on the left and right for the margins.

**Making Registration Marks in PostScript**

We use PostScript to draw registration marks on the master pages. Since every page gets these marks, we put the PostScript code in the headers. If there is more than one section, it appears in the header for each section. If a section has a special header for the first page, the same code goes in that header, too. This isn’t as onerous as it sounds, because we put it all in the chapter template, and we keep a copy in the master glossary. Since a new chapter is begun by duplicating the template, it automatically gets all the correct PostScript. (Of course that means you have to be thinking about registration marks right from the beginning. If you don’t deal with them, someone will have to add the code to the header in every section of every chapter.)

Listing 18.1 shows the actual PostScript code for drawing the registration marks. You can see that it specifies drawing on the whole page and defines variables to hold the relevant page coordinates. Then it defines the procedure \texttt{regX} to set a mark at the current location. In the last part of the code, after setting the line width to something very thin, the \texttt{regX} procedure is called once for each mark. Finally, the \texttt{stroke} command actually draws the marks.

Figure 18.10 shows how the registration marks are clipped off on the outside. Again, this is because the LaserWriter will not draw within about $\frac{3}{8}$ inch of the edge of the paper.

**Bleeding to the Edge**

On the page facing the title page of most chapters in this book, the example documents extend all the way to the edge of the paper. When this happens, printers call it a *bleed*. To make something bleed, that is, extend to the paper edge, it must actually extend beyond the edge on the master copy so that small errors in cutting the paper will not show. Figure 18.10 shows what we mean. The artwork extends well beyond the edge of the page.
.page. % drawing relative to the entire page
/inch {72 mul} def % function to convert points to inches
/pagebottom 1 inch def % y coordinate of bottom reg marks
/pageyt $y 1 inch sub def % y coordinate of top reg marks
/pageleft .5 inch def % x coordinate of left reg marks
/pageright wp$x .5 inch sub def % x coordinate of right reg marks
/regX { % makes a reg mark at current position;
  % call is "size regX", size in inches.
  /size exch inch def % the size of the mark in inches
  /half size 2 div def % half the size of the mark in inches
  0 half rmoveto % up to the top
  0 size neg rlineto % down to the bottom
  half half rmoveto % over to the right without drawing
  size neg 0 rlineto % over to the left
} def % a very thin line

01 setlinewidth

pageleft pagebottom moveto .5 regX % move to bottom-left, make the mark
pageleft pagetop moveto .5 regX % similarly for top-left corner, etc.
pageright pagebottom moveto .5 regX
pageright pagetop moveto .5 regX
stroke % actually draw all four marks

Listing 18.1: PostScript to draw registration marks at the page corners

Figure 18.10 The artwork on pages facing the chapter title must extend beyond the edges of the page to insure a good bleed.
The pasteup for the chapter-art pages of this book, and thus the bleed, was done manually. But in cases where you want to use Word to do the bleed, a positioned object is a good candidate, because you can move it wherever you want on the page in print preview.

**Producing Camera-Ready Copy**

Finally, when all the editing is done and the page breaks have been adjusted properly, we print final page proofs on a LaserWriter. The pages are proofread, corrections are made, and new printouts are proofed again. At last everything, down to the last comma and graphic, has printed just the way we want. Each chapter has the correct starting page, as set in the **Document** dialog box.

We’re ready to take the files to the typesetter, who will print all the chapters at high resolution. Along with the files goes a final printout from the LaserWriter. The typesetter will use the printout to check the output of the L300. Everything should be in the same place, but of higher quality.

**The Table of Contents and the Index**

When the camera-ready copy has come back from the typesetter, the words are frozen on the page. It’s time to put Word to work to produce a table of contents and an index.

**A Linked Chain of Files**

A table of contents or an index, by its very nature, contains information about the entire book. As we discussed in Chapter 12, we have to help Word out by linking all the chapters together using the **Next File** button in each chapter’s **Document** dialog box. We create a separate document for the table of contents and link it to Chapter 1. Similarly, another blank document, soon to be the index, gets linked to the final appendix. You can see what we mean by linking in Figure 18.11.

**The Table of Contents and the Figure List**

In this book the chapter titles are formatted in the **heading 1** style, and the headings get styles **heading 2** through **heading 4**. In Chapter 11, we saw how to use the **Table of Contents...** command on the **Utilities** menu
to construct a complete table of contents for the book from these titles and headings. With only the table-of-contents document open in Word, we give the Table of Contents... command and watch Word go through each of the files gathering up the headings. Finally, the complete table of contents appears.

Some books have a list of figures as well as a table of contents. Word can help produce that as well. Recall from Chapter 11 that you can place instructions for generating a table of contents as hidden text in the document. Each figure caption should have a hidden .C. in front of it. Then the Table of Contents... command with the .C. Paragraphs option selected can produce a list of figures with the correct page numbers.

The Index

In Chapter 14 we dealt with the details of creating an index. Getting the index entries complete and consistent is no easy task. But once it’s done, Word can produce the index with the Index... command on the Utilities menu. The result will go in the last of the linked chain of files.

Unfortunately, there is a problem with large indexes. Word uses a fixed-size buffer to keep track of certain kinds of operations. Large indexes can force Word to run out of space in this buffer. The suggestion in our checklist about saving with Fast Save turned off helps prevent this from happening. If Word complains that it is running out of memory while creating your index, you will have to use the Index Characters From: To: option in the Index dialog box to break the index into two or more parts.
An Indexing Checklist

It's surprisingly easy for things to go wrong when you make an index. Here is a checklist to help get it all right.

- Make sure you are working with copies of the exact files that were used in printing. If changes were made during printing, you need to incorporate those changes in your files.
- The LaserWriter must be the selected printer in the Chooser.
- Each chapter should be repaginated forcibly using the Repaginate Now... command on the Document menu. This will speed up Word during the building of contents and index.
- Making a large index pushes Word's memory limitations. The best you can do is to use Save As... on each file with the Fast Save option turned off. Doing so frees up as much memory as possible for Word to use in constructing the index.
- Put all the documents into a single Macintosh folder on your hard disk. Word will be able to locate them without having to ask you where they are.
- Go ahead and make the index—possibly only a few letters at a time—and check the results carefully against the printed chapters!

Changing Character Formatting with RTF Files

In this chapter we discussed the problem of changing all occurrences of Chicago to Helvetica Narrow Bold, and we promised you a shortcut for doing this. A reasonably efficient way to solve this problem is to save each file in its Rich Text Format (RTF) form. Figure 18.12 shows the box you can invoke by pressing the File Format... button in the Save As dialog box.

In the RTF form, all the formatting commands, including font changes, are displayed with normal text using control words. For example, the phrase

The Section command appears on the Format menu.
comes out in an RTF file as

The \f0 Section command appears on the \f0 Format menu.

\f0 means "change to font zero," which happens to be Chicago, and the closing braces indicate that it's time to go back to whatever font was being used previously—in this case, Palatino. To accomplish the change from Chicago to Helvetica Narrow Bold, we first determined that \b\f15 (bold and font 15) was the desired control and then used Word's Change All command (see Figure 18.13). It took about fifteen minutes on a Mac Plus to convert the fonts in a typical chapter. Most of this was the time it took Word to convert the RTF file back to normal format, time we spent doing other things away from the computer.

![Figure 18.12: The File Format... options with RTF checked](image1)

![Figure 18.13: The change from Chicago to Helvetica Narrow Bold](image2)
Customization Corner

We did a lot of customizing of Word while we were writing this book in order to make our work easier. We put Paragraph Borders, Cell Borders, and Fractional Widths on the menu bar. We almost always used Smart Quotes, but since we occasionally needed to make them stupid, we put that command on the Edit menu.

We added keyboard shortcuts to the commands we needed most, such as Position..., Show Hidden Text, and Insert Index Entry. We also installed shortcuts for our most-used fonts, so that $\&$-OPTION-SHIFT-B changed to Helvetica Narrow Bold, for example.

Our Work menu was full of glossary items: the $\&$-combination, headers, the gotcha graphic, a sample fraction, and the hand table we mentioned earlier. We also installed our master template (locked, of course!) and a separate file that served as a to-do list.

An unexpected result of this extensive use of customization was to wish it were available in other programs. We could hardly have survived without it!

For More on Various Topics

Finding and changing character styles—You can learn more about this in Chapter 11.

Importing styles—You can learn how to import styles from a template document in Chapter 12.

Indexing—We first prepared an index in Chapter 14.

High-resolution printing—See Chapter 16 for a comparison of Linotronic and LaserWriter printing.

Multiple files—We talk about handling multiple files for a single document in Chapter 12.

Page size—In Chapter 12 we show how to think about laying out a page that is smaller than the print paper.

PostScript—In Chapter 15 we draw a frame around the page, something similar to making registration marks.

Table of contents—See Chapters 11 and 12 for the details of creating a table of contents.

Widows—We show the effect of widow control on column breaks in Chapter 13.
The two cops were there when I needed them. Manny was close behind. Morton Delgado was shackled and away before I could catch my breath.

Manny took me by the shoulder and brought me around to my own office. He was carrying a brown paper bag. He reached in and pulled out a pair of Black Currant Calistogas, opened them both, and handed me one. I sipped.

“Good to see you, Sergeant,” I said.

“Good work, detective.”

“How did you manage to be here?”

“We had Delgado figured for the murder when I called you at the pay phone, but we were waiting for the right time to pick him up. We thought he was safe in the crowd, but when he left, we followed him.”

“You had him figured? How?”

“Three things. First of all, we couldn’t see how anybody but Clara McConnell could have gotten into Markovsky’s apartment while he was out. After we found the note in her car, it struck me to look at Victor’s car.”

“Hide-a-key?”

“Right. Second, a clerk at a specialty liquor store in North Oakland identified Delgado’s picture as the man who bought a bottle of slivovitz but couldn’t pronounce it. Third, the book Thompson sent Victor. If you’d read it carefully, you would have found Morton’s M.O. for the stock scam. He’d been taken before; he was just learning from the burning. Until Victor got in the way.”

“I feel so stupid. I had him on my list of suspects this morning, but I just got caught up in Alice.”

“But you still figured him out. How did you do it?”

I told him about the cookies and the newsletter. “But it was the note, really. Whoever made it doesn’t understand the Mac. Victor does. Clara does. Alice wrote that manual; she does. And Chuck Hines, who scares me to death, wrote a proposal that shows that he does.”

“What was it about the note that told you?”

I showed him the two printouts I had made. “The problem has to do with font substitution,” I said. He looked at me blankly. I handed him my mutilated copy of the book. “I think it’s in an appendix. Read it. You’ll learn something.”
APPENDIX A

WHAT YOU NEED TO USE THIS BOOK

This appendix will help you if you are preparing to use Microsoft Word on the Macintosh for the first time. We'll tell you what you need to have available to get going. If you have already been using Word, you are almost certainly set to go. If you are thinking about purchasing a Mac, you will find some pointers here about what tradeoffs of equipment versus expense you should consider.
The Macintosh

Word Version 4.0 will run on the 512KE Macintosh, but you'll be much happier with at least a megabyte of memory. More memory would be useful as you work through the chapters of this book that deal with graphics, because you might want to have both Word and a graphics program resident at the same time. Word takes advantage of all the computer memory you give it, and the more you give it, the faster it runs.

The example documents we create in this book are not long, so it is possible to work with a minimum configuration of two 800K drives, especially if you have trimmed your System file to remove unnecessary fonts and desk accessories.

Word takes up a lot of disk space, however, so working with just 800K of disk space leads to frustration. Life becomes much easier with two 800K drives. And with a hard disk, you can really concentrate on your task instead of caring for your computer; besides, those annoying delays caused by the Mac reading from the disk are practically nonexistent.

Keyboards

There are four extant keyboards for the Macintosh (see Figure A.1). For the purposes of this book, few differences exist among them. We often refer to a key labeled BACKSPACE on the Macintosh Plus keyboard. This key is labeled DELETE on the SE keyboard and the extended keyboard. We occasionally refer to the four arrow keys; these are not present on the original Macintosh keyboard.

Word offers many keyboard shortcuts that we do not mention in this book, some of which are not available on the original keyboard. In fact, it is possible to do everything in Word without using the mouse at all, but we don't recommend it. The keyboard shortcuts are generally more helpful if you are doing a lot of word processing than if you are doing desktop publishing.

Printers

Desktop publishing has grown up around laser printers, especially Apple's LaserWriter. In this book, we frequently discuss techniques that apply to printing on a laser printer, but not to printing on a dot-matrix printer, such as Apple's Imagewriter. We doubt that you would have bought this book unless you have access to a laser printer, perhaps
at your local print shop. While you can learn a lot with just an Image­
writer, its maximum of 144-dots-per-inch resolution is just not
acceptable for publishing. At the other extreme, we spend a little
time in Chapter 16 talking about what it's like to use a 1270- or
2540-dots-per-inch Linotronic printer, but we don't assume you have
one in your back room.

**System Software**

Apple frequently updates its system software—the System, Finder,
and LaserWriter files. Version 4.0 of Word works with System 3.2 and
Finder 5.3; if you're using a Mac SE or a Mac II, you need System
Version 4.1 and Finder Version 6. But your best policy is to use the
latest system software that will run with your Macintosh. As of this
writing, the latest are System 6.0.3, Finder 6.1, and MultiFinder 6.0; they
work with a Mac Plus, Mac SE, or Mac II. If you have a megabyte or
more of memory, MultiFinder will make it possible to run other
programs, especially graphics programs, concurrently with Word.

**Word**

Just as Apple updates its system software, Microsoft comes out
with periodic updates and occasional major revisions of Word. The first
Word for the Mac was 1.05. While an adequate word processor for its time, Word 1.05 did not have sufficient power to do desktop publishing. This book has nothing to do with Word 1.05.

Next came Word 3.0, a completely different piece of software. It was full of bugs—an embarrassment, really. Then there was 3.02, for which we wrote the first edition of this book. You can tell what version you have by selecting About Microsoft Word... from the ⌘ menu.

We're using Word 4.0 for this edition. It works very well, even though there are still a few bugs and some awkwardly implemented features. Version 4.0 offers major improvements over 3.02. Read about them in your Word documentation and in Appendix F.

**Graphics Software**

If desktop publishing became practical because of laser printers, it is the ability to integrate graphics and text that makes desktop publishing exciting and fun. Word lets you place graphics in your documents easily, once you get the hang of it. But you can't create graphics with Word; for that you need a graphics program. The grandparents of all Macintosh graphics programs are MacPaint and MacDraw. Either or both of these, or any of their many descendants, will work for trying out the graphics examples in this book. Microsoft has done us a great favor by bundling SuperPaint with Word.

**Paperware**

Besides this book, and an introductory book on Word if you want one, we recommend that you have Getting Started with Microsoft Word and the Reference to Microsoft Word (the thick one), both of which came with Microsoft Word, handy. Whenever you need a comprehensive explanation of one of Word's features, (for example, the function of every one of the parts of a dialog box) the Reference is the place to look. Remember to start with the index!
APPENDIX B

BASIC WORD SKILLS

To use this book, you should already understand the basics of Word. This appendix outlines what we think those basics are. You might check here if you’re not sure about your basic skills and want to brush up, or if it seems that we’re assuming you know something you don’t. First we’re going to describe basic Macintosh skills. Then we’ll describe word processing skills such as moving the cursor, inserting text, selecting, using the clipboard, and imposing character formats. For those of you who have mastered the basics and can get around well in Word, we have included some timesaving tips in this appendix you might not be aware of. Check the section on selection especially. If you’re having trouble remembering keyboard shortcuts, be sure to keep handy the Quick Reference Guide that came with Word.
Basic Macintosh Skills

In order to drive Word, you have to know how to do certain basic things on the Mac. We'll run through them very quickly. One thing to note is the language. The Macintosh came with its own vocabulary, which we'll use here and translate into English wherever necessary.

Click, Double-Click, and Drag

The mouse is the input device that most characterizes the Macintosh. There are three mouse actions you need to understand in order to use this book.

- To click (with the mouse button) means to press the mouse button down and release it without moving the mouse. A click is not over if the button is still down. When we tell you to click on an icon, point at it, press, and release.

- To double-click means to click twice within a short period of time and in almost the same place. How short? It's variable, set in the Control Panel desk accessory under Mouse.

- To drag means to point somewhere, press the button, and hold the button down while moving. You drag, for example, to move files to the trash, to choose an item from a menu, or to select text.

Documents and Applications

When you first start a session on the Mac, you see windows shaped like desk blotters and icons—little pictures—on the desktop or screen (see Figure B.1). The windows can vary in size and can overlap one another.

The icons represent four kinds of things:

- The trash
- Disks—hard disks and floppies—that are currently attached to the Macintosh
- Folders, which are organizational structures that look like manila folders
- Files, in which information gets stored
We can divide files into two categories:

- **Applications**, that is, programs—the computer instructions for doing something
- **Documents**, that is, data—the information that the applications operate on. Most documents are associated with a particular application, usually the one that created it.

Thus, the file Microsoft Word is an application; a letter you create in Word and save on the disk is a document.

**Launching Word**

The Macintosh verb for running a program is to *launch*. There are a lot of ways to launch Word. These are the two most common:

- Double-click on the Word icon. This brings up a new, untitled document.
- Double-click on a document created by Word. This launches Word and brings up the document you double-clicked.

Some people get the mistaken idea that in order to quit editing one document and begin editing another, you have to quit Word and double-click the other document. Not so. You can always open an existing document without quitting Word. Similarly, you can always get a new, untitled document, even if you’re editing an old one. You can have several documents open for editing at one time.
**Selecting from Menus**

You open an existing document or create a new one by selecting **Open** or **New** from the **File** menu.

And how do you do that? When we talk about the **File** menu, we mean the pull-down menu whose title, **File**, appears on the **menu bar**, that list of names that crosses the top of the screen. If you point the mouse at the title of the menu you want and hold the button down, you'll see the menu. To select a command from the menu, drag the mouse from the menu title to the command you want.

After you release the mouse button, the Mac will execute your command. The picture in the side bar shows the **Open** command about to be selected.

Frequently, a menu command will have a keyboard shortcut. For example, in the **File** menu, we could select the **Open** command by using the `~O` shortcut (holding down the `~` key and pressing `O`).

**Using the Open and Save Dialog Boxes**

When you select **Open**, a dialog box will appear on the screen. In Word, it looks like Figure B.2; in other applications it looks and behaves similarly. You can do a great deal with this box, but beginners have some problems with it. Here are two frequent complaints:

- **My file isn't listed here.** Probably not. The box doesn't list all the files, just the ones in the current folder. You may need to do a combination of these things: look inside a folder (open the folder by clicking on its name to select it and then clicking the **Open** button or by double-clicking its name); close the current folder to go up one level in the hierarchy (click on the name of the disk or use the pop-up menu under the folder name); or look on a different disk (use the **Drive** button to change disk drives).

- **The disk I want isn't in the computer.** No problem; use the **Eject** button to eject the disk you don't need, then insert the one with the document you want to open.

The **Save** dialog box appears whenever you save something for the first time, use the **Save As...** command, or try to save a locked file. It operates analogously to the **Open** box except that since you have to give the file a name, there's a space for you to type the name in. Figure B.3 shows a typical **Save** dialog box.
Figure B.2: The Open dialog box. Use it to select files to open while you are running an application.

Figure B.3: The Save dialog box. We have typed in the name we want to give the file. The figure also shows what the pop-up menu that helps us traverse the hierarchical tree of folders looks like.
Scrolling

You will make documents that are bigger than a screenful. Word provides two scroll bars, horizontal and vertical, to help you move to parts of the document that aren't visible. We'll discuss only the vertical scroll bar here.

There are five parts to a scroll bar, labeled in Figure B.4. The most basic are the two arrows, which move you slowly in each direction. Next is the elevator box, called the thumb, which shows you where you are, relative to the whole document. You can also drag the thumb to any position you want, and Word will transport you to that place in your document instantly.

That leaves the page-up and page-down regions. Clicking in these gray areas between the thumb and the arrows moves you one screenful in that direction.

![Figure B.4: Anatomy of the scroll bar](image)

Basic Editing

Once you're in Word, you have to know how to edit. That involves inserting and deleting text. Inserting and deleting are intimately involved with the cursor, also known as the insertion point.

We need to distinguish the cursor from the mouse pointer. The mouse pointer is the thing that your mouse moves around the screen. If there is a cursor, it looks like a flashing vertical bar. The cursor always appears between characters.
If you’re moving your mouse around in the editing window, the mouse pointer looks like an I-beam. In other parts of the screen it looks like an arrow. At some special times, it may look like a wrist watch, a plus sign, a minus sign, a magnifying glass, or a question mark. But the cursor is the flashing vertical bar. This brings us to three rules of basic editing:

**The First Rule of Editing: Inserting Text**
If there is a cursor and you type, whatever you type appears at the cursor.

**The Second Rule: Moving the Cursor**
If you point with the I-beam mouse pointer and click (not drag!), the cursor will move to the position of the I-beam.

**The Third Rule: Deleting Text**
If you press BACKSPACE, Word deletes the character to the left of the cursor.

With these three rules, you can edit anything. It may be tedious, but you can do it. To be more efficient you have to learn how to operate on more than one character at a time. This involves selection.

**Selection**
If you’re using a black-and-white Mac (we are), selected text is white-on-black instead of black-on-white. If you have a wealthy patron, you should be using a Mac II, in which case selected text is highlighted in color.

Selected text and the cursor are mutually exclusive: if there’s any text selected, there’s no cursor; if the cursor is there, no text is selected. Selected text is great, because when you do something, what you do affects the entire selection, not just the text at the cursor. There’s
another property of selected text that's very powerful, but it gets everybody into trouble once in awhile:

---

**Typing into a Selection**

If there is any text selected, whatever you type replaces the selected text.

---

Let's see what this implies in several different situations.

You've typed a sentence and you want to replace one word. Select the word and type the replacement. No need to delete the word; that happens automatically. Just select and type.

A dialog box appears with a number selected. You want to change it. Just type the number you want. You don't have to delete the number first; whatever you type will replace the selected text.

You're preparing to change the whole document to Helvetica, so you've selected the whole thing. The doorbell rings, and your cat walks on the keyboard while you're answering the door. Word replaces your entire document with whatever your cat typed. Of course, if you have text selected, BACKSPACE also deletes the selection.

There are two fundamental ways to select text:

- Drag from one end of the text you want selected to the other. It doesn’t matter whether you start at the beginning or the end, and it doesn’t matter what path your mouse takes. The only thing that matters is where the mouse was when the button went down and where it was when the button came up.

- Place the cursor at one end of the selection range, then hold the SHIFT key down and click at the other end.

Those two methods are pretty powerful, but Word supplies a few more useful shortcuts:

- Double-clicking on a word selects the word. This technique is great for deleting, replacing, or italicizing single words. If, having double-clicked a word, you drag the mouse, the selection will expand by whole words at a time.

- If you hold down the % key and click in a sentence, you will select the sentence, up to and including any final punctuation, but not
including any paragraph mark that follows it. This is great for removing or rewriting entire sentences.

The next few shortcuts require that you understand the selection bar. The selection bar is an invisible region about \( \frac{1}{8} \)" wide running down the left edge of the regular editing window. As you move the I-beam mouse pointer to the edge, you’ll see it change into an arrow pointing northeast. It looks like the regular arrow pointer, except that the regular pointer faces northwest.

- Clicking in the selection bar selects the line (including any paragraph mark that may be there).
- Double-clicking in the selection bar selects the paragraph. This is great for cutting and pasting whole paragraphs.
- Holding down the `Shift` key and clicking in the selection bar selects the whole document. So does `Shift`-OPTION-M, by the way, but we find the click easier to remember.

**Cut, Copy, and Paste**

These three functions appear on the Edit menu. They operate with the clipboard, that ethereal never-never land on which you can store one thing at a time for later use.

- **Cut** removes whatever is selected from your document and puts it on the clipboard. On the screen, it looks the same as deleting the selection. `Shift`-`X` is the shortcut for cutting.
- **Copy** puts the selection on the clipboard without deleting it from your document. On the screen, it looks as if nothing happened. `Shift`-`C` is the shortcut for copying.
- **Paste** will insert the contents of the clipboard at the cursor. If something is selected, **Paste** replaces the selection with the contents of the clipboard and leaves the cursor at the end of the selection. `Shift`-`V` is the shortcut for pasting.

Use these commands to duplicate text and move it around, including between documents and between applications. In case you’re ever in doubt as to what is on the clipboard, you can choose **Show Clipboard** from the Window menu.
Imposing Character Formats

We assume you know how to impose the basic character formats—italics, boldface, and so forth—on your text. In case you’re rusty, there are two ways to do it:

On the Fly

If you’re typing text for the first time and you know that the next word is going to be italic, change to italic, type the word, change back to plain text, and type on.

You can use any of these methods to change to italic:

- Select Italic from the Format menu.
- Click on Italic in the Character dialog box (also from Format).
- Use the X-SHIFT-I shortcut.

You can change back to plain text by repeating any of the above actions. The italics command acts as a toggle switch.

After the Fact

If you’ve already typed the word, and you want to italicize it, select it and then do one of the three things listed above. These same procedures work for changing fonts and font sizes. Naturally, you should use the selection shortcuts to do the selecting.

Getting Help

Word comes with a built-in help system. The file Word Help must be in your System folder or in the same folder as the Word program in order to use the help system. One way to get information from the help system is to choose About Microsoft Word... from the menu, and then click on the Help button. You will see a list of topics arranged alphabetically. That’s all well and good if you can guess which topic you should look under.

Another way to get help is through the X-? keyboard command. Your cursor will change to a ?. You can then click the mouse on any object on the screen, including a dialog box, and Word will bring up the portion of its help system that deals with that object.
APPENDIX C

WHAT WORD CAN AND CANNOT DO

Word on the Macintosh claims to be a powerful word processor—which it is. Yet it is more than that. With Word you can do most of what is now called desktop publishing. In this appendix you will find a list of those tasks that you would not ordinarily expect a word processor to be able to accomplish. You can do some of these tasks quite a bit more easily in Word than in the currently available page-layout programs. Following the list of what Word can do is a list of desktop publishing tasks that are so difficult to do inside Word that you should avoid taking them on. That’s not to say they’re impossible, as there may be some clever way we haven’t thought of to do some of them. You might also get the work done in a graphics program such as MacDraw and then import the result into Word. You could write PostScript code to accomplish a task. (Because Word allows PostScript, nothing is completely impossible.)
Word Can

Handle very long documents—Word does not limit the size of a single document, but the time to save the file can become quite long. It's still best to break a very long document into portions about the size of a book chapter.

Create a table of contents—Word can use either paragraphs with outlining styles (see Chapter 11) or embedded commands (see Chapter 12) to create a table of contents, even one that spans a large number of files.

Create an index—You can embed indexing commands in the text to create an index. (See Chapter 18 for information about memory limitation and how to get around it.)

Keep side headings and graphics with the right body text—Page-layout programs let you place headings to the side of body text, but if you edit the body text, the headings will soon be out of alignment. In Word, that doesn't happen because the headings move with the text.

Change headers and footers in the middle of a document—Each section in a Word document can have its own header and footer, and the first page of a section can have a special header and footer. You can put any text, the page number, date, and time in the headers and footers. All formatting commands work the same way in headers and footers as they do in the body text.

Do mathematical typesetting—Word provides a reasonably complete typesetting language for formatting mathematical expressions and equations. (See Chapter 13 for details.)

Do a good first approximation on page breaks—With widow control, Keep Lines Together, and Keep With Next, Word can handle most page-break decisions automatically. For documents without large figures or tables, you can define paragraph styles, so Word's page breaks are as good as any you would choose yourself.

Allow multiple columns—Word has many different methods for creating multiple columns on the page. (See Chapter 10 for advice about how to decide which to use and when.) You can also change the number of columns in the middle of a page.
Pin a graphic down to a particular location—Let’s say you want a photo in an article at the bottom of the third column, no matter what. Word provides positioned objects to specify that condition.

Flow text around graphics—Using positioned objects, you can flow text around graphics—as long as they’re rectangular.

**Word Cannot**

Kern—Text is *kerned* when one letter is made to overhang its neighbor to even up the spacing. Kerned text looks better and is easier to read than un kerned text. Word doesn’t give you an easy way to do kerning. You can import some text (a headline, for example) as a graphic from another program, or you can kern by hand using formulas (see Ch. 13).

Fit an edge of a paragraph to the shape of an illustration—Word can’t flow text around a graphic contour. You can do it laboriously by hand by pressing `SHIFT-RETURN` at the appropriate place in the line.

Deal with several articles in a document, beginning all of them on page 1 and continuing on later pages—A Word document is one flow of text, so trying to intertwine more than one article in a single document is not worth the trouble. You can, however, format the articles with the desired column width and cut and paste the resulting galleys by hand into a finished layout.

Allow different column widths next to each other when the text flows from the bottom of one column to the top of the next—Fortunately, this situation does not come up very often. Usually we use a column of different width for side headings or graphics.

Put gray screens behind paragraphs—You can import paragraphs with gray screens from graphics programs, or you can use PostScript to create a screen. In the latter case you must format the paragraph with **Keep Lines Together**, or else the part of the paragraph continued on the next page will not get screened. In other words, you can have screens, but they’re a real bother.
Produce white on black—As with screens, you can do it with graphics or PostScript, but Word doesn’t provide an intrinsic formatting for it.

Do vertical justification—Just as there are times when you want to fully justify lines of text so that the right edges of paragraphs all line up, there are times when you would like to justify pages vertically so that the bottom lines of text are all on the same line. Word can’t do that for you, though you could adjust the line spacing of paragraphs, vertically justifying by hand.

Float a figure and caption—Some sophisticated layout systems will let you specify that a particular figure with a caption be allowed to float within a certain range of text to allow the best possible page break. In Word you have to cope with placement of figures yourself with no help from the computer.

Maintain a character stylesheet—While Word does a good job with its stylesheet for paragraph formatting, it doesn’t allow you to keep a stylesheet for character formats within paragraphs. With such a stylesheet you would record styles for emphasis, fonts to use to signify special things, and so on. When you changed your mind about a particular format, you would have to change only the style definition to accomplish the change.

Automatically change page references—It would be wonderful if you could refer to a place in your document, as in “See page 47,” and have Word recalculate and insert the appropriate page number automatically. But Word can’t do that. Likewise, Word cannot renumber figures or tables as it does footnotes.
APPENDIX D

A SAMPLING OF THE
ADOBE TYPE LIBRARY

Gathered in this appendix are font specimens of fifteen of the PostScript typefaces that are available from Adobe Systems Incorporated. Our purpose is to introduce you to the tremendous variety of fonts already available for PostScript printers. More will come. Included here are all of the fonts that come with the LaserWriter and LaserWriter Plus printers. The others are fonts that you can download from the Macintosh to the laser printer. With each font is listed its full PostScript name and its name as it appears on the Macintosh font menu. For most writing, you need to have only the roman version of the screen font in your system; the printer will automatically use the bold, italic, or bold-italic version of the PostScript font where you have imposed that character style. If you are doing detailed layout, you would do well to get screen versions of these other three forms of the font, because you will get a truer picture on the screen of what you will see on the paper. Many people inadvertently fall in love with the world of fonts. If this happens to you, get copies of font catalogs from the font vendors and peruse to your heart's ease and eye's delight.
ITC Avant Garde

Avant Garde is a distinctive sans-serif font with narrow vertical lines and nearly circular curves. It works well for display and some text applications, but its uneven texture makes it disturbing for large blocks of body text.

18 point
ABCDEFGHJKLMabcdedfghijklm
12 point
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456789!@#$%^&*()_+-='"|}{\[\]<>?/.,;:"\]}
12 point Italic
ABCDEFGHIJKLabcdefghijklmnopqrstuvwxyz
12 point Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456789!@#$%^&*()_+-='"|}{\[\]<>?/.,;:"\]}
12 point Bold Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456789!@#$%^&*()_+-='"|}{\[\]<>?/.,;:"\]}

ITC Bookman

Bookman, as a highly legible, serif font, works well for both display headlines and body text. It is a general-purpose font.

18 point Roman
ABCDEFGHJKLMabcdedfghijkl
12 point Roman
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456789!@#$%^&*()_+-='"|}{\[\]<>?/.,;:"\]}
12 point Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456789!@#$%^&*()_+-='"|}{\[\]<>?/.,;:"\]}
12 point Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456789!@#$%^&*()_+-='"|}{\[\]<>?/.,;:"\]}
12 point Bold Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456789!@#$%^&*()_+-='"|}{\[\]<>?/.,;:"\]}

Courier

Courier is a monospaced typewriter font, suitable for business correspondence and program listings. With PostScript, Courier can only be stroked, not filled.

18 point

ABCDEFGHJKLMabcdefghijkl

12 point

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

0±®t1234567890<[{[(«£§¶† »¿¡]}}]>!@#$%

12 point Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Garamond

Garamond shows a stronger-than-usual contrast between the thick and thin strokes. Use it when you want highly legible, yet elegant type. The italic, since it is not strongly slanted, remains very readable.

18 point Roman

ABCDEFGHJKLMabcdefghijklmn

12 point Roman

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

0±®t1234567890<[{[(«£§¶† »¿¡]}}]>!@#$%

12 point Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
Goudy

Goudy Old Style is a graceful, elegant font with smooth curves and gentle gradations from thick to thin. Use it when you need a touch of class in brochures, reports, and pamphlets.

18 point Roman

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Roman

abcdefghijklmnopqrstuvwxyz

12 point Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Helvetica

Helvetica is a widely used sans-serif typeface of uniform line weight that you can use anywhere. It makes a good headline when combined with a serif font.

18 point

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
Helvetica Narrow

Helvetica Narrow has the look of Helvetica but packs a lot more characters into the same space. Use it when you need to put a lot of information in a small space.

18 point

ABCDEFGHIJKLMNOPQRSTUVWXYZ abcdefghijklmnop

12 point

ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz abcdefghijklmnopqrstuvwxyz\[\{\]<\[]£\¥\±\%\®\±\±\&\%\±\±\±

12 point Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz abcdefghijklmnopqrstuvwxyz\[\{\]<\[]£\¥\±\%\®\±\±\&\%\±\±\±

12 point Bold

ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz abcdefghijklmnopqrstuvwxyz\[\{\]<\[]£\¥\±\%\®\±\±\&\%\±\±\±

12 point Bold Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz abcdefghijklmnopqrstuvwxyz\[\{\]<\[]£\¥\±\%\®\±\±\&\%\±\±\±

New Century Schoolbook

New Century Schoolbook is a clean, dignified font. Many of us remember it as the Dick-and-Jane font of our youths—but it’s highly legible at adult sizes as well.

18 point Roman

ABCDEFGHIJKLMNOPQRSTUVWXYZ abcdefghijklmnop

12 point Roman

ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz abcdefghijklmnopqrstuvwxyz\[\{\]<\[]£\¥\±\%\®\±\±\&\%\±\±\±

12 point Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz abcdefghijklmnopqrstuvwxyz\[\{\]<\[]£\¥\±\%\®\±\±\&\%\±\±\±

12 point Bold

ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz abcdefghijklmnopqrstuvwxyz\[\{\]<\[]£\¥\±\%\®\±\±\&\%\±\±\±

12 point Bold Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz abcdefghijklmnopqrstuvwxyz\[\{\]<\[]£\¥\±\%\®\±\±\&\%\±\±\±
Optima

Optima is a sans-serif typeface that can be used in a wide variety of applications. It goes well with both other sans-serif and serif fonts. Notice that, unlike Helvetica, Optima has an uneven line weight.

24 point

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Palatino

Palatino is an elegant typeface, useful for display headlines and body text. We like it so much we chose it for this book.

18 point Roman

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Roman

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

12 point Bold Italic

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
ITC Souvenir

Souvenir, with its small serifs and round curves, has a muted effect that is pleasing in large amounts of copy. Use it for display as well, especially in applications that require an informal look.

18 point Roman
ABCDEFGHJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
12 point Roman
abcdefghijklmnopqrstuvwxyz
12 point Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
de
12 point Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
de
12 point Bold Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
de

Symbol

Symbol contains a Greek alphabet and the mathematical symbols that are used in typesetting equations. Word provides the %-SHIFT-Q shortcut for typing the next character in the Symbol font.

18 point
ABXΔΕΦΓΗΙΩΚΛΜΝΟΠΘΡΣΤΥϕΩΞΨαβχδεφηηιικλμνπθ
θρστυωξυς1234567890
⊕ ρΚΞ≡ ∞∂⊗♠♥♦∅→≠⊥≠≤
>'f∞≈…↑∧⇔⇐⇑±∪Π÷√\|\Sigma≤L
{ |}→{ |}..} \|\x
Times

Times is a workhorse that serves well almost anywhere. It is slightly condensed, so you can pack more text into the space than with most other fonts. The strokes of the letters are relatively heavy, so Times can survive adverse printing conditions.

18 point Roman

```
ABCDEFGHIJKLMabcdefghijklmno
```

12 point Roman

```
ABCDEFGHIJKLMNOPQRSTUVWXYZ
defghijklmnopqrstuvwxyz
```

12 point Italic

```
ABCDEFGHIJKLMNOPQRSTUVWXYZ
defghijklmnopqrstuvwxyz
```

12 point Bold

```
ABCDEFGHIJKLMNOPQRSTUVWXYZ
defghijklmnopqrstuvwxyz
```

12 point Bold Italic

```
ABCDEFGHIJKLMNOPQRSTUVWXYZ
defghijklmnopqrstuvwxyz
```

ITC Zapf Chancery

Zapf Chancery flows over the page like fine calligraphy, completely surprising from a computer. Use it for awards, invitations, poetry, or love letters.

18 point

```
ABCDEFGHIJKLMabcdefghijklmno
```

14 point

```
ABCDEFGHIJKLMNOPQRSTUVWXYZ
defghijklmnopqrstuvwxyz
```

12 point

```
ABCDEFGHIJKLMNOPQRSTUVWXYZ
defghijklmnopqrstuvwxyz
```

1234567890<]]]>$%^*+\>[]-!@#$%
ITC Zapf Dingbats

Zapf Dingbats provide a wealth of bullets, symbols, and graphics to use in places where a graphic will communicate what you want to say better than words.

18 point

12 point
<table>
<thead>
<tr>
<th>Font Family Name</th>
<th>PostScript Name</th>
<th>Macintosh Screen Font Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITC Avant Garde</td>
<td>AvantGarde-Book</td>
<td>Avant Garde</td>
</tr>
<tr>
<td>(LaserWriter Plus)</td>
<td>AvantGarde-BookOblique</td>
<td>I Avant Garde BookOblique</td>
</tr>
<tr>
<td></td>
<td>AvantGarde-Demi</td>
<td>B Avant Garde Demi</td>
</tr>
<tr>
<td></td>
<td>AvantGarde-DemiOblique</td>
<td>BI Avant Garde DemiOblique</td>
</tr>
<tr>
<td>ITC Bookman</td>
<td>Bookman-Demi</td>
<td>B Bookman Demi</td>
</tr>
<tr>
<td>(LaserWriter Plus)</td>
<td>Bookman-Demiltalic</td>
<td>BI Bookman Demiltalic</td>
</tr>
<tr>
<td></td>
<td>Bookman-Light</td>
<td>Bookman</td>
</tr>
<tr>
<td></td>
<td>Bookman-LightItalic</td>
<td>I Bookman LightItalic</td>
</tr>
<tr>
<td>Courier</td>
<td>Courier-Bold</td>
<td>B Courier Bold</td>
</tr>
<tr>
<td>(LaserWriter)</td>
<td>Courier-BoldOblique</td>
<td>BI Courier BoldOblique</td>
</tr>
<tr>
<td></td>
<td>Courier-Oblique</td>
<td>I Courier Oblique</td>
</tr>
<tr>
<td></td>
<td>Courier</td>
<td>Courier</td>
</tr>
<tr>
<td>Garamond</td>
<td>Garamond-Bold</td>
<td>B Garamond Bold</td>
</tr>
<tr>
<td>(Downloadable)</td>
<td>Garamond-BoldItalic</td>
<td>BI Garamond BoldItalic</td>
</tr>
<tr>
<td></td>
<td>Garamond-Light</td>
<td>Garamond</td>
</tr>
<tr>
<td></td>
<td>Garamond-LightItalic</td>
<td>I Garamond LightItalic</td>
</tr>
<tr>
<td>Goudy</td>
<td>Goudy-Bold</td>
<td>B Goudy Bold</td>
</tr>
<tr>
<td>(Downloadable)</td>
<td>Goudy-BoldItalic</td>
<td>BI Goudy BoldItalic</td>
</tr>
<tr>
<td></td>
<td>Goudy-Italic</td>
<td>I Goudy Italic</td>
</tr>
<tr>
<td></td>
<td>Goudy</td>
<td>Goudy</td>
</tr>
<tr>
<td>Helvetica</td>
<td>Helvetica-Bold</td>
<td>B Helvetica Bold</td>
</tr>
<tr>
<td>(LaserWriter)</td>
<td>Helvetica-BoldOblique</td>
<td>BI Helvetica BoldOblique</td>
</tr>
<tr>
<td></td>
<td>Helvetica-Oblique</td>
<td>I Helvetica Oblique</td>
</tr>
<tr>
<td></td>
<td>Helvetica</td>
<td>Helvetica</td>
</tr>
<tr>
<td>Helvetica Narrow</td>
<td>Helvetica-Narrow-Bold</td>
<td>NB Helvetica Narrow Bold</td>
</tr>
<tr>
<td>(LaserWriter Plus)</td>
<td>Helvetica-Narrow-BoldOblique</td>
<td>NB Helvetica Narrow BoldObli</td>
</tr>
<tr>
<td></td>
<td>Helvetica-Narrow-Oblique</td>
<td>NI Helvetica Narrow Oblique</td>
</tr>
<tr>
<td></td>
<td>Helvetica-Narrow</td>
<td>N Helvetica Narrow</td>
</tr>
<tr>
<td>Font Family Name</td>
<td>PostScript Name</td>
<td>Macintosh Screen Font Name</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>NewCenturySchlbk-BoldItalic</td>
<td>BI New Century Schlbk BoldItalic</td>
</tr>
<tr>
<td></td>
<td>NewCenturySchlbk-Italic</td>
<td>I New Century Schlbk Italic</td>
</tr>
<tr>
<td></td>
<td>NewCenturySchlbk-Roman</td>
<td>New Century Schlbk</td>
</tr>
<tr>
<td><strong>Optima</strong> (Downloadable)</td>
<td>Optima-Bold</td>
<td>B Optima Bold</td>
</tr>
<tr>
<td></td>
<td>Optima-BoldOblique</td>
<td>BI Optima BoldOblique</td>
</tr>
<tr>
<td></td>
<td>Optima-Oblique</td>
<td>I Optima Oblique</td>
</tr>
<tr>
<td></td>
<td>Optima</td>
<td>Optima</td>
</tr>
<tr>
<td><strong>Palatino</strong> (LaserWriter Plus)</td>
<td>Palatino-Bold</td>
<td>B Palatino Bold</td>
</tr>
<tr>
<td></td>
<td>Palatino-BoldItalic</td>
<td>BI Palatino BoldItalic</td>
</tr>
<tr>
<td></td>
<td>Palatino-Italic</td>
<td>I Palatinoitalic</td>
</tr>
<tr>
<td></td>
<td>Palatino-Roman</td>
<td>Palatino</td>
</tr>
<tr>
<td><strong>ITC Souvenir</strong> (Downloadable)</td>
<td>Souvenir-Demi</td>
<td>B Souvenir Demi</td>
</tr>
<tr>
<td></td>
<td>Souvenir-Demilight</td>
<td>BI Souvenir Demilight</td>
</tr>
<tr>
<td></td>
<td>Souvenir-Light</td>
<td>Souvenir</td>
</tr>
<tr>
<td></td>
<td>Souvenir-LightItalic</td>
<td>I Souvenir LightItalic</td>
</tr>
<tr>
<td><strong>Symbol</strong> (LaserWriter)</td>
<td>Symbol</td>
<td>Symbol</td>
</tr>
<tr>
<td><strong>Times</strong> (LaserWriter)</td>
<td>Times-Bold</td>
<td>B Times Bold</td>
</tr>
<tr>
<td></td>
<td>Times-BoldItalic</td>
<td>BI Times BoldItalic</td>
</tr>
<tr>
<td></td>
<td>Times-Italic</td>
<td>I TimesItalic</td>
</tr>
<tr>
<td></td>
<td>Times-Roman</td>
<td>Times</td>
</tr>
<tr>
<td><strong>ITC Zapf Chancery</strong> (LaserWriter Plus)</td>
<td>ZapfChancery-MediumItalic</td>
<td>Zapf Chancery</td>
</tr>
<tr>
<td><strong>ITC Zapf Dingbats</strong> (LaserWriter Plus)</td>
<td>ZapfDingbats</td>
<td>Zapf Dingbats</td>
</tr>
</tbody>
</table>
APPENDIX E

ABOUT FONT SIZES

Once you begin exploring typefaces and the way they print, you discover strange things about the sizes of letters. Because typography has conventions and traditions that date back hundreds of years, the point-and-pica system of type measurement doesn’t correspond exactly with inches or centimeters. After clearing the fog that surrounds measuring letters and the space between lines of type, we’ll look at the relationship between the size of type and how many words you can fit on a page. Smaller type, more words? Not always. Finally, we’ll show what effect font substitution has on word spacing and why you should always format your document in a PostScript font when printing on a laser printer.
The Truth about Points and Picas

We have said that 72 points is about 1 inch. How close is about? Our dictionary claims that in the United States, 1 point is defined as 0.013835 inch. (The unit is defined differently in continental Europe.) Multiply by 72 and you get 0.99612 inches—very close to 1, but an inch contains a small fraction of a point more than 72. Twelve points equal 1 pica, so there are almost exactly 6 picas per inch.

On a ruler that has scales in inches and in picas, you can easily see the accumulated difference—about \( \frac{1}{16} \) inch in 18 inches. Typesetters have stuck to using points and picas for measuring text because they are more convenient units than inches. You can get used to using points and picas by setting Word's default measurement system to points with the Preferences... command in the Edit menu.

The Size of Letters

Let's return to fonts and type and ask whether 12-point Helvetica is exactly 12 points tall. The answer is no. In fact, you can look at the type samples in Appendix D and see that the same letters in the same point size in different fonts have different heights. How can this be?

There are a number of factors that make font-size arithmetic so problematic. One of them is a historical accident. Point sizes for various typefaces are the sizes of the pieces of lead individual letters were originally cast in, not the sizes of the letters themselves. Some fonts used more of their lead than others; they are actually taller than other fonts of the same point size. But all 12-point letters must be smaller than 12 points tall.

Of course, it matters which letter we are talking about. Since the lead had to account for lowercase letters with descenders as well as uppercase letters, the point size is actually the maximum ascent plus the maximum descent plus whatever lead was left over. Thus, a capital E is usually about two-thirds of the point size, that is, a 12-point E is about 8 points tall, depending on the font.
Leading

In the days of lead type, leading (pronounced "ledding") referred to little strips of lead inserted between rows of type in order to spread the lines apart and improve readability. If you put 2 points of lead between 12-point type, you would say that your type was set 12/14, or 12 on 14. The 14 was measured between the baselines of the characters (in real points).

We still use this same terminology. It’s important to remember that the first number does not translate directly into the size of the characters, but the second number really does describe the vertical spacing. Thus, 12/14 type set in different fonts will have different amounts of vertical space between the letters but the same number of lines per inch.

As we showed in Chapters 10 and 17, you can set the space between lines in the Paragraph dialog box. Word’s default is Auto, but the spacing for Auto is different for different fonts. For example, ten lines of 12-point Palatino take up more vertical space than ten lines of 12-point Times because the automatic line spacing is different.

Typewriter Terms—Pica, Elite, and Pitch

The word pica may be a familiar one to you from your typewriter days. Pica, in typewriter terms, refers to type with a true height of 12 points between the top of an ascender and the bottom of a descender. (Another typewriter term, elite, refers to type with a true height of 10 points.) Pica type produces six lines to the inch, which is the typewriter standard.

Another term that can mess you up is pitch. Pitch refers to the number of characters that fit in a horizontal inch and is a sensible measurement only for a monospaced font. By a confusing coincidence, pica type has a pitch of ten characters per inch while elite’s pitch is twelve characters per inch.

What Happens with Font Substitution

We wrote briefly about font substitution in Chapter 5. We want to elaborate on it here; we see many documents whose authors don’t fully understand the implications of this feature.
Font substitution is an option in the **Page Setup** dialog box, and its default setting is On. With font substitution, New York is converted to Times, Geneva to Helvetica, and Monaco to Courier. It may seem like a good thing for Word to give you an attractive PostScript font when you have been writing in a bit-mapped one, but there are problems. Figure E.1 shows how much these pairs differ in true size when they are set to 12 points.

<table>
<thead>
<tr>
<th>Font</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>New York</td>
<td>Dear Clara, this has to end.</td>
</tr>
<tr>
<td>Times</td>
<td>Dear Clara, this has to end.</td>
</tr>
<tr>
<td>Geneva</td>
<td>I've been a heel, I know.</td>
</tr>
<tr>
<td>Helvetica</td>
<td>I've been a heel, I know.</td>
</tr>
<tr>
<td>Monaco</td>
<td>You won’t see me again.</td>
</tr>
<tr>
<td>Courier</td>
<td>You won’t see me again.</td>
</tr>
</tbody>
</table>

*Figure E.1: 12-point text in bit-mapped fonts and their PostScript surrogates*

In the case of 12-point New York, for example, the New York text is so much bigger that the Mac substitutes 14-point Times in order to make the size come out closer—but it just can’t match exactly.

**Why Font Substitution Looks Strange**

Not matching exactly turns out to be a big problem, because Word tries to adjust the space inside the words to make the line breaks come where they did with the original font. After deciding what font to substitute for yours, Word does its best to put every letter of the new font where the corresponding letter of the old would have been. You can see the consequences easily. After this has happened to you a few times, you’ll look at text like that on the left in Figure E.2 and ask yourself, “why did they type this in New York?”

Don’t distract your readers—use genuine PostScript fonts when you print.
Dear Clara, this has to end. Please don’t come after me. I’ll be leaving IA, so you won’t have to see me any more. I’ve been a heel, I know. Things just haven’t worked out right with us. It’s nothing you’ve done; there’s nothing you can do. You won’t see me again. -V

Dear Clara, this has to end. Please don’t come after me. I’ll be leaving IA, so you won’t have to see me any more. I’ve been a heel, I know. Things just haven’t worked out right with us. It’s nothing you’ve done; there’s nothing you can do. You won’t see me again. -V

Figure E.2: Two versions of the same note. The one on the left was formatted in New York 12 and printed with font substitution. The one on the right is in Times 14. Notice the letter spacing in the left-hand example.

**Real Italics and Real Bold**

When you saw the PostScript names of fonts in Appendix D, you saw that the italic and bold versions of the fonts had their own separate names (for example, Palatino-Italic). We also listed the names of the Macintosh screen fonts (for example, I Palatino Italic) that correspond to these PostScript variations.

Apple supplies only Palatino-Roman with the LaserWriter. Do you have to have I Palatino Italic installed in order to get the genuine article? Yes and no. If you have vanilla Palatino installed on your system, the Mac fakes an italic for your screen by slanting the letters. When Word sends the text to the LaserWriter, it substitutes the genuine PostScript Palatino-Italic font for the italicized words. But just as before, it tries to locate the letters as close as possible to where they appear on the screen.

Is that so bad? In the case of Palatino, the true italic type is narrower than the corresponding roman type. That means that there will be more space between letters than necessary if you print italic passages without using the italic screen font.
Oh, no. Do you have to change fonts every time you want to italicize something? Miraculously, no. If the font is in your system, the Mac automatically shifts to the appropriate font for your screen when you italicize. The same holds true for boldface and for the italic-bold combination.

So get yourself some italic and bold versions of your favorite fonts and install them. This business of quadrupling the number of fonts you use is a natural for a desk accessory like Suitcase, by the way. It's only disk space.
APPENDIX F

WHAT'S NEW IN VERSION 4?

You will be able to use Version 4 to edit your Word 3 documents, and you can do anything in Version 4 you could in Version 3—though it may sometimes be hard to find the command. If you've used Word only for simple word processing, you won't notice many differences; but if you're experienced at using styles and doing fancy formatting, you'll find answers to some of your frustrations—and some pleasant surprises—in Word Version 4. This appendix describes four of the most important enhancements: customizability of menus and keyboard shortcuts, access to styles from the ruler, tables, and positioned objects. You can read at length about these and other new features in Chapter 1 of Getting Started with Microsoft Word, which came with your software.
Customization

Word's designers have done a good job arranging the important commands sensibly on menus and assigning them keyboard shortcuts. Even so, you may be uncomfortable with Word's default assignments. After all, Word has many more commands than will fit on the menus. You may have a favorite that you'd like to add, or a useless one you'd like to remove. You can also assign and reassign keyboard shortcuts to any command.

The easy way to adjust your menu choices is with the newly expanded `⌘-OPTION- +` (Add to Menu) and `⌘-OPTION- -` (Remove from Menu) commands. In Version 3, they maintained only the Work and Font menus. In Word 4, you can remove any item with Remove from Menu and add items to Font, Format, and Work with Add to Menu. (To add to other menus, you have to use Commands...)

The basic method is this: use `⌘-OPTION- +` to get a ✪ cursor. Then use that cursor to invoke a command, such as Keep Lines Together. Presto! The command appears on a menu.

What about keyboard shortcuts? If you're tired of the command for small caps being `⌘-SHIFT-H`, you could change it to something else. Or if you want the Format Section command to have a keyboard shortcut, such as `⌘-CONTROL-S`, you can arrange that. Use Assign to Key (also `⌘-OPTION- +`, but this time the + is on the keypad) and issue the command. Word will prompt you to type the key combination.

The keyboard combinations must include `⌘` and one normal key, and may include one or more of SHIFT, OPTION, and CONTROL, up to a maximum of four keys. Word now uses the symbols shown in Figure F.1 when describing keyboard shortcuts.

<table>
<thead>
<tr>
<th>Command (a.k.a. clover)</th>
<th>Shift</th>
<th>Right arrow</th>
<th>Escape</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td></td>
<td>Enter</td>
<td>Space</td>
</tr>
<tr>
<td>Control</td>
<td></td>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tab</td>
<td>Return</td>
</tr>
</tbody>
</table>

Figure F.1: The semiotics of the menu bar. Word uses these symbols to display keyboard combinations.

The most comprehensive tool for changing menu and key combinations is the Commands... dialog box. Look for it in the Edit menu; a
What's New in Version 4?

A sample appears as Figure F.2. There, you can select the command you want from an alphabetized list box, select the menu you want to add the command to (Word will have a default suggestion) or remove it from, and assign or deassign key combinations. Word will make sure you don't assign the same keys to two commands; for example, if you want to assign % I as well as % SHIFT-I to the Italic command, Word will ask if you want to remove % I from Print Preview.

We've decided to add the Side by Side command to a menu.

If we add the command, it will appear on the Format menu by default.

This button actually adds the command to the menu.

Clicking here will prompt us for a key combination.

---

**Figure F.2**: The Command dialog box, showing a few of the many commands you can add to menus—even the now-obsolete Side by Side!

---

**Styles on the Ruler**

There's a new little box on the ruler, toward the left-hand side; it's called the style selection box. You can see it in Figure F.3. Like the style box in the status area (the box to the right of the page number at the bottom of the window), it displays the name of the current style. But it has more uses:

- If you press the arrow to its right, the style selection box becomes a menu of style names. Select one to apply it to the current
paragraph.

- Suppose you want to change a style definition. Reformat a paragraph of that style, click in the box, and press RETURN or ENTER. Word will ask if you want to reapply the style—undoing your work—or redefine it. Redefining the style will make the change global in your document.

- Suppose you want to define a new style. Create a paragraph like the one you want, click in the style selection box to highlight it, type the name of the new style, and press RETURN or ENTER. Word will ask if you want to define the new style. If you do, the style definition will describe the paragraph you just made; it will be based on the original style of the paragraph.

This new feature of the ruler will let you make most of your style definitions and adjustments without the dreaded Define Styles dialog box. That one works the same as in Version 3 and is still indispensable for complex definitions and sorting out the style inheritance tree.

![Figure F.3: The new ruler, showing the style selection box](image)

### Tables

Tables are probably the single most wonderful feature of Word. They make many uses of side-by-side paragraph formatting obsolete, which is a relief, as you know if you ever used it. Positioned objects, whose description follows, finish off the Side by Side feature for good.

Tables essentially let you put paragraphs inside boxes called cells, which are arranged in rectangular arrays. You can control the size of each cell and what kind of border it gets.
Tables are so intuitive that we won’t tell you how to use them here; check out Chapter 7 for an introduction and Chapter 10 for more detail. The manual helps, too. The down side of tables is that it’s sometimes hard to remember just which table command you want or how to find it. But you can customize Word to fix that.

Figure F.4 shows an Insert Table dialog box from the Document menu with which we’re about to create a three-column, seven-row table.

![Insert Table Dialog Box]

**Figure F.4: A sample Insert Table dialog box**

### Positioned Objects

Some of us think that positioned objects are even niftier than tables. They are, however, less intuitive, harder to learn about, and implemented in a more Byzantine manner. But what are they?

Normal text, tables, and graphics flow from left to right and from top to bottom. If you add something in the middle of a document, everything after it moves down to make room. But you can fix the position of an object so that it appears in the same place, no matter what normal material is around it.

For example, if you have a graphic that you want to appear in the top-right corner of a page, you can specify that, and text will wrap
around it. You can see the Position dialog box to do that in Figure F.5.
(You get to it from the Format menu.)

An indispensable feature of Word’s positioning is that you don’t have to specify the position in both dimensions. If you want, you can specify it in the horizontal direction only, leaving the vertical specification reading, “In Line.” That means that the positioned object appears vertically wherever it is in the file, but horizontally wherever you specify it. This feature is great for drop caps and side headings.

We introduced Positioned objects in Chapter 8 and use them extensively in subsequent chapters, notably Chapter 11 (wrapping text around illustrations), Chapter 12 (drop caps), and Chapter 14 (side headings as positioned objects).
APPENDIX G

BIBLIOGRAPHY

A rapidly expanding literature exists for the emerging field of desktop publishing. In this appendix we list a few good books and articles that will help you grow in understanding how to use computers effectively in designing and laying out documents.
Design and Desktop Publishing

The books we've included here will educate your designer's eye and provide you with insight into the many things you can do with desktop publishing. The magazine articles, though introductory in nature, deal with current problems and solutions for desktop publishing on the Macintosh.


From the people who created PageMaker, this lovely little book will draw you into the wonderful world of page design with the best examples we've seen anywhere.


Without pinning itself to any particular software or hardware, the excellent collection of articles in this book presents an overview of the entire field, including a discussion of the comparative costs of desktop publishing versus conventional typesetting that is helpful and sobering.


The pages of this 8 1/2-by-11-inch, spiral-bound book contain many well-commented examples of everything from typefaces to binding. Refer to it for inspiration and information.


This is a book of recipes based on PageMaker. But no matter what software you are using, you will find good ideas for layout and interesting background information.


This special supplement to *MacUser* has articles about various software, pointers on setting up a type shop, and a directory of publishers of desktop publishing software.
This introductory article contains useful information about using the various laser-printer shops.

Here you have an introduction to using PostScript fonts on the Mac. A lot of questions remain unanswered, though.

**PostScript**

If you were titillated by the little bit of PostScript programming we have done in this book, here are the books to take you further. These books all require at least some experience in programming. We haven’t seen an introduction to PostScript for the novice.


Though technical in scope and style, this book proceeds in a leisurely, readable manner through a thorough introduction to the PostScript language.


This well-written manual has the complete description of programming in PostScript, a few examples, and a useful appendix on the Apple LaserWriter.


A companion to the reference manual, this book is, as its name proclaims, a tutorial with thoroughly explained examples of all of the kinds of things you would want to do with PostScript.
Writing

As you do desktop publishing, you will also remain concerned with basic writing techniques and styles.


If your desktop publishing involves any writing, read (or reread) this classic. Fewer than one hundred pages long, the examples of use and misuse of the language and suggestions on how to improve your writing style are timeless and valuable.


Are you trying to decide whether to use an em dash or an en dash, how to punctuate a bibliography, or how to create a comprehensive index? This is the book for you.
INDEX

A

Abstracts
for articles, 316
for proposals, 258
Again command (⌘-A), 209
find format again (⌘-OPTION-A), 272
Apostrophes, 418
Apply button in character dialog box, 202
Applying styles. See Styles
Arrays and matrices in mathematical formulas, 322
Arrow keys in outlining, 131, 134
Articles, 309–333
ASCII codes, inserting characters by, 340
Asymmetry, 34–36
Automatic styles, 135
displaying, 146
footer, 327
footnote, 322, 325
header, 293
heading, 135, 341
PostScript, 387
toc, 279, 360

B

Back-to-back printing, 284
Bit maps, 171–173, 339
Bleeding to the paper edge, 467–469
Boldface (⌘-SHIFT-B), 233
fonts, 511–512
Books, creating simple, 283–306
Borders, 36–39. See also Cell borders;
Paragraph borders
alignment of, table cell and paragraph, 239
Boxes, 38. See also Cell borders;
Paragraph borders
around words, 322
Brackets in mathematical formulas, 320
Brochures, 191–217
Bulleted lists, 52–63
elements, 53, 58, 61, 354, 464
nesting, 57
Bullets, 50
creating, 52
denoting automatic styles, 135
in style lists, 135
Calculation within Word, 245–246
Camera-ready copy, 310
Captions. See also Figures
split, 274
styles for, 267, 317, 405
Cell borders
drop shadow, 239
removing, 234
underlining, 243
Cell Borders dialog box, 232
adding as menu command, 247
examples, 228, 234
how to use, 228
Cells. See also Tables
cutting and pasting, 151
deleting last paragraph in, 152
end-of-cell markers, 145
indents inside, 149
tabs inside, 231
Cells dialog box, 228, 232
Centering. See also Justification
graphics, 180, 183
with positioned text, 379–380
Centering (continued)
with PostScript, 391–394, 436
problems with, 112
Character dialog box
Apply button, 202
examples, 165, 179, 202–203
Character formats
applied to graphics, 165
applied to picture font, 171
basics of, 490
boldface, 233
design considerations, 28–30, 463
expanded, 202, 377, 379
global changes, 471–472
gotchias, 369
italic (⌘-SHIFT-I), 490
lack of stylesheet for, 463, 494
outline, 379, 404
shadow, 377
small caps (⌘-SHIFT-H), 202, 297, 377
subscript and superscript, 166
underline (⌘-SHIFT-U), 139, 165
white-on-black, 377, 494
Check boxes, how to make, 440
Checklists
for indexing, 471
for layout, 312
for printing, 458
Chicago Symbols font, 341
Chooser desk accessory, 80, 299, 422
Clicking, 482
Clip art, 170, 176
Clipboard, 162, 489
Clover symbol, typesetting of, 340–341
Columns (continued)
changing the number of, 196–199, 236,
314, 431
controlling breaks between, 115, 331
evening out, 213, 332–333, 408, 431
filling with gray, 445
multiple, 99–101, 155, 223–226, 403
space between, 101
Commands (continued)
in tables, 157, 225, 230
using outdented paragraphs, 224, 264
using tabs, 224
vertical lines between, 445
Command key. See Clover symbol or
individual commands
Commands dialog box, 187, 515
Comparing documents, 255
Coordinates from print preview, 388
Copy (⌘-C), 489
Crop marks. See Registration marks
Cursor, 486
finding, 348
moving, 487
Customization, 473, 514–515
adding keyboard commands, 122, 186
adding menu commands, 89, 186,
218–219, 247
Cut (⌘-X), 489
D
Dashes, em and en, 420
Dates
in glossary items, 73
in headers, 292
Decimal tabs, 230
Default styles, 435–436
Define Styles dialog box
avoiding, 516
Cancel button, 86
Define button, 85–86
examples, 136, 435
importing styles with, 90, 253, 302
Next Style box, 137
OK button, 85
printing style definitions with, 253, 459
reverting to “Based On” style, 210, 293
Deleting text, 487
Descenders, 508
problems with, 298
Index 525

Design considerations, 23, 450
  balance, 34, 36, 119, 122
  boxes, 38–39
  for bulleted lists, 63
  busyness, 28–30, 118
  character styles, 28–30, 463
  columns, 31
  and “computer look,” 172
  consistency, 40–41, 255
  folding, 192
  fonts, 24–25, 28–30, 83, 311
  form and function, 128
  grids, 32
  headings, 25–28, 200, 204
  line length, 31
  line thickness, 227
  for manuals, 338
  relative importance of elements, 118, 409
  for a report, 402
  ruled lines, 36–38
  separating header from body, 292
  symmetry and asymmetry, 34–36, 154, 256–257, 311
  tables, 222
  three stages of proofing, 79
  vertical positioning, 114
  vertical space, 119
  white space, 32–34, 71, 258, 402

Desk accessories
  Chooser, 299, 422
  Comment, 255
  Key Caps, 61, 340
  Scrapbook, 162
  Suitcase, 512

Desktop, 482

Desktop publishing, 13
  cost of, 18
  history of, 13–17
  learning, 4, 18
  as a misnomer, 68

Dictionaries. See also Spell checking
  creating, 329
  main, 328
  saving, 331
  user, 328–331

Dingbats, 60, 503

Disk drives, 478

DocuComp, 255

Document dialog box
  Even/Odd Headers option, 289, 403
  examples, 99, 195, 313, 452
  Mirror Even/Odd Margins option, 289, 455
  Next File button, 303, 469
  Number Pages From field, 302, 327, 469
  specifying facing pages in, 289, 403
  specifying footnote position in, 313
  specifying gutter width in, 289, 403
  specifying margins in, 99
  Widow Control option, 213

Documents
  levels of formatting, 99
  organization of, 46
  when to divide into sections, 410

Double-clicking, 482, 488

Dragging, 482

Drop caps, 297–299

E

Editing text, 487

Em and en dashes, 420

Event programs, 95–121

Excel
  graphics from, 265–268
  links with spreadsheets, 269–271

F

Facing pages, 283–286, 403–404
  setting in Document dialog box, 289
Figures
- lists of, 470
- screens for, 443
- styles for, 267, 318, 405

Files, 482–483
- linking, 469
- sequences of, 303, 362

Fill (PostScript command), 413
Finding character and paragraph formatting (CTRL-OPTION-R), 272
Finding the cursor (CTRL-OPTION-Z), 348
First Page Special option, 276, 290, 315, 383
Fliers, 161–187
Folded paper, designing for, 193

Font examples
- Avant Garde, 24, 376, 496
- Bookman, 14, 256, 496
- Cairo, 170
- Carta, 171
- ChicagoSymbols, 341
- Courier, 83, 139, 497
- Garamond, 497
- Goudy, 498
- Helvetica, 14, 24, 177, 498
- Helvetica Narrow, 8, 499
- New Century Schoolbook, 25, 499
- Optima, 500
- Palatino, 193, 500
- Souvenir, 501
- Symbol, 501
- Times, 14, 24, 83, 153, 193, 502
- Zapf Chancery, 14, 502
- Zapf Dingbats, 52, 503

Font substitution, 83, 510
Fonts, 495–503, 507–512
- changing Normal, 84
- decreasing size (CTRL-SHIFT-<), 196
- global changes, 471–472
- headings, as used in, 26

Imagewriter and LaserWriter
- compared, 82
- increasing size (CTRL-SHIFT->), 196

Footnotes
- dialog box examples, 323
- in Document dialog box, 313
- effect on columns, 333
- size of reference numbers, 326
- split windows with, 323

Formatting problems
- balance, 407
- centering text, 112
- columns of different widths, 350, 353, 493
- difficult layouts, 432
- drop caps, 298
- filling space, 121, 212, 407
- headlines above multiple columns, 431
- horizontal positioning, 111
- leaving room for a graphic, 167, 211, 404
- misaligned first lines, 146, 408
- positioning graphics, 178–180
- pull quotes, 442–443
- side headings, 142, 350–353
- uneven column bottoms, 332, 333
- uneven column tops, 408
- vertical justification, 332–333, 494
- vertical positioning, 114
- white text on a black background, 378–381
- wrapping text around a graphic, 177, 265, 493

Fonts (continued)
- installing, 85
- picture fonts, 170–171
- serif and sans serif, 24
- size arithmetic, 296, 416
- sizes, 25–28, 31, 311, 508
- substitution, 83, 509
- texture, 24
- too many on a page, 28, 118

Footers, 315, 326–327. See also Headers
Footnote dialog box, 323
Forms, 221–247
Formulas
  examples, 321, 381
  styles for, 318
  typesetting, 319–322
  for white text on black, 381
Fractional widths, 420–421
Fractions in mathematical formulas, 319–320
Full Menus command, 70, 90, 435

G

Galley view, 78, 109
  compared to other views, 129
  headers in, 291
Galleys, 493
Glossaries
  clutter in, 445
  date item, 73
  examples of use, 341, 369, 443, 445, 460
  how to use, 60–63
  installing on Work menu, 62
  master for large projects, 460
  for PostScript, 445
Graphics
  applying character formats to, 165
  converting text to, 298
  cropping, 167, 298
  distorting, 168
  draw art, 173–175
  fixing location on page, 493
  frames for check boxes, 440
  how Word treats graphics, 164
  importing from SuperPaint, 377
  limitations in Word, 169
  mixed with text, 178–184, 258–269
  object-oriented, 173
  paint layer of SuperPaint, 171
  pasting, 162–164
  picture fonts, 170–171
  positioning, 178–180

Graphics (continued)
  reserving space for, 167–168, 211, 404
  resizing, 166–167
  screens behind text, 377–381, 493
  sources for, 170–176
  stretching and shrinking, 168–169
  subscripting, 166
  in table cells, 240
  whether to paint or to draw, 175
  for white-on-black text, 494
  wrapping text around, 177, 179–180,
  265–268, 493
Gray scale, 172
Gray screens, 443–444, 493
Gray text, 388–396, 439–440
Grids, 32, 255
Group projects
  cooperative writing, 252
  and template files, 457
  use of hidden text in, 252–255
Gutters, 285, 289, 403–404

H

Hairlines, 241
  for cell borders, 227, 229
  for paragraph borders, 207
Half-tones, 172
Handles on graphics, 165–169
Header windows, 291–292
Headers, 283, 290–294
  absent from first page, 285
  changing within a document, 410
  compared to headings, 409
  on the Document menu, 289–291
  galley view vs page view, 291
  getting the wrong header, 412
  overlapping regular text, 385
  page numbers in, 292
  in page view, 294
  placement on page, 293
  PostScript in, 413–418
Headers (continued)
in print preview, 294
problems in multiple files, 461
repositioning, 294
styles for, 293, 411
when to design, 410
Headings. See also Outlining
  brochure, 200–207
  compared to headers, 409
  design considerations, 25–28
  hierarchical, 25–28, 357–359
  numbering, 357–359
  purpose of, 252
  side headings, 352
Headlines. See Headings
Help, on-line, 197, 490
Heresies
  inserting hard page breaks, 275
  staying Normal, 76
  using spaces for positioning, 51
Hidden text (%-SHIFT-X), 254
  appearance on screen, 255
  for comments, 253–255
  for indexing, 362
  making visible, 254
  for PostScript, 387
  printing, 255
  for table-of-contents entries, 304
  uses of, 410
Hierarchical numbering, 357–359
Hyperfontia, 28–29
Hyphenation
  automatic, 299–301
  effect on column length, 407
  guidelines for, 301, 331
  manual, 216–217
  optional hyphen (%-HYPHEN), 217
Imagesetters, 172–173, 422–424, 469
Indents, 47
  compared to margins, 49
  design considerations, 27
  first line, 48
  left and right, 48
  inside table cells, 149
Indexing
  checklist for, 471
  conventions, 364–365
  cross-references, 366–368
  dialog box example, 364
  formats, 363
  gotchas, 368–369, 470
  Insert Index Entry command, 362
  page number formats, 366
  page ranges, 365–366
  subentries, 363, 365
Inheritance, 75–76, 465
Insert Graphics command, 168, 392
Insert Table command
  dialog box, 144, 227, 232, 517
  problems with, 150
Integrals in mathematical formulas, 322
Invoices. See Forms
Italics (%-SHIFT-I), 272, 490
  fonts, 511
J
Justification
  centering, 106, 138
  effect on word spacing, 216
  gotchas, 332
  right, 234
  with rulers, 86
  vertical, 494
K
Keep Lines Together, 274–275, 318, 466
Keep With Next, 273–274, 318, 465
Key Caps desk accessory, 61, 340
Keyboard commands
  customizing, 122, 186, 473, 514
  symbols for, 514
Keyboards, 478

Labels
  for table columns, 232
  for table rows, 238
Landscape orientation, 98
Large projects, 449–473
LaserWriter, 16, 478
  limitations of, 466
  printing near the edge, 431, 467
LaserWriter Options dialog box, 432
Leading, 509. See also Line spacing
Left margin, putting text in, 351–352, 381–385
Letterheads, 375–399
Letters, 67–91
Level styles, default definitions of, 135
Ligatures, 419–420
Line spacing, 509
  negative, 442
  problems with, 442
  setting with ruler, 120
Lines. See Paragraph borders;
  Cell borders
Linotronic printers. See Imagesetters
Long documents, 301–305, 469–470
  file sequences for, 303, 470
  page numbering in, 302

Macintosh
  assumptions about using, 4
  basic skills, 481–490
  metaphor, 4, 482
Macros, 460

Manuals, 337–369, 480
Margins
  compared to indents, 49
  for folding, 193
  mirrored, 455
  in print preview, 81
  problems with changing, 462
  relationship to working area, 98–99
Mastheads, 430, 436–439
Mathematical typesetting. See Formulas
Mathematics, 245–246
Measurement
  converting, 388, 468
  leading, 509
  page coordinates in print preview, 388
  points, inches, and centimeters, 508
  sizes of letters, 508
Menus
  adding commands to (%-OPTION-+), 514
  choosing commands from, 484
  customizing, 89–90, 186, 218, 247, 514
  with Full Menus command, 70
  removing commands from
    (%-OPTION- -), 514
  Work menu, 89, 247
Mouse pointers, 486–487
Multifile documents. See Long Documents
MultiFinder, 163, 479
  background printing, 303
  examples, 164
  use with SuperPaint, 339

N

Naming files, 88
Naming glossary items, 61
Nesting (%-SHIFT-N) and un-nesting
  (%-SHIFT-M), 57
New command (%-N), 484
Newsletters, 429–445
Next Style box, 137
Normal style, 75
   applying (⌘-SHIFT-P), 74–75, 287
   basing styles on, 107
   making global changes with, 76
   reasons not to stay Normal, 76
   redefining, 84–85, 287, 435
Numbering, 353–359

Outlining (continued)
   showing and hiding body text, 342
   specifying what text appears, 343–346
   for table of contents, 262
   typing body text, 133
Oxford rules, 442–443

Page Break Before, 404
Page break limitations, 493–494
Page breaks, 272–275, 331, 465–466
   keyboard command (SHIFT-ENTER), 117
   split captions, 274
Page forward icon, 199
Page numbers
   automatic starting numbers, 303
   in headers, 292
   in long documents, 302
   in PostScript, sideways, 440, 445
   in print preview, 81
   in Section dialog box, 276
Page Setup dialog box
   examples, 83, 98
   Font Substitution option, 83, 510
   Fractional Widths option, 420
   paper orientation, 98, 195
   Smoothing option, 172
Page view (⌘-B), 115–116, 179, 198–199
   compared to other views, 129
   headers in, 291
Pages
   facing. See Facing pages
   landscape orientation of, 192
   odd and even, 284
   odd sizes, 287, 466
   orientation, 98
   turning in page view, 294
Panels, 192
Paper, odd sizes, 287–289

Odd and even pages, 284
Open command (⌘-O), 90, 484
Orphans, 465
Outdentlended paragraphs, 50
   examples, 51, 224, 265, 354–355
   keyboard shortcut, 52
Outline view
   applying styles in, 342
   compared to other views, 129
   icon bar, 129
   printing from, 347
Outlining
   advanced topics, 341–349
   applying styles, 342
   arrow icons, 133
   arrow keys, 131
   basics, 128–134
   entering (⌘-U), 130
   expanding and collapsing, 344
   gotchas, 343, 348, 410
   headings, 131
   icon bar, 343
   leaving, 134, 347
   moving sections, 348
   number icons, 345
   numbering sections, 357–359
   for page layout, 129
   printing, 347
   promoting and demoting, 131–132
   Show All icon, 343
   Show All with keypad asterisk, 343
Paragraph borders, 204–207, 241
  adding to a menu, 219
  bars, 206
  boxes, 206, 269
  dialog box examples, 206–207
  double underline, 205
  in headers, 292
  for Oxford rules, 442
  rules for, 205

Paragraph formatting
  Keep Lines Together, 274–275, 318, 466
  Keep With Next, 273–274, 318, 465
  Line Spacing, 120–121, 509
  Page Break Before, 404
  principle of, 54
  Space Before and Space After, 71, 208
  Tabs dialog box, 103

Paragraph properties mark, 184

Paragraphs, 46–47
  creating with ~-OPTION-RETURN, 106
  deleting last in a cell, 152
  delimiting paragraphs, 464
  numbering, 353–359
  outdented. See Outdented paragraphs
  paragraph marks, 46
  selecting, 272, 489
  setting vertical extent, 436
  soul of, 60
  width set in Position dialog box, 236

Paste (~-V), 489
  paragraph into a table cell, 151

Photographs. See Figures; Graphics

Picas, 452, 508–509

PICT, 162

Picture fonts, 170–171

Pitch, 509

Pixels, 172

Points, 24
  converting from inches, 388, 468
  and picas, 452

Portrait orientation, 98

Position dialog box
  Distance From Text setting, 298
  double-clicking shortcut, 184
  examples, 180, 183, 236, 261, 268, 353, 518
  Paragraph Width setting, 236, 267, 297, 383

Positioned objects, 178–181, 235–238,
  297–299, 517–518
  adjusting in print preview, 181–182,
  379–381
  for a bleed, 469
  examples, 180, 259–262, 266–268
  gotchas, 184, 452–454
  headings in the side bar, 352–353
  interacting with tables, 239, 244
  overlapping text and graphics, 377–381
  when to use, 260

PostScript, 16, 386–387, 413–418
  centering text, 391–394, 436
  clipping, 438
  comment delimiter, 390
  creating a print file, 387
  example output, 437–438
  framing the page, 396–399
  gray screens, 443
  gray text, 388–396, 439–440
  for a masthead, 436–439
  printing page numbers, 440, 445
  registration marks, 445, 468
  rotating text, 393, 440
  setting the font, 390–391, 416, 440
  as a source of graphics, 176
  style for, 387
  style redefined, 389, 435

PostScript commands
  charpath, 438
  clip, 438
  closepath, 398
  fill, 413
  lineto, 398
  moveto, 389, 391
  .page., 398
PostScript commands (continued)
  .para., 392
  .pic., 444
  setfont, 416, 440
  setgray, 391, 413
  show, 391
  stringwidth, 418
PostScript variables
  wp$bottom, 398
  wp$page, 416, 440
  wp$left, 398
  wp$right, 398
  wp$top, 398
  wp$x, 392, 418
  wp$y, 392
Preferences dialog box, 254, 508
Print Next File option, 303
Print preview, 79–81, 199, 380
  changing margins in, 81
  compared to other views, 129
  margins icon, 81, 181
  numbering pages, 81
  page coordinates in, 388
  repositioning headers, 294
  viewing one or two pages, 81, 200
Printers. See also Imagesetters
  dot matrix, 14
  laser, 14, 172
  letter quality, 14
  resolution, 16, 172
Printing
  back to back, 284
  background printing, 303
  close to the page edge, 431
  hidden text, 255
  on an imagesetter, 422–424
  linked files, 303
  lists of styles, 253, 459
  to a PostScript file, 387
  preparing for, 327–333, 458
  from print preview, 81
  production issues, 466
  Proportional fonts, 83
  Proposals, 251–279
  Pull quotes, 207, 404, 442–443

Q

  Questionnaires, 440
  Quotes, 418

R

Radicals in mathematical formulas, 322
Registration marks, 445, 466–467
Renumber command, 353–359
Reports, 401–424
Resolution, 479
  bit maps, 172
  draw vs paint, 173, 186
  on an imagesetter, 422
  improving through reduction, 173–175
Résumés, 127–158
RETURN
  what it does, 53
  what it should not do, 19
Rotating text, 194, 394, 439–440
RTF (Rich Text Format), 471–472
Rulers, 47
  column markers, 145, 157, 230
  controlling justification on, 86, 234
  decimal tab icon, 230
  defining styles with, 516
  how they work, 56
  line spacing icons, 54, 120, 150, 154
  redefining styles with, 149, 516
  right margin mark, 99
  scale icon, 145, 149, 157, 229
  Show Ruler command (#R), 47
  style selection list, 146, 515
  tab setting icons, 102
  using style selection box, 150
Running heads, 259. See also Headers
S

Same as Previous button, 292
Save command (€-S), 484–485
Scrapbook desk accessory, 162
Scrapbooks, 176
Screen shots (€-SHIFT-3), 339
Scripts, 63–64
Scroll bars, 486. See also Split bar
Section dialog box
columns, 99–101, 197, 315
examples, 100
First Page Special option, 276, 290, 315, 383
From Bottom setting, 315, 326
From Top setting, 293, 409
Header/Footer settings, 293, 315
Include Endnotes option, 315
New Page option, 260
No Break option, 200, 213, 314
Odd Page option, 290
Page Numbers option, 276
Restart at 1 option, 412
section start, 200, 260, 314
Sections, 46
formatting the wrong, 413
how to use, 197
marking (€-ENTER), 197, 314
multiple, 314
when to use, 410
Selecting
columns, 246
columns in a table, 230
commands from menus, 484
entire document, 287, 489
entire lines, 200, 489
entire paragraphs, 272, 489
entire table, 229
paragraph marks, 57–60
paragraphs, 105
rows in tables, 233
sentences, 488
Selecting (continued)
single words, 488
table cells, 150
Selection bar, 105, 489
Serifs, 24
Setgray, PostScript command, 413
Shadow border, for table cells, 239
SHIFT-RETURN
appearance of, 109, 258
examples, 109, 114, 239, 295, 318, 383–384
fitting text to a graphic, 493
Short Menus command, 70
Show Hidden Text command, 254
Show ¶ (€-Y), 46
as it affects formulas, 319
as it affects graphics, 168
effect on page view, 180
Show Ruler command (€-R), 47
Side headings, 141, 144
Slop, 466
Small caps (€-SHIFT-$), 202–203, 297, 377
Smart Quotes feature, 418–419
Smoothing, 170, 172
Space Before
gotchas, 208
icon on ruler, 54
and Space After, 72
Spaces, unconscionable use of, 19, 51
Spell checking, 327–331. See also
Dictionaries
Split bar, 323, 367
Spreads, 283–285, 412
Square roots, 322
Stretching text, 200
Style selection box, 70, 515
examples, 516
redefining styles with, 150, 516
Style sheets, 90, 302, 310, 452
Style suggestions
   for captions, 317, 404–405
   for computer manual, 369
   for figures, 318, 404–405
   for formulas, 318
   for headers, 293, 411
   for how-to lists, 464
   identify elements first, 109
   for letterheads, 377
   for newsletter, 433
   one per design element, 78
   for PostScript, 389, 435
   for pull quotes, 405
   when to define, 71, 105, 208

Styles, 69. See also Automatic styles;
   Define Styles dialog box
   applying, 74–75, 91, 208, 287, 515
   applying to table cells, 238
   applying while in outline view, 342
   character styles, 463
   dealing with many styles, 457, 459
   defaults, 435–436
   defining, 69, 105, 287, 516
   defining style chains, 442
   deleting redefined defaults, 436
   describing, 77
   gotchas, 456
   hierarchy, 256, 293, 459, 465
   importing, 90, 253, 301–302
   Next Style examples, 136–138, 317
   reasons for using, 97, 455–457
   redefining, 149–150, 516
   style name aliases, 293
   when to use next style, 137
   within tables, 146

Styles dialog box, 74
 Summations in mathematical formulas, 322
 SuperPaint, 163
   draw layer, 173
   laser bits, 173
   paint layer, 171, 173
 Symmetry, 34–36

T
 Tab leaders, 103, 441
 Tab settings, 102–103, 234. See also Tabs
 Table dialog box, 157, 232
 Table of Contents
   dialog box, 277
   editing, 278
   for figure lists, 470
   gotchas, 360, 422
   for a long document, 303–305
   purpose of, 252
   redefining styles, 360–361
   using .c. paragraphs, 303–305
   using heading styles, 277–279
   using outlining, 262, 359–361
 Tables, 141–143, 225–226, 516–517.
   See also Cells
   adding columns, 155–158
   adding rows, 145, 239
   changing column width, 148–149
   for a chapter title, 295
   column labels, 232
   column widths in, 157, 230
   for columns, 225
   creating new ones, 144, 227
   cutting and pasting cells in, 151
   examples, 144–146, 148–149, 225, 296
   filling in, 244
   four dialog boxes, 232
   imported from Excel, 270, 402, 423–424
   inserting paragraph above, 240
   inserting rows, 232–233
   misaligned first lines, 146
   moving around, 229
   pasting text into, 151
   as positioned objects, 244
   selecting cells, 150
   selecting columns, 148, 230
   selecting rows, 151, 233
   side headings with, 143–145
   styles within, 146, 149
Tables (continued)
tabs inside cells, 231
when to use, 260
Tabs
for adding rows to tables, 145, 239
decimal, in tables, 230
default settings, 57
examples, 224
gotchases, 132, 360
to make columns, 224
for moving in tables, 229
in table cell text, 231
Tabs dialog box, 103–104
Tearoff lines, 441
Templates, 301–302, 457–460
installing in Work menu, 89
for journal article, 333
for letter, 87
locking master, 89
rules for group projects, 457
Text sandwiches. See Pull quotes
Text to Table dialog box, 151
Thumb, 486
Thumbnail sketches, 68
Time, in headers, 292
Traditions
beginning on an odd page, 285
indexing, 364
no headers on first page, 285
page numbering, 284
Typefaces, 8, 14, 495–503. See also Fonts

Typesetting, 14–15
Typewriting, habits from, 19

V
Vaporware, 338
Vertical alignment, in table cells, 440
Vertical justification, 213, 332–333, 494

W
White space, 32–34, 311, 402
controlling through paragraph formatting, 72
in justified text, 216
White text on black, 377, 381, 494
Widow control, 213, 332, 465
Windows, 482
Word, 17
advantages of, 492
basic skills, 481–490
hardware requirements, 478–479
help system, 490
launching, 483
limitations of, 431–432, 491–494
opening a document, 483
software requirements, 479–480
Word processing, as distinct from typesetting, 14
Word Settings file, 90, 435
Word wrap, 48
Work menu, 89–90, 247, 473
installing glossary item on, 62
Writing problems, 252–255
WYSIWYG, 15
counter-examples, 109
in page view, 115

U
Underlining, 19, 243, 272
Undo (⌘-Z), 60
Selections from The SYBEX Library

APPLE/MACINTOSH

Mastering ProDOS
Timothy Rice/Karen Rice
260pp. Ref. 315-5
An in-depth look at the inner workings of ProDOS, for advanced users and programmers—with discussion of system programming techniques, sample programs in BASIC and assembler, and scores of ready-made ProDOS utility routines.

Mastering Adobe Illustrator
David A. Holzgang
330pp. Ref. 463-1
This text provides a complete introduction to Adobe Illustrator, bringing new sophistication to artists using computer-aided graphics and page design technology. Includes a look at PostScript, the page composition language used by Illustrator.

Mastering WordPerfect on the Macintosh
Kay Yarborough Nelson
462pp. Ref. 515-8
The graphics-oriented Macintosh version of WordPerfect is discussed from startup to mastery in this excellent tutorial. Detailed treatment of software features, plus sample layouts and design tips especially for the Mac. Includes Fast Track speed notes.

Understanding HyperCard
Greg Harvey
580pp. Ref. 506-9
The enormous potential of this major software development is clarified and explained in this extensive hands-on tutorial which covers all aspects of the HyperCard and HyperText world, using step-by-step discussions, examples, and insights. The best way to construct, fill, and use stacks efficiently is covered in detail.

HyperTalk Instant Reference
Greg Harvey
316pp. Ref. 530-1
For serious HyperCard users, this finger-tip reference offers complete, cross-referenced summaries of HyperTalk commands, functions, properties, and constants. Examples of usage and an introduction to Scripting are provided.

Mastering AppleWorks (Second Edition)
Elna Tymes
479pp. Ref. 398-8
New chapters on business applications, data sharing DIF and Applesoft BASIC make this practical, in-depth tutorial even better. Full details on AppleWorks desktop, word processing, spreadsheet and database functions.

AppleWorks Tips and Techniques (Second Edition)
Robert Ericson
462pp. Ref. 450-1
An indispensable collection of timesaving techniques, practical solutions, and tips on undocumented problems for every AppleWorks user. This expanded new edition covers all versions through 2.0, and includes in-depth treatment of macros.

The ABC’s of Excel on the Macintosh
Douglas Hergert
314pp. Ref. 562-X
This title is written for users who want a quick way to get started with this highly-acclaimed spreadsheet program. The ABC’s offers a rich collection of hands-on

Mastering Excel on the Macintosh
(Second Edition)
Carl Townsend
607pp. Ref. 439-9
A new edition of our popular hands-on guide to using Excel's extensive worksheet, database, and graphics capabilities. With in-depth coverage of special features and techniques, sample applications, and detailed treatment of macros.

Programming the Macintosh in Assembly Language
Steve Williams
779pp. Ref. 263-9
A comprehensive tutorial and reference covering assembly-language basics, the 68000 architecture and instruction set, the Macintosh Toolbox, linking with high-level languages and more; plus an extensive macro library and sample programs.

Programming the Macintosh in C
Bryan J. Cummings/Lawrence J. Pollack
294pp. Ref. 328-7
A comprehensive introduction to C programming, especially for Macintosh users. Covers the design philosophy and special advantages of C, as well as every feature of the language. With extensive reference material.

WORD PROCESSING

The ABC's of WordPerfect 5
Alan R. Neibauer
239pp. Ref. 425-9
This basic introduction to WordPerfect consists of short, step-by-step lessons—for new users who want to get going fast. Topics range from simple editing and formatting, to merging, sorting, macros, and more. Includes version 4.2

Mastering WordPerfect 5
Susan Baake Kelly
709pp. Ref. 500-X
The revised and expanded version of this definitive guide is now on WordPerfect 5 and covers wordprocessing and basic desktop publishing. As more than 200,000 readers of the original edition can attest, no tutorial approaches it for clarity and depth of treatment. Sorting, line drawing, and laser printing included.

Advanced Techniques in WordPerfect 5
Kay Yarborough Nelson
586pp. Ref. 511-5
Now updated for Version 5, this invaluable guide to the advanced features of WordPerfect provides step-by-step instructions and practical examples covering those specialized techniques which have most perplexed users—indexing, outlining, foreign-language typing, mathematical functions, and more.

WordPerfect Desktop Companion
SYBEX Ready Reference Series
Greg Harvey/Kay Yarborough Nelson
663pp. Ref. 507-7
This compact encyclopedia offers detailed, cross-referenced entries on
every software feature, organized for fast, convenient on-the-job help. Includes self-contained enrichment material with tips, techniques and macros. Special information is included about laser printing using WordPerfect that is not available elsewhere. For Version 4.2.

**WordPerfect 5 Desktop Companion**
SYBEX Ready Reference Series
Greg Harvey/Kay Yarborough Nelson
1000pp. Ref. 522-0
Desktop publishing features have been added to this compact encyclopedia. This title offers more detailed, cross-referenced entries on every software features including page formatting and layout, laser printing and word processing macros. New users of WordPerfect, and those new to Version 5 and desktop publishing will find this easy to use for on-the-job help. For Version 5.

**WordPerfect Tips and Tricks**
(Third Edition)
Alan R. Neibauer
650pp. Ref. 520-4
This new edition is a real timesaver. For on-the-job guidance and creative new uses, this title covers all versions of WordPerfect up to and including 5.0—covers streamlining documents, automating with macros, new print enhancements, and more.

**WordPerfect 5 Instant Reference**
Greg Harvey/Kay Yarborough Nelson
316pp. Ref. 532-2
This pocket-sized reference has all the program commands for the powerful WordPerfect 5 organized alphabetically for quick access. Each command entry has the exact key sequence, any reveal codes, a list of available options, and option-by-option discussions.

**WordPerfect Instant Reference**
SYBEX Prompter Series
Greg Harvey/Kay Yarborough Nelson
254pp. Ref. 476-3
When you don't have time to go digging through the manuals, this fingertip guide offers clear, concise answers: command summaries, correct usage, and exact keystroke sequences for on-the-job tasks. Convenient organization reflects the structure of WordPerfect.

**Mastering SAMNA**
Ann McFarland Draper
503pp. Ref. 376-7
Word-processing professionals learn not just how, but also when and why to use SAMNA's many powerful features. Master the basics, gain power-user skills, return again and again for reference and expert tips.

**The ABC's of Microsoft WORD**
Alan R. Neibauer
321pp. Ref. 497-6
Users who want to wordprocess straightforward documents and print elegant reports without wading through reams of documentation will find all they need to know about MicroSoft WORD in this basic guide. Simple editing, formatting, merging, sorting, macros and style sheets are detailed.

**Mastering Microsoft WORD**
(Third Edition)
Matthew Holtz
638pp. Ref. 524-7
This comprehensive, step-by-step guide includes Version 4.0. Hands-on tutorials treat everything from word processing basics to the fundamentals of desktop publishing, stressing business applications throughout.

**Advanced Techniques in Microsoft WORD**
Alan R. Neibauer
537pp. Ref. 416-X
The book starts with a brief overview, but the main focus is on practical applications using advanced features. Topics include customization, forms, style sheets, columns, tables, financial documents, graphics and data management.

**Mastering DisplayWrite 4**
Michael E. McCarthy
447pp. Ref. 510-7
Total training, reference and support for users at all levels—in plain, non-technical
language. Novices will be up and running in an hour’s time; everyone will gain complete word-processing and document-management skills.

Mastering MultiMate Advantage II
Charles Ackerman
407pp. Ref. 482-8
This comprehensive tutorial covers all the capabilities of MultiMate, and highlights the differences between MultiMate Advantage II and previous versions—in pathway support, sorting, math, DOS access, using dBASE III, and more. With many practical examples, and a chapter on the On-File database.

The Complete Guide to MultiMate
Carol Holcomb Dreger
208pp. Ref. 229-9
This step-by-step tutorial is also an excellent reference guide to MultiMate features and uses. Topics include search/replace, library and merge functions, repagination, document defaults and more.

Advanced Techniques in MultiMate
Chris Gilbert
275pp. Ref. 412-7
A textbook on efficient use of MultiMate for business applications, in a series of self-contained lessons on such topics as multiple columns, high-speed merging, mailing-list printing and Key Procedures.

Introduction to WordStar
Arthur Naiman
208pp. Ref. 134-9
This all-time bestseller is an engaging first-time introduction to word processing as well as a complete guide to using WordStar—from basic editing to blocks, global searches, formatting, dot commands, SpellStar and MailMerge. Reviewers call it “clearly written, conveniently organized, generously illustrated and definitely designed from the user’s point of view.”

Practical WordStar Uses
Julie Anne Arca
303pp. Ref. 107-1
A hands-on guide to WordStar and MailMerge applications, with solutions to common problems and “recipes” for day-to-day tasks. Formatting, merge-printing and much more; plus a quick-reference command chart and notes on CP/M and PC-DOS.

Practical Techniques In WordStar Release 4
Julie Anne Arca
334pp. Ref. 465-8
A task oriented approach to WordStar Release 4 and the DOS operating system. Special applications are covered in detail with summaries of important commands and step-by-step instructions.

Mastering WordStar Release 4
Greg Harvey
413pp. Ref. 399-6
Practical training and reference for the latest WordStar release—from startup to advanced features. Experienced users will find new features highlighted and illustrated with hands-on examples. Covers math, macros, laser printers and more.

WordStar Instant Reference
David J. Clark
314pp. Ref. 543-3
This quick reference provides reminders on the use of the editing, formatting, mailmerge, and document processing commands available through WordStar 4 and 5. Operations are organized alphabetically for easy access. The text includes a survey of the menu system and instructions for installing and customizing WordStar.

Understanding WordStar 2000
David Kolodney/Thomas Blackadar
275pp. Ref. 554-9
This engaging, fast-paced series of tutorials covers everything from moving the
cursor to print enhancements, format files, key glossaries, windows and MailMerge. With practical examples, and notes for former WordStar users.

Advanced Techniques in WordStar 2000
John Donovan
350pp. Ref. 418-6
This task-oriented guide to Release 2 builds advanced skills by developing practical applications. Tutorials cover everything from simple printing to macro creation and complex merging. With MailList, StarIndex and TelMerge.

DESKTOP PUBLISHING

Mastering Ventura (Second Edition)
Matthew Holtz
600pp. Ref. 581-6
A complete, step-by-step guide to IBM PC desktop publishing with Xerox Ventura Publisher. Practical examples show how to use style sheets, format pages, cut and paste, enhance layouts, import material from other programs, and more.

Ventura Tips and Techniques
Carl Townsend/Sandy Townsend
424pp. Ref. 559-X
Packed with an experienced Ventura user’s tips and tricks, this volume is a time saver and design booster. From crop marks to file management to using special fonts, this book is for serious Ventura users. Covers Ventura 2.

Ventura Instant Reference
Matthew Holtz
320pp. Ref. 544-1
This compact volume offers easy access to the complex details of Ventura modes and options, commands, side-bars, file management, output device configuration, and control. Written for versions through Ventura 2, it also includes standard procedures for project and job control.

Mastering PageMaker on the IBM PC (Second Edition)
Antonia Stacy Jolles
400pp. Ref. 521-2
A guide to every aspect of desktop publishing with PageMaker: the vocabulary and basics of page design, layout, graphics and typography, plus instructions for creating finished typeset publications of all kinds.

Mastering Ready, Set, Go!
David A. Kater
482pp. Ref. 536-0
This hands-on introduction to the popular desktop publishing package for the Macintosh allows readers to produce professional-looking reports, brochures, and flyers. Written for Version 4, this title has been endorsed by Letraset, the Ready, Set, Go! software publisher.

Understanding PostScript Programming (Second Edition)
David A. Holzgang
472pp. Ref. 566-2
In-depth treatment of PostScript for programmers and advanced users working on custom desktop publishing tasks. Hands-on development of programs for font creation, integrating graphics, printer implementations and more.

SPREADSHEETS AND INTEGRATED SOFTWARE

The ABC’s of 1-2-3 (Second Edition)
Chris Gilbert/Laurie Williams
245pp. Ref. 355-4
Online Today recommends it as “an easy and comfortable way to get started with the program.” An essential tutorial for novices, it will remain on your desk as a valuable source of ongoing reference and support. For Release 2.
Mastering 1-2-3
(Second Edition)
Carolyn Jorgensen
702pp. Ref. 528-X
Get the most from 1-2-3 Release 2 with this step-by-step guide emphasizing advanced features and practical uses. Topics include data sharing, macros, spreadsheet security, expanded memory, and graphics enhancements.

Lotus 1-2-3 Desktop Companion
(SYBEX Ready Reference Series)
Greg Harvey
976pp. Ref. 501-8
A full-time consultant, right on your desk. Hundreds of self-contained entries cover every 1-2-3 feature, organized by topic, indexed and cross-referenced, and supplemented by tips, macros and working examples. For Release 2.

Advanced Techniques in Lotus 1-2-3
Peter Antonlak/E. Michael Lunsford
367pp. Ref. 556-5
This guide for experienced users focuses on advanced functions, and techniques for designing menu-driven applications using macros and the Release 2 command language. Interfacing techniques and add-on products are also considered.

Lotus 1-2-3 Tips and Tricks
Gene Welsskopf
396pp. Ref. 454-2
A rare collection of timesavers and tricks for longtime Lotus users. Topics include macros, range names, spreadsheet design, hardware considerations, DOS operations, efficient data analysis, printing, data interchange, applications development, and more.

Lotus 1-2-3 Instant Reference
SYBEX Prompter Series
Greg Harvey/Kay Yarborough Nelson
296pp. Ref. 475-5; 4 3/4x8
Organized information at a glance. When you don't have time to hunt through hundreds of pages of manuals, turn here for a quick reminder: the right key sequence, a brief explanation of a command, or the correct syntax for a specialized function.

Mastering Lotus HAL
Mary V. Campbell
342pp. Ref. 422-4
A complete guide to using HAL "natural language" requests to communicate with 1-2-3—for new and experienced users. Covers all the basics, plus advanced HAL features such as worksheet linking and auditing, macro recording, and more.

Mastering Symphony
(Fourth Edition)
Douglas Cobb
857pp. Ref. 494-1
Thoroughly revised to cover all aspects of the major upgrade of Symphony Version 2, this Fourth Edition of Doug Cobb's classic is still "the Symphony bible" to this complex but even more powerful package. All the new features are discussed and placed in context with prior versions so that both new and previous users will benefit from Cobb's insights.

The ABC's of Quattro
Alan Simpson/Douglas J. Wolf
286pp. Ref. 560-3
Especially for users new to spreadsheets, this is an introduction to the basic concepts and a guide to instant productivity through editing and using spreadsheet formulas and functions. Includes how to print out graphs and data for presentation. For Quattro 1.1.

Mastering Quattro
Alan Simpson
576pp. Ref. 514-X
This tutorial covers not only all of Quattro's classic spreadsheet features, but also its added capabilities including extended graphing, modifiable menus, and the macro debugging environment. Simpson brings out how to use all of Quattro's new-generation-spreadsheet capabilities.

Mastering Framework II
Douglas Hergert/Jonathan Kamin
509pp. Ref. 390-2
This business-minded tutorial includes a complete introduction to idea processing, "frames," and software integration, along with its comprehensive treatment of word
processing, spreadsheet, and database management with Framework.

The ABC's of Excel on the IBM PC
Douglas Hergert
326pp. Ref. 567-0
This book is a brisk and friendly introduction to the most important features of Microsoft Excel for PC's. This beginner's book discusses worksheets, charts, database operations, and macros, all with hands-on examples. Written for all versions through Version 2.

Mastering Excel on the IBM PC
Carl Townsend
628pp. Ref. 403-8
A complete Excel handbook with step-by-step tutorials, sample applications and an extensive reference section. Topics include worksheet fundamentals, formulas and windows, graphics, database techniques, special features, macros and more.

Mastering Enable
Keith D. Bishop
517pp. Ref. 440-2
A comprehensive, practical, hands-on guide to Enable 2.0—integrated word processing, spreadsheet, database management, graphics, and communications—from basic concepts to custom menus, macros and the Enable Procedural Language.

Mastering Q & A (Second Edition)
Greg Harvey
540pp. Ref. 452-6
This hands-on tutorial explores the Q & A Write, File, and Report modules, and the Intelligent Assistant. English-language command processor, macro creation, interfacing with other software, and more, using practical business examples.

Mastering SuperCalc 4
Greg Harvey
311pp. Ref. 419-4
A guided tour of this spreadsheet, database and graphics package shows how and why it adds up to a powerful business planning tool. Step-by-step lessons and real-life examples cover every aspect of the program.

Understanding Javelin PLUS
John R. Levine
Margaret Levine Young
Jordan M. Young
558pp. Ref. 358-9
This detailed guide to Javelin's latest release includes a concise introduction to business modeling, from profit-and-loss analysis to manufacturing studies. Readers build sample models and produce multiple reports and graphs, to master Javelin's unique features.

DATABASE MANAGEMENT

Mastering Paradox (Third Edition)
Alan Simpson
663pp. Ref. 490-9
Paradox is given authoritative, comprehensive explanation in Simpson's up-to-date new edition which goes from database basics to command-file programming with PAL. Topics include multiuser networking, the Personal Programmer Application Generator, the Data-Entry Toolkit, and more.

The ABC's of dBASE IV
Robert Cowart
300pp. Ref. 531-X
This superb tutorial introduces beginners to the concept of databases and practical dBASE IV applications featuring the new menu-driven interface, the new report writer, and Query by Example.

Understanding dBASE IV (Special Edition)
Alan Simpson
880pp. Ref. 509-3
This Special Edition is the best introduction to dBASE IV, written by 1 million-reader-strong dBASE expert Alan Simpson. First it gives basic skills for cre-
ating and manipulating efficient databases. Then the author explains how to make reports, manage multiple databases, and build applications. Includes Fast Track speed notes.

Alan Simpson
1056pp. Ref. 508-5
Programmers will save untold hours and effort using this comprehensive, well-organized dBASE encyclopedia. Complete technical details on commands and functions, plus scores of often-needed algorithms.

**The ABC's of dBASE III PLUS**
Robert Cowart
264pp. Ref. 379-1
The most efficient way to get beginners up and running with dBASE. Every 'how' and 'why' of database management is demonstrated through tutorials and practical dBASE III PLUS applications.

**Mastering dBASE III PLUS: A Structured Approach**
Carl Townsend
342pp. Ref. 372-4
In-depth treatment of structured programming for custom dBASE solutions. An ideal study and reference guide for applications developers, new and experienced users with an interest in efficient programming.

Also:

**Understanding dBASE III**
Alan Simpson
300pp. Ref. 267-1

**Understanding dBASE II**
Alan Simpson
260pp. Ref. 147-0

**Advanced Techniques in dBASE III PLUS**
Alan Simpson
454pp. Ref. 369-4
A full course in database design and structured programming, with routines for inventory control, accounts receivable, system management, and integrated databases.

**Simpson's dBASE Tips and Tricks (For dBASE III PLUS)**
Alan Simpson
420pp. Ref. 383-X
A unique library of techniques and programs shows how creative use of built-in features can solve all your needs—without expensive add-on products or external languages. Spreadsheet functions, graphics, and much more.

**Expert dBASE III PLUS**
Judd Robbins/Ken Braly
423pp. Ref. 404-6
Experienced dBASE programmers learn scores of advanced techniques for maximizing performance and efficiency in program design, development and testing, database design, indexing, input and output, using compilers, and much more.

**dBASE Instant Reference**
SYBEX Prompter Series
Alan Simpson
471pp. Ref. 484-4; 4 3/4x8
Comprehensive information at a glance: a brief explanation of syntax and usage for every dBASE command, with step-by-step instructions and exact keystroke sequences. Commands are grouped by function in twenty precise categories.
Understanding R:BASE
Alan Simpson/Karen Watterson
609pp. Ref.503-4
This is the definitive R:BASE tutorial, for use with either OS/2 or DOS. Hands-on lessons cover every aspect of the software, from creating and using a database, to custom systems. Includes Fast Track speed notes.

Also:
Understanding R:BASE 5000
Alan Simpson
413pp. Ref. 302-3

Understanding Oracle
James T. Perry/Joseph G. Lateer
634pp. Ref. 534-4
A comprehensive guide to the Oracle database management system for administrators, users, and applications developers. Covers everything in Version 5 from database basics to multi-user systems, performance, and development tools including SQL*Forms, SQL*Report, and SQL*Calc. Includes Fast Track speed notes.

COMPUTER-AIDED DESIGN AND DRAFTING

The ABC’s of AutoCAD
(Second Edition)
Alan R. Miller
375pp. Ref. 584-0
This brief but effective introduction to AutoCAD quickly gets users drafting and designing with this complex CADD package. The essential operations and capabilities of AutoCAD are neatly detailed, using a proven, step-by-step method that is tailored to the results-oriented beginner.

Mastering AutoCAD
(Third Edition)
George Omura
825pp. Ref. 574-3
Now in its third edition, this tutorial guide to computer-aided design and drafting with AutoCAD is perfect for newcomers to CADD, as well as AutoCAD users seeking greater proficiency. An architectural project serves as an example throughout.

Advanced Techniques in AutoCAD
(Second Edition)
Robert M. Thomas
425pp. Ref. 593-X
Develop custom applications using screen menus, command macros, and AutoLISP programming--no prior programming experience required. Topics include customizing the AutoCAD environment, advanced data extraction techniques, and much more.

DOS

The ABC’s of DOS 4
Alan R. Miller
250pp. Ref. 583-2
This step-by-step introduction to using DOS 4 is written especially for beginners. Filled with simple examples, The ABC’s of DOS 4 covers the basics of hardware, software, disks, the system editor EDLIN, DOS commands, and more.

ABC’s of MS-DOS
(Second Edition)
Alan R. Miller
233pp. Ref. 493-3
This handy guide to MS-DOS is all many PC users need to manage their computer files, organize floppy and hard disks, use EDLIN, and keep their computers organized. Additional information is given about utilities like Sidekick, and there is a DOS command and program summary. The second edition is fully updated for Version 3.3.

Mastering DOS
(Second Edition)
Judd Robbins
700pp. Ref. 555-7
"The most useful DOS book." This seven-part, in-depth tutorial addresses the needs of users at all levels. Topics range from running applications, to managing
files and directories, configuring the system, batch file programming, and techniques for system developers.

**MS-DOS Handbook**  
(Third Edition)  
Richard Allen King  
362pp. Ref. 492-5  
This classic has been fully expanded and revised to include the latest features of MS-DOS Version 3.3. Two reference books in one, this title has separate sections for programmer and user. Multi-DOS partitions, 3 1/2 disk format, batch file call and return feature, and comprehensive coverage of MS-DOS commands are included.

**MS-DOS Power User's Guide, Volume I**  
(Second Edition)  
Jonathan Kamin  
482pp. Ref. 473-9  
A fully revised, expanded edition of our best-selling guide to high-performance DOS techniques and utilities—with details on Version 3.3. Configuration, I/O, directory structures, hard disks, RAM disks, batch file programming, the ANSI.SYS device driver, more.

**MS-DOS Power User's Guide, Volume II**  
Martin Waterhouse/Jonathan Kamin  
416pp. Ref. 411-9  
A second volume of high-performance techniques and utilities, with expanded coverage of DOS 3.3, and new material on video modes, Token-Ring and PC Network support, micro-mainframe links, extended and expanded memory, multitasking systems, and more.

**DOS User's Desktop Companion**  
Judd Robbins  
969 pp. Ref. 505-0 Softcover  
459-3 Hardcover  
This comprehensive reference covers DOS commands, batch files, memory enhancements, printing, communications and more information on optimizing each user's DOS environment. Written with step-by-step instructions and plenty of examples, this volume covers all versions through 3.3.

**MS-DOS Advanced Programming**  
Michael J. Young  
490pp. Ref. 578-6  
Practical techniques for maximizing performance in MS-DOS software by making best use of system resources. Topics include functions, interrupts, devices, multitasking, memory residency and more, with examples in C and assembler.

**Essential PC-DOS**  
(Second Edition)  
Myrl Clement Shaw/Susan Soltis Shaw  
332pp. Ref. 413-5  
An authoritative guide to PC-DOS, including version 3.2. Designed to make experts out of beginners, it explores everything from disk management to batch file programming. Includes an 85-page command summary.

**The IBM PC-DOS Handbook**  
(Third Edition)  
Richard Allen King  
359pp. Ref. 512-3  
A guide to the inner workings of PC-DOS 3.2, for intermediate to advanced users and programmers of the IBM PC series. Topics include disk, screen and port control, batch files, networks, compatibility, and more.

**DOS Instant Reference**  
SYBEX Prompter Series  
Greg Harvey/Kay Yarborough Nelson  
220pp. Ref. 477-1; 4 3/4x8  
A complete fingertip reference for fast, easy on-line help: command summaries, syntax, usage and error messages. Organized by function—system commands, file commands, disk management, directories, batch files, I/O, networking, programming, and more.
TO JOIN THE SYBEX MAILING LIST OR ORDER BOOKS
PLEASE COMPLETE THIS FORM

NAME __________________________________ COMPANY ____________________________
STREET __________________________________ CITY _____________________________
STATE ______________________ ZIP ________________

☐ PLEASE MAIL ME MORE INFORMATION ABOUT SYBEX TITLES

ORDER FORM (There is no obligation to order)

<table>
<thead>
<tr>
<th>TITLE</th>
<th>QTY</th>
<th>PRICE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

SHIPPING AND HANDLING PLEASE ADD $2.00 PER BOOK VIA UPS
 FOR OVERSEAS SURFACE ADD $5.25 PER BOOK PLUS $4.40 REGISTRATION FEE
 FOR OVERSEAS AIRMAIL ADD $18.25 PER BOOK PLUS $4.40 REGISTRATION FEE

CALIFORNIA RESIDENTS PLEASE ADD APPLICABLE SALES TAX

TOTAL AMOUNT PAYABLE

☐ CHECK ENCLOSED ☐ VISA ☐ MASTERCARD ☐ AMERICAN EXPRESS

ACCOUNT NUMBER ____________________________

TOTAL BOOK ORDER $____

EXPIR. DATE _____ DAYTIME PHONE _________

CUSTOMER SIGNATURE __________________________________________

CHECK AREA OF COMPUTER INTEREST:
☐ BUSINESS SOFTWARE
☐ TECHNICAL PROGRAMMING
☐ OTHER: ____________________________

OTHER COMPUTER TITLES YOU WOULD LIKE TO SEE IN PRINT:

THE FACTOR THAT WAS MOST IMPORTANT IN YOUR SELECTION:
☐ THE SYBEX NAME
☐ QUALITY
☐ PRICE
☐ EXTRA FEATURES
☐ COMPREHENSIVENESS
☐ CLEAR WRITING

OCCUPATION
☐ PROGRAMMER ☐ TEACHER
☐ SENIOR EXECUTIVE ☐ HOMEMAKER
☐ COMPUTER CONSULTANT ☐ RETIRED
☐ SUPERVISOR ☐ STUDENT
☐ MIDDLE MANAGEMENT ☐ OTHER:

☐ ENGINEER/TECHNICAL
☐ CLERICAL/SERVICE
CHECK YOUR LEVEL OF COMPUTER USE
☐ NEW TO COMPUTERS
☐ INFREQUENT COMPUTER USER
☐ FREQUENT USER OF ONE SOFTWARE PACKAGE:
  NAME ________________________________
☐ FREQUENT USER OF MANY SOFTWARE PACKAGES
☐ PROFESSIONAL PROGRAMMER

OTHER COMMENTS:
____________________________________
____________________________________
____________________________________
____________________________________
____________________________________

PLEASE FOLD, SEAL, AND MAIL TO SYBEX

SYBEX, INC.
2021 CHALLENGER DR. #100
ALAMEDA, CALIFORNIA USA
94501
SYBEX Computer Books are different.

Here is why . . .

At SYBEX, each book is designed with you in mind. Every manuscript is carefully selected and supervised by our editors, who are themselves computer experts. We publish the best authors, whose technical expertise is matched by an ability to write clearly and to communicate effectively. Programs are thoroughly tested for accuracy by our technical staff. Our computerized production department goes to great lengths to make sure that each book is well-designed.

In the pursuit of timeliness, SYBEX has achieved many publishing firsts. SYBEX was among the first to integrate personal computers used by authors and staff into the publishing process. SYBEX was the first to publish books on the CP/M operating system, microprocessor interfacing techniques, word processing, and many more topics.

Expertise in computers and dedication to the highest quality product have made SYBEX a world leader in computer book publishing. Translated into fourteen languages, SYBEX books have helped millions of people around the world to get the most from their computers. We hope we have helped you, too.

For a complete catalog of our publications:

SYBEX, Inc. 2021 Challenger Drive, #100, Alameda, CA 94501
Tel: (415) 523-8233/(800) 227-2346  Telex: 336311
Fax: (415) 523-2373
## CHAPTE RS

### ABOUT SECTIONS

<table>
<thead>
<tr>
<th></th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Page Special</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Headers and Footers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Section Columns</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Section Mark</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Section Start</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
</tbody>
</table>

### ABOUT CHARACTERS

<table>
<thead>
<tr>
<th></th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expanded and Condensed</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Finding Special Characters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Font Size</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Font Substitution</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Hidden Text</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Ligatures</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Special Characters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Tab Character</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
</tbody>
</table>
### ABOUT OUTPUT

<table>
<thead>
<tr>
<th></th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linotronic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### SPECIAL PROGRAM FEATURES

<table>
<thead>
<tr>
<th>Feature</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Again Shortcut</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customizing Menus and Keys</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Formulas</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Glossary</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphics</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measures</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PostScript</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resizing Graphics</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spell Checking</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
DESKTOP PUBLISHING WITH MICROSOFT WORD
ON THE MACINTOSH

You don't need expensive publishing software to create expensive-looking desktop publications using this project-oriented guide.

Desktop Publishing with Microsoft Word on the Macintosh provides a basic introduction to the software and also gives special emphasis on desktop publishing techniques. Readers are shown the best new ways to get what they want on the page, with fifteen desktop publishing projects.

You'll find step-by-step instructions and ready-made examples showing exactly how to produce your own custom résumés, newsletters, programs, forms, fliers, brochures, proposals, reports, technical documents, articles, letterheads, and more.

How about a murder mystery to lure you through the maze of desktop publishing techniques? Hard-boiled detective Delilah Stone stalks through the text, where a killer is on the loose—and clues lie hidden in a paper trail of typeset publications. If you study the examples carefully, you may solve more than just your desktop publishing needs. And here are a few of the things you'll learn how to do along the way:

• select and use type sizes and styles to best effect
• apply the same design principles used by professionals to create attractive, high-impact layouts
• import, resize, and position graphics on a page
• create special graphic effects with text
• choose among many techniques for handling columns
• use the PostScript page composition language to create extra-fancy layout effects

Desktop Publishing with Microsoft Word on the Macintosh provides specific, easy-to-follow examples covering every publishing need—from the simplest to the most complex. It's a complete guide to desktop publishing that no Word user should be without!

“The reader can look up any particular type of document and start building. . . beautifully formatted to support the clearly written text.”

Computer Currents

About the Authors

Tim Erickson trains teachers and designs curricula in mathematics and science. Author of Off and Running, a computer activities book for the classroom, and Get It Together, a collection of cooperative math problems, Erickson has also taught desktop publishing on the Macintosh.

William Finzer designs software, teaches mathematics, and plays the MIDI synthesizer. His published software includes a computer dance program, statistics simulations, and programs for creating computer game playing strategies.

SYBEX books bring you skills—not just information.